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Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of
one (1) year from the date of shipment. If any such product proves defective during this warranty period,
Tektronix, at its option, either will repair the defective product without charge for parts and labor, or will
provide a replacement in exchange for the defective product. Parts, modules and replacement products used
by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced parts,
modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the
expiration of the warranty period and make suitable arrangements for the performance of service. Customer
shall be responsible for packaging and shipping the defective product to the service center designated by
Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if
the shipment is to a location within the country in which the Tektronix service center is located. Customer
shall be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned
to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or
inadequate maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to
repair damage resulting from attempts by personnel other than Tektronix representatives to install, repair or
service the product; b) to repair damage resulting from improper use or connection to incompatible equipment;
¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product
that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE
AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs
on the media will be free from defects in materials and workmanship for a period of three (3) months from the
date of shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will
provide a replacement in exchange for the defective medium. Except as to the media on which this software
product is furnished, this software product is provided “as is” without warranty of any kind, either express or
implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s
requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the
expiration of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in
materials and workmanship within a reasonable time thereafter, Customer may terminate the license for this
software product and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR
BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF
WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF
SUCH DAMAGES.
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Welcome Technical Support

Technical Support

Tektronix welcomes your comments about products and services. Contact Tektronix via mail, telephone,
or through the Web site. Click Contacting Tektronix ) for more information.

Tektronix also welcomes your feedback. Click Customer Feedback (see page 1) for suggestions for
providing feedback to Tektronix.

Several software enhancements are included to support your TLA product. Refer to the release notes on
the TLA Application CD for the latest information. Access the release notes by selecting:

Start > All Programs > Tektronix Logic Analyzer > TLA Release Notes

About Tektronix Logic Analyzers

The Tektronix family of logic analyzers consists of the TLA7000 Series Logic Analyzers and the TLA5000
Series Logic Analyzers. The TLA7000 series offers the highest performance for today’s demanding
applications and consists of portable and benchtop modular mainframes with expansion capability.
Instrument modules include logic analyzers and serial analyzers. The TLAS5000 series offers a selection
of standalone logic analyzer instruments that make 500 ps-deep memory timing resolution available to
designers of today’s mainstream embedded systems. A full line of complementary support products for
popular processors and buses is available for the entire TLA family.

Logic Analyzer Modules

The logic analyzer modules support the iLink tool set, which provide tools to take digital and analog
measurements through a single logic analyzer probe, display time-correlated views of digital and analog
waveforms, and analyze multi-signal buses and eye diagram validation. Logic analyzer modules also
feature MagniVu, an acquisition technology that enables each of the logic analyzer modules to offer

125 ps timing resolution on all signals. MagniVu technology gives you a high-resolution window into the
actual signal activity for each channel.

Serial Analyzer Modules

The serial analyzer modules provide tools to analyze serial buses using mid-bus or slot probes. Two
different serial analyzer modules are available with different types of probes. Both modules can be used
with PCI Express Generation 1 and Generation 2 serial buses.

Customer Feedback

Tektronix values your feedback on our products. To help us serve you better, please send us any
suggestions, ideas, or other comments you may have regarding the TLA Series Logic Analyzer.
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Welcome Customer Feedback

Direct your feedback to us by email to:
techsupport@tektronix.com

In the subject field, please indicate TLA Customer Feedback.

Or FAX at (503) 627-5695, and include the following information:
®  TLA Logic Analyzer

B TLA Application software version

B TLA modules (for example, TLA7BB4)

B Microprocessor or bus support package and version.

For specific information on your TLA Series Logic Analyzer, go to the System menu, select System
Properties, and click on the appropriate property page.

The following items are important, but optional:

B Your name

B Your company

B Your mailing address

®  Your phone number

®  Your FAX number

Enter your suggestion below. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

TIP. 1o copy the above information to your email text editor, right-click the mouse and click Copy. The
above information will be copied to the clipboard to paste it into any text editor.

To include screen shots of the user interface, press the Alt key and the Print Screen key simultaneously to
copy the image to the clipboard. Paste the image into Microsoft Paint and save the image as a .BMP file.
Attach the file to your email (depending on the capabilities of your editor).
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Getting Started Overview of Connection Choices

Overview of Connection Choices

Connect to your instrument in three different ways: Remote Host, Remote Desktop, or Local. Work offline,
without connecting to the instrument, to modify setups or view data files previously saved to your PC.

Connecting as a remote host allows you to control the instrument remotely, and then store the data locally
on your PC.

Remote Host mode is best for the following:
m  Connecting to an instrument over a LAN (must be using V5.0 software or above).

B Sending data to where the application is running.

NOTE. When you open the application on the remote computer, the analyzer name is shown in the title bar.
A TLA7016 is always connected as remote host because there is no internal computer in a TLA7016.

Connecting as a remote desktop means that you are running the application on the instrument from your
PC and storing the data on the instrument.

Remote Desktop mode is best for the following:
m  Connecting site-to-site over a network.
B Troubleshooting from a remote location.

B Viewing data stored on the analyzer.

NOTE. Use remote desktop to start the TLA Server, and then connect as remote host.

Connecting locally means that you are working directly on the analyzer.
Using Local if you want to do the following:
®  Run the application and store data on the analyzer.

®  Connect a printer to the analyzer.

Related Topics

Connect to a Networked Instrument (see page 5)
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Getting Started Configuring your TLA7000 without a TL708EX

Configuring your TLA7000 without a TL708EX (see page 4)

Configuring your TLA7000 without a TL708EX

Overview

Use this dialog box to change the configuration of your TLA system when you only have two mainframes
connected with a TekLink cable. Specify which TLA is the mainframe and which one is the expansion
mainframe using this dialog box.

TLA Configuration - tlasystem1

Mainframe and Expansion Corfiguration

* Mainframe: tlasystem1 {Exp 11lasystem? )
" Mainframe: tlasystem?2 (Exp 11lasystem1)

Metwor: Properties

tlasystem1
tlasystem? MNetwork Properties ... |

oK | Cancel |

NOTE. This dialog is only accessible if the system has no more than two TLA7000 mainframes connected
with a TekLink cable.

To use the TLA Configuration dialog box, perform the following steps:
1. Select Choose TLA from the File menu to open the TLA Connection dialog box.
2. Select an instrument, and then click the TLA Configuration button.
The TLA Configuration dialog box opens.
3. Select the desired configuration under Mainframe and Expansion Configuration.

4. To edit the network properties, select the TLA7016 instrument, and then click the Network Properties
button.

Related Topics

Connect to a Networked Instrument (see page 5)
Network Properties (see page 7)
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Getting Started Connect to a Networked Instrument

Connect to a Networked Instrument

From the TLA Connection dialog box, select the instrument that you want to connect to and click the
Connect button. Customize your startup by specifying whether to run power-on diagnostics and whether to
automatically connect to a selected instrument each time you login.

NOTE. If you choose to automatically reconnect to an instrument, the next time that you start the TLA
application, it will open in the offline mode.

To change your customized settings, select Choose TLA from the File menu. Note that the TLA Server
must be running on your instrument to populate the TLA Connection dialog box. To start the TLA Server,
click the TLA Server Control icon in the Windows system tray and select Start TLA Server. The TLA
Server does not run on your PC.

&2 TLA - Conmection
i & & TLaConbguaton.,

TLA Nara Shatur Medal Dasetiztion

] jedline) TLATDNZ

| [ I s by Adrrvetrz,,  TLATONZ

¥ 128181,110,135 TLATIS Fareste Dresk [1F13)

TLAT2
1281813058 TLATiE P00 onyirg’s destF12)

4

A apphsatan sk
[ At sy sacareeed b [Local

[ Russ Penwas an Basnosdics, i

Conrect I E Cloge |

A

If you want to view the configuration of your TLA system, select an instrument, and then click the TLA
Configuration button. (This button is not active until you have selected a TLA.)

TLA Configuration - 128.181.30.58

Frama Hust tama 1P Addreas
Marfame  f2701B0g000C2 28, 13E121.20E2
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Getting Started Network Search

The instruments that are listed in the TLA Connection dialog box are determined by the network search

properties. Change the properties by clicking the i) | icon and enter your preferences in the Network
Search Preferences dialog box.

TLA MNetwork Search

Locate TLA systems on local subnat

Incleda theas hostnamas or |F in seamch
Add hostname or [P

Hostname or [P
1r.ej\:u.-.al':5

Ha 701 EqDO00E coe bek com
ala 125361 coa tek com

E Fieptace ALL with TLAS found on suhnet ]

Carnice I Search H Claze ]

A

TIP. If you do not know the host name or IP address, select the Locate TLA systems on local subnet check
box. This will find any TLA instrument that is connected to the same subnet as your host PC in the search.

What would you like to do next?

Learn About the LA Setup Window. (see page 13)
Learn About the LA Trigger Window. (see page 143)

Network Search

Use the Network Search dialog box to set the preferences for the search criteria that the Connection dialog

box uses. Open the dialog box by clicking i | in the Connection dialog box.
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Getting Started Network Properties

TLA Network Search

Locate TLA systems on local subrat
Includs theas hostnames or [P in ssanrch
Add hostname or [P

Hestname of |P
fitznqualls

ta 701 Bglldld coe bek com
ala125361 cea tex com

[ Replace ALL with TLA% found on subnet ]

Cancel I Search ]I Close ]

A

1. Select Locate TLA systems on local subnet to include any TLA system connected to the same subnet
as your host PC in the search.

2. Select Include these hostnames or IP in search to include the instruments listed in the Hostname or IP
text box in the search. If you know the name of an instrument, add it directly by entering the name
in the Add hostname or IP text box and then clicking the Add button. This adds the instrument to
the search but not to the Connection dialog box. The instrument must be found in the search to be
added to the Connection dialog box.

3. To remove an instrument from the search, select it from the Hostname or IP text box, and then click
the Delete Selection button.

4. To update the Hostname or IP text box, click Replace All with TLAs found on subnet.

5. Click the Search button to search the subnet according to the criteria that you have set, and update the
Connection dialog box. When the search is completed, the Network Search dialog box closes and
the Connection dialog box is updated.

Related Topics

Connect to a Networked Instrument (see page 5)
Overview of Connection Choices (see page 3)

Network Properties

Overview

Use the Network Properties dialog box to configure the Host Name and IP address of your networked
instruments.
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Getting Started Network Properties

Behavior

This dialog box appears when you click the Network Properties... button in the TLA Configuration dialog
box. The Default name is a combination of the TLA7016 Interface Module model number and the serial
number. Select Use the following Name to assign a unique name. The TLA7016 Interface Module will
attempt to get its IP address automatically when Obtain Address Automatically is selected.

NOTE. This dialog is only supported on TLA7016 mainframes.

Product TLATIME, Sernial Mumber;

Heast Marie
(O Default name [a7016] Lookup IP Address |
%) U = the fobowing Mame

[TLA7016 |

“ou can get a network address automatically if your retwork
supports DHCP. Otherwize, vou must get an [P address from your
riebvanrk administratar,

%) Dbtain Address Automaticaly
) Use the folowing Address

e [ e || | ookop ot Meme
Subnet Masgk: I 285 255 10 i I
Giateway: [152. 168. I

To Use
1. Select either Default name or enter one of your choosing in the Use the following Name text box.
2. Click the Look Up IP Address button to find an IP address.

3. To specify an IP address, select Use the following Address, and then enter the IP Address, Subnet
Mask, and Gateway.
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Getting Started Options of Powering On and Off

Options of Powering On and Off

To power on the analyzer without the TLA application starting, perform the following steps:
1. Access the System folder using the following path: Program Files\TLA \System.

2. Click TLA700SU.bat and use your right mouse button to click Edit.

3. Enter the characters REM in front of the following line:

C:\ WINDOWS\COMMAND\START /MAX .\TLA700.EXE.

Specify how you want the instrument to power off through a program labeled Mainframe Utilities located
in the Windows Control Panel.

The utility also provides a screen dim mode to reduce the brightness by 60%. Refer to the help provided
with the utility for more information on both functions.

TIP. Access the Mainframe Utilities by clicking the Windows Start button, pointing to Settings and Control
Panel, and then clicking Mainframe Utilities.

Examine the Waveform

Use the Waveform window controls to view and measure the waveforms. Here are some suggestions
for getting started:

m  Use the scroll bars to display data that is currently off-screen.

®  Click 2 in the toolbar and select a mark to jump to.

B Select Cursor 1 and drag the cursor handle to a new location. The handles shown along the top of the
display are for fine control; those at the bottom are for coarse control. Note the change in the cursor
time readouts in the Cursor toolbar.

= Click the | ** ™" button to display an external oscilloscope waveform.

m  Click the “ MagniVu pytton to display a MagniVu waveform.

B To zoom data, click and drag the mouse over the area that you want to zoom. The window will zoom
to the data when you release the mouse button.

B To increase the size of the area in which the data is displayed, select Full Screen from the View menu.

=T
®  (Click e (Zoom Out) or ** (Zoom In) in the toolbar to change the horizontal scale.

B Select a waveform header and the whole row is highlighted, making it easier to view.
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Getting Started Viewing Other Types of Waveforms

La1: Al
Double-click (or any other waveform label). Change the color and size (size is
also changeable directly) of the waveform in this property page. Click OK to complete the changes
and return to the Waveform window.

Click the + on the waveform label to expand the waveform into the individual signal elements.

Drag the split box (above the top arrow of the vertical scroll bar) down to display a second data area
to view two different portions of the same acquisition memory.

TIP. If you are using a portable mainframe, use the front panel knobs to change the horizontal scale
and to scroll the data.

Viewing Other Types of Waveforms

10

Add the MagniVu version of the data at any time by clicking the < Ma@niVl pytton or use the following
steps. (MagniVu Data (see page 361) is always acquired with your other data.)

Eal o

=
Click & (Add Waveform) in the toolbar.
From the Data Source list, select LA1 - MagniVu.
Select a MagniVu waveform or group (for example, Mag_A3), and click Add.

Click the Close button when you have finished adding waveforms.

When viewing LA groups, view the data as busforms or as magnitude waveforms by right-clicking the
mouse over a data label and selecting either Display Busform or Display Magnitude. Expand the group
into the individual busforms by clicking the + on the label.

Or,

1.

=
Double-click the label of a signal waveform. (If you do not have a group waveform, click G , select
an LA Data Source, and choose a group to display. Confirm and exit the dialog box.)

2. From the Waveform Properties tab, click the Options button.

3. Select Busform or Magnitude, and click OK to close the Waveform Options dialog box.
4. Click OK. The waveform is displayed accordingly.

Related Topics

Multi-Signal Magnitude LA Waveforms (see page 211)

Multi-Signal Busform LA Waveforms (see page 211)
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Getting Started Viewing a Magnitude Waveform Sample

Viewing a Magnitude Waveform Sample

20w N =

® A N

Click F in the toolbar to start the New Data Window wizard.
Click Waveform and click the Next button.
Click Add Data Source.

Enter the following path into the File name box, or click browse to navigate to the SampleSystem.tla
file:

C:\Program Files\TLA700\Samples\TLA700 Samples\Data Files\SampleSystem.tla

Click the Add button. The SampleSystem data source is added to the list of data sources.

Click LA under SampleSystem.tla and click the Next button.

Enter a name for the new data window or use the default name and then click the Finish button.
Choose one of the following procedures:

a. Right-click the mouse over any data label and select Display Magnitude.

Or

a. Double-click the new Down Count label.

b. Click Options and select Magnitude, click OK twice to close the dialog boxes.

c. Click the Zoom buttons to view a sawtooth waveform. The waveform is a graphic representation
of counter data.

Examine the Listing Data

Here are some suggestions for viewing Listing window data:

1.

2.
3.

Use the scroll bars to display data that is currently off-screen.

Click fﬁ' in the toolbar and select Cursor 1.

Drag the cursor handle to a new location. The handles shown along the left of the display are for
fine control; those at the right are for coarse control. Note the change in the cursor sample number
and delta time readouts in the Cursor toolbar.

Click the toolbar Font buttons to change the display font size.

Drag the split box (beside the left arrow of the horizontal scroll bar) to display a second data area to
view two different portions of the same acquisition memory.

Double-click an address or data column label (for example, -) Change the attributes of the
column in this property page.
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Getting Started Searching Selected Data

7.

8.

From the Column property page, try loading a symbol file: click the radix button box, choose the
Symbolic radix, click the Symbol File button, and choose a symbol file.

Confirm and exit the property page.

Searching Selected Data

1.

2.
3.

Double-click a data entry in one of the columns of the Listing window. The data is now selected. Click

in the toolbar to copy the data onto the clipboard.

Click () in the toolbar.

From the Search Definition drop-down list, select a saved search definition from the selected data
window or type in a new search name.

NOTE. 7o add a search definition from another data source, click the Load button to open the Load
Search dialog box.

10.

12

Click the Start from drop-down list to select where you want to start searching and enter the number of
occurrences to find in the occurrence text box.

Click the Search Options... button to open the Search Options dialog box and select what action you
want the logic analyzer to take when the search is successful.

Type a Description of the search in the Description text box.
From the Search drop-down list, select the data source.

Paste the data that you copied from the Listing window into the appropriate text box in the Find
area by pressing CTRL+V (the paste shortcut key combination). Use the same method for pasting a
quick entry into a trigger program definition.

Use the Group drop-down list to select the column from which you copied the data.

Click Search Forward. The logic analyzer displays the next instance of the specified data. Once you
have defined the search criteria, click the Search Forward or Backward toolbar buttons for additional
searches.
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System Setup LA Setup Window

LA Setup Window

The primary function of the Setup window is to configure the LA module for compatibility with the system
under test. Use this window to do the following tasks:

m  Set thresholds

®  Set global setup and hold sampling
m  Specify signal groups

®  Name signals

®  Select filter and analysis tools

To Use

1. From the TLA toolbar, click the Setup button, and then select your module, (for example LA 1, when
there is more than one LA module).

Specify the type of sampling (see page 14).

Set the memory depth (see page 27).

Specify the storage option (see page 25).

Associate meaningful signal names (see page 18) to probe channels.

Create meaningful groups (see page 22).

A S o o

Deskew the probes (see page 16).

NOTE. After defining the LA Setup window, you can immediately acquire data. To improve your acquisition
results, revise your Trigger window and adjust your data window properties.

Behavior

The LA Setup window and the associated Trigger window determines what data will be acquired. Each
module has a Setup window and Trigger window; they are set up individually and used separately for
their particular purposes. Configure the Setup window before the Trigger window; many of the Setup
window settings affect Trigger window selections.

TIP. To duplicate the current setup for another LA module, open to the File menu and click Save Module.

For quick access to the Setup window on the TLA7012 Portable Mainframe, press the Setup button on
the front panel. Continue to press the Setup button to cycle through all the acquisition module Setup
windows in the system.
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System Setup Sampling

Base Signal

A memory storage location for acquisition data.

Prime Signal

An expanded memory location for high speed data acquisition. The logic analyzer creates prime
signals for storage when the speed of acquisition exceeds that available for base signals alone. Prime
signals have an exponent added to the base name.

Creating a prime signal increases the memory available and removes the base signal from the
Signal Mapping area.

Sampling

14

The logic analyzer supports two basic types of sampling: asynchronous and synchronous, each displayed
in its own tab on the sampling screen. A third type of sampling, custom sampling (see page 328) is
available only when a support package (see page 14) is loaded on the logic analyzer. The tab label includes
the name of the support package.

When you use asynchronous sampling, the logic analyzer generates its own clock signal at regular, fixed
intervals to sample data from the system under test. Acquisitions taken with asynchronous sampling are
often referred to as timing acquisitions, and are best viewed in the Waveform window.

When you use synchronous sampling, a clock from the system under test samples the signal. This clock
can be a fixed frequency, or it may be highly variable. Acquisitions taken with synchronous sampling are
often referred to as state acquisitions and are best viewed in the Listing window.

To Use
1. From the TLA toolbar, click the Setup button, and then select your module, (for example LA 1).
2. Click the Asynchronous, Synchronous, or support package tab.

3. Adjust the controls as needed for your situation.

NOTE. Sampling and state speeds will vary by module.

Microprocessor or Bus Support Package

A microprocessor or bus support package is a software application that allows the logic analyzer to
acquire and disassemble microprocessor data or data from a bus.

Some support packages include a hardware probe adapter that is attached directly to the
microprocessor in the system under test to capture microprocessor signals.

The LA Setup window shows which support package is currently installed.
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System Setup Synchronous Sampling: Define Single Clock

Synchronous Sampling: Define Single Clock

The default controls for the Synchronous tab establish global settings for setup and hold across all signals
in the module. Use this tab to specify a single clock from the system under test for your synchronous clock.
Change the settings for individual signals in the Signal Mapping area (see page 18).

To Use

1. From the TLA toolbar, click the Setup button for your module.

Click the Synchronous tab.

If necessary, click the drawer arrow (<||||) to open the Define Single Clock panel.

Select the clock source from the Single Clock Source list.

A

Adjust the Global Default Threshold. This setting should match most of the signals that you are
sampling with the current module.

6. Enter a maximum clock rate or the minimum clock period for your module.

Setting this value helps scale the T, and T}, elements in the diagram. Enter a value that is likely to be
greater than your maximum clock rate; an accurate value is not needed.

7. Select the clock edge and adjust the busform to match your SUT setup and hold times; drag the
whole busform or just the edges.

Behavior

When you select the DDR check box, the logic analyzer automatically selects the appropriate sampling
points based on the Max Clock Rate and currently selected sample points. If you manually select two
points, the DDR check box is automatically selected.

Synchronous Sampling: Define Compound Clock

Use the Define Compound Clock controls to set up a compound synchronous clock. This is a global
setting for the module. Use this tab to change the settings for individual signals in the Signal Mapping

area (see page 18).

To Use

1. From the TLA toolbar, click the Setup button for your module.
2. Click the Synchronous tab.

3. [If necessary, click on the drawer arrow (|||[>) to open the Define Compound Clock panel.

TLA Online Help 15



System Setup Deskew Panel

4. In the Master Sampler table, define the synchronous clock sources by selecting the clocks and
qualifiers from the drop-down list within each table cell. The graphic shows the resultant settings.

5. Adjust the Default Threshold. This setting should match most of the signals that you are sampling
with the current module.

6. In the Speed drop-down list box, select a bandwidth for the module you are using. If you select
Max, and reload a different module, the default setting uses the maximum speed of the module (only
available with TLA7000 series logic analyzer modules).

7. Set the Pipeline Delay for all acquired signals.

8. Enter the minimum clock period for your module.

Behavior

When you display the Define Compound Clock panel, the logic analyzer uses the default values you
assigned in the Define Single Clock panel, including Min Clock Period, T; and T, and the number
of sample points.

If you defined a DDR sampling structure in the Define Single Clock panel, the Sampler Definition area
indicates two sample points corresponding to the DDR definition. However, you will note that the
Compound Clock diagram differs significantly from the Single Clock diagram.

NOTE. To configure individual channels with varying numbers of sample points, use Compound Clocking
and then adjust each signal definition using the Signal Sampling Screen (see page 24).

Deskew Panel

Deskew allows you to compensate for propagation delays in your circuit traces that differ from your design
due to the location of the probe header. Perform the deskew on all signals in the module by clicking the
Deskew button. You can also deskew individual signal groups (see page 17).

This procedure applies deskew to all signals in the module.
1. From the TLA toolbar, click the Setup button for your module.
2. Click the Synchronous tab.

3. Use the Search Range and Accuracy controls to adjust deskew settings for all signals for the connected
modules.

4. Click the Deskew button.

The logic analyzer displays the Deskew progress bar in the Status area during deskew.
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System Setup Group Deskew

Group Deskew

This procedure deskews selected signals within a defined group based on parameters you set in the
Deskew panel. After you make any changes to selected signals in the group, the Global Values check box
will be cleared. This indicates that these signals will not track changes to the parameters in the Global
Sampling diagram.

1. From the TLA toolbar, click the Setup button for your module.
2. Click the Synchronous tab.

3. In the Group Management area, adjacent to the Signal Mapping area, create and name a signal

group (see page 22).

4. In the group card, click the Local Sampler Definition thumbnail —l;(_ in the group card header
to open the Signal Sampling screen.

5. In the Signal Sampling screen, verify that the signals that you want to deskew are highlighted in
the Signal tree.

6. Click the Deskew button to deskew the highlighted signals in the group.
The logic analyzer displays the Deskew progress bar in the Status area during deskew.

To return signals to the global value, select the Use Global Values check box.

Behavior

Before deskew, the logic analyzer displays all of the signals in the local Setup and Hold diagram on top
of one another. After the deskew, the logic analyzer displays the signals as a fuzz band (see page 18) in
the Setup and Hold diagram.

Related Topic
Signal Sampling Screen: Adjusting Setup and Hold Values (see page 24)
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System Setup Signal Mapping Area

Fuzz Band

The logic analyzer displays signals as a fuzz band within the Setup and Hold diagram. The display
shows the signal frequency as a temperature gradient where the warmer or brighter colors represent a
higher density of signals. The cooler or darker colors represent areas where fewer signals overlap.
Click an area in the fuzz band to select a signal from the tree. Adjust the Setup and Hold values for
the selected signal or move the signal within the fuzz band.

176 ps |E|v T: Th [Ops =

Signal Mapping Area

18

The Signal Mapping area allows you to view the physical resources of the module. It also provides a
centralized area for viewing signal activity, signal type and characteristics, sampling configuration, and

base (see page 14) and prime (see page 14) signal participation.

Use the Signal Sampling screen to configure the threshold, polarity, type, and the sampling definitions for
individual signals. Access the Signal Sampling screen either through the right-click menu (by clicking the
activity indicator in a channel cell for the signal), or by clicking the Local Sampler Definition thumbnail

—;(_ next to the probe section header

Behavior

The Signal Mapping area is a collection of cells organized into a two-dimensional matrix. The columns
represent the probe leads (consisting of probe sections in a 7 — 0 order, plus the clock and qualification
leads). The rows represent probe sections, with adjacent rows representing paired probe sections. Columns
and rows cannot be individually sized, and header cells cannot be renamed.

The Signal Mapping area may display logical signals that have no physical counterpart (such as status
bits or static bits).
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System Setup Signal Mapping Area

Sampling Definition Thumbnails. When a module is sampling in synchronous sampling mode or custom
sampling mode, the Thumbnail column displays images representing the sampling definition of the probe
signals. In addition to identifying the characteristics of the probe section sampling characteristics, the
thumbnail is a button used to display the Signal Sampling screen.

NOTE. The logic analyzer does not display thumbnails in the asynchronous sampling mode.

Click the thumbnail image to open the Signal Properties screen to set the sampling offsets for base (see
page 14) and prime (see page 14) signals.

Thumbnail type Description
_/— —\_ Basic sampling, rising or falling edge, single sample point
= - Compound sampling, one or more rising or falling edges, no
qualifier
Same as above with additional sample point
o/ oljs\c
.—. Basic sampling, rising or falling edges, two sample points
Compound sampling, one or more rising and falling edges,
x o no qualifier
F = Compound sampling, one or more edges with one or more
_/_IJ _\_D qualifiers.
= Compound sampling, one or more rising and falling edges,
)'{ o one or more qualifiers
Varies (variable sampling), signals in a group or section have
D_I;(E;:! different sampling characteristics

The clocking figure may have any of the images shown above;
the rising edge shown for illustration purposes only

By default, the displayed thumbnail corresponds to the Global Sampling Definition. When you change
an individual signal sample point (either manually or as a result of the deskew function), the thumbnail
displays the Varies image, indicating that at least one signal in the section has a different sample point.

Thumbnails appear for base signals and group cards and are not available for prime signals, status bits,
or custom sampling contexts.

Probe Section Header

The logic analyzer uses the Probe Section Header to identify base (see page 14) (true sources) and prime
(see page 14) (cloned data streams from the base source) signals.

The Probe Section Header displays the name of the probe section (A0, Al, A2). Base probe sections (true
sources) display the name left-justified in the header cell.
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System Setup Signal Mapping Area

Prime probe sections (data streams cloned from the base source) are labeled with the base name and an
exponent (A0!, A02). The labels are right justified in the header cell. Prime probe sections are always
placed sequentially below their Base probe section (A0 is followed by A0!, A02).

Signal Column Header

Each probe lead is assigned a cell below its signal number. The Signal column header is a display item
only and has no interactive behavior.

Clock / Qual Header

Two columns identify the clock and qualification lead for each probe section that has one of these
additional leads. The left column permanently displays the resource name, for example CK0(), and the
right column contains the Channel / Signal cell. The Channel / Signal cell initially shows the resource
name, but you can enter your own name. For probe sections that do not have a clock, qual, or both,
both cells in the column are disabled.

Group Participation Bar

Running horizontally across the top of each Signal cell, is a color-pattern bar that indicates how signals
participate in a selected group or multiple groups. The following table shows examples of two adjacent
cells.

Appearance Description

E107) . E1(6) I Default appearance. The channels do not participate in any group.

DEACK ] Deack e | Group participation. The signals participate in the currently selected group.

Multiple group participation. The signals participate in the current selected

- I
BT g - group and at least one other group.

Other group participation. The signals participate in a group other than the

addr 31 addr 30
o selected group.

Activity Indicator

The rightmost region of a base Channel / Signal cell displays activity information and a means to modify
the operating characteristics of the signal. Instead of activity indicators, polarity indicators are displayed
for prime signals, status bits, static bits, or custom signals using the crossbar (custom storage signals).
Although you cannot change most of the operating characteristics of these types of signals, change the
polarity by right-clicking the polarity indicator and by selecting the Invert Signal Polarity from the
right-click menu.

The following table shows examples of the polarity indicators and activity indicators.
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System Setup

Signal Mapping Area

Appearance Description
D3(6) I Normal, high polarity. The indicator appears as a vertical bar in the upper cell.
a2(5) Normal, low polarity. The indicator appears as a zero in the lower cell.
o
o Inverted, low polarity. The indicator appears as a zero in the upper corner.
A2(E) Similarly for the inverted, high polarity, the indicator appears as a vertical bar
in the lower cell.
Transitioning signal.
DU g 950

Click the green and yellow activity indicator to display the Signal Sampling panel, where you set the signal

threshold value and polarity.

Static and Status Bits

These are additional signals to use in group definitions for triggering.

Related Topic

Group Management Area (see page 22)

TLA Online Help
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System Setup Group Management Area

Group Management Area

Use the Group Management area to organize the probe signals to match the configuration of the system
under test. Depending on your application, match the signal groups (see page 28) to the address and
data buses, or match the signal groups to other signals of interest. Each signal group is displayed as an
individual group card with a group name and grid. Group cards contain additional elements, such as an
activity indicator and thumbnail to help you define signal properties within the signal group.

To Use
1. From the TLA toolbar, click the Setup button for your module.
2. To create a new group, click the + icon at the top of the Group Management area.

a. Enter a group name (see page 23) for easy identification.

b. In the Signal Mapping area, select individual signals or entire probe sections, and then drag and
drop the signals to the group card.

¢. To rearrange the order of signals within a group, drag and drop them from one location to another
within the group card grid. Alternatively, right-click the mouse and select Reverse Signal Order
to change the MSB-LSB order of the signals.

3. After creating multiple group cards, rearrange them by dragging and dropping them in the Group
Management area.

4. Click the thumbnail or the activity indicator in a group card to access the Signal Sampling screen (see
page 24) to adjust signal thresholds or to adjust the setup and hold requirements for signals.

NOTE. Activity indicators and thumbnails might not display depending on the sampling you have defined.

5. Expand and collapse group cards to make room for more cards on the screen using the right-facing
arrow in the upper left corner of the group card.

Behavior

Create any number of group cards. Each group can contain any combination of module signals; you are
not restricted from mixing or repeating signals from various groups.

Groups are used in other displays and setup controls, such as the Waveform and Listing windows, and
the Trigger window. The order of the groups in this table determines the presentation order of groups in
other parts of the application.
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System Setup Signal Sampling Screen: Setting Thresholds

Support Packages

If a microprocessor support package is loaded, the signal groups are already defined. You should not
change or delete these groups; doing so can lower the accuracy of disassembly analysis. However, you still
have the option of adding and deleting new groups.

Related Topic
Signal Mapping Area (see page 18)

Group Name

Each group must have a unique name. When you use the same name as a previous group, the
application prefixes your name with a number. For example, if you try to name a group, MyGroup,
and another group already exists with the that name, the application will redisplay your group name
as 1:MyGroup.

Use the default name, or enter another name as long as it is unique. The names will appear in the
Listing and Waveform windows. There is no limit to the number of groups to create.

Signal Sampling Screen: Setting Thresholds

Use the Signal Sampling screen to set the probe signal characteristics appropriate to your system under test.

To Use
1. From the TLA toolbar click the Setup button for your module.
2. In the Signal Mapping area, select one or more cells.

3. Click the Activity Indicator in one of the selected cells. Alternatively, from the right-click menu,
select Signal Sampling.

4. Confirm the signals you want to work with are highlighted in the Signal tree. Clicking an item
removes the existing highlighting. (Press and hold CTRL+Click or SHIFT+Click to highlight multiple
items in the Signal tree.)

5. Use the slider or Preset controls to set threshold values for the highlighted items.

6. Click Normal or Inverse to set the polarity for the highlighted items.

NOTE. If you highlight a prime (see page 14) signal in the Signal tree, no corresponding threshold control
becomes available (no slider highlights in the threshold graph). Prime signals do not have thresholds.
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System Setup Signal Sampling Screen: Adjusting Setup and Hold Values

Behavior

Changes you make to the threshold are immediately applied to the signals that you highlighted (see
page 25) in the Signal tree.

NOTE. Highlight a different set of signals from the "selected" set of signals (the signals you selected
in the Signal Mapping area).

Use one of the buttons adjacent to threshold graph to assign the threshold value to more signals than the
ones you’ve highlighted. For example, if you have highlighted only one signal in the tree, (and you have
several "selected") click the Selected Signals button to assign the threshold to the selected set of signals.
Similarly, click the Probe Sections button to assign the threshold to all signals in a probe section to which a
highlighted signals belongs. The buttons are arranged top to bottom in increasing scope.

NOTE. Not all buttons will be enabled for all types of highlighting and selecting. Depending on your
module type, you might have fewer or more buttons available.

Related Topic

Signal Sampling Screen: Adjusting Setup and Hold Values (see page 24)

Signal Sampling Screen: Adjusting Setup and Hold Values

24

Use the Signal Sampling screen to adjust setup and hold times for signals at the local (probe section or
group) level when working with synchronous or custom sampling.

To Use
1. From the TLA toolbar, click the Setup button for your module.

2. Select the Synchronous tab (or custom sampling if you want to adjust signals for a loaded support
package).

3. Click the Local Sampler Definition thumbnail —I;(_ in the probe section column in the Signal
Mapping area or in the group card to open the Signal Sampling screen (the image on the thumbnail
differs depending on your setup).

4. Click to select a signal in the tree (CTRL or SHIFT to select multiple signals) in the Signal tree.
Alternatively, click on the busform in the clocking diagram. Repeated clicking on a busform will cycle
through the signals in the order they are displayed in the Signal tree.

5. Adjust the local setup and hold values for your signal by dragging the Setup or Hold indicators,
dragging the entire busform, or by entering specific values in the boxes.
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System Setup Acquisition Options

When you select more than one signal (within the same sample or across samples) the logic analyzer
displays an open selection outline around each of the signals.

Interactions Between Global and Local Sampling Definitions

When you first open the Signal Sampling screen, the default settings are based on the global default
values. When you change a local setting, the setting is no longer affected by changes that you make at
the global level.

If you work in a local context and you change the global settings, any local settings that you have not
manually changed will be updated to the global settings. To reestablish the local value connection with
the global values, click the Use Global Values check box. The check box affects the T and T, values
of the current highlighted signals (see page 25) in the Signal tree. The check box is disabled when no
signals are highlighted.

Related Topics

Signal Sampling Screen: Setting Thresholds (see page 23)
Group Deskew (see page 17)

Highlighted vs. Selected Signals

In the sample tree structure below, signals C2(3), C2(2), and C2(1) were selected and highlighted
when you first opened the Signal Sampling screen. Any changes that you made to the highlighted
signals were automatically applied.

[ ¢z When you click signal C2(5), the signal becomes highlighted while signals
C2(3), C2(2), and C2(1) remain selected, but not highlighted. Any changes

247 that you make in the Signal Sampling screen will be applied to highlighted
26 signals, in this case, just C2(5). This gives you the flexibility to change
(g signals by highlighting them without having to close and reenter the Signal
c2|:4]| Sampling screen.
23 Highlighting and selection apply to both sides of the Signal Sampling
screen: changing thresholds and changing setup and hold times. In the
2(2) case of thresholds, the threshold slider highlights based on which signals
C2(1) you have highlighted. When you move the slider, only the highlighted
czim) signals are affected.

When used with thresholds, the highlighted signals determine which
buttons on the left side of the Signal Sampling screen become available for
changing thresholds.

Acquisition Options

The acquisition options determine the data to store. The options that are available depend on the sampling
type that you specify.
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26

To Use
1. From the TLA toolbar, click the Setup button for your module.
2. Select your sampling type (synchronous, asynchronous, or custom).
3. Select Samples to store only the samples you acquire (default).
4. Select 63-Sample Blocks to store 31 samples before your stored sample and 31 samples after your
stored sample. (Use conditional storage in Trigger to store only events of interest).
5. Select Samples + Glitches (Asynchronous) or Samples + Violations (Synchronous) to store both
the acquired sample and glitch or violation data.
Behavior
Sampling type Acquisition options and resulting data
Asynchronous Samples - stores samples only
63-Sample Blocks - stores blocks of data around each
stored sample
Samples + Glitches (see page 26) - stores both signal and
glitch data
Synchronous Samples - stores samples only

63-Sample Blocks - stores blocks of data around each
stored sample

Samples + Violations (see page 26) - stores both samples
and setup & hold data

NOTE. Selecting Samples + Glitches or Samples + Violations decreases the maximum memory depth by
half and decreases the maximum sampling speed.

Related Topics

Sampling (see page 14)

LA Setup Window (see page 13)

63-Sample Blocks Mode (see page 162)

Samples + Violation Storage Mode

The Samples + Violation storage mode captures both setup and hold violation data and regular data
for each signal. This mode limits memory depth to half of the memory depth.

Samples + Glitches Storage Mode

The Samples + Glitches storage mode captures both glitch data and regular data for each signal. This
mode limits memory depth to half of the maximum depth and limits the sample period to 4 ns.
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Sample Storage

Use the Samples per Signal setting to specify the total number of samples acquired for each signal by
the logic analyzer.

To Use
1. From the TLA toolbar, click the Setup button for your module.

2. In the Setup window, use the slider to set the Samples per Signal.

Behavior

For a given number of samples, there is a trade-off between the sample rate and the sample duration, and
the time period over which samples are taken. A faster sample rate provides a more detailed record of
a shorter sampling duration.

If you do not require the maximum number of samples, select a lesser value. This will improve the
response time for search and zoom operations.

NOTE. Selecting Samples + Glitches reduces the available memory by one half. Double the available
memory by increasing the sample rate below a certain value in Asynchronous sampling. In Synchronous
sampling, double the available memory by increasing the maximum clock rate of the SUT clock rate

by reducing the clock period.

Related Topics

Selecting Memory: A General Approach (see page 91)
Acquisition Options (see page 25)

Merged Module Synchronous Sampling

If you use synchronous sampling with a merged module formation and you use a single clock source, you
only need to connect the clock lead from the master module to the clock source.

This condition is also true for qualifier lines.

Related Topic
Merge Modules Properties (see page 365)
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Highlight Signal Names Dialog Box

Use this dialog box to highlight signals by name.

1.
2.
3.

From the toolbar, open the Setup menu and select your module.
In the signal mapping area, right-click and select Highlight Signal Names.

In the Highlight Signal Names dialog box, enter the text you want to find. For example, enter RESET
to highlight any signal name that contains RESET.

NOTE. Enter multiple strings, separated by spaces. The space-separated strings are logically ORed. That
is, the name that matches any one of the strings will be highlighted.

4.
5.

Select the highlight criteria.
Click OK.

Grouping

28

Group cards list the signals that make up each group. Use the group cards to do the following:

Create arbitrary collections of signals by dragging them from the Signal Mapping area.

Type the signal name in an empty cell in the group card grid or type the signal name in the Keystroke
Entry field (see page 29).

Arrange the signals in order of significance by clicking and dragging them within the group card; the
Keystroke Entry field automatically updates when you rearrange signals.

Establish operating conditions on the logical groups to establish proper operating conditions of the
logic analyzer.

Provide the appropriate logical relationship to the system under test.

There are several ways to delete signals within a group card:

Delete the signal name from the Keystroke Entry field.
Select a signal name within a cell and delete it.
Select one or more signals and press the Delete key.

Select an individual signal and drag it to another group or to the Signal Mapping area.

When you delete a signal from a group card, the signals on the least-significant bit side of the deleted
signal move to fill the gap created by the deleted signal.
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Keystroke Entry Field

Use the Keystroke Entry field to enter valid expressions for signals in the group card. Enter hardware
section notation variants (such as A3, A2(), E1(0—4)) as well as logical names. The field automatically
updates the section notation to individual hardware names. The field also applies logical names to
signals, if they are available, such as when your logic analyzer has a bus support loaded.

iCapture Analog Feeds

Use the iCapture Analog Feeds dialog box to assign a digital data signal to a TLA7000 Series logic
analyzer module analog output.

Assign data signals in the following ways:
m  Select an individual channel; then assign it to an analog output channel.
B Select a group of channels; then select the analog output channels to which you want them assigned.

The Physical Module field, which is located at the top of the dialog box, allows you to select which logic
analyzer module channels you want to direct to an oscilloscope.

NOTE. iCapture Analog Feeds are only available in TLA7000 Series logic analyzer modules.

To Use

From the TLA toolbar, click the iCapture button.

Behavior

Under Analog Output Attenuation, select an attenuation level based on the amplitude of the signals being
assigned. 5X Attenuation is best suited for small amplitude, high-performance signals for improved signal
to noise ratio. Please note that waveforms displayed on your oscilloscope will be displayed at twice their
normal height because the attenuating factor is 5X and not 10X.
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30

iCapture Analog Feeds @@
Phyzical Module: | ELR R0y b Close
Analog Dutput Atbenuabion
(%) 104 Atteruation [-2. 5 to +5.0 inpat range)
) 5 Atterwiation [-1.5 to +2 5 input range)
Select Channelis] Assign To Current R outing
By Group | AnglogDutpyt  Analog Feed Dectination
[ cKo CH1 |  CHT: A3(5) CSAT154: Charmel]
E"AE
A2 CH2 A3(0) CSAT154: Channel2
CH 3 43(3) CSAT154: Channel3
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[ Systern Inter-peobing ... ]
Analog Feed Cycling
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[JcH 2 RN EEER BN
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After selecting which module contains signals that you want to output, you use the contents of Select
Channels to choose one or more specific signals to use as feeds for analog outputs. Select Channels
contains a drop-down list to choose the how digital signals are displayed.

The drop-down list provides the following display options:

B By Group. This displays signals organized by group. Only groups that are defined in the LA Setup
window can be displayed using this option. In addition, a group can only be expanded if it contains
signals from the selected physical module.

B By Probe. This displays signals that are alphanumerically organized by individual signal. All signals
are displayed when this option is selected, regardless of whether they are part of a group that is
defined in the LA Setup window.

m By Name. This displays signals by name assigned to them from the LA Setup window. Signals that
have not been assigned custom names are not listed when using this selection.

Selecting Individual Signals

After you have chosen a digital signal to output, assign it to an analog output signal by clicking a signal
button under Assign To. Confirm that the digital signal was correctly routed by reviewing the analog feed
assignment information under Current Routing.
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Selecting Groups

When you select multiple digital signals to output, assign them to one or more analog output signals by
selecting the check boxes associated with the target signals. If you are interested in more digital signals
than you have analog outputs, use the Analog Feed Cycling buttons to cycle the selected digital signals
through the selected analog outputs. Direct the system to exclude signals assigned to unchecked outputs,
to guarantee that signal assignments to unselected outputs are preserved. To do so, select the check box
labeled Exclude signals assigned to unchecked outputs.

NOTE. The system reassigns digital signals only when the assigned digital signal is a member of the
signals that you specified for output in Selected Channels and the analog output signal to which the
digital signal is assigned is not selected.

If one or more of the selected digital signals are already assigned to an analog output, those signals are
highlighted under Select Channels. As you feed digital signals to the selected analog output signals, this
highlighting changes to reflect current signal routing.

Use the following Analog Feed Cycling buttons to cycle the selected digital signals to the selected
analog output signals.

& Assigns up to the first four (depending on number of analog output signals selected) digital
signals to the selected analog output signals.

T Assigns the selected digital signals to the selected signal outputs in groups equal to the number
of signal outputs selected. The order in which the digital signals are assigned is from the bottom of
the list to the top.

_* | Assigns the selected digital signals to the selected signal outputs, in groups equal to the
number of signal outputs selected. The order in which the digital signals are assigned is from the top of
the list to the bottom.

. # | Assigns up to the last four (depending on the number of analog output signals selected) digital
signals to the selected analog output signals.

The Current Routing group box displays read-only details about the assignment of individual data signals
to analog outputs and the oscilloscope input signals to which they are physically connected. It additionally
provides a System Inter-probing button to reassign oscilloscope destination of data signals.

TIP. To acquire the best possible signal-to-noise ratio on live waveforms through the analog probe outputs,
use an external oscilloscope when the logic analyzer acquisition is idle.

The iCapture Analog Feeds dialog box retains the signal assignment settings for each TLA7000 Series
logic analyzer module represented in the System window. When using Analog Feed Cycling, assign
signals using one of the previously described control buttons, then close the dialog box. Later, when
you reopen the dialog box, resume assigning digital signals to analog outputs. However, if you change
either the setup of groups or any signal names, signal assignment settings will return to defaults the next
time the dialog box is opened.
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When using the logic analyzer’s demultiplexing capabilities to acquire digital data, the analog output data
may not match the digital data. The analog output connector always gets the signal directly from what is
present at the probe tip. For a demultiplexed destination signal, the digital data comes from the demux
source signal and not from the probe tip. Looking at the LA Setup dialog box signal grid, to tell which
analog output signals will not match the digital data: Demultiplexed destination signals (pink background)
and signals forced to 1 or 0 (yellow background) will not match.

Related Topics

System Inter-Probing (see page 51)
Changing Signal Routing (see page 69)
Setting Up Analog Feeds (see page 66)

Filter Definitions Dialog Box

From the toolbar, click the Filters button for your module.

Overview

Use this dialog box to display and manage all filters in the logic analyzer.

Behavior

The dialog box displays all modules and filters currently used by the logic analyzer. Use the tree controls
to expand and collapse the filter contents of the modules. Modules are listed first, followed by any loaded
data sources, and then the filters. Loaded data sources consist of a file name and a module name (for
example, System1.tla:LA-1).

To Use

Manage the filters using the toolbar buttons at the top of the dialog box, the right-click menu, or the
keyboard. By selecting a module in the dialog box, attach a new filter to the module, load an existing filter,
or paste a new filter using the clipboard contents and attach it to the module. By selecting a filter, cut, copy,
paste filter contents, load another filter’s contents from the Load Filter Dialog Box (see page 34), or view
or edit the filter’s contents through the Define Filters dialog box (see page 32).

Define Filter Dialog Box

32

Overview

The logic analyzer normally displays all data acquired by the probes from the target system. Frequently,
it displays data that you are not interested in. Use data filters to display only the data that you want to
see in the data window.
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Use filters to do the following:

B Hide specific data. For example, define a filter to hide data when all of the data in a group is equal to
FFFF.

m  Show specific data. For example, define another filter to show data from a specific address.

®  Color specific data. For example, define a filter to display data to another address with a specified color.

Behavior

Filters are made up of clauses and events and are very similar to trigger definitions.
Use the drop-down list located at the upper left corner of each clause to select
an action for each clause. All clauses in the filter are evaluated beginning with the first

M Define Filter - LA 1 - Filter

Module -Fiter: |14 1 - Filtar v [#]Enable this Filter
Description: |
Show | When([CKO OR E3(7)] OR Tinestamp]
PR N OO |
[or )|chamnel v E307) v||fchan] | 1 v
| G [rmestere ][ A E - oo g
Then hide all remaining data.

| oc || canca J| apply ] [LoadFiter... | [  Hep |

clause.

When you select a Show or Hide action, fill in the event fields by using the drop-down lists or text boxes to
define the event that you want to either show or hide.

When you select a Color action, a color options button appears to select the color options for the filter.
After you select the color options, fill in the event fields to further define the data that you want to filter
for the specific event.

Edit events and clauses by clicking the mouse at the right-end of the clause and either placing the mouse
over the indicator or right-clicking the mouse to display a context-sensitive menu.

Filters are saved as part of the module setups. Load filters when you need them. Edit and rename filters
as needed. When you apply a filter to a data window, the filter name is appended to the data label (for
example LA1: FilterA: A3 indicates that FilterA is attached to the A3 group of module LA1).
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To Use

Use this dialog box similarly to the trigger window by defining events and clauses for the filter. By default
the filter is enabled if it is not enabled, click the Enable this Filter check box.

Load Filter Dialog Box

Overview

Use this dialog box to load filter contents from any current or saved module setups.

Behavior

This dialog box loads filter contents from any saved module setup files or system setup files. The load
operation replaces all settings in the selected filter (specified in the title bar). If no filter is selected, the
load operation creates a new filter and attaches it to a module.

When a module setup name or system setup name appears in the File Name text box, all modules and
filters associated with that setup are listed in the center of the dialog box. If a module has a filter attached,
select and load that filter.

To Use

Enter a module setup or a system setup name in the File Name text box or click the Browse button to
locate a module or system setup file. Select a filter from the setup to enable the Load button; click the
load button to load the filter.

NOTE. Ifyou load a filter that uses groups or signals that are not included with the module, the events will
be discarded. A message box will display, explaining what happened.

Related Topic
Load Filter Browser Dialog Box (see page 34)

Load Filter Browser Dialog Box

34

Use this dialog box to find TLA module or system setup files that contain filters. This dialog box is similar
to the standard Open Dialog Box. The main exception is that the Content area describes whether the
module has any filters defined.

Use the dialog box to browse the file system for filters. After you select a file name and click the Open
button, the dialog box closes and adds the file name to the File Name field of the Load Filter Dialog

Box (see page 34).
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Applying Filters

TIP. If you don t see the file that you want, make sure that the file is a valid TLA module setup file or
system setup file. These files have the .tla suffix.

Applying Filters

When you apply a filter to a data window, the filtered data appears as a data source. The filter name is
appended to the data source name in a data window. Define the filter before you apply it to a data window.

1.
2.

Add a new column or waveform with filtered data by clicking the Add Column or Add Waveform icons

In the Listing window, click the column name; in the Waveform window, click a waveform name.

Right-click the mouse and elect Apply Filter followed by the filter name.

and selecting a filtered data source:

1.

In the Listing window, click i (the Add Column icon); in the Waveform window, click BC (the
Add Waveform icon), .

In the new dialog box, select a data source that contains filtered data. For example, LA1:Filter1.
Select the data group that contains the filtered data.
Click the Add button followed by the Close button.

Color Options Dialog Box

Use this dialog box to control the color of groups in the data window.

0 W b=

Select a filter in the Filter Definitions dialog box and then click to open the filter.
Select Color from the filter definition.
Click the button to the right of the drop-down list to open the Color Options dialog box.

Determine whether you want to use separate colors for an individual group or the same color for
all groups.

Click the color button to select the foreground and background color from the color matrix.

In addition to using a basic color, click More Colors... at the bottom of the color selection box to
define custom colors.

Click OK to close the dialog box.
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Signal Import and Export Formats

The Signal import and export uses a structured text file format to organize the import and export
information. Only formatted text files can be processed by the parser.

The import or export file is separated into multiple lines by EOL (EOL can be CR, LF, or CRLF). During
importing or exporting, the parser processes one line at a time. The following lines are allowed in the file:

Comment Lines (see page 39)

Control Lines (see page 40)

Information Lines (see page 42)

Click Sample File (see page 38) to view an Import/Export file.

Related Topics
Signal Setup Import Dialog Box (see page 37)

Signal Setup Export Dialog Box (see page 37)

Signal Setup Import Behavior (see page 36)

Signal Setup Import Behavior

36

Be aware of some of the behavior of the logic analyzer when it imports signal setup files:

B The logic analyzer detects the delimiters used in the imported file. Therefore it is important to use
only one delimiter in the file. If you need to embed the delimiters in a signal name or group name,
enclose the name with quotes.

m  The import operation will update the signal setup parameters related to the selected fields. For
example, if a user-defined signal name is selected, the old name will be replaced by the new name
without any warnings. Similarly, if there are two lines in the imported file setting for the same signals,
the second line receives the new name.

B The import operation will not change the signal setup parameters related to unselected fields. A
skipped field (an empty field name between two delimiters) acts as an unselected field.

B User-defined signal names must be unique. If an imported user-defined signal name exists, the two
signals will exchange their user-defined names (for example, if you have A0(0):A and A0(1):B, and
you set AO(1) to A, the result will be A0(0):B and AO(1):A).

m  If an imported file contains a definition for a signal that does not exist, the definition will be ignored
and a warning message will be saved in the error log file. You may experience this when importing a
file to a narrow module.

m [fan imported file does not contain definitions for all the signals of the logic analyzer, the definitions
of the missing signals remain unchanged. This may happen when you import a file to a wide module.
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®m  The parser processes one line at a time. It will stop processing on any unrecognizable line and then
display an error message.

B All warning and error messages will be written to a file named ImportExportError.log in the same
location as the import file.

Signal Setup Export Dialog Box

Overview

Use this dialog box to export signal setups to a text file. The setups can then be imported by another
logic analyzer.

Behavior

This dialog box allows you to save the setups to a text file listed in the Export Path box. Click the Browse
button to save the file to a folder of your choosing. You have the choice of exporting individual signal
information or group information by selecting the appropriate Export Selections. If you select Export
Signal Information, specify the type of information that you want to export by selecting one or more of
the check boxes. Select one of four field delimiters to separate the fields within the file; an empty field is
represented by two consecutive field delimiters in the file.

Any warning or error messages are saved in a log file in the same location as the exported file.

To Use

Select Export Signal Setup... from the File menu. Specify a file name and the path to the file. Use the
other selections in the dialog box to define the signal information and delimiters. Click the Export button
to export the file.

Related Topics

Signal Setup Import Dialog Box (see page 37)
Signal Import and Export Formats (see page 36)
Signal Setup Import Behavior (see page 36)

Signal Setup Import Dialog Box

Overview

Use this dialog box to import signal setups from a saved location.
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Behavior

This dialog box allows you to specify the signal setup information that you want to import. Specify the
file location in the Import Path box or click the Browse button to browse the file system for the file. The
setups are normally saved in a text file.

Select the Automatically detect from file to import all fields from the import file. Select Custom options to
specify the fields that you want to import by selecting one or more custom options. If you try to import

a field that does not exist in the import file, the logic analyzer will display a warning message. Click

the Import button to import the setups. Warning and error messages are saved in a log file in the same
location as the imported file.

To Use

Select Import Signal Setup... from the File menu while the Setup window is active. Locate the import file,
specify the import options in the dialog box, and then click the Import button.

Related Topics
Signal Setup Export Dialog Box (see page 37)

Signal Import and Export Formats (see page 36)

Signal Setup Import Behavior (see page 36)

Sample Signal Setup File

38

The following file shows an example of the different parts of a Signal Import/Export file.

[17771777777777777777777777777777777777777777/7777777777777777777/7777/777777777
// TLA Signal Import/Export File

// Created on June 10, 2007 at 16:05:27

// by TLA Import/Export Utility Version: 1.0.001

// (Field Delimiter: <Tab>)

1177777777777 77777777777777777777777/77777777777777/7/7/7/7/77/77777777/7/////7/

1171777777777 777777777777777777777/7777777777777777/7/7/7/7/7777777777/7//7///7/
// Remove all user-defined signal names

//+ResetAllSignals

//

// Remove all groups

//+RemoveAl1Groups
[177777777777777777777777777777777777777777777/777777777777777/7777777/777777777

[1177777777777777777777777777777777777777777777777777777777777777777777777/777/
// Signal definition format
//+SignalFormat : HWwWName UserName Polarity Compare

/1711777777777 777/7777/77777777777/77777777777777777777/777/77777/777/77777/777777777
Cc0(7) NMI - TRUE
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CO0(6) IGNNE# - TRUE
C0(5) EADS# - TRUE
C0(4) SRESET - TRUE
C0(3) HOLD - TRUE

C0(2) KEN# - TRUE

CO0(1) LOCK# - TRUE
Cc0(0) RDY#= - TRUE

Q3 Q3 - TRUE
Q2 Q2 - TRUE
Ql Q1 - TRUE
Q0 Q0 - TRUE

CK3 CLK - TRUE
CK2 RDY# - TRUE
CK1 BRDY# - TRUE
CKO BRDYC# - TRUE

[111777777777777777777777777777777777777777777777/7777777/7777777777/7/7777/7/77/
// Group definition format

//+GroupFormat : GroupName ChannelList

[I1177777777777777777777777777777777777777777777777777777777777777777777777777
Data D31 D30 D29 D28 D27 D26 D25 D24 D23 D22 D21 D20 D19 D18 D17 D16 D15 D14
D13 D12 D11 D10 D9 D8 D7 D6 D5 D4 D3 D2 D1 DO

control BLAST# AHOLD HLDA BOFF# M/IO# D/C# W/R# SMIACT#
DataSize BS8# BS16# BE3# BE2# BEl# BEO#

Misc CLK= ADS#

Cache KEN# EADS# FLUSH#

Misc2 BREQ# INTR LOCK# PLOCK# RDY#= BRDY#= BRDYC#= HOLD IGNNE# FERR# RESET
SRESET NMI

Comment Lines

All lines starting with "//" are treated as comments, unless the very next character is a *+’, which signifies a
control line. The "//" can also be used to initiate a comment on the end of "non-comment" line. In this
case, a delimiter is needed before the "//", all text between the "//", and the end of the line is treated as a
comment (ignored by the parser). Examples of using comments lines are shown below:

[1117777777777777777777777777777777/777777777777777777777777/7/77777/77/7777/777
// TLA Signal Import/Export File

// Created on June 10, 2007 at 16:05:27

// by TLA Import/Export Utility Vversion: 1.0.001

// (Field Delimiter: <Tab>)

LIT1777777777777777777777777777777777777777777777777777777777777777777777777
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Related Topics

Control Lines (see page 40)

Information Lines (see page 42)

Sample Signal Setup File (see page 38)
Signal Setup Import Behavior (see page 36)

Control Lines

All lines starting with "//+" are treated as control lines. This special character sequence is used to mark
instructions to the parser. Each word in a control line is considered as a keyword, which can be recognized
by the parser. Only delimiters and predefined keywords are allowed in a control line. Each control line
signifies a structure, which is used to organize the information in the following information lines.

The first keyword in a control line specifies the name of the defined structure. The keywords after
the structure name specify the names of the structure items. Currently, there are four structure names
available, ResetAllSignals, RemoveAllGroups, SignalFormat, and GroupFormat. The keywords
are not case sensitive.

ResetAllSignals

This keyword works as a command to remove all user-defined signal names as shown in the following
example:

LIT177777777777777777777777777777777777777777777777777777777777777777777777777

// Remove all user-defined signal names.
//+ResetAllSignals
[17777777777777777777777777777777777777777777/777777777777777/7777777/777777777

RemoveAllGroups

This keyword works as a command to remove all of the groups.

LIT17777777777777777777777777777777777777777777777777777777777777777777777777777777

// Remove all groups.
//+RemoveAl1Groups
[177777777777777777777777777777777777777777777777/7777/777/7777/777/77777777/7777777777

SignalFormat :

This is a structured line containing the following fields: HWName, UserName, Polarity, Threshold, and
Compare.

HWName. This is the hardware name of the signal. It is required in all SignalFormat structures. The
hardware name of the signal should never be empty in the information lines. For normal acquisition
signals, the syntax is the hardware pod name followed by the signal number enclosed in parentheses, (for
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example, AO(1) or A0(2)). The syntax for clock and qualifier signals is the type identifier "CK " or " Q"
respectively, followed by a number (for example, CK0, CK1, QO, or Q1). This field is not case sensitive.

UserName. This is the user-defined name of the signal. This field is case sensitive. The user name should
be unique among signals; otherwise the latest defined name will replace the pre-existing name. The user
name cannot contain embedded spaces, commas, or tabs. The TLA application allows semicolons in
names. When using semicolons as delimiters, embed the name and the delimiter within double quotes
("sample;name"). Similarly, if you want to embed "//" in the name, the name and the "//"" symbol must

be enclosed in double quotes.

Polarity. This is the polarity of the signal. The values for this field are + and -.

Threshold. This is the threshold voltage of the signal. The syntax is the voltage value and the unit, (for
example, 2.5V, or 100mV). This field is not case sensitive.

Compare. This field contains the compare enable/disable information of the signal. Values for this field
are TRUE and FALSE. This field is not case sensitive.

[11177777777777777777777777777777777777777777777777777777777777777/7777777/7777/777/777/7,
// Signal definition format
//+SignalFormat: HwName UserName Polarity Threshold Compare

II177777777777777777777777777777777777777777777777777777777777777777777777777777777777
C1(7),RESET,-,1.5V, TRUE

GroupFormat
This is a structured line containing the following fields: GroupName and SignalList .

GroupName. This field defines the group name. This field is case sensitive. The group name must be
unique; otherwise the later-defined name replaces the previous-defined name. The group name must not
contain embedded tabs. When using delimiters with the name, embed the group name and the delimiter
within quotes ("sample name").

SignalList. This field is a list of signal names assigned to the group. This field is case sensitive. The
names can be user-defined names or probe-based names. When using probe-based names, there are several
ways to specify the signals. For individual signals, the syntax is the hardware pod name followed by the
signal number enclosed in parentheses (for example AO(1) or A0(2)). Groups of contiguous signals can
be specified using a range of signal numbers within the parentheses (for example, A0(7-0) or A1(3-5)).
When you want to specify all signals in a hardware pod, use a shorthand notation using an empty pair of
parentheses (for example, AO() or A1()). The syntax for clock and qualifier signals is the type identifier
"CK " or " Q" respectively, followed by a number (for example, CK0, CK1, QO0, or Q1). Multiple signals
or groups must be separated by delimiters. Embedded spaces are not allowed.

The number of the names is unlimited. The parser reads the delimiter-separated names until it finds an
EOL character or a "//" sequence. Break a long line into several lines by adding a delimiter followed by the
\” character before you add each EOL character. The parser treats those lines as a single line.

[1177777777777777777777777777/7777777777777777777/7777777/7777777777/77/77/777//7/77/
// Group definition format
//+GroupFormat:GroupName SignalList

LI1177777777777777777777777777777777777777777777777777777777777777777777777/77
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control,BLAST,AHOLD,HLDA,BOFF,M/10,D/C,W/R,SMIACT

pata,D31,D30,D29,D28,D27,D26,D25,D24,D23,D22,D21,D020,D019,D18,D17,D16, ,\
pl5,p014,p13,p012,D011,D10,D9,D8,D7,D6,D5,D4,D3,D2,D1,D0
Address,A00),A10),A20,A30

Related Topics

Comment Lines (see page 39)

Information Lines (see page 42)

Sample Signal Setup File (see page 38)
Signal Setup Import Behavior (see page 36)

Information Lines

Lines not starting with "//" or "//+" are treated as information lines. An information line can be separated
into several fields by a pre-defined delimiter. The orders of the fields are declared in the control line
defined earlier. For more information, see the Sample File. (see page 38)

Related Topics

Control Lines (see page 40)

Comment Lines (see page 39)

Sample Signal Setup File (see page 38)
Signal Setup Import Behavior (see page 36)

Serial Analyzer Setup Window

The Setup window provides access to all controls needed to configure the serial analyzer module to capture
data from a particular serial data stream or link.

A dedicated status area at the top of the window provides basic status information for the current link.
Controls at the left side of the window define the link, define the reference clock, and to specify how to
store data.
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The signal activity indicators in the Setup window provide a visual indication of the signal activity at the
probe. The module always acquires data and updates the status indicators. The legend items in the status
area near the top of the Setup window describes the various signal states.

Status Area

The status area is located near the top of the serial analyzer Setup window. It provides status information
for the Setup window and includes the following components:

B Text messages

®  Command buttons

B Channel activity indicator legend
®  Link status readout

Text messages provide informational, warning, or violation messages about the status of the Setup window
and the module. Some messages include an Acknowledge button. These messages appear when you
make a change to the analyzer settings that may require your further interaction. Click the Ack button to
dismiss the message.

The signal activity indicator legend defines the signal status of the signals and the system under test (SUT)
clock signals. The following table lists the possible values and their indication.

Indicator Meaning Description
No signal (gray) No signal activity and none was
expected; the channel is not assigned
to a lane.
S S Missing signal No signal activity. The signal is

connected to a lane on the system
under test and a signal is expected.

Signal (yellow) Signal activity. A symbol lock was not
achieved; a signal was detected, but
the data has not been recognized.

Data signal (green) Signal activity. The serial analyzer
has achieved symbol lock.

NOTE. The SUT CLOCK indicator (located at the bottom of the Channel-Lane Assignment area) indicates
the status of the clock signal via the clock cable connected to the SUT or slot interposer probe. This
indicator uses similar colors and patterns as the other status indicators. This color is gray if the SUT
Reference Clock selection is set to Not Used.

If the indicators appear different than what you expect, this could indicate a possible problem with the
probe or the signals at the system under test. The legend is always on the screen unless another status
message is displayed.
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The right side of the status area shows key information about the current condition of the link. The top
readout displays the link width during the previous update interval and the bottom readout displays the
transfer rate. The readout displays “Link not Trained” when the link is not trained or when no signals are
active. If the link width changes during the update interval, the readout displays “Varies.”

Autoset Status

When a link has trained, the serial analyzer can detect the training results for each lane. When this occurs,
the serial analyzer displays a status message along with the Ack button and the Autoset button. When you
click the Autoset button, the serial analyzer automatically completes the following setups for the link:

®  Link direction
®m  Link width. The highest lane number among the trained lanes plus one.

®  Channel-to-lane associations. The Setup window displays the associations with lines connecting
from the lanes to the activity indicators.

®  Channel polarity

The serial analyzer can only detect changes in the transfer rate when Transfer Rate is set to Track Training.
If the Transfer Rate is set to one of the fixed rates, the serial analyzer cannot detect the signals at the link
when they train to a different rate. These changes are reported in the status area.

To disregard the changes and dismiss the status message, click the Ack button.

Left Side Control Area

44

The Left-side controls configure the behavior of the serial analyzer. The area contains three groups of
controls: the link definition group, reference clock source group, and the link data storage group.

Link Definition Group

The name of the link appears on the tab at the upper left side of the control area. Rename the link by
clicking text and entering a new name.

Select one of the Acquire buttons to identify the upstream and downstream lanes for capturing data. The
selection that you make impacts the appearance of the signal-lane assignment area on the right side. For
example, if you acquire downstream data, the upstream signal-lane assignments become unavailable.

Select the maximum link width from the drop-down list. The link widths depend on the other settings in
the Link Definition group, such as the number of signals in the module and the Acquire selections. It is a
good idea to select the largest width to which the link can train because the link can down-train during
operation. If the serial analyzer detects changes that may require further user interaction, it displays

a message in the status area.
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System Setup Channel-Lane Assignment Area

Select the transfer rate from the drop-down list. Use Track Training when you want the serial analyzer to
watch the TS1 an TS2 training sequences to determine the transfer rate that the link is trying to establish
or to anticipate and to follow any rate changes.

Reference Clock
The serial analyzer can synchronize its reference clock to one of two sources.

Select Not Used to use an embedded clock signal. A stable reference signal is generated by the serial
analyzer and synchronizes with the embedded clock signal. A clock cable connection is not required,
because the serial analyzer recognizes the embedded signal from the probe.

Select Connected at Front Panel to use an external clock from the system under test and then select one of
the clock rates from the drop-down list. Tektronix recommends connecting a clock cable to assure that data
is accurately synchronized with the clock signal. Select an approximate frequency (100 +£10% or 125 MHz
+10%) from the drop-down list. Make sure the reference clock cable is connected correctly.

NOTE. If SSC (spread spectrum clocking) is enabled, and your PCI Express link uses power management
states, connect a clock cable to the SUT and set the reference clock source to Connected at Front Panel to
ensure that all symbols are recognized by the serial analyzer during the links transition from a power
management state to the L0 state. An external clock is also required to conduct frequency margin testing
when the SUT is operating at rates other than 2.5 GT/s or 5 GT/s.

Data Storage Area

Use the Data Storage area to specify the data format and the amount of data to acquire and the type of
filtering. The data volume is expressed in terms of symbols per lane with a maximum of 32 M symbols
per lane.

Use the Trig Pos control to specify where the trigger will appear in memory (1% accuracy within the
data record).

In addition to specifying the amount of data to acquire, you can also filter data during an acquisition cycle.

Use the filters from the drop-down list or define your own by clicking L2l (the Define Filter button). The
filtering applies to both upstream and downstream data and does not restrict any triggering.

Use the Define Filter function to define a filter that meets your needs. After you create a filter, save
it for future use. The new filter appears in both the upstream and downstream lists. The last filter that
you use becomes the selected filter in the lists.

Channel-Lane Assignment Area

The Channel-Lane Association area of the serial analyzer Setup window provides controls for making
logical connections between module signals and the logical lanes of the Listing and Waveform windows.
The area consists of graphical representations of the module bordered by the upstream and downstream
lanes. The downstream and upstream lanes provide connection points to the module.
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Connector groups (of four Channel Activity Indicators) represent the connectors on the front of the serial
analyzer. Each group has four signals consisting of a signal emblem, a polarity indicator, and two signal
connection points (one on each side of the emblem). The SUT Clock emblem shows the activity of the
clock when you select the SUT clock as the reference clock source.

Use the polarity indicators to change how the serial analyzer senses the differential signal on a signal. The
plus and minus signs represent the normal or inverted polarity. The buttons show the last trained value
after you click the Autoset button. However, the values do not automatically track training.

When the probes are connected to the system under test, the appearance of the emblems represent the
status of the signals at the probe tips. Refer to the legend at the top of the Setup window to understand
the signal status.

The easiest way to connect the lanes to the module connectors is to click the Autoset button after the serial
analyzer has detected training. Manually connect the lanes to the module connector by clicking the mouse
on a lane and dragging a line to the desired module connector.

Defining Electrical Idle Transition Detection in the Serial Analyzer

46

Use the Define Electrical Idle Transition Detection dialog box to view or change detector channel settings.
To access this dialog box, right-click the mouse anywhere in the Channel-Lane Assignment area of the
Serial Analyzer Setup window to open the context menu.

For most applications, Tektronix recommends that you use the standard (default) settings. If necessary,
manually change the settings. Some link configurations will require that you change the detector channel
that a listener channel listens to, while very few configurations will require you to rewire the module-end
probe connector.

In general, any time that the link transitions to a x2 or x1 width, and Lanes 0 or 1 are no longer connected
to detector channels, the link will appear to be in an idle state when it is not. Be aware when this situation
occurs and follow the suggested link formats that are provided in the P6700 Series Probes Instruction
Manual. Contact your local Tektronix representative for assistance.

Bypassing the Transition Detectors

To temporarily bypass the detectors to observe data on all lanes at a slower transition detection rate, turn
off the LOs detection. This disables fast electrical idle transition detection to place the serial analyzer in a
troubleshooting/debugging mode. The electrical idle detectors are bypassed, and signal activity on all
lanes is recognized. However, this mode inhibits the speed at which the link recovers from an LOs state (up
to 6 us). When you have finished troubleshooting or debugging and are ready to begin acquiring data,
disable the selection by selecting Standard - Automatic detector assignment (Recommended).

Changing the Maximum Electrical Idle Timeout

Use the Maximum Idle Time Detector to specify the maximum timeout for your application.
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When the serial analyzer module Transfer Rate is set to Track Training and an electrical idle occurs longer
than the specified timeout, the module switches the acquisition rate from 5 GT/s to 2.5 GT/s. An electrical
idle can happen when the system under test has shut down and starts up again in 2.5 GT/s mode.

Some applications return to an electrical idle state after a preset timeout period. The circuits should
have returned from an L1 state within the timeout period. However, some tests might require a longer
timeout setting.

Timestamp Averaging with the Serial Analyzer

When using bi-directional storage, both sides of the link are essentially ORed together to determine
when the storage should occur. When Timestamp Averaging is enabled (default setting), both sides of
the link must work together to calculate the average timestamp. (Problems can occur if one side of the
link enters or exits the electrical idle state and the other link resets its alignment. For example, when a
down-side link enters or exits an electrical idle state, the up-side link becomes misaligned because the
FIFOs on the down-side link must be reset.)

To avoid problems when using bidirectional links with buses entering or exiting electrical idle states,
Tektronix recommends that you disable the Timestamp Averaging feature. Disabling Timestamp
Averaging allows each side of the bus to track alignment and revert to a series of bursts. The burst samples
are separated by 1.8 ns followed by time gaps in the range of 10 ns to 100 ns.

TIP. To set or clear Timestamp Averaging, right-click the mouse in the Setup window to display the context
menu.

Setting Up External Oscilloscope Communication

The iView External Oscilloscope Setup wizard provides instructions to connect your Tektronix logic
analyzer to an external Tektronix oscilloscope, enabling communication between the two instruments.

B [fthe external oscilloscope that you are adding does not appear in the list, then the logic analyzer does
not have the files necessary to support your model of external oscilloscope. In this event, go to the
Tektronix Web site and download the latest external oscilloscope support files.
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®m  After you complete the process of adding your external oscilloscope to the logic analyzer system,
set up your oscilloscope from the logic analyzer System window.

B Specify horizontal and vertical settings on external oscilloscope. In addition, if the external
oscilloscope is triggering the TLA, specify the trigger settings on the external oscilloscope.

iView Setup Window

Overview

A Setup window is available to assist you in verifying, changing, and testing the external oscilloscope
settings.

Before acquiring and displaying a waveform, establish a connection between your Tektronix Logic
Analyzer and external oscilloscope using the Add iView External Oscilloscope setup wizard.

To Use

To access the setup wizard from the System menu, click Add iView External Oscilloscope. Then step
through the external oscilloscope setup process, following the provided directions that guide you through
physically connecting the analyzer, choosing both your GPIB address and where to display your external
waveform data, and initializing the system trigger.

The Connections tab contains diagrams that help you to confirm that your logic analyzer and external
oscilloscope are physically connected correctly. Diagrams are available for confirming the physical
connection of both your logic analyzer and your specified external oscilloscope. Click the TLA
Connections button to display the logic analyzer diagram, or click the TDS Connections button to display
the diagram for the external oscilloscope that you specified in the setup wizard.

To open the iView Setup window from the System window, click the iView Setup button.

Related Topic

Troubleshooting Connections (see page 48)

Troubleshooting External Oscilloscope Communication
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If you experience difficulty in establishing communication between your logic analyzer and external
oscilloscope, the following checklist will assist you in identifying and correcting the problem.

Diagnostic Checklist

B s your external oscilloscope turned on?
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®m s the GPIB configuration on your external oscilloscope set up correctly? (See your oscilloscope’s
online help.)

B Are your cable connections securely attached?
B Did you select the correct model number for the external oscilloscope to which you are connecting?

Use the Back button to return to the window where you specified the external oscilloscope model
number and make changes as necessary.

= Have you correctly connected the cables between your logic analyzer and external oscilloscope?

Use the Back button to return to the windows that describe the proper cable configuration between
your logic analyzer and external oscilloscope. Alternatively, cancel the setup wizard and begin the
setup process again.

B If you specified the external oscilloscope GPIB address instead of letting the setup wizard
automatically detect it for you, did you correctly select the GPIB address where your external
oscilloscope is set to communicate?

Use the external oscilloscope user interface to ensure that the GPIB address you selected in the setup
wizard agrees with the GPIB address at which the external oscilloscope is set to communicate.

Once you correct the communications problem, the error message will disappear when you press the
Next button to establish communication.

Signal Routing from the Logic Analyzer

Overview

Use the Route from LA dialog box to send probe data from a logic analyzer signal to the currently selected
oscilloscope signal. To display the Route from LA dialog box, select Route from LA from the right-click
menu associated with a selected oscilloscope signal waveform.

To D50 1 - Channeld

From Feed Through Inter-probe Connector

[ System Inter-probing. .. ]

k. ] [ Apply ] [ Cancel ] [ Help
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Behavior

The Route from LA dialog box displays the currently defined inter-probe connection and the feed for the
oscilloscope signal. This item cannot be selected and is displayed for information only. If no inter-probe
connection is defined for the oscilloscope channel, the field is empty.

To Use

Click the System Inter-probing button to change the contents of the scroll list by adding or changing
the connection to the logic analyzer.

Click the Select Channel button to select a new logic analyzer channel to feed the inter-probe connection
to the oscilloscope channel. This button is made available when an inter-probe connection is defined.

Related Topics

Signal Routing to the Oscilloscope (see page 50)
Routing a Signal from a Logic Analyzer Output (see page 68)
Routing a Signal to an Oscilloscope Input (see page 68)

Signal Routing to the Oscilloscope

Overview

Use the Route to DSO dialog box to send probe data from the selected logic analyzer signal to one of the
oscilloscope channels. To display the Route to DSO dialog box, select Route to DSO from the right-click
menu associated with a selected LA signal waveform. The Route to DSO right-click menu item is only
enabled if the selected waveform is a TLA7000 Series logic analyzer signal.

Route to DSO - Waveform 1 E|[g|

Foute LA 1: Magniviu: kagnido: CEO[

Fram Slatz 1-2

Through Inter-probe Connectaor To Destinatian

CH 1 CEO D50 1 - Channell

CH 2 RUMM C547154 - Channel2

[ Syztem [nter-probing. . ] [ Add wavefom to view

[ Apply ] [ Cancel ] [ Help
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Behavior

The Route to DSO dialog box provides a list of oscilloscope channels that have inter-probe connections
defined to the logic analyzer. If no inter-probe connections are defined, the list is empty. If the oscilloscope
list contains the desired LA signal, then that list item is picked by default.

The check box named Add waveform to view is unchecked by default because the waveform view
typically contains waveforms for the oscilloscope of interest. Selecting this check box and clicking OK
will add a waveform of the selected oscilloscope destination to the view.

To Use

Select an oscilloscope channel and click OK to feed the logic analyzer signal to the inter-probe connection
attached to the oscilloscope channel.

Click the System Inter-probing button to change the destination list contents by adding or deleting the
connections for the logic analyzer.

Related Topics

Signal Routing from the Logic Analyzer (see page 49)
Routing a Signal from a Logic Analyzer Output (see page 68)
Routing a Signal to an Oscilloscope Input (see page 68)

System Inter-Probing

Overview

Because the TLA application cannot sense probe physical connect/disconnects, it is unable to manage logic
analyzer or oscilloscope mapping automatically. Use the System Inter-probing dialog box to manually
specify which connectors between the logic analyzer and oscilloscope are fitted with probe connections.
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System Inter-probing
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Behavior

When an inter-probing connection is created, the oscilloscope signal name changes to reflect the logic
analyzer signal that is feeding it. The signal name is visible in both the DSO Setup channel tabs and as the
waveform element label. The rule that the system uses for generating the DSO signal name is to make

it identical to the LA signal name. The system also automatically adjusts the time alignment dialog to
incorporate whatever signal path delay is determined for the oscilloscope individual signal. The delay is a
single time value, based on both the cable length and the particular path of the logic analyzer signal feed.

NOTE. Your ability to use the LA Setup, Time Alignment, and Waveform windows depends on correct
set up and maintenance of system inter-probing.

To Use

To create an inter-probing connection, click either an oscilloscope or logic analyzer signal button.
The system responds by changing the cursor to the shape of a probe connector. Then click a button
corresponding to the opposite end of the connection to establish the connection. Upon establishing an
inter-probing connection, the cursor changes back to the normal shape.

NOTE. Ifyou click anywhere other than on a legal endpoint for the connection, then no connection is made
and the cursor changes back to the normal shape.
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To delete a system inter-probing connection, click either endpoint button of the existing connection. When
a connection is deleted, the oscilloscope signal name changes to the normal default and the oscilloscope
individual signal time alignment is set to zero.

Related Topic
Setting Up Analog Multiplexing (see page 57)
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Loading Saved Setups to an LA module

1.
2.

5.

In the System window, click the LA Setup button.
From the File menu, select Load Module.

Click Browse to search for the system or module with the setup you want. Enter the path in the File
name text box.

Select the file and click Open; the Load Module dialog box appears with a list of modules in the
saved file.

Select the module you want and click Load.

If the setup does not load, refer to Load System Options Dialog Box (see page 355) for a list of possible
problems.

Merging Modules

Before merging modules in the application, physically connected the modules as described in the TLA
Series Logic Analyzer Installation Manual.

Follow these rules and restrictions when merging modules:

TLA7BB2 (68-channel) modules can be merged. For other modules, 102 channel and 136 channel
modules can be merged.

TLA7Bxx modules cannot be merged with TLA7Lx, TLA7Mx, TLA7Nx, TLA7Px, TLA7QX, or
TLA7Axx modules.

TLA7Axx/TLA7NAx modules cannot be merged with TLA7Lx, TLA7Mx, TLA7Nx, TLA7Px,
TLA7Qx, or TLA7Bxx modules.

TLA7Nx modules can be merged together, or with either TLA7Px or TLA7Qx modules.
TLA7TNx, TLA7Px and TLA7Qx modules cannot be merged with TLA7Lx and TLA7Mx modules.
Any combination of TLA7Axx and TLA7NAx modules (up to five) can be merged.

Modules containing different memory depths can be merged but will default to the shallowest memory
depth being used.

The maximum merged combinations are five TLA7Bxx modules, five TLA7Axx modules, five
TLA7NAx modules, three TLA7Nx/Px/Qx modules, or two TLA7Lx/Mx modules. The graphic shows
how to orient modules in a multiple module merge.
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The number of channels in the master module must be equal to or greater than the number of channels
in the modules with which it is merged. If there is a second slave module, the first slave must have
greater than or equal to the number of channels in the second slave module. Slave 3 cannot have
more channels than the master, slave 1, or slave 2. Slave 4 cannot have more channels than the
master, slave 1, slave 2, or slave 3.

Modules cannot be merged between a mainframe and an expansion mainframe; merged modules must
be in the same physical mainframe.

To merge a module to an established merged set, the established merged set must first be unmerged
through software. Only unmerged modules can be used to create a merged configuration.

Use the following steps to merge logic analyzer modules.

1.
2.

From the System menu, click System Configuration.

Click the Merge Modules tab.

Click the merge button. Eﬂ The button closes and the module icons become one to indicate that the
modules are merged.

Click the OK button

Related Topics

Merge Modules Properties (see page 365)

Calibrating Modules (see page 61)

Saving LA Setups
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In the System window, click the LA Setup button.
From the File menu, click Save Module.
Select the folder.

Enter the file name if you want a new name.

TLA Online Help



Module Setup Setting Up Analog Multiplexing

5. Enter any comments you want to save with the file.

6. Click the option button associated with the save option you want: Save All Data, Save Only
Unsuppressed Data, or Don’t Save Data

7. Click Save.

Setting Up Analog Multiplexing

1. From the LA Setup window, click the iCapture button. The system responds by displaying the
iCapture Analog Feeds dialog box.

NOTE. Analog multiplexing is available only in TLA7000 Series logic analyzer modules.

2. Specify signal routing between the LA module’s ANALOG PROBE OUTPUT connectors and both
the DSO module’s and external oscilloscope’s Analog IN connectors (as applicable).

3. Set up signal routing from the LA probe input channel to the LA module’s ANALOG PROBE
OUTPUT connectors.

4. Click the following links to complete the analog multiplexing setups.

Setting Up System Inter-Probing (see page 67)
Setting Up Analog Feeds (see page 66)
Changing Signal Routing (see page 69)

The following figure depicts the logical process of setting up analog multiplexing.

Establishing a Logical Connection
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Use the following procedure to establish a logical connection between your logic analyzer and oscilloscope
from the Setup window.

1. Connect probe from the channels on system under test to the Tektronix Logic Analyzer.
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Establish logical connections between the logic analyzer and the DSO, using the System Inter-probing

(see page 51) dialog box.

Determine which channels to route from the logic analyzer input to the Analog Output, using the
Analog Feeds (see page 29) dialog box.

Reconfiguring an Existing Logical Connection
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Alternately, use the following procedures to reconfigure the logical connection between your logic
analyzer and oscilloscope from the Waveform window.

Reconfigure logical connections from the logic analyzer to the oscilloscope:

1.
2.
3.

Right-click the waveform label associated with a digital waveform being routed to the oscilloscope.

Select Route To DSO (see page 50) from the shortcut menu to display the Route to DSO dialog box.

Use the Route to DSO dialog box to modify probe data being sent from the logic analyzer to the
oscilloscope.

Reconfigure logical connections from the oscilloscope to the logic analyzer:

1.

58

Right-click the waveform label associated with an analog waveform being routed from the logic
analyzer.

Select Route from LA (see page 49) from the shortcut menu to display the Route from LA dialog box.

Use the Route from LA dialog box to modify probe data being sent from the logic analyzer to the
oscilloscope.
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Acquisition Overview

Overview

When you start an acquisition, all modules start acquiring data together. (Exceptions are when one module
has been programmed to arm another or when a module has been turned off.) Modules stop acquiring data
individually, according to their trigger programming.

Starting and Stopping an Acquisition

In the Control bar, click Run to start an acquisition or press the Run/Stop button on the front panel. The
Tek icon on the right animates while the logic analyzer runs. Point at this icon with the mouse to display a
tool tip showing the analyzer status.

There are two ways to acquire data: Single-run or Repetitive mode. Within Repetitive mode, specify
the following three conditions:

®  Save Module and Data
m  Stop if Compare with Reference is Equal or Not Equal
m  Stop After N Acquisitions

When comparing acquisition data against reference data, view the results in either a Listing window or in
a Waveform window.

Single-Run Mode

In Single-run mode, the logic analyzer automatically stops acquiring and displays data when it fulfills the
setup conditions. Use Single-run mode to find and display a specific event.

During acquisition, the logic analyzer monitors the data, looking for the events you specified in the Trigger
windows. When the specified events occur, the logic analyzer responds according to the selections you
made in the Setup and Trigger windows.

Repetitive-Run Mode

In Repetitive-Run mode, the logic analyzer keeps acquiring data until you click Stop or until it fulfills the
stop conditions.

Use Repetitive-Run mode as follows:

B To observe the same waveform or listing for a period of time

m  To stop after a set number of acquisitions for a period of time and look for differences
After each acquisition use the logic analyzer do the following tasks:

B Save the system or module setups and data
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Specifying Multiple Acquisitions

®  Export the data to separate files or overwrite the same file
B Compare the acquisition data against data in another LA module or a saved LA module file

B Open a file or execute a set of defined tasks after the acquisition is complete. For example, execute a
command such as sending email or paging you that the logic analyzer has stopped.

Select Repetitive Properties from the System menu to select the different options for the Repetitive mode.

NOTE. Minimize the time between acquisitions by specifying compare conditions under the LA Setup
window, deleting (not just minimizing) all data windows, and then starting the logic analyzer. When the
logic analyzer fulfills the compare conditions, create a new data window with the New Data Window
wizard to view the data.

Related Topics

Setup Window (see page 13)
Compare Definition Dialog Box (see page 190)

Specifying Multiple Acquisitions

From the System menu, click Repetitive Properties.
Select the Stop After check box.

Enter the number of acquisitions to execute.

L A S

Click OK.

TIP. Click the button to the right of the Run button to set the repetitive run mode. ©

To improve the response time of the logic analyzer during repetitive operations, delete any unnecessary
data windows. This allows the logic analyzer to spend time on processing data rather than redrawing
data in data windows.

Related Topic
Repetitive Properties Dialog Box (see page 191)

Opening a Document or Program after an Acquisition
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1. From the System menu, click Repetitive Properties.
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Calibrating Modules

Select the Open: <Name of program or document> check box.

Click the Open button.

In the Open dialog box, click the Browse button to locate the document or application you want to open.
Specify any arguments and file locations, if needed.

Click OK to close the Open dialog box.

Click OK.

Calibrating Modules

U S o

Save your system before performing calibration. Calibration invalidates acquired data.
From the System menu, click Calibration and Diagnostics.

Click the Self Calibration tab.

Select the module or modules to calibrate.

Click Run. Calibration time can take up to several minutes to complete, depending on the type of
modules chosen.

If the calibration fails, refer to the service manual for that particular module or contact your local Tektronix
service center.

Related Topics

Self Calibration Properties (see page 363)

Technical Support (see page 1)

Calibrating Probes

For a DSO module:

1.
2.
3.

In the System window, click the DSO Setup button.
Click a channel tab.

Attach probes that you want to calibrate to the PROBE COMPENSATION output through a dual-male
BNC adapter and Probe-cal Adapter board.

NOTE. Passive or unknown probes are not calibrated.

1.

Click Probe Cal.
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2. Click Calibrate Chan < n> to calibrate the probe attached to the selected channel.

3. Click Calibrate All to calibrate the probes attached to all channels that can be calibrated.
The channel number and probe calibration status for each probe are displayed in the dialog box.
For an external oscilloscope:

Use the Vertical menu on the external oscilloscope to calibrate the probes.

Developing Custom Color Schemes

With the System active, go to the System menu and select Options.

Click the Colors tab.

Select the element you want to change.

Select a color for the element. This will be the default.

Click Save Scheme. Enter a new name; you cannot save changes to a default color scheme.

Click OK.

LA D

Related Topic
Changing Defaults (see page 87)

Comparing Data

Use the logic analyzer to compare acquired data against saved reference data. Use color to highlight
the results in the Listing or Waveform window.

1. Decide which signals to compare and set them up in groups in the LA Setup window.

2. Go to a Listing or Waveform window and add the groups to that window.
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3.

Specifying Stop Conditions for Compare Operations

o . . . il i
In the Listing or Waveform window, click 111 D&fine Compare

TLA toolbar to open the Define Compare dialog box.

(the Define Compare button) in the

a. Select the Enable Data Compare box, if it is not already selected.

b. Select a reference data source from the list, or click Add Data Source to add reference data from a
saved file.

¢. Select one of the following compare regions:
= Use All Data Possible: Compares the entire acquisition against the reference data.

= Partial Data around Ref Begin: Compares a specified number of samples after the beginning
of the reference data.

= Partial Data around Ref Trigger: Compares a specified number of samples before or after the
trigger mark in the reference data.

d. Specify the data alignment.

Align the data with respect to the beginning of memory or to the trigger location and specify the
number of samples to offset the data.

e. Click OK to close the dialog box.

Click (the properties toolbar button) in the Listing or Waveform window.

a. Select either the Listing or Waveform window tab.
b. Select the color for memory differences (Acq != Ref).

If you want to display that the acquisition data equals the reference data (memory equalities),
select Acq = Ref and the desired color.

c¢. Click OK.
Click Run to perform an acquisition.

The compare data (memory differences or equalities) will be highlighted in the regions of the display
window that you specified in the Define Compare dialog box.

Follow these guidelines for comparing data:

Acquisition modules and reference modules must be the same width.
You cannot compare glitch data, disassembler group data, MagniVu data, or oscilloscope data.

Although you cannot compare disassembler group data directly, compare raw, nondisassembled data
by using groups as defined in the Setup window. Add the groups in a Listing window.

Specifying Stop Conditions for Compare Operations

TLA Online Help

1.

From the System menu, click Repetitive Properties.
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New

New

64

New Histogram Data Page

2. Select the Stop criteria.

3. Specify additional parameters as needed for your application, such as executing a program after
meeting stop conditions or saving information to a file.

4. Click OK.

NOTE. Select Enable Compare in the Compare Definition dialog box to stop the acquisitions when the
compare conditions are met.

TIP. Click the button to the right of the Run button to set the repetitive run mode. ©

Related Topic

Repetitive Properties Dialog Box (see page 191)

Histogram Data Page

Use to specify the data source for the new Histogram window:

1. Click Data from an LA in the system to use data from a currently installed logic analyzer or from a
saved logic analyzer.

2. Click the No data to create an empty Histogram window; add the data later.
3. Click Next.

Histogram Options Page

Use to select specific data options for the new Histogram window:
1. Seclect a data source. The data source can be from a logic analyzer or from saved TLA files.
2. Select a group or counter/timer from the selected logic analyzer.

3. Click Next.

Related Topic

Data Source Properties (see page 217)
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Select Axis Type

Select Axis Type

Axis

Overview

Use this page to specify the X-axis and Y-axis for the empty Graph window.

Behavior
For either axis, select one of the following:
®  Sample Number. Use the drop-down list to select Begin, Trigger, or End.

= Row Number. This selection is the same as the Sample Number but does not include any gaps
due to filtering.

B Timestamp. Use the drop-down list to select either an Absolute timestamp or the Previous timestamp.
m  Value of Group. Use the drop-down list to select an Address, Data, or Control group.

The axis label will be the same as the type that you specify from the above list. After you set up the
window, use the Graph Window (see page 301) to further define each axis of the graph.

NOTE. Once you have specified the axis type using the wizard, you cannot change the type without
creating a new Graph window.

To Use

Select the axis type and click the Finish button to finish the wizard.

Related Topic
Add Series Dialog Box (see page 307)

Type Wizard

Overview

Use the Axis Type wizard to add a data series to an empty graph window. The wizard appears when
you click the Add Series toolbar button or select Add Series from the Edit menu in an empty Graph
window. It allows you to select the data source for the Graph window and then specify the X-axis and
Y-axis types for that data source.

In an empty Graph window, click the Add Series toolbar button to start the wizard.
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New Source Data Page

Use to specify the data for the new Source window:
1. Select An existing Listing window to use data from an existing Listing window.
2. Select the No Listing window to create an empty Source window; add the data later.

3. Click Next.

New Source Options Page

Use to select specific data options for the new Source window:

1. Select a Listing window, data source, and listing column. The Source window will use the data
from these selections.

2. Select a symbol file to use.

3. Click Next.

Related Topic
Source Data Properties (see page 234)

Setting Up Analog Feeds

Analog feeds functionality allows you to assign multiple digital signals to the DSO using multiple
analog channel outputs. Access the iCapture Analog Feeds dialog box from the LA Setup window by
clicking the iCapture button.

NOTE. Analog feeds functionality is only available in TLA7000 Series logic analyzer modules.

Use the following procedure to set up this functionality from the iCapture Analog Feeds dialog box.

1. Select the LA module containing digital signals that you want to route to a DSO from the Physical
Module list box.

2. Select an analog output attenuation level.

3. From the Select Signals list box, choose a method of displaying signals: By Group - lists groups as
defined in the Setup window. By Probe - lists signals by the probe name. By Name - alphabetically
lists signals by their name.

4. Select the digital signals that you want to route through analog outputs to the DSO.
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Setting Up System Inter-Probing

5. Select the check boxes associated with the analog outputs, located under Analog Feed Cycling.

6. Click a button in the Analog Feed Cycling group box to assign the selected signals to the selected
outputs, in groups equal to the number of outputs selected.

7. Optionally select the check box labeled Exclude signals assigned to unchecked outputs.

8. Click the System Inter-probing button to display the System inter-probing dialog and select the DSO
inputs to which the signals will be routed.

Related Topics

Setting Up System Inter-Probing (see page 67)

Signal Signal Routing (see page 69)

Analog Feeds (see page 29)

Setting Up System Inter-Probing

Only TLA7000 Series logic analyzer modules, DSO modules, and external oscilloscopes can be displayed
in the System Inter-probing dialog box. If a TLA7000 Series logic analyzer module and either a DSO
module or external oscilloscope exist but none are available, the dialog box can still be opened but is empty.

1. From the System menu, click System Inter-probing to display the System Inter-probing dialog box.

2. Click an LA, DSO or external oscilloscope channel button to begin the inter-probing connection. The
system responds by changing the cursor to the shape of a probe connector.

3. Click a channel button corresponding to the physical connection at the opposite end of the probe to
establish the probe connection. Upon establishing an inter-probing connection, the cursor changes
back to its normal shape.

NOTE. Ifyou click the mouse anywhere other than on a legal endpoint for the connection, no connection is
made and the cursor changes back to its normal shape.

4. Repeat steps 1 and 2 for each LA module-to-DSO module or external oscilloscope physical connection
that you want to specify.

TIP. To remove an inter-probing connection, click one of its endpoints or use the Delete button.

Use the Clear All button to remove all probe connections simultaneously.

TLA Online Help 67



How to

Routing a Signal from a Logic Analyzer Output

Routing a Signal from a Logic Analyzer Output

1. From the Waveform window, right-click the waveform label associated with the oscilloscope to which
you want to route the digital signal.

2. In the right-click menu, click Route from LA. The Route from LA dialog box displays.
3. Click the Select Channel button. The Select Signal dialog box displays.

NOTE. The Select Signal button is disabled when you have not previously setup logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying signals.

5. Choose the signal to route to the oscilloscope.

Related Topic

Routing a Signal to an Oscilloscope Input (see page 68)
Setting Up System Inter-Probing (see page 67)

Routing a Signal to an Oscilloscope Input

68

1. From the Waveform window, right-click the waveform label associated with the logic analyzer module
from which you want to route the digital signal.

2. In the right-click menu, click Route to DSO. The Route to DSO dialog box displays.

3. Select the logic analyzer signal that you want to send to the oscilloscope.

NOTE. No logic analyzer signals display in the Route to DSO dialog box until you set up logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. When you want to add a new waveform to the waveform window containing the rerouted signal, select
the check box labeled Add waveform to view.

Related Topic
Routing a Signal from a Logic Analyzer Output (see page 68)

Setting Up System Inter-Probing (see page 67)
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Changing Signal Routing

Use the following procedure to change digital signal routing from either a DSO channel input or a logic
analyzer output that is displayed on the Waveform window.

Routing from the LA

1. Right-click the label of the DSO channel waveform.

2. From the right-click menu, click Route from LA. The Route from LA dialog box displays.
3. Click the Select Signal button. The Select Signal dialog box displays.

NOTE. The Select Signal button is disabled when you have not previously setup logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying signals.

5. Choose the signal to rout to the oscilloscope.

Routing to the Oscilloscope

1. Right-click the label of the LA waveform.

2. From the right-click menu, click Route to DSO. The Route to DSO dialog box displays.
3. Click the Select Signal button. The Select Signal dialog box displays.

NOTE. The Select Signal button is disabled when you have not previously setup logical system
inter-probing connections. To perform this setup, click the System Inter-probing button.

4. Select a method of displaying signals.

5. Choose the signal to route to the oscilloscope.

Related Topics

Setting Up System Inter-Probing (see page 67)
Setting Up Analog Feeds (see page 66)
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Edit Protocol Files

Edit Protocol Files

1.

2.

To open a protocol for editing from the Stack Definition pane, do one of the following:
= Double-click the protocol you want to edit. The protocol is displayed in the Protocol Editor pane.
= From the Protocol Editor pane select the File menu, and then select Open Protocol.

Type your changes directly in the Protocol Editor pane.

TIP. Use the Replace function to help you locate and replace text.

SO S

From the Protocol Editor pane, select the Edit menu and then select Replace.... The Replace dialog
box opens.

Type the text you want to change in the Find What text box.
Type the new text in the Replace with text box.
If the text is case sensitive, select the Match case check box.

Click Replace to replace the next instance of the text in the Find What text box with the new text in
the Replace text box. Click Replace All to replace all instances. Click Find Next to find the next
instance but not replace the text.

Editing the Protocol Window Properties

70

Follow these steps to edit the Protocol Window Properties:

1.

® RN AR W

Place the cursor in the Protocol window and click View > Properties to display the Protocol Properties
dialog box.

Click the About Data tab to view the current data source information.

Click the Protocol window tab to adjust the display settings of the Protocol window.

Click the Column tab to adjust the column settings in the Packet view.

Click the Color tab to adjust the color settings in the Decode View.

Click the Marks tab to adjust the properties for the marks that you placed.

Click the Framer options tab to set the port address and packet identifier for framing the packets.
Click OK.

Related Topic

Protocol Window Properties (see page 269)
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Edit Relations Between Protocols

1. In the Stack Definition pane, right-click the protocol for which you want to edit the relations. The
Protocol shortcut menu appears.

2. From the Protocol shortcut menu, select Define Relations. The Protocol Setup dialog box appears,
displaying the Relations tab.

3. To remove any protocol from the Current Relations list, select the protocol, and then click the Remove
button.

4. To add any protocol to the Current Relations list, select the protocol you want to add from the
Available Protocols, and then click the Add button.

5. Click Up or Down to determine the order of the relations, and then click OK.

6. If you specify the Type of Relation as Single Parameter or Raw Data, enter hexadecimal values
preceded by Ox or binary values preceded by Ob. For example, to enter the 3 in hexadecimal, enter
0x3; to enter it in binary, enter 0b0011.

Edit Stack Files

1. To open an existing stack file, select Open Stack from the File menu.
2. In the Open dialog box, select the stack to open and click OK.
3. To see how to edit the stack files, click the following links:

To Replace a Protocol from the Stack (see page 288)

To Remove a Protocol in the Stack (see page 286)

To Define a Protocol in the Stack (see page 286)

To Modify Relations Between the Protocols in the Stack (see page 71)

Editing a Tool on the Tools Menu

1. From the System menu, click Options and then click the Tools tab.

2. In the User-Defined Tools box, select the tool that you want to edit.

3. Perform one or more of the following actions:

m  To move the tool up one position in the menu, choose the Move Up button.

B To move the tool down one position in the menu, choose the Move Down button.
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Removing a Tool from the Tools Menu

®  To change the menu text, command line (tool path and file name), command-line arguments, or the
initial directory, click the Edit button and then type the new information in the appropriate text box.

B To specify a letter in the menu title as an accelerator key, precede that letter in the Menu Name box
with an ampersand. The first letter in the title is the accelerator key by default.

Related Topics

Removing a Tool from the Tools Menu (see page 72)
Adding a Tool to the Tools Menu (see page 134)

Removing a Tool from the Tools Menu

To remove a tool from the Tools menu:
1. From the System menu click Options, and then click the Tools tab.

2. In the User-Defined Tools box, select the tool you want to delete and click the Delete button.

Related Topics

Editing a Tool on the Tools Menu (see page 71)
Adding a Tool to the Tools Menu (see page 134)

Editing Symbol Files

72

To edit symbol files supplied by the support package, make a copy of the file and then edit the copy.

NOTE. Do not change signal assignments. If you do so, the disassembler may not function correctly.

Most support packages provide two types of ASCII symbol files: pattern and range. Make a copy of the
type you need and edit it using an editor.

NOTE. Save the symbol file as ASCIL. If saved in any other format, the symbol file cannot be used.

Related Topics

Symbol Tables (see page 335)
Color Properties (see page 369)
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Exporting Data from a Protocol Window

Exporting Data from a Protocol Window

Follow these steps to export data from Protocol window

1. Place the cursor in the Protocol window, and select Export... from the Data menu to display the
Export Data dialog box.

2. In the Export Data dialog box, specify the file name and location that you want to export data to.

3. Under Export Range, select either Packet View or Decode View, and then select the export range.

4. If you want to include the Hex View, select the Append Hex View check box.

5. Ifyou selected Packet View, you should also select the export options, including the delimiters you
want to use.

6. Click Save.

Related Topic

Export Data Dialog Box (see page 272)

Exporting Data from a Listing Window

1.
2
3
4.
5
6
7

In the System window, click the Listing window icon.

From the File menu, click Export Data.

In the Export Data dialog box, select the folder you want to export data into.
Enter a name for the exported file.

Click Options to specify the format options.

Select one of the Export ranges.

Click Save.

NOTE. Use a Tab or Semicolon as a delimiter when exporting data from a Listing window. If a Space
or Comma is chosen as a delimiter, the timestamp values are erroneously exported from the Listing
window in picoseconds without units.

Exporting Histogram Data

1.

In the System window, click the Histogram data window icon.
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From the File menu, select Export Histogram.
In the Export Data dialog box, select the folder you want to export data into.
Enter a name for the exported file.

Determine how many rows of data you want to export and click the appropriate button.

AN O S o

Click Save.

NOTE. Click Options to change the field delimiters or to change how the bounds will be exported.

Loading a Saved System

1. From the File menu, click Load System.
2. Navigate to the directory where you saved your system.

3. Select the file and click Open.

NOTE. The saved system must exactly match the current system in order for all parts of the system to
load. If the saved system does not match, load parts of the saved system using the Load System Options
dialog box.

The current version of software can load files saved under older versions of software.

Related Topics

Saving a System (see page 80)
Load System Options Dialog Box (see page 355)

Loading Portions of a Saved System

From the File menu, click Load System.
Navigate to the folder where the saved file is located.

Click Options. The Load System Options dialog box opens.

L A S

Click a Saved System module and drag the module to a compatible module in the current system.
Reference data sources and data windows in the saved system load automatically.
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NOTE. The icon itself will not drag. The cursor will change to a drag cursor. If you attempt to drag a
saved module to an incompatible current module the cursor changes to a no drop shape.

5. Click OK.

Related Topic
Open Options (see page 355)

Loading a Saved Module

From the System window, click the Setup or Trigger button of the destination module.

From the File menu, click Load Module.

Navigate to the directory where you saved your file.

1.

2

3

4. Select the file name and click Open.

5. Select the module you want to load in the Load Module dialog box.
6

Click Load.

Adding a Data Source to an Active Listing Window

1. In the System window, click the appropriate data window icon.

From the Edit menu, click Add Column.

2
3. Select the Data Source or click Add Data Source if the source is not listed.
4. Select the columns and click Add.

5

Click Close.

TIP. Click t*n to open the dialog box.

Loading an LA Module with Saved Trigger Settings

1. In the System window, click the LA Trigger button.

. L= . .
2. Click the ~ T button, located in the trigger toolbar.
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3.

Loading an LA Module with Saved Trigger Settings

From the Load LA Trigger dialog box, click the Browse button to search for the trigger file. Then click
a filename from the displayed file listing to show all modules in the selected file.

NOTE. Alternatively, enter the path name to the desired trigger program.

4.

5.

Click the Open button to select the file. The Load LA Trigger dialog box lists the modules included in
the saved file. Select only the module that contains the LA trigger settings.

Click Load.

When a trigger program is not compatible with the current setup (for example, different groups), perform
the following adjustments, when necessary:

Groups that are used in group events are matched by name. If a match cannot be found, the event
defaults to the first available group.

Restored values are left-truncated or left-extended with don’t cares (XXXX ....) for word events;
left-extended with zeros for range events.

Channels used in channel events are matched by name. If a match cannot be found, the events are
matched by probe name. If a match is still not found, the trigger event defaults to the first available
channel.

Restore event values that are set by group (for example, Setup & Hold or Word events) by matching
groups by name. Groups in the current module that are not found in the trigger program being loaded
are assigned default settings. Settings for groups not defined in the current module are discarded.

The Arm Module actions that cannot be present because of target module conflicts are changed to
Do Nothing actions.

Word event definitions are merged with existing word event definitions. If word event definitions
have the same names as the current word event definitions then the new definitions will replace
the previous ones.

Channel groups in word events are matched by name. The restored values are left truncated or left
extended with don’t care values.

Channel groups in word events in the current module, that are not found in the trigger program being
loaded, are assigned default don’t care values.

Settings for groups in word events not defined in the current module are discarded.

Transition event definitions are merged with existing transition event definitions. If transition event
definitions have the same names as the current transition event definitions, then the new definitions
will replace the previous ones.

Channel groups in transition events in the current module, that are not found in the trigger program
being loaded, are enabled by default.

Settings for groups in transition events that are not defined in the current module are discarded.
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Adding MagniVu Data to a Listing or Waveform Window

1. In the System window, click the appropriate data window icon.

2. From the toolbar, click N (the Add Column icon) or e (the Add Waveform icon).

3. From the Data Source list, click MagniVu (see page 361). If the source you want is not listed, click
Add Data Source and add the one you want to the list.

4. Select the required columns or waveforms.
5. Click Add. The column or waveform appears in the data window.

6. Click Close.

TIP. To quickly display MagniVu data, click = MagniVi i, the data window. Click the button again to
remove the MagniVu data from the window.

Loading Source Code Symbol Information

In the System window, click the Source data window icon.

From the Edit menu, click Properties.

Click the Data properties tab.

Click the Symbol File button to locate a symbol file in the file system.

Choose the symbol file.

Verify that the file information in the File Contents box shows that the Type is Range.
Click Open.

ol A o L o

Click OK.

The new symbol file with source code is loaded in the Source window.

TIP. Click =" in the Source window to open the Properties dialog box .

Loading Filters

1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.
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Moving to a Mark (Go To)
Click the i oo button to open the Load Filter dialog box.

Enter a file name and path in the File Name box for the LA module or system setup that contain the
filters that you want to load. Click Browse to browse the file system.

Select the filter from the Load Filter dialog box.
Click the load button to load the filter to the LA module.

Moving to a Mark (Go To)

U S

In the System window, click a Waveform or Listing window icon to open the window.
From the Edit menu, click Go To.

In the Go To dialog box, select the Mark option.

Select the mark from the available list.

Click OK.

Related Topics

Adding a Mark to a Data Window (see page 136)

Moving Marks (see page 137)

Modifying the Location of Cursors Using the Overview Markbar

1.
2.

In the System window, click a waveform or listing icon.

Click the cursor handle (in the data area mark bar or the overview mark bar) and drag the mark to
the new location.

Related Topics

Adding a Mark to a Data Window (see page 136)

Sending Stacked Marks to the Back (see page 137)

Changing the Position of Cursors

1.
2.

78

In the System window, click the Waveform or Listing window icon.

Click the cursor handle (in the data area mark bar or the overview mark bar) and drag the cursor to
the new location.
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Alternate Method
1. In the System window, click a Waveform or Listing window icon.
2. From the View menu, click Cursor Toolbar if the cursor toolbar is not displayed.

3. Enter the cursor position using either the C1: or C2: cursor spin box.

Related Topics

Adding a Mark to a Data Window (see page 136)
Moving Marks (see page 137)
Sending Stacked Marks to the Back (see page 137)

Print Dialog Box

Use this dialog box to print the current active window. Print hard copies of the current data windows and
setup windows. Depending on the window, specify the print range and the number of copies.

When printing Listing, Source, and Waveform windows, print data between two marks, such as the trigger
point and one of the data cursors. Cancel printing at any time by pressing the ESC key.

From the File menu, click Print.

Related Topics

Exporting Data from a Listing Window (see page 73)
Exporting Histogram Data (see page 73)

Save Dialog Box

Use to save the system or a logic analyzer module to a file. A system file includes the setup information,
the trigger program, and acquired data from all modules (if you select Save Acquired Data). It also
includes all data windows and any links to data sources that were added.

A saved logic analyzer module file includes the setup information, the trigger program, and acquired data
from the current logic analyzer (if you select Save Acquired Data).

Saved system and module file names have a .tla file name extension. The initial default location for
saved files is C:\My Documents.

To open the Save dialog box from the File menu, click either Save System As or Save Module As.

Related Topics

Loading a Saved System (see page 74)
Loading a Saved Module (see page 75)
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Saving a System

Loading an LA Module with Saved Trigger Settings (see page 75)

Saving a System

Save system setups to a saved system file (see page 80)

Go to the File menu and click Save System.

To save a system and change the name, do the following:

1.

DA I

From the File menu, click Save System As.

Navigate to the directory where you want to save the system.
Go to File Name and enter the name you want.

Enter any comments you want to include.

Select the Save all Acquired Data option if you want the data (including measurement statistics)
to be included with the file.

Click Save.

Saved System File

A saved system file contains the setup and trigger program information needed to automatically
set up the logic analyzer with all installed modules. This file can also contain acquired data from
the modules.

Saving a Module

80

Click a module icon in the System window, then go to the File menu and click Save Module.

To save a module and change the name, do the following:

1.

AN o

From the File menu, click Save Module As.

Navigate to the directory where you want to save the module.

Go to File Name and enter the name you want.

Enter any comments you want to include.

Select the Save all Acquired Data option if you want the data to be included with the file.
Click Save.
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Saving Repetitive Acquisition Data

From the System menu, click Repetitive Properties.

Select the Save check box.

In the list associated with the Save check box, select Export Data.

In the From list, select a data window (this selection is only available with Export Data).
Enter a file name or click Browse to specify the location and file name.

Select whether to overwrite the existing file or to create a new file for each acquisition.
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Click OK to close the dialog box and save your settings.

The data will be saved in an ASCII file with the .txt extension under the specified file name.

TIP. Click the button to the right of the Run button to set the repetitive run mode. [

Related Topic

Repetitive Properties Dialog Box (see page 191)

Saving Repetitive Module Setups and Data

1. From the System menu, click Repetitive Properties.

Select the Save check box.

In the list associated with the Save check box, select Save Module and Data.
In the From list, select a module.

Enter a file name or click Browse and specify the location and file name.

Select whether to overwrite the existing file or to create a new file for each acquisition.

AL

Click OK to close the dialog box and save your settings.

To improve the response time of the logic analyzer during repetitive operations, delete any unnecessary
data windows. This allows the logic analyzer to spend time on processing data rather than redrawing
data in data windows.

Related Topic

Repetitive Properties Dialog Box (see page 191)
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Saving Repetitive System Setups and Data

Saving Repetitive System Setups and Data

From the System menu, click Repetitive Properties.

Select the Save check box.

In the list associated with the Save check box, select Save System and Data.
Enter a file name or click Browse and specify the location and file name.

Select whether to overwrite the existing file or to create a new file for each acquisition.

AN

Click OK to close the dialog box and save your settings.

To improve the response time of the logic analyzer during repetitive operations, delete any unnecessary
data windows. This allows the logic analyzer to spend time on processing data rather than redrawing
data in data windows.

Related Topic

Repetitive Properties Dialog Box (see page 191)

Setting the Search Options

The Search Options dialog box defines the action that you want the logic analyzer to take when the
search is successful. Access the Search Options dialog box from the Search Options... button in the
Define Search dialog box.

To create a new mark upon a successful search:
1. Select the Create new mark at point found check box.

2. Use the existing Mark Name Prefix or enter a new one in the Mark Name Prefix text box.

NOTE. When a new mark is created, the Mark Name Prefix and a numeric suffix are appended to the mark
to ensure that the new mark is unique.

Searching for Specifics in a Listing or Waveform Window

82

1. In the System window, click the appropriate data window icon.
2. From the Data menu, click Define Search, and then select Search.

3. From the Search Definition drop-down list, select a saved search definition from the selected data
window or type in a new search name.
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How to Searching for Source Data

NOTE. To add a search definition from another data source, click the Load button to open the Load
Search dialog box.

4. Click Start from the drop-down list to select where you want to start searching and enter the number of
occurrences to find in the occurrence text box.

5. Click the Search Options... button to open the Search Options dialog box and select what action you
want the logic analyzer to take when the search is successful.

Type a Description of the search.
From the Search drop-down list, select the data source.

Use the drop-down lists under Find to select the criteria for which you want to search.

e * 22

Right-click in the Search event area to open a menu where to cut, copy, or paste events.

NOTE. Add and delete sources and enable or disable searches with the short cut edit menu.

10. Click either the Search Fwd or Search Back button. The first occurrence is marked according to
how the Search Options are set up.

TIP. Click ) to open the dialog box.

Related Topic
Searching for Source Data (see page 83)

Searching for Source Data

In the System window, click the Source data window icon.
1. From the Data menu, click Define Search.

2. Click either All Files to search all files identified by the symbol file, or select This File to search
the current file.

3. Enter a text pattern.

4. Click Search Fwd or Search Back. The first occurrence is marked by the active cursor.

NOTE. Search for any text pattern including leading and embedded white space; trailing white space
is ignored.
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How to Searching in the Protocol Window

The search operation follows the order of files as listed in the Source File properties tab. When you search
for data in all files, and one or more of the files cannot be found, the Source File Locator dialog box
displays, asking you to specify the file location.

If the search is not completed in a set amount of time, the Search Progress dialog box shows the status of
the search. Let the search continue, or click Abort to stop the search.

TIP. Click o to open the dialog box.

Copy text to use as a search pattern from the Source window and paste it into the Source Window Search
Definition dialog box.

Related Topic
Searching for Specifics in a Listing or Waveform Window (see page 82)

Searching in the Protocol Window

Follow these steps to search for a data packet or a message pertaining to the packet:

1. Place the cursor in the Protocol window and click Data > Define Search to display the Search dialog
box.

Select a protocol from a list of protocols. Use the drop-down list to select a protocol.
Select the fields to search from the Fields text box.

Select operation used to compare field values from the Operation group box.

SO R

Specify the value and the format for the selected field. The packets that have the specified values
are searched for in the Packet View.

&

Select either the << Back or Forward >> button to search before or after the current cursor position.

7. Clear the Enable Fields selection to search the packets based on the selected protocol.

Related Topic
Protocol Search Dialog Box (see page 272)

Setting the Waveform Style

1. In the System window, click the Waveform window icon.

2. Double-click the label of the LA waveform whose options you want to set.
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How to Setting the Waveform Limits

NOTE. The Options selection is not available if you select a waveform with only one channel.

Click Options.
To display LA waveforms as a busform, click Busform.

To display LA waveforms as magnitude waveforms, click Magnitude.

AU

If you selected Magnitude, select whether you want acquisition data interpreted as signed data.

NOTE. When you want to interpret the LA waveform as signed data, make sure you select a radix, such as
signed decimal, so that the readouts will display the correct information.

Related Topics

Setting Waveform Options (see page 124)
Setting the Waveform Limits (see page 85)
Showing Waveform Readouts (see page 120)

Setting the Waveform Limits

In the System window, click a Waveform window icon.
Double-click the label of the waveform whose options you want to set.
Click Options.

If you want the waveform limits locked to the DSO setup, click Lock to Setup.

A

If Lock to Setup is not checked, set the maximum and minimum value to display in the waveform.

The Max and Min values correspond to the top and bottom of the waveform range.

Related Topics

Setting Waveform Options (see page 124)
Setting the Waveform Style (see page 84)
Showing Waveform Readouts (see page 120)

Determining the Data Source of the Selected Waveform

1. In the System window, click a Waveform window icon.

2. Double-click the label of the waveform about which you want to view attributes.
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How to Selecting the Radix of Busform Readouts

3. If not selected, select the waveform you want to change from the waveform list.

4. View the source of the waveform from the Source field, which is located in the upper-left corner
of the Waveform tab.

5. Click Cancel.

Source is only available when a single waveform is selected.

Related Topics

Changing Waveform Appearance (see page 119)

Changing the Height of a Waveform (see page 124)
Selecting the Radix of Busform Readouts (see page 86)
Changing the Color of the Selected Waveform (see page 119)
Controlling Whether a Waveform is Visible (see page 121)

Selecting the Radix of Busform Readouts

In the System window, click a Waveform window icon.

Double-click the label of the waveform whose attributes you want to change.

If not selected, select from the Waveform list the waveform you want to change.
From the Radix list, select the waveform radix.

Click OK.

L A

Related Topics

Changing Waveform Appearance (see page 119)

Changing the Height of a Waveform (see page 124)

Determining the Data Source of the Selected Waveform (see page 85)
Controlling Whether a Waveform is Visible (see page 121)

Changing the Zoom Options

Change the zoom options by changing the system preferences.

To change the zoom options, select Options from the System menu. Under the Preference tab, click the
Click & Drag Zoom option to display a drop-down list with the following selections:

B Zoom Immediately
m  Show Context Menu

®  Show Rectangle Only
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How to Setting the Default Trigger Tab

Zoom Immediately

This is the default setting. To zoom data in a Waveform window, click and drag the mouse over the area
that you want to zoom. The window will automatically zoom after you release the mouse button. If you
click and drag from the left to the right, the window zooms to the selection. If you click and drag from the
right to the left, the window repeats the previous zoom operation.

When you zoom data in a Listing window, a right-click menu appears after you click and drag the mouse.
The right-click menu gives several choices where to copy text, bitmaps, move cursors to the edge of
the rectangle, show, or suppress data.

Show Context Menu

Use this setting to show the right-click menu as soon as you click and drag the mouse over the zoom area.
Select one of the choices from the right-click menu.

Show Rectangle Only

Use this setting to draw a rectangle by clicking and dragging the mouse. Resize the rectangle so that to
focus on the data of interest. Right-click the mouse to display a right-click menu with several options for
handling the data inside the rectangle.

NOTE. You cannot suppress or show oscilloscope data. The Suppress and show selections only function
for logic analyzer data.

Setting the Default Trigger Tab

1. From the System menu, click Options to display the Options dialog box.
2. Click the Defaults tab.
3. Click the Trigger Window Style field and then select the desired trigger tab from the list box.

Changing the Start-Up Default Settings

From the System menu, click Options.
Click the Defaults tab.

Click the option and change the setting.

& B b=

Click OK.

The settings here are used as defaults when creating a new data window.
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How to

Changing the Color of a Graph Mark

Changing the Color of a Graph Mark

Eol o

In the System window, click the Graph data window icon.
Double-click the mark that you want to change to open the Marks property page.
Click the Color button and select a new color.

Click OK.

Changing the Data Series Range

o Wb

In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property pages.
Click the Series Data tab.
Enter new values for the minimum and maximum data range setting for each axis.

Click OK.

Changing the Graph Drawing Style

A S

In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property page.
Click the Series Format tab.
Select the series type.

Use the drop-down lists in the Line section of the property page to change the line style, color, and
thickness. Use the drop-down lists in the Data Points area of the property page to change the data
point style, color, and thickness. The graphic in the property page provides a brief example of what
your changes will look like.

Click OK to close the property page.

Changing the Graph Window Properties

1.

2.
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In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property pages.
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How to

PG Run Properties Dialog Box

3. Click the Graph Window tab.

4. Make the changes that you want to the:

Graticule

Select Show Graticule check box. Set the color, style, and thickness using the drop-down lists. To
hide the graticule, clear the Show Graticule check box.

X and Y axis

Enter new values for the minimum and maximum data range setting for each axis. If desired, enter
an new label for each axis.

Axis readout

Select the Show Readout check box. Select the color for the readout from the Color drop-down
list. If you do not want the readout to display, clear the Show Readout check box.

Background color

Click the Background color button at the bottom of the property sheet and select a background
color.

5. Click OK.

PG Run Properties Dialog Box

The Pattern Generator Run Properties dialog box selections determine if the TLA Start button will start
and stop the pattern generator (PG) modules.

The When the TLA Runs list box selections are:

B Ignore PG. Do not start or stop the pattern generator modules.

m  Start PG after TLA. When the TLA start button is pressed the LA modules will start before the
pattern generator modules.

®  Start PG before TLA. When the TLA start button is pressed the pattern generator modules will
start before the LA modules.

The two check box options are:

= Stop PG when TLA stops. When this box is checked the pattern generator modules will be forced to
stop after all LA modules are finished acquiring data.

If this box is not checked the system will wait for all LA and PG modules to complete before indicating
that the system (PG and LA modules) are stopped.

m  If repetitive run, restart at each iteration. Normally the pattern generator will run once and stop
even in repetitive mode.

If this box is checked, the pattern generator will be restarted each iteration (Repeat count).

TLA Online Help 89



How to Waveform Properties

Waveform Properties

Overview

Use the Waveform tab to setup, change, or view the properties of a waveform. The properties displayed in
the Waveform tab depend on the waveform that you select in the Waveform window.

Behavior

The following are properties that are common to all waveforms, regardless of whether you choose an
individual waveform, a waveform group, or an individual waveform within a waveform group:

B Waveform: lists the label that displays in the Waveform window. Select a different waveform from
the list. The list contains the names of all waveforms in the active window. The initial waveform
is the selected waveform or the first waveform if no waveform is selected. The list box is empty
if multiple waveforms are selected.

m  Height: controls the height of the waveform. Height can range from 10 to 500 pixels. The default
height of waveforms is fixed at 18 pixels.

To Use

To change waveform properties from the System window, click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics

Individual Waveform Properties (see page 207)
Group Waveform Properties (see page 205)
Individual Waveform Properties within a Waveform Group (see page 209)

Waveform Window Properties

Overview
Use to format the current Waveform window.

B Acq != Ref determines if data differences (see page 187) will be displayed during data compare
operations.

B Acq = Ref determines if data equalities (see page 187) will be displayed during data compare
operations.
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How to

Selecting the Sample Size: A General Approach

Behavior
To display differences and equalities, define a valid data reference and enable the comparison.

®  Show Graticule determines if a graticule will be displayed. Graticule color determines the color
of the graticule.

B Show Violations determines if glitches or setup and hold violations will be displayed. Violation
color determines the color of glitches and violations. Glitches or setup and hold violations must be
stored before they can be displayed.

B Background determines data area background color for the active data window.
B Color Scheme determines the named color scheme for the active data window.

B Snap cursors/marks to transition edges allows you to place the cursors or marks quickly on a transition
edge.

When you select a new color scheme, the color of all waveform data window elements reset to the new
color scheme (All color selections in this dialog box will change to the colors defined by the new color
scheme).

To Use

To change Waveform Window properties from the System window, click a Waveform window icon,
double-click a waveform label and then click the Waveform Window tab. Access this tab from the toolbar,
menu bar, or from the right-click menu on the waveform label.

Related Topics

Changing Waveform Window Properties (see page 120)
Waveform Tab (see page 90)

Changing Waveform Properties (see page 119)
Waveform Options (see page 214)

Color Settings (see page 369)

Making Violations Visible (see page 122)

Selecting the Sample Size: A General Approach

To make the most effective use of memory, use sample suppression to limit the number of samples acquired.
From the LA Setup window follow these steps to set the sample size:

1. Select the desired number of samples.

2. Click the Suppress button in the toolbar to activate the Sample Suppression dialog box.

3. Make a selection in the dialog box to limit the number of samples initially displayed after each
acquisition.

For example: Show 1024 Samples around trigger.
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How to

Storing LA Module Setup and Hold Violations

During data acquisition memory is filled up to the selected depth (maximum in this case). After acquisition
only 1024 samples will be delivered to all data displays.

If the acquisition you are looking for is not visible, show more samples using the Show dialog box or
right-click menu in the Listing or Waveform window. This can be done without reacquiring data.

If too much data is delivered to all data displays, remove samples using the Suppress dialog box or
right-click menu in the Listing or Waveform window.

Related Topics

Suppress Samples Dialog Box (see page 199)

Sample Storage depth (see page 27)

Storing LA Module Setup and Hold Violations

Select the LA Setup window.

Select synchronous sampling or if you have previously loaded a support package, use the Custom
sampling selection.

Select the Samples + Violations (Setup and Hold) storage option.

NOTE. When you select the maximum acquisition length under the Samples storage and you change to
Setup and Hold storage, the logic analyzer changes the acquisition length to half the original.

If you use synchronous sampling, adjust the global setup T, and hold T, values in the sampling area of
the LA Setup window.

Adjust the values of individual groups or signals in the Signal Sampling screen.

If you use Custom Sampling, adjust values in Signal Sampling screen.

Setting up Transitional Storage for the LA Module

92
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In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click Transitional from the Storage list box, located in the trigger toolbar.
Click the Change Detect button.

From the Change Detect dialog box, select the groups in which you want the logic analyzer to detect a
change in state for the transitional storage.

Click OK.
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How to Storage Definition Dialog Box

When you start the logic analyzer, the logic analyzer module will begin storing data when it detects a
change in any one of the selected groups.

Conflicts are possible when groups share signals. Conflicts are noted in the boxes. Conflicts do not prevent
acquisition. Value settings closer to the top of the list override later settings.

On TLA7000 Series logic analyzer modules and TLA5000 Series mainframes, the first transition state
indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). To avoid triggering on a false first
transition indication, set the first state to "If Anything Goto Next State". This will consume a state, but will
ensure that there is no false triggering on the first transition indication.

TIP. An easy method for setting up a transitional storage trigger is to load one of the EasyTrigger
programs (Store on all transitions, Store on signal transitions, or Store on group transition). If necessary
modify the program from the PowerTrigger tab.

Storage Definition Dialog Box

Overview

Use this dialog box to define the condition when storage occurs after Conditional storage is selected in the
Trigger window toolbar. This dialog box defines an If event the same way as does the Clause definition
dialog box. The Then action stores a sample; this action cannot be changed.

To Use

To open the Storage definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Set Storage to Conditional and click the If/Then button in the Storage state.
A few things to keep in mind when using this dialog box:

B Counter and timer events are not available in storage definitions.

B Violation Storage is not available for Prime signals.

m  Storage Definition is not available from the EasyTrigger tab.

®  Snapshot events are not available in storage definitions.

Related Topic

Clause Definition Dialog Box (see page 163)
LA trigger Event Table (see page 166)
Storage Selection for an LA Module (see page 140)
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How to

Triggering a Logic Analyzer Using the Trigger Tab Page

Triggering a Logic Analyzer Using the Trigger Tab Page

Use the Trigger tab page to quickly add one of the following trigger programs:

Channel edge

Bus Value

Glitch

Trigger on Anything
Channel Value
Multi-Group Value
Setup and Hold

To use the Trigger tab page, do the following:

1.

2
3.
4

From the data window, click the Trigger tab page.

Drag a trigger from the Add Trigger group box to the waveform that you want to trigger on.
Edit the trigger expression under Trigger Details in the Trigger tab page.

Click Run.

Adding a State to a Trigger Program

1.
2.
3.

In the System window, click the LA Trigger button.
Click the PowerTrigger tab.
From the Edit menu, click Add State.

NOTE. The state is added after the currently selected state. If a state is not selected, then the state is
added as the last state.

TIP. Add State is also available on the toolbar of the Trigger window. shate

Defining If/Then Clauses in a Trigger Program

1.
2.
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In the System window, click the LA Trigger button.

Click the PowerTrigger tab.
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How to Defining Multiple Transition Recognizers

3. Click the If/Then button of the clause you want to edit.
4. Make changes in the If/Then clause dialog box.
5. Click OK.

On TLA7000 Series logic analyzer modules and TLA5000B Series mainframes, the first transition state is
always false. On TLA700 Series logic analyzer modules the first transition state always shows a transition
indication (even if there are no probes plugged in). To avoid triggering on a false first transition indication,
set the first state to "If Anything Goto Next State". This will consume a state, but will ensure that there is
no false triggering on the first transition indication.

If transitions are used as events, there will be a false indication of a transition. The first state needs to be
set up as "If Anything Then Next State."

Defining Multiple Transition Recognizers

In the System window, click the LA Trigger button.
Click the PowerTrigger tab.
Click the corresponding If/Then button of the state clause you want to define.

In the event definition drop-down list box, click Transition and specify the related transition condition.

A o

Optionally, from the Clause Definition dialog box, click the Add button to specify additional transition
events.

&

Click the Define Transition button to display the Transition Definition dialog box.

7. Click the Add button to add a new transition definition and specify the groups in which transition
events will be monitored.

NOTE. Add as many transition event definitions as you want within the Transition dialog box. However,
use eight events of any kind within an event clause. The events that are selected when you close the
Transition dialog box are used in the event clause.

8. In the event definition drop-down list box, click Transition and specify the related event action.

9. Optionally, click the Define Transition button to define a unique transition name.

NOTE. Define up to 16 trigger events and two counters or timers for a given trigger setup.

TIP. An easy method for defining multiple transition recognizers is to load the Trigger on Nth occurrence
of edge from the Easy Trigger programs. If necessary, modify the program from the PowerTrigger tab.
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Selecting Signals for an LA trigger Channel Event

Related Topics

Add Transition Dialog Box (see page 158)
Transition Definition Dialog Box (see page 157)

Selecting Signals for an LA trigger Channel Event

In the System window, click the LA Trigger button.
Click the PowerTrigger tab.

Click the If/Then button of the clause you want to edit.
Select Channel in the first box of the If section.

Click the Select Channel button.

AU

Do one of the following:

= Double-click the desired group in the Select Signals dialog box and select the signal.
- Click By Probe and select the signal.

= Click By Name and select the name of the signal you assigned in the Setup window.

7. Click OK.

Selecting When to Store Data

1. In the System window, click the LA Trigger button.
2. Click the PowerTrigger tab.

3. Specify the desired storage mode in the Storage box, which is located in the LA Trigger dialog box
toolbar. Refer to Data Sample Storage Selections (see page 150) for definitions of the storage modes.

NOTE. This functionality is only available when defining trigger programs using the PowerTrigger tab.
Otherwise, the Storage box is disabled.

Positioning the Trigger

96

1. In the System window, click the LA Trigger button.

2. Position the trigger using one of the following methods available from the trigger toolbar:
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How to Triggering an LA Module on a Glitch

®  Move the Trigger Pos slider until the desired percentage of data before the trigger shows in the text
field.
®  Enter the desired percentage in the text field.

B Use the controls in the list box to reach the desired percentage.

Triggering an LA Module on a Glitch

NOTE. Only Asynchronous sampling allows glitch selection. Glitch storage is not available with Prime
signals.

In the TLA toolbar, click the Trigger button for your module.

Click the EasyTrigger tab.

Locate the Trigger on glitch EasyTrigger program under Simple Events.
Click the Define Glitches button.

Select the groups for which you want to detect a glitch.

Click OK.

AN S A

TIP. An easy method for setting up a glitch trigger program is to drag-and-drop a glitch trigger into the
Waveform or Listing window from the Trigger tab page. Then make any necessary changes to the trigger
expression, under Trigger Details, to set up the trigger.

Triggering an LA Module on a Setup and Hold Violation

NOTE. Setup and hold violation storage is unavailable when using Prime signals. Violations can only be
selected with synchronous or custom sampling. Custom is available when a support package is loaded.

1. From the LA Setup window select synchronous sampling. If you have previously loaded a support
package, the Custom selection is correct.

Open the LA Trigger window.
Click the EasyTrigger tab.
Select the Trigger on group setup & hold violation program from the Simple Event list.

Click the Define Violation button to display the Setup and Hold Event dialog box.

AU S i

Select the groups for which signals that you want to detect a setup and hold violation.
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How to

7.
8.

Triggering an LA Module on Timer Values

Enter the values in the corresponding group setup and hold boxes.

Click Close.

TIP. An easy method for setting up a setup and hold violation trigger program is to drag-and-drop a Setup
and Hold trigger from the Trigger tab page into a Waveform or Listing window. Then make any necessary
changes to the trigger expression, under Trigger Details, to set up the trigger.

Related Topics

Loading an LA with Saved Trigger Settings (see page 75)

Using the Trigger Tab Page (see page 94)

Triggering an LA Module on Timer Values

LI S

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Timer in the If section of the Clause Definition dialog box.

Select the specific Timer.

NOTE. Counters and Timers share resources. For example if Counter 1 is selected, Timer 1 is not
available as an action or event.

6. Select the operation.

7. Select the value.

8. Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

Related Topic

Triggering an LA Module on Counter Values (see page 99)

98
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Triggering an LA Module on Counter Values

Triggering an LA Module on Counter Values

A S A

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Counter in the If section of the Clause Definition dialog box.

Select the specific counter.

NOTE. Counters and Timers share resources. For example if Counter 1 is selected, Timer 1 is not
available as an action or event.

a

Select the operation.
Select the value.

Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

Click OK.

Related Topic

Triggering an LA Module on Timer Values (see page 98)

Triggering an LA Module on an Internal Signal

A A e

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Signal in the If section of the Clause Definition dialog box.
Select the signal.

Select the signal logic level.

Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as a
system trigger.

Click OK.
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Triggering an LA Module on a Word Event

Related Topics

Internal Signaling (see page 154)

Trigger Action Signal Restrictions (see page 155)

Module Arming Using an LA Module (see page 153)

Triggering an LA Module on a Word Event

10.
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In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Word in the If section of the Clause Definition dialog box.
Click the Define Word button.

Enter the word values for each group.

Click the box to the left of the group to enable or disable each group.
Click OK.

Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

Click OK.

TIP. Define multiple word events by clicking Add in the Word Definition dialog box and assigning a name
to the definition. Select the definition from the Clause Definition dialog box directly.

An easy method for setting up a word event trigger is to load the Trigger on word value EasyTrigger
program. If necessary, make modifications to the program from the PowerTrigger tab.

Triggering an LA Module on a Snapshot Event

100
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In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.

In the Clause Definition dialog box, If section, select Snapshot from the event selection list.
Click the Define Snapshot button.

Click the box to the left of the group to enable or disable each group.
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How to Triggering on Group Data Values

7. Click OK.
8. In the Then section of the Clause Definition dialog box click either:
- Trigger - to trigger the current module.

= Trigger All Modules - to trigger all modules, which is the same as a system trigger.

9. Click OK.

Triggering on Group Data Values

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Group in the If section of the Clause Definition dialog box.

Select the group.

Select the operation for word recognition. Valid selections are = and Is Not.

Enter the value to recognize.

Sl A G o

Click either Trigger or Trigger All Modules in the Then section of the Clause Definition dialog box.
Selecting Trigger will trigger the current module; Trigger All Modules triggers all modules, which is
the same as a system trigger.

9. Click OK.

TIP. An easy method for setting up a group data value trigger is to load the EasyTrigger programs Trigger
on group value. If necessary make modifications to the program from the PowerTrigger tab. Alternatively,
drag-and-drop a Multi-Group Value trigger from the Trigger tab page onto a waveform. Then make the
necessary selections in the trigger expression, under Trigger Details, to set up the trigger.

Related Topic
Using the Trigger Tab Page (see page 94)

Triggering on Group Data Ranges

1. In the System window, click the LA Trigger button.
2. Click the PowerTrigger tab.

3. Click the corresponding If/Then button of the clause you want to edit.
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Triggering an LA Module on a Single Channel

Click Group in the If section of the Clause Definition dialog box.
Select the group.

Select the operation for range recognition. Valid selections are:
<, <=,>,>=,Is In and Is Not In.

Enter the values for the range.

Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as a
system trigger.

Click OK.

TIP. An easy method for setting up a group data value trigger is to load one of the EasyTrigger programs
(Trigger on group value outside of a range or Trigger on group value within a range). If necessary, make
modifications to the program from the PowerTrigger tab. Alternatively, drag-and-drop a Multi-Group
Value trigger from the Trigger tab page onto a waveform. Then make the necessary selections in the
trigger expression, under Trigger Details, to set up the trigger.

Related Topic

Using the Trigger Tab Page (see page 94)

Triggering an LA Module on a Single Channel

102
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In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause that you want to edit.

Select Channel in the If section of the Clause Definition dialog box.

Click the Select Channel button to display the Select Channel dialog box.

Select both the selection method and the signal that you want to trigger on, and then click OK.
Select the operation.

Select the logic level.

Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as a
system trigger.

Click OK.
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Triggering an LA Module on a Group

TIP. An easy method for setting up a single channel trigger is to load one of the EasyTrigger programs
(Trigger on signal low/high or Trigger on signal transition edge). If necessary, modify the program from
the PowerTrigger tab. Alternatively, drag-and-drop a Channel Value or Channel Edge trigger onto a
waveform from the Trigger tab page. Then make the necessary selections in the trigger expression, under
Trigger Details, to set up the trigger.

Related Topics

Signal Selection (see page 157)
Using the Trigger Tab Page (see page 94)

Triggering an LA Module on a Group

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Click Group in the If section of the Clause Definition dialog box.
Select the group.

Select the operation for group recognition.

Select the group value or pattern.

® SRk w D=

Click either Trigger or Trigger All Modules in the Then section of the dialog box. Selecting Trigger
will trigger the current module; Trigger All Modules triggers all modules, which is the same as a
system trigger.

9. Click OK.

TIP. An easy method for setting up a group trigger is to drag and drop a Multi-Group Value trigger from
the Trigger tab page onto a waveform or listing window. Then make the necessary selections in the trigger
expression, under Trigger Details, to set up the trigger.

Alternatively, load one of the EasyTrigger programs (Trigger on group value or Trigger on group
transition). If necessary, modify the program from the PowerTrigger tab.

Related Topic
Using the Trigger Tab Page (see page 94)
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Arming other Modules from an LA

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.
Select the event type in the If section of the Clause Definition dialog box.
Click Arm Module in the Then section of the Clause Definition dialog box.
Select the module you want to arm.

Click OK.

P A A o R

Related Topics

Internal Signaling (see page 154)
Trigger Action Signal Restrictions (see page 155)
Module Arming Using an LA (see page 153)

Triggering other Modules from an LA

In the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click the corresponding If/Then button of the clause you want to edit.

Select the event type in the If section of the Clause Definition dialog box.

Click Trigger All Modules (see page 104) in the Then section of the Clause Definition dialog box.
Click OK.

LA D

NOTE. All trigger actions in the trigger program must be the same and can be either Trigger or Trigger
All Modules.

TIP. An easy method for triggering all modules is to load the EasyTrigger program Trigger all modules
when A occurs. If necessary, modify the program from the PowerTrigger tab.

Trigger All Modules

Trigger All Modules is the same as a system trigger.
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Troubleshooting LA PowerTrigger Programs

If you have problems with your PowerTrigger program, try these suggestions:

®  Look at the trigger clauses. The clauses, although appearing to be evaluated simultaneously, have
precedence, and are given priority from top to bottom in the active state. Therefore, you will not
trigger when you think you should if you have a program like the following examples.

If Anything
Increment Counter 1
Else If Counter 1 > 5
Then Trigger

A trigger will never occur because the first clause is always true.

If counter 1 > 5

Then Reset Counter 1
And Increment Counter 2
Else if Counter 1 <=5
Then Increment Counter 1
Else if Counter 2 > 10
Then trigger

A trigger will never occur because counter 1 will either be >5 or <=5.

B Check for a bad probe lead: go to the Setup window and check the activity indicators for activity
at the probe tip.

®  When setting up to trigger on group ranges, check that the signals in the group are assigned in
descending order in the Setup window. For example:

A3(7), A3(6), A3(4) or A3(7-0) is correct.
A3(6) A3(7), A3(4) or A3(0-7) is incorrect.

The values triggered on in the incorrect example will not be correct in the data windows. For example, if
the incorrect group above is in the range of FO to 70 the only possible values to cause a trigger would be FO
and 70. Values in the range of FO through 70 will not cause a trigger.

B Check that the probe order is correct. Verify that you have the correct probe or probe leads connected.

m  Check the progress of the trigger program in the Status monitor to see which state may be causing the
trigger problem.

B Onthe TLA7000 Series logic analyzer modules and the TLA5000 Series mainframe, the first transition
state indication is always false. On TLA700 Series logic analyzer modules the first transition state
always shows a transition indication (even if there are no probes plugged in). To avoid triggering on a
false first transition indication, set the first state to "If Anything Goto Next State". This will consume a
state, but will ensure that there is no false triggering on the first transition indication.
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Related Topics

Status Monitor Dialog Box (see page 358)
Troubleshooting Triggering (see page 332)

Timer Event Target Value Limit

The maximum value that can be entered as an event value limit is 2,000,000 seconds, which is about 23
days.

Actual ending timer values up to the full 104-day limit can be read from the hardware and displayed
in the status monitor.

The 23-day limit is imposed by the user interface in the If/Then dialog.

Data Measurement Types and Definitions: Count

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Count measurements

Pattern Match

C‘pﬂ!. — ZX?*

The number of occurrences of a specified group value.

Where Cr is the total number of occurrences of the matched pattern in the gated region.

X, is the pattern to match.

The total number of occurrences of the specified group value in the gated region is displayed in the Value column.
Edge Count

n—1

The total number of signal edges (positive and negative).

Where r:"*'f'-is the Edge Count.

X(LH) is an edge represented by a transition from Low to High.

X(HL) is an edge represented by a transition from High to Low.

The total number of signal edges in the gated region is displayed in the value column.
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Data Measurement Types and Definitions: Count

Count measurements

Cycle Count

CC_'.'::'E = Z LHLH

le_'.'::'; - Z H‘E’HL

The number of signal cycles in the specified region. One cycle is defined as the time period between rising edge to next

rising edge or from a falling edge to the next falling edge.
Where Cgy is the cycle Count.

Positive Pulse count

b= LHL

" Pulse

The number of positive pulses.

Where Crse is the Positive Pulse Count.
The total number of positive pulses in the gated region is displayed in the Value column.

Negative Pulse Count

C; :ZHLH

" Pulze

The number of negative pulses.

Where Crse is the Negative Pulse Count.
The total number of negative pulses in the gated region is displayed in the Value column.

Violation Count

Ci'.‘-_:.":.!ii-_:?: - Z V

The of number of group setup/hold violations or number of glitch violations in the gated region. Setup/Hold violations are only
available for synchronous sampling. Glitch violations are only available for asynchronous sampling.

Where C oot is the Violation Count.
The total number of violations in the gated region is displayed in the Value column.

Violation Rate

R, =C,

iglaticn

/N(S)

Ratio of the number of group setup/hold or glitch violations (depending on the sampling) per number of seconds.

Where <=2 is the Violation Rate. ot is the number of violations in the gated region. N (S) is the number of seconds.

The rate at which violations occur in the gated region expressed as a fraction of total number of violation/seconds is
displayed in the Value column.
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Data Measurement Types and Definitions: Jitter

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Jitter measurements

Period Jitter
AF, =F,. —F,

The timing variation in the period measured in seconds.

AD
Where “ is the Period Jitter.

B is the Period of the (n +1) Cycle.

‘Pi-is the Period of the First Cycle.

The difference of the Maximum period measured minus the Minimum period measured in the gated region is displayed in the
Value column. This is also called peak-to-peak period jitter.

Cycle-to-Cycle Jitter
AP =F_.—P,

The timing variation in the period in adjacent cycles measured in seconds.

AR .
Where ~— * is the Cycle-to-Cycle Jitter.

B is the Period of the (n+1) Cycle.

£ is the Period of nth Cycle.

The difference of the Maximum cycle-to-cycle jitter minus the Minimum cycle-to-cycle jitter in the gated region is displayed in
the Value column. This is also called peak-to-peak cycle-to-cycle jitter.

Data Measurement Types and Definitions: Minimum/Maximum

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms for each measurement.

Minimum/Maximum measurements
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Minimum/Maximum measurements

Group Min
Min(X) = Lowest Value of Group
The minimum value the group values.The lowest value of the group in the gate region is displayed in the Value column.

Group Max
Max(X') = Highest Value of Group

The maximum of the group values.The highest value of the group in the gated region is displayed in the Value column.

Data Measurement Types and Definitions: Time

There are four LA data measurement types or categories. Click the following buttons for definitions
and algorithms of each measurement.

Time measurements

Frequency
F, =1/P,

Frequency is the reciprocal of the period of a signal measured in hertz (Hz).

Where F, is the Frequency and P, is the Period.

The average frequency of all cycles in the gated region is displayed in the Value column.
Period

P — ‘T:?—l o T

Time it takes for a complete cycle in the gated region. Reciprocal of frequency, measured in seconds (s).
Where P, is the Period and T is the point in time of a Transition (Low to High or High to Low).

The average of all period measurements in the gate region is displayed in the Value column.

Positive Pulse Width

7T T

I’T'?”_ _ I:TL _ I:_H

The time duration of a positive pulse (low-high-low) measured in seconds (s).

Where " ® is the Positive Pulse Width.

= is the point in time of the Transition from High to Low.

is the point in time of the Transition from Low to High.
The average of all positive pulse width measurements in the gated region is displayed in the Value column.
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Data Measurement Types and Definitions: Time

Time measurements

Negative Pulse Width

TIF 7T

E Fila _T.'_.': _I‘F‘u‘.
H?: — *hn 7

The time duration of a negative pulse (high-low-high) measured in seconds (s).

I7
Where " is the Negative Pulse Width.

is the point in time of the Transition from Low to High.

e is the point in time of the Transition from High to Low.
The average of all negative pulse width measurements in the gated region is displayed in the Value column.

Positive Duty Cycle
D =W /P

The ratio of the positive pulse to the total signal period expressed as a percentage (%).
Where D, is the positive duty cycle.

-

"+ is the Positive Pulse Width.

£ is the Period.

The average of all positive duty cycle measurements in the gated region is displayed in the Value column.

Negative Duty Cycle
D?: = H?' -E,.

The ratio of the negative pulse to the total signal period expressed as a percentage (%).
Where D, is the negative duty cycle.

7~ is the Negative Pulse Width.

£ is the Period.

The average of all negative duty cycle measurements in the grated region is displayed in the Value column.

Channel-to-Channel Delay

o
Cth = A‘L‘E?F'c'.!ge’.(/ ZT?:D?::'E?::H:-_:?: _ Tﬂ?se;r:?)

Time delay between the edges of two different signals measured in seconds (s).

Where ChD, is the Channel to Channel Delay. ~ - is the Transition (location of the type of edge selected in the Ul
using the drag and drop action) of the Destination Channel. This is indicated as the second channel selected during the
measurement setup. The average of the delay from the first edge of the type selected as the source to the first edge of the
type selected as the destination plus the delay from the second edge of the type selected as the source to the second edge
of the type selected as the destination...plus the delay from the nth edge of the type selected as the source to the nth edge of
the type selected as the destination for each pair of edges in the gated region is displayed in the Value column.

is the Transition of the Source channel. This is indicated as the first channel selected during the measurement setup.
The delay from the first edge of the type selected for each edge in the gated region is displayed in the Value column.
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Using LA Data Measurements

To use LA data measurements follow these steps:
1. Add a new measurement.
a. To select a measurement, right-click on the signal or group header.
b. Select Add LA Measurement and then select the measurement you want to add.
OR
a. Select the Setup page in the Measurements tab.

b. Click and drag a measurement item from Add Measurements to a signal or group in the data
window.

If a measurement is dropped onto any group, the measurement will be applied to all the signals in
the group.

2. Define gating.
a. Select gating type from the Gate drop-down list on the Setup page.
b. Select Display to analyze the samples in the visible display.
¢. Select Cursors to analyze the samples between Cursor 1 and Cursor 2.
d. Select Full Record to analyze all the samples.
3. Select mode for analysis.
= Select the Accumulate check box to add results to the existing measurement results.
OR

= Clear the Accumulate check box to clear previous results and update with new results.

NOTE. The results are accumulated when you click Run but not when you click Recalc.

4. Analyze the data.

Results and statistics are displayed in the Statistics page. To get new data, click Run. To recalculate
measurements, click Recalc.

Related Topic
Adding Dual Channel Measurements (see page 112)
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Statistic Definitions for Data Measurements

Statistic Definitions for Data Measurements

Statistic Definition

Average The sum of the results calculated in the gated
region divided by the total number calculations. The
measurement is expressed in the same units as the data.

\ = 1 [N l"'!

wX)=X=—|Y X,

Min Minimum of all the results calculated in the gated region.
Min(X)=LowestValueof X

Max Maximum of all the results calculated in the gated region.

Mad X) = HighestValue of X

Standard Deviation

A statistical measure of the spread of results. Itis a measure
of variability expressed in the same units as the data.

StdDev(X) = o, = %\ Z(X ~xT |

-

Population

The number of times the measurement was performed in

Population(X)= N

the gated region.

Note: The samples or data considered for calculating the results for all the above measurements and statistics are bound by
the gated region. Gating options include display, cursors, and full record.

Adding Dual Channel Measurements

To add a dual channel measurement using drag and drop, do the following:

1. Select the Setup page from the Measurements tab.

2. Click and drag a measurement item from the Available Measurements list to the first channel. While
dragging to the first channel there is a tool tip that says on which channel the measurement is to

be dropped.

3. Drop the measurement button on the first channel. The tool tip will change to indicate the first channel
selected and that a second channel needs to be selected.

4. Click the channel header to select the second channel.

Copying Filters

1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.

12
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2. Double click the LA module that contains the filter that you want to copy. The filter list will expand to
show all filters attached to the selected LA module.

3. Select the filter and click the Copy button in the dialog box.
4. Select the LA module to which you want to copy the filter.

5. Click the Paste button.

TIP. Open the Filter Definitions dialog box from the Listing or Waveform window by selecting Filter
Definitions... from the Data menu.

Creating Filters

1. Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.
Logic analyzers with filters attached to them have an expand and collapse button to the left of the name.
2. Select an LA module in the dialog box.

3. Click the New button to attach a new filter to the module.

4. Click the = button to open the Define Filter dialog box to define the filter contents.

TIP. Open the Filter Definitions dialog box from the Listing or Waveform window by selecting Filter
Definitions... from the Data menu.

Opening Filters

Click the Filters button in the LA Setup window to open the Filter Definitions dialog box.
Locate and double-click the LA module that contains the filter that you want to open.

Select the filter.

0w b=

Click the Properties button to view and edit the filter contents in the Define Filter dialog box.

TIP. Open the Filter Definitions dialog box from the Listing or Waveform window by selecting Filter
Definitions... from the Data menu. Alternately, right-click a column label in the Listing window or a
waveform label in the Waveform window to display a right-click menu to access the filters.
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Adding Reference Data to a Listing Window

Adding Reference Data to a Listing Window

Sl A L A

Open a Listing window.

Right-click anywhere inside the Listing window header area or data area and select Add Column.
In the Add Column dialog box, click the Add Data Source button.

Click Browse and search for the appropriate data source.

After the source is added, select it in the Add Column dialog box.

Select the desired columns and then click Add.

Click Close.

If necessary, select the new column in the header and drag the column to the desired location.

TIP. 1o delete a column from the Listing window, select the header and press the Delete key on the keyboard.

Adding an Opcode Mark

Occasionally, you might want to change the way the disassembler interprets a cycle type. Mark Opcodes
synchronizes the disassembler. Install a support package to use this feature.

1
2
3
4.
5
6

In the System window, click the Listing window icon.

From the Edit menu, click Mark Opcode.

The pointer changes to a cross hair pointer.

Move the pointer to the data sample where you want to place an Opcode and click.
The Mark Opcode Dialog Box opens.

Double-click the Opcode type.

TIP. Move the pointer to the desired data sample and click the right mouse button. Select Mark Opcode.

Showing Qualification Gaps in a Listing Window

1.
2.
3.

14

In the System window, click the Listing window icon.
From the Edit menu, click Properties.

From the Properties dialog box, click the Listing Window tab.
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How to Showing Glitches in a Listing Window

4. Select Show Qualification Gaps.
5. Click OK.

Gaps are shown in the display with a horizontal gray line above the first data after the gap.

TIP. Click = 1o open the Properties dialog box.

Showing Glitches in a Listing Window

In the System window, click the Listing window icon.

From the Edit menu, click Properties.

From the Properties dialog box, click the Listing Window tab.
Select Show Glitches.

A o

Select the glitch color.
6. Click OK.

Glitches are shown in the display by highlighting the character in the sample containing the glitch. In
binary data the individual bit containing the glitch is highlighted.

NOTE. Select Samples + Glitches in the Storage Options box of the Setup window before making an
acquisition.

TIP. Click to open the Properties dialog box.

To see the individual glitch bit, change the radix of the column to binary.

Going to a Specific Column

In the System window, click the Listing window icon.
From the Edit menu, click Go To.
Click Column.

Select the column.

U N o

Click Go To.
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TIP. Click % 1o open the Go to dialog box.

Creating Symbol Files

Open any text processor application. For example: WordPad.
Use lines beginning with a number sign (#) to indicate comments.

Enter a Symbol File Header (see page 117). Include the #+ characters at the beginning of the line.

0 P =

Enter symbol names and values.
The following is an example of a simple pattern symbol file.

# Pattern symbol file

# TSF Format Type Display Radix File Radix

# _

#+ Version 2.1.0 PATTERN BIN BIN # Symbol Name Pattern Color
# [ ——

NUL X000 0000 SOH X000 0001 @blue STX X000 0010 @white @red
The following is an example of a simple range symbol file.

# Range symbol file with function symbols

# TSF Format Type Display Radix File Radix Offset
# ——

#+ Version 2.1.0 RANGE HEX HEX 00000000

#+ Function # Symbol Name Low High
#
displayBanner 006035ba 00603675
buiTdMenus 00603676 006036e5
displayLCDmenu 006036e6 0060372f

There are four different types of range symbols. For more information on these range symbols, click
the symbol type you are interested in:

Function Range Symbols (see page 337)
Variable Range Symbols (see page 338)
Source Range Symbols (see page 338)
Color range symbols (see page 347)

When you create range symbols avoid defining symbols where the ranges overlap within a given type,
such as function or variable because overlapping ranges can produce unexpected results.

Color is an effective means for conveying information that allows you to view your data more efficiently
and highlight items of interest. Symbol files provide an easy way to color-code samples in your
acquisitions to help distinguish various features of the data. When you set the group radix to Symbolic
in the data window property sheet and then pick a symbol file with color information in it, the group
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values may be displayed in color in a Listing or Waveform window. The foreground color as well as the
background color of the data can be set by the symbol file.

For a detailed description of symbol file syntax, see TLA Symbol File Format (see page 344).

Related Topic
Symbols Dialog Box (see page 340)

Symbol File Header

Use header lines to help the logic analyzer identify the contents of a symbol file.

Pattern Symbol File Header

The header line of a pattern symbol table has the following form:

#+ <file format version> PATTERN <display radix> <file radix>
The file format version contains three fields:

B Major version number

®  Minor version number

®  Build number (for example, 2.0.0); each field is separated by a period.

The display radix field determines the radix used in the data windows and properties tab controls when
there is no symbol defined for a value (valid values for Pattern files are Hex, Oct, or Bin).

The file radix field specifies the radix used for the symbol values in the file; valid values for pattern files
are Hex, Oct, or Bin.

Range Symbol File Header

The header line of a range symbol table has the following form:

#+ <file format version> RANGE <display radix> <file radix> <offset>
The file format version contains three fields:

®  Major version number

B Minor version number

B Build number (for example, 2.0.0); each field is separated by a period.

The display radix field determines the radix used in the data windows and properties tab controls when
there is no symbol defined for a value (valid values for Pattern files are Hex, Dec, Oct, or Bin).
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Coloring Data

The file radix field specifies the radix used for the symbol values in the file; valid values for pattern
files are Hex, Dec, Oct, or Bin.

The offset is a 32-bit hexadecimal value added to the lower and upper bound of each range symbol read
from the file.

Coloring Data

From the Systems window, click the Listing window icon.
Double-click a column heading to display the Listing Properties dialog box.

Change the radix to symbolic.

Eal o

Click the Symbol File button to load a symbol tab with color symbols.

NOTE. Use this column as a color source for other columns by double-clicking another column in the
Listing window. From the Listing Properties dialog box, click Same As in the Color group box.

Related Topics

Symbol Files (see page 335)
TLA Symbol File Format (see page 344)

Adding a Waveform

18

1. In the System window, click the Waveform window icon.
2. From the Edit menu, click Add Waveform.

3. Select the Data Source. If the data source you want is not listed, click Add Data Source and select
your particular data source.

4. Ifyou are adding a DSO or External Oscilloscope channel, Select the Channel and then click Add. If
you are adding a LA channel, select the Group, the Channel, and then click Add.

:I-I-I:
=

TIP. Click on the waveform toolbar to select a waveform to add.

From the front panel or from the waveform toolbar, click P VEW 15 add external oscilloscope

waveforms to the Waveform window.
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From the front panel or from the waveform toolbar, click = MagniVu ¢, add MagniVu waveforms to the
Waveform window for those main timebase waveforms that are already displayed in the Waveform window.

Changing Waveform Appearance

In the System window, click a Waveform window icon.
Double-click the label of the waveform you want to change.

If not selected, select the waveform you want to change from the Waveform list.

L e

In the dialog box, select the desired waveform Color, Height, Offset, Radix, Readout Options, and
Waveform Measurements, and select whether to Use Polarity and Show the Waveform.

NOTE. Radix and Use Polarity are only available for logic analyzer waveforms. Offset is only available
for logic analyzer, DSO, and external waveforms that are included in a waveform overlay. Waveform
Measurements are only available for DSO and external waveforms.

Related Topics

Selecting the Waveform Color (see page 119)

Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 86)

Determining the Data Source of the Selected Waveform (see page 85)
Controlling Whether a Waveform is Visible (see page 121)

Setting the Overlay Waveform Offset (see page 207)

Setting Up Waveform Measurements (see page 126)

Selecting the Waveform Color

In the System window, click a Waveform window icon.

Double-click the label of the waveform you want to change.

If not selected, select the waveform you want to change from the Waveform list.

From the Color drop down list, select the desired waveform Color.

Alternately, select "Same As" and choose another waveform to use as the color source.

Click OK.

AU S o A

Related Topics
Changing Waveform Appearance (see page 119)
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Displaying Waveform Readouts

Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 86)

Determining the Data Source of the Selected Waveform (see page 85)

Controlling Whether a Waveform is Visible (see page 121)

Displaying Waveform Readouts

I O e

In the System window, click a Waveform window icon.

Double-click the label of the waveform whose options you want to set.
Click Options.

If you want to show readouts, click Show Readouts.

If Show Readouts is checked, set the color of the displayed readouts.

Related Topics

Setting Waveform Options (see page 124)

Setting the Waveform Style (see page 84)

Setting the Waveform Limits (see page 85)

Changing the Waveform Time Scale (Time/Division)

In the System window, click a Waveform window icon to open the window.
If the Waveform Toolbar is not displayed, click Waveform Toolbar from the View menu.

Using the Time/Div control, select the time per division or enter the time/div if the desired value
does not appear in the list.

The center of the screen remains fixed when time per division changes. You cannot display less than
two horizontal divisions.

Changing Waveform Window Properties

120
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In the System window, click a Waveform window icon to open the window.
From the View menu, click Properties.

Select the Waveform Window tab.

In the dialog box, select whether or not to show graticules and violations.

Click Show Compare to enable comparison of data.
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Controlling Whether a Waveform is Visible

6. Use the drop-down list to select the color of glitches, graticules, and background.
7. Select the desired Color Scheme.

8. Select whether or not to snap cursors and marks to transition edges.

TIP. To quickly access the Properties dialog box, right-click in the Waveform window and select Properties.

Related Topics
Making Glitches Visible (see page 122)

Selecting the Glitch Color (see page 121)

Selecting the Graticule Color (see page 123)
Selecting the Background Color (see page 123)

Selecting the Active Data Window Color Scheme (see page 122)

Controlling Whether a Waveform is Visible

1. In the System window, click a Waveform window icon.
Double-click the label of the waveform whose attributes you want to change.
If not selected, select from the Waveform list the waveform you want to change.

Click the Show Waveform check box.

A

Click OK.

Related Topics

Changing Waveform Appearance (see page 119)
Changing the Height of a Waveform (see page 124)

Selecting the Radix of Busform Readouts (see page 86)

Determining the Data Source of the Selected Waveform (see page 85)

Changing the Color of a Waveform (see page 119)

Selecting the Violation Color

1. In the System window, click a Waveform window data icon.
2. Double-click a waveform label.

3. Click the Waveform Window tab.
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Making Violations Visible

4. Click the violation color from the Show Violations color drop-down list.

5. Click OK.

Related Topics
Making Violations Visible (see page 122)

Changing Waveform Window Properties (see page 120)

Making Violations Visible

1. In the System window, click a Waveform window data icon.
Double-click a waveform label.

Click the Waveform Window tab.

Click the Show Violations check box.

A

Click OK.

When the Show Violations box is checked, violations are displayed on all waveforms.

Related Topics
Changing Waveform Window Properties (see page 120)

Selecting the Violation Color (see page 121)

Selecting the Active Data Window Color Scheme

122

In the System window, click a Waveform window icon.
Double-click a waveform label.

Click the Waveform Window tab.
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Related Topics
Selecting the Glitch Color (see page 121)

Selecting the Graticule Color (see page 123)

Selecting the Background Color (see page 123)

Changing Waveform Window Properties (see page 120)

From the Color Scheme drop down list, select the color scheme for the active window.
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Selecting the Background Color

In the System window, click a Waveform window icon.
Double-click a waveform label.

Click the Waveform Window tab.

From the Background drop down list, select the background color.

Click OK.

A o

Related Topics

Selecting the Glitch Color (see page 121)

Selecting the Graticule Color (see page 123)

Changing Waveform Window Properties (see page 120)
Selecting the Active Data Window Color Scheme (see page 122)

Selecting the Graticule Color

In the System window, click a Waveform window icon.
Double-click a waveform label.

Click the Waveform Window tab.

From the Show Graticule color list, select the graticule color.

Click OK.
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Related Topics

Making Graticules Visible (see page 123)
Changing Waveform Window Properties (see page 120)

Making Graticules Visible

1. In the System window, click a Waveform window icon.
2. Double-click a waveform label.

3. Click the Waveform Window tab.

TLA Online Help 123



How to

Changing the Size of a Waveform

4. Click the Show Graticule check box.
5. Click OK.

When the Show Graticule box is checked, graticules are displayed on all waveforms.

Related Topics

Changing Waveform Window Properties (see page 120)
Selecting the Graticule Color (see page 123)

Changing the Size of a Waveform

Move the cursor over the lower part of the waveform label until it changes from a pointer to a resize cursor.
Click the left mouse button and drag to change the size of the waveform.

Alternate Method

1. In the System window, click the Waveform window icon.

To open the waveform Properties dialog box, double-click the label of the waveform you want to resize.
Click the Waveform tab.

Enter the size you want the waveform to be using the Height spin box.

Click OK.

A

This procedure changes the size of the waveform by changing the size of the labeled waveform track. The
size of the waveform is also affected by the vertical input range setting.

Jump Over Time Gaps in the Waveform Window

One way to jump over large time gaps in the Waveform window is to create a Listing window of the same
data as that of the Waveform window, and then lock the two windows together. As you move the cursor
through the Listing window, the cursor in the Waveform window will track and jump over the "dead" or
blank space between samples.

Setting Waveform Options

124

1. In the System window, click a Waveform window icon.
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2. Double-click the label of the waveform whose options you want to set.
3. Click the Options button.

From this dialog box:

m  Set whether to show readouts.

B Set the waveform voltage limits.

B Set the style of logic analyzer waveforms.
Em  Set the readout color.

Related Topics

Setting the Waveform Style (see page 84)
Setting the Waveform Limits (see page 85)
Showing Waveform Readouts (see page 120)

Viewing an LA Waveform in Magnitude Mode

In the Waveform window, right-click on any LA busform label and select Display Magnitude from the
menu.

NOTE. Magnitude mode is only available for LA busforms. Magnitude mode is not available for DSO
or External Oscilloscope waveforms.

Alternate Method

1. In the System window, click the Waveform window icon.
Double-click an LA waveform.

Click Options.

Click Magnitude.

SO S

Click Signed data if you want to interpret the acquisition data as signed data.

NOTE. When you want to interpret the LA waveform as signed data, make sure you select a radix, such as
signed decimal, so that the readouts will display the correct information.

6. If Lock to Setup is not checked, set the maximum and minimum values to display in the waveform.

7. Click OK twice and adjust the time per division to view the waveform.
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Scrolling Between Samples in a Waveform Window

1. In the Waveform window, move the pointer to the center of the window.
2. Right-click the mouse and click either Go To Next Sample or Go To Prior Sample.
The Waveform window will scroll to the next or previous sample.

Use this method of scrolling over gaps in the waveform data where there are no data samples due to
clock or data qualification.

Selecting the DSO Horizontal Settings

For an external oscilloscope:
1. In the System window, click the External Oscilloscope Setup button, and then select the Setup tab.
2. Use the Depth Limit drop-down list to select the Memory Depth.

3. Use the Horizontal menu on the external oscilloscope to select the remaining horizontal settings.

Setting Up Waveform Measurements

1. In the System window, click the Waveform window icon.

2. Double-click the external waveform label for which you want to set up measurements, and then
click the Measurement Setup button.

3. Use the >> button to select up to three measurements from the Available Measurements list.

4. For each measurement type, select a Base-Top Determination method.

5. Select a Reference Level to use for the waveform measurements.

6. From the High-, Low-, and Mid-Reference list boxes, set the desired reference values or click the

Set Defaults button to use the default values.

7. Select the Gating method to use for the waveform measurement and then set the related parameters, if
applicable.

NOTE. Acquire waveform data before selecting the Marks gating method and setting related parameters.

8. Click OK.
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Alternate Method

1. In the System window, click the Waveform window icon.

2. From the Waveform window, right-click the waveform label, and then click Add/Delete DSO
Measurements.

Use the >> button to select up to three measurements from the Available Measurements list.
For each measurement type, select a Base-Top Determination method.

Select a Reference Level to use for the waveform measurements.

AR e

From the High-, Low-, and Mid-Reference list boxes, set the desired reference values or click the
Set Defaults button to use the default values.

7. Select the Gating method to use for the waveform measurement and then set the related parameters, if
applicable.

NOTE. Acquire waveform data before selecting the Marks gating method and setting related parameters.

8. Click OK.

Related Topic

Removing Selected DSO Waveform Measurements (see page 127)

Removing Selected Analog Waveform Measurements

1. In the waveform Properties dialog box, select the waveform containing measurements that you want to
remove and click the Measurement Setup button.

2. Select the waveform measurement that you want to remove from the Selected Measurements list
box and click the Remove button (<<).

3. Click OK.

Related Topic
Selecting DSO Waveform Measurements (see page 126)

Taking Voltage Measurements

1. In the System window, click a waveform icon.

2. Select a waveform.
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Taking Delta Volts Measurements

Move Cursor 1 to the location on the waveform that you want to measure.
Read the voltage from the C1 readout on the Measurement toolbar.

Move Cursor 2 to another location on the waveform that you want to measure.
Read the voltage from the C2 readout on the Measurement toolbar.

Read the voltage difference between the two waveform locations from the Delta readout on the
Measurement toolbar.

Related Topics

Taking Time Measurements (see page 128)

Taking Delta Time Measurements (see page 129)

Taking Delta Volts Measurements (see page 128)

Taking Logic Analyzer Measurements (see page 130)

Taking Delta Volts Measurements

1
2
3.
4
5

In the System window, click a waveform icon.

Select a waveform.

Move Cursor 1 to the first location on the waveform that you want to measure.
Move Cursor 2 to a second location on the waveform that you want to measure.

Read the voltage difference between the two waveform locations from the Delta readout.

For LA Busform, the delta shows a sort of bit-wise difference. The delta is formed by treating C1 and C2
values as bit vectors, and setting a 1-bit in the delta at each position where C1 and C2 differ.

For example, in LA Busform if C1 has a group value of 0x8A and C2 has a group value of 0x0C, the
delta is 0x86 (the difference is 0X7E).

Related Topics

Taking Voltage Measurements (see page 127)

Taking Time Measurements (see page 128)

Taking Delta Time Measurements (see page 129)

Taking Logic Analyzer Measurements (see page 130)

Taking Time Measurements

1.
2.

128

In the System window, click a waveform window icon.

Select a waveform.
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Taking Delta Time Measurements

Move Cursor 1 to the location on the waveform that you want to measure.
Read the time from the C1 readout on the Measurement toolbar.

Move Cursor 2 to another location on the waveform that you want to measure.
Read the time from the C2 readout on the Measurement toolbar.

Read the time difference between the two waveform locations from the Delta readout on the
Measurement toolbar or from the Delta Time toolbar.

Cursor time is relative to the system trigger.

Related Topics

Taking Delta Time Measurements (see page 129)

Taking Voltage Measurements (see page 127)

Taking Delta Volts Measurements (see page 128)

Taking Logic Analyzer Measurements (see page 130)

Taking Delta Time Measurements

To take a single Delta Time measurement do the following:

1.

AN U S o

In the System window, click a waveform window icon.

Click the Add Delta Time toolbar button af if the toolbar is not already displayed.

Select a waveform.

Move Cursor 1 to the location on the waveform where you want the time measurement to start.
Move Cursor 2 to another location on the waveform where you want the time measurement to end.

Read the time difference between the two locations from the Delta Time toolbar.
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Taking Logic Analyzer Measurements

To lock the Delta Time do the following:
1. Click the drop-down list on the Delta Time toolbar button.

2. Select Lock Delta Time. This locks the cursors or marks in the Delta Time toolbar with respect to

delta time.
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Lock Delta time is disabled if either of the following is true:
B The data window is locked

®  You have an unmovable measurement point selected for the delta time calculation such as System
Trigger

The delta time readout is negative when C2 precedes C1.

For an LA Busform, the delta shows a sort of bit-wise difference. The delta is formed by treating C1 and
C2 values as bit vectors, and setting a 1-bit in the delta at each position where C1 and C2 differ.

For example, in LA Busform if C1 has a group value of 0x8A and C2 has a group value of 0x0C, the
delta is 0x86 (the difference is 0X7E).

TIP. Take multiple Delta Time measurements by selecting different measurement points from the Delta
Time toolbar. Alternatively, add Delta Time toolbars to take additional measurements.

Related Topics

Taking Time Measurements (see page 128)

Taking Voltage Measurements (see page 127)

Taking Delta Volts Measurements (see page 128)

Taking Logic Analyzer Measurements (see page 130)

Taking Logic Analyzer Measurements

130

1. In the System window, click a waveform icon.
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Selecting the Trigger Action and Target for an External Oscilloscope

Select a logic analyzer group magnitude, group digital, or digital waveform.

Move Cursor 1 to the location on the waveform that you want to measure.

Read the value of the logic analyzer waveform from the C1 readout on the Measurement toolbar.
Move Cursor 2 to another location on the waveform that you want to measure.

Read the value of the logic analyzer waveform from the C2 readout on the Measurement toolbar.

Read the value of the difference in time between the two waveform locations from the Delta readout
on the Measurement toolbar.

Values for logic analyzer digital waveforms are binary 0 or 1.

Values for logic analyzer group magnitude and group digital waveforms are in the selected radix. The
delta values are blank if you use a symbolic radix.

Related Topics

Taking Time Measurements (see page 128)

Taking Delta Time Measurements (see page 129)

Taking Voltage Measurements (see page 127)

Taking Delta Volts Measurements (see page 128)

Selecting the Trigger Action and Target for an External Oscilloscope

1.
2.

In the System window, click the External Oscilloscope Trigger button.

Select the trigger event:

= Oscilloscope triggers — The external oscilloscope initiates the trigger

- TLA System trigger — The TLA System trigger initiates the oscilloscope trigger
Select the trigger action:

Trigger oscilloscope only

Trigger TLA too

Adding Reference Data to a Waveform Window

1.
2.
3.
4.

In the System window, click the Waveform window icon.
From the Edit menu, click Add Waveform.
From the Add Waveform dialog box, click the Add Data Source button.

Click the Browse button and search for the appropriate source.
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5. After the data source is added, select it in the Add Waveform dialog box.

6. Select the desired waveforms.

-

TIP. Click " to open the Add Waveform dialog box.
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Running Extended Diagnostics

1. You may want to save your system before running diagnostics. Extended diagnostics will invalidate
your acquired data.

Disconnect any probes attached to your instrument.
From the System menu, click Calibration and Diagnostics.
Click the Extended Diagnostics tab from the Calibration and Diagnostics dialog box.

Select the test or set of tests you want to run.
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Click the option button associated with the Run mode you want to use: One Time, Continuous, or
Until Fail.

7. Click Run. If you selected Continuous or Until Fail, click on the Abort or Stop buttons to stop the
process.

If the diagnostics fail, refer to the service manual for the particular product, or contact your local Tektronix
service center.

Related Topics

Extended Diagnostics (see page 331)
Technical Support (see page 1)

Defining Reference Data

Open a Listing or Waveform data window.
Click Define Compare in the TLA toolbar to open the Define Compare dialog box.
Click the Enable Data Compare check box.
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Click the Add Data Source button, then select the reference module from the list or click Browse to
search for a saved LA module.

Click the Add button to add the data source to the Reference Data Source list.
Select a Reference Data Source from the list.
Define the parameters in the Compare Data Region.

Define the parameters for the Data Source Alignment.

I

Click OK.
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Customizing the System Tools menu

134

Customize the Tools sub-menu of the System menu by adding, editing, and deleting menu items. Add
frequently used utilities to the Tools menu and run them from within your TLA. To do this, use the Tools
page in the Options dialog box (accessed from the System menu).

To add a tool to the Tools menu

As an example, the following procedure demonstrates how to add the Windows WordPad accessory to
the Tools menu.

1.

0 » b

6.
7.

From the System menu, click Options and then click the Tools tab.

Click the Add button to bring up the Tool Properties Dialog.

In the Menu Name text box, type WordPad.

In the Command box, browse or type the path and name of the program, for example:
C:\program files\accessories\wordpad.exe

In the Arguments text box, type any arguments to be passed to the program.

In the Initial Directory box, type the file directory where the command is located.

If you want the program to run in a minimized window, check the Run Minimized box.

Once the tool appears on the Tools menu, to run the program, just choose it from the menu or click
on its button in the Toolbar.

Enclose quotes around arguments and commands with embedded spaces in the Tool Properties (App
Options) dialog box for the commands to work.

Related Topics

Editing a Tool on the Tools Menu (see page 71)

Removing a Tool from the Tools Menu (see page 72)
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Adding a Data Source to an Active Waveform Window

In the System window, click a Waveform window icon.
From the Edit menu, click Add Waveform.

From the Data Source list, select a Data Source or click the Add Data Source button if the source is
not listed.

Click the Close button.

TIP. Click "€ 1o open the dialog box.

To quickly add MagniVu waveforms, clic

k <@ MagniVu iy the waveform window. Or press the MagniVu

button on the front panel. Click the button again to remove the MagniVu data from the window.

Opening a Saved Data Window

1.
2
3.
4
5

From the Window menu, click Load Data Window.

Click the Browse button to search for the file, or enter a path to the desired file.
Enter a Window name or use the default.

Once the file is found, click Open.

Click OK.

NOTE. The saved data file must be a saved system file.

Creating an Overlay Waveform

In the System window, click the Waveform window icon.
Click the label of a waveform you want to include in an overlay waveform.

Drag the waveform label to the second waveform that you want included in the overlay waveform. As
you drag the waveform label, a drop marker displays at the left edge of the waveform label. Use this
drop marker to determine which waveform you will be selecting to form a waveform overlay.

In the Add Overlay Waveform Name dialog box, either enter a name and click OK or simply click OK
to use the default overlay waveform name. This name will be prepended to all waveform labels in
the overlay waveform.
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Related Topics

Overlay Waveform (see page 204)

Overlay Waveform Properties (see page 205)
Waveform Properties (see page 90)

Changing Waveform Properties (see page 119)

Locking Windows

In the System window, click a Listing, Waveform, Graph, or Protocol window icon.
From the View menu, select Lock Windows.

From the Lock Windows dialog box, select which windows to lock together.

Click either the No time offsets or Current time offsets option button.

If you select No time offsets, select which window is the reference in the Reference Window list.

AN

Click OK.

Aligning Time of Correlated Data Sources

In the System window, click a Listing or Waveform window icon.
From the Data menu, select Time Alignment.
Perform the following steps for each data source:

Click OK.
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Related Topics

Adding Reference Data to a Listing Window (see page 114)
Adding Reference Data to a Waveform Window (see page 131)

Adding a Mark to a Data Window

From the Edit menu, click Add Mark. The mark appears at the center of the display and has default
properties.

TIP. Use the right mouse button in the data area to add a mark at a particular sample.
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Related Topic
Moving Marks (see page 137)

Moving Marks

1. In the System window, click the appropriate data window icon.

2. Select the mark handle (in the data area mark bar or the overview mark bar) and drag the mark to
the new location.

NOTE. You cannot move begin, end, or trigger marks. If you drag a mark past the boundary of the data
area using a handle in the Data Area Mark bar, the data area scrolls to keep the mark in view. If you drag
a mark off-screen using its handle in the Overview Mark bar, the data area scrolls keeping the mark in
view. The mark in the Data Area Mark bar indicates that the mark is off screen with an arrow, such as

i : ,
5 if you scroll the data window, causing the mark to move off screen.

Related Topics

Sending Stacked Marks to the Back (see page 137)
Adding a Mark to a Data Window (see page 136)

Sending Stacked Marks to the Back

1. Select a mark you know is on top of another one.

2. From the Edit menu, select Send To Back.

TIP. Click the right mouse button on the mark and select Send To Back.

Going to a Specific Mark

1. In the System window, click the appropriate data window icon.
From the Data menu, click Go To.
Click the Mark option button.

Select the mark you want to display.

U

Click the Go To button. The mark appears in the center of the display.
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NOTE. When moving between marks in a Source window, the new mark may cause another source file
to load in the Source window.

TIP. In the data window, click b2 to open the name of the dialog box.

Click the right mouse button on a mark and click Go To.

Related Topic
Adding a Mark to a Data Window (see page 136)

Expand Signals

Expand Signals replaces all busforms in the selection set with their component signal waveforms.

After the operation is finished, the selection set is modified to contain only the added waveforms.

Related Topic
Collapse Signals (see page 138)

Collapse Signals

Collapse Signals replaces all signal waveforms with their container busform waveforms. Exactly one
instance of each busform is added, no matter how many signals are actually present in the selection set.
After the operation is finished, the selection set is modified to contain only the added waveforms.

Related Topic
Expand Signals (see page 138)

Removing Data from a Listing or Waveform Window

1. Go to the data window where you want to remove a column or a waveform.
2. Select the column or waveform labels that correspond with the data you want removed.

3. Press the Delete key on the keyboard.
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NOTE. Some columns or waveforms in the display may not be visible. This is generally true if a
microprocessor support package is in use. To verify that invisible columns or waveforms exist, open the
Properties dialog box and select the Column or Waveform tab. Check whether the Show Column or
Waveform option is selected for each column or waveform.

Removing Waveforms from an Overlay Waveform

1. In the System window, click the Waveform window icon.
2. Click the label of a waveform you want to remove from the overlay waveform.

3. Drag the waveform label to the boundary of the overlay waveform. As you drag the waveform label,
a drop marker displays at the left edge of the waveform label. Use this drop marker to position the
waveform label outside of the overlay waveform.

Alternate Method
1. In the System window, click the Waveform window icon.
2. Double-click the waveform overlay to display the Waveform properties tab.

3. Click the label of a waveform you want to remove from the Overlay Waveforms list, and then use the
<< button to remove it from the overlay waveform.

NOTE. You cannot remove waveforms from an overlay waveform using the Waveform properties tab,
unless they were added using the Waveform properties tab in the current session. If you attempt to do so,
selecting a waveform label from the Overlay Waveforms list prompts the system to disable the << button.

Storage

Overview

Storage refers to storing acquired data in memory. Select storage modes that filter the data, discard
unwanted samples, and store only the data you want.

Storage Qualification

The trigger function block includes storage qualification that looks at sampled data. If the storage
conditions are met, a storage qualifier signal enables sampled data to pass into the acquisition memory as
qualified data. Any unqualified data samples are excluded.
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Storage Options

The Storage Options pane in the Setup window controls storage, using individual storage actions specified
in If/Then clauses and the Storage box in the Trigger window toolbar.

NOTE. On TLA7000 Series logic analyzer modules and TLA5000 Series mainframes, the first transition
state indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). To avoid triggering on a false first
transition indication, set the first state to "If Anything Goto Next State". This will consume a state, but will
ensure that there is no false triggering on the first transition indication.

NOTE. When global storage is set up to use transitional storage, to ensure that a false transition is not
recorded, the first state must be "If Anything Then Next State".

Storage Selection for an LA Module

Use the Storage box to select the default storage (see page 139) rules for the module. The default storage
setting can be overridden by a storage action in a trigger clause definition.

The Storage box is located in the toolbar of the LA Trigger window.

Related Topics

Clause Definition Dialog Box (see page 163)
Data Sample Storage Selections (see page 150)

Storing DSO Data in Memory

140

The acquisition memory works like a circular buffer, storing data samples until the entire memory is full.
After that, each new data sample overwrites the oldest existing sample.

This process continues until the trigger event is found and the post-trigger delay counter reaches the
specified value (based upon the trigger position selection), which stops the acquisition.

During the acquisition, monitor the progress of the data storage process using the Status Monitor.

Displaying DSO Data
After storing the data, display the acquired data in the data windows.
In the Waveform window the data is shown as analog waveforms.

In the Listing window the data is shown as a series of voltage values.
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Waveform Cursors

Overview

Cursors in a waveform data window are vertical lines that mark time points in the data record. The two
cursors are always present, although they may be off-screen. Each cursor has a handle in the Data Area
Mark bar and in the Overview Mark bar.

To Use

To select a cursor or other data mark, click its handle in the Data Area Mark Bar or Overview Mark Bar.
Selecting a mark changes its color. To edit a data mark, select the mark and then use the Edit menu. Select
a cursor or user mark handle and drag the mark to a new location. Drag a cursor past the boundary of the
data area using a handle in the Data Area Mark bar. The data area scrolls to keep the cursor in view. If you
drag a cursor off-screen using its handle in the Overview Mark bar, the data area scrolls to keep the mark
in view. The cursor in the Data Area Mark bar indicates that the cursor is off screen with an arrow, such as

2+ . . .
v if you scroll the data window, causing the cursor to move off screen.

Behavior

When you open a Waveform window, cursor C1 is active. The name of the active cursor is displayed in
bold text in the cursor bar. The active cursor is also displayed as a dashed line. Selecting a cursor handle or
changing the cursor position using the cursor bar readout makes the cursor the active cursor. Changing
the delta time readout changes the position of the inactive cursor.

Cursor time values that fall within an acquisition gap are forced to the closest valid display point. When
you place cursors on both sides of an acquisition gap, the displayed delta value is greater than the time
between the two data points.

If you drag a cursor past the boundary of the data area using a handle in the Data Area Mark bar, the data
area scrolls to keep the cursor in view. If you drag a cursor past the boundary using its handle in the
Overview Mark bar, the data area scrolls to keep the cursor in view. The cursor in the Data Area Mark bar

.- . . 2+ . . .
indicates that the cursor is off screen with an arrow, such as % if you scroll the data window, causing
the cursor to move off screen.

Time per Division

Use the Time/Division dialog box to select the horizontal time per division scaling for the current
Waveform window. The list contains standard time per division values in a 1, 2, 5 sequence. If you enter a
non-standard time per division value in the Custom box, the can be any number between the minimum and
maximum values shown in the list. The default value is the current setting.

Change the time per division from a Waveform window or from the Time/Division dialog box. To access
the Time/Division dialog box from the View menu, click Time/Div.
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Related Topic
Changing the Time per Division (see page 120)
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Trigger Tab Page

Overview

The Trigger tab page allows you to quickly and easily set up a trigger program. Drag and drop trigger
programs directly from the Trigger tab page to a data window.

Behavior

The Trigger tab page is only active when a data window is active. Each data window has a unique
Trigger tab page. After dragging a trigger program to a data window, a trigger expression is displayed
under Trigger Details. The Undo Trigger and Redo Trigger buttons apply only to the current trigger
and the previous trigger. The Undo Trigger and Redo Trigger buttons are not active until you use a
drag and drop trigger setup.

To Use

Click any Trigger program button and drag it to the waveform or listing window. Edit the trigger expression
using the controls on the Trigger tab page. The controls change depending on the trigger expression.

Click the Undo Trigger button to restore the previous trigger setup. Click the Redo Trigger button to
restore the current drag-and-drop trigger setup.

Related Topics

EasyTrigger Programs (see page 183)
Triggering from the Trigger Tab Page (see page 94)

Trigger Window

Overview

The primary function of the Trigger window is for constructing a trigger program (see page 354). Use the
Trigger window to select how and when to store data; and to set the trigger position, which indicates the
percentage of samples that are stored after the trigger occurs.

If you have a TLA7000 Series logic analyzer module or a TLAS5000 Series logic analyzer, use the Trigger
window to defer execution of the trigger state machine until the main memory prefill amount is met. In
addition, set both the MagniVu storage rate and the amount of pretrigger MagniVu data to store.
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Behavior

Before you acquire and display data, set up the LA module using the LA Setup and Trigger windows.
These windows determine what data will be acquired. Each module has its own Setup and Trigger
window, which are set up individually.

Configure the Setup window before the Trigger window, because some of the Setup window settings
affect Trigger window selections.

Trigger programs range from the simple to extremely complex. They are the key to logic analyzer
operation. One method for setting up a trigger program is to load a trigger program from the EasyTrigger
Program list. The trigger list, which is available from the EasyTrigger tab, contains simplified trigger
programs that hide many of the program implementation details, allowing you to focus on acquiring

and displaying data. Either view or alter the trigger program details from the PowerTrigger tab, as
necessary. Once you become familiar with trigger programming, create trigger programs without the help
of predefined triggers from the EasyTrigger program list.

Click the following selections for further information:

® LA Triggers

B Trigger Program Structure for an LA Module

Trigger Window Structure
The Trigger window contains two tabs that summarize the trigger program to varying degrees.

The EasyTrigger tab contains a trigger program list, program controls, and both a description and graphic
example of the selected trigger program. The trigger list is categorized by trigger program function. Once
you have selected the trigger program that best fits your data requirements, click the trigger program to
display the underlying program controls. The program controls are a simplified representation of the
selected trigger program that allows you to select events and set event, timer, and counter values.

The PowerTrigger tab contains both an Overview section and a Trigger Detail section. The Overview
shows the general structure of the trigger program. The Trigger Detail summarizes activity within
individual program states. Click the If/Then button in the Trigger Detail to access the Clause Definition
dialog box, which is where the actual trigger programming takes place.

Specify which trigger tab is displayed when you start the TLA application. From the System menu,
click Options, and then click the Defaults tab. Click the Trigger Window Style field and then select the
desired trigger tab from the list box.

Click the following selections for further information:

® PowerTrigger Overview

® PowerTrigger Detail

B (Clause Definition Dialog Box

®  Storage Selection for an LA Module

B Trigger Position for an LA Module

B MagniVu Trigger Position
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® MagniVu Storage Rate
B Force Main Prefill

To Use
To open the LA Trigger window, go to the System window and click the LA module Trigger icon.

To load a trigger program, click the EasyTrigger tab and then select a trigger program. The system
responds by loading the selected trigger program, replacing the previous window contents with new
program controls, program overview text, and a sample trigger graphic.

Related Topics

Loading an LA with Saved Trigger Settings (see page 75)

LA Setup Window (see page 13)

Adding a State to a Trigger Program (see page 94)

Trigger Programming Tips for an LA Module (see page 151)

System Trigger and Reference System Trigger Relationship (see page 165)

LA Triggers

Overview

The trigger identifies when to stop acquiring data. The trigger also identifies the data of interest. The
trigger position determines how much data to store before and after the event of interest. Triggers also
provide the main reference points in the acquired data. There are two types of triggers: system and module.

System Trigger (Trigger All)

The system trigger is an overriding command to all modules that causes them to stop looking for a trigger,
and to acquire their post-trigger data, regardless of whether they have been armed or have fulfilled their
own trigger conditions.

The system trigger is the primary reference point for the entire data acquisition. In data windows,
timing and location information is relative to the system trigger. The system trigger is identified in the
data windows by the large T mark, iy 3

Module Trigger (Trigger)

The module trigger is local to a module. When a trigger occurs, the module continues to acquire data until
the specified amount of post-trigger data is acquired, and then stops. Module triggers are identified in the
data windows by the small T mark, [=P.
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Related Topic
System Trigger Placement (see page 147)

System Trigger

146

Overview

The system trigger is a global trigger event that forces all untriggered modules or instruments to arm
immediately and trigger. Only one system trigger occurs per acquisition. When displaying data, the logic
analyzer uses the system trigger as the primary reference point for the acquisition. The data windows show
the system trigger and all module or instrument triggers. Module or instrument triggers can be forced by
the system trigger or specified by trigger programs.

The system trigger can be generated from any of several sources. Often, the system trigger is specified in a
trigger program. Any module or instrument can specify the system trigger as a trigger action (Trigger All
Modules). However, modules or instruments can also specify trigger actions other than system triggers,
and the system trigger does not have to originate from a module or instrument. The logic analyzer

can also accept a system trigger generated by an external source. External system triggers are input
through the SYSTEM TRIG IN connector. Regardless of the source of the system trigger, all modules

or instruments must respond.

Use the System Trigger dialog box to specify triggering for the overall system.

System Trigger Source

The following options allow you to change the trigger programs of all modules from one location. A brief
functional description follows each System Trigger Source option.

B Modules trigger independently - Trigger All Modules and Wait for System Trigger actions in all
trigger programs are changed to Trigger actions.

B Systems triggered by this module - The trigger program of the selected module uses the Trigger All
Modules action, while all other programs will wait for the system trigger. Use the associated list
box to select which module triggers the system.

m  System triggered by the first module that triggers - Trigger actions in all programs are changed to
Trigger All Modules. If the system has an external oscilloscope, it is set up to wait for the system
trigger.

m  Modules trigger using the current custom setup - Enabled by default when your trigger setups do not
match one of the previous system trigger options.

NOTE. When you apply a system trigger option, your choice will only affect those modules that currently
have a trigger action. Logic analyzer trigger actions include Trigger, Trigger All Modules, and Wait for

System Trigger. DSO and external oscilloscope modules are always affected because all of their actions

result in triggering the module.
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System Trigger In/Out Connectors

System Trigger In/Out Connector check boxes reflect the current state of the System Trigger In and System
Trigger Out connectors, and can be used to both enable and disable them.

If an external scope is enabled, the options chosen in System Trigger Source can affect the values and
sensitivity of the System Trigger In/Out check boxes.

Designated System Trigger

It is not uncommon to have a condition in which the acquisition completed, but an explicit system trigger
did not occur. (This means that there was neither an external system trigger, nor a system trigger generated
internally by a module trigger program.) To ensure that a time reference exists for the acquisition, the
logic analyzer must designate a system trigger. If no system trigger is generated during an acquisition
(the modules are internally triggered), the logic analyzer designates the latest-occurring module trigger

as the system trigger.

NOTE. If an acquisition does not complete because one or more modules did not receive a trigger or did
not complete the post-trigger acquisition, then manually stop the acquisition by clicking the Stop button.
Clicking the Stop button effectively generates a system trigger and completes the acquisition.

Internal and External System Triggers

The system trigger is a latched event and it resets to a false state between acquisitions. The external
system trigger input uses real-time gating and is only active (capable of latching system triggers) during
the actual acquisition period.

The logic analyzer can also send an internally-generated system trigger out to the target system or to other
test equipment through the SYSTEM TRIG OUT connector. All the external signal inputs and outputs
operate at TTL levels. The connectors are located at the rear of the portable mainframe and at the front
of the benchtop mainframe.

Related Topics

Setting the System Trigger Source (see page 148)
Signal Properties (see page 367)
External Signal Selection (see page 359)

System Trigger Placement

Overview

There is only one system trigger. Because the system trigger is the primary reference point for an
acquisition, all acquisitions must have a system trigger identified, even if you did not specifically include
one in your trigger program.
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Behavior

It is not always obvious how the logic analyzer places the system trigger. The logic analyzer determines
the system trigger by one of the following:

B A system trigger occurs when the Stop button is clicked.
B Data windows usually have at most one system trigger plus one module trigger per module.

B [fa module initiates the Trigger All Modules action, then the system trigger is also the module trigger
for that module.

B [f only module triggers are generated, then the latest occurring module trigger is designated the
system trigger.

Related Topic

System Trigger and Reference System Trigger Relationship (see page 165)

Setting the System Trigger Source

148

1. From the TLA System toolbar, click the Bl button. The system responds by displaying the System
Trigger dialog box.

2. Select a trigger option from the System Trigger Source group box.

3. Ifyou chose to trigger the system from one module in the previous step, use the associated list box to
specify which module is used to trigger the system.

4. If you have an external oscilloscope, the System Trigger In/Out Connector check boxes are disabled
and automatically set by the system, based on the system trigger source option that you choose.
Otherwise, optionally disable these connectors if they are not in use.

NOTE. To save these settings as part of your system setup, perform a Save System (see page 80) operation.
This step enables you to reload your saved system settings in a later session.

Related Topic

System Trigger (see page 146)
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PowerTrigger Overview

!, :w Overview
_ : The Overview portion of the PowerTrigger tab primarily
I e shows how the trigger program flows from one state to
i the next. The arrow leading to State 1 is marked Run if
S the module is not armed by another module. The arrow

is marked Armed By <name of module> if this module is

armed by another module.
Behavior

State 2 Arrows indicate the transfer of trigger program control
between states. Markers indicate system-level actions that
could occur if a clause in that state goes true. Use the
Clate 2 trigger overview to check that states are connected. With
the exception of State 1, all states must have an arrow

leading to them (indicating activation by another state), or
they will not execute.

These actions are all defined in the Clause Definition dialog box(es) for each state.

TIP. Double-click the State icon in the Overview to open the top-most clause definition for that state.

PowerTrigger Detail

Overview

The PowerTrigger tab shows a summary of clause settings within the states. To open the Clause Definition
dialog box, click the If/Then button. The following dialog box displays:

State 2 |Trigger an the wery first tranzition |

Channel 43[7] Goez High
Then| GoTao3

To Use

Enter comments in the text box. This feature is controlled by the View menu State Comments selection.

NOTE. There is a clause summary for each clause defined.
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TIP. For lengthy trigger programs, click the State icon in the Overview to jump to the corresponding
PowerTrigger properties.

Related Topics

PowerTrigger Overview (see page 149)
Clause Definition Dialog Box (see page 163)

Data Sample Storage Selections

Data sample storage is selected in the LA Trigger window by using the Storage box in the toolbar. The
following selections are available for PowerTrigger data sample storage.

= All. Store all samples.

Exclude a sample from being stored by selecting the Don’t Store action in the Then statement of the
trigger clause. The trigger sample is always stored.

B None. Do not store samples.

Explicitly store a sample by selecting the Store Sample action in the Then statement of the trigger clause.
The following selections generate a special storage clause:

B Transitional. Store samples only if one of the specified groups changes state.

To select the groups, click Change Detect in the Trigger Detail.

NOTE. On TLA7000 Series logic analyzer modules and TLA5000 Series mainframes, the first transition
state indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). To avoid triggering on a false first
transition indication, set the first state to "If Anything Goto Next State". This will consume a state, but will
ensure that there is no false triggering on the first transition indication.

B Conditional. Store samples only if the storage clause is true.
Program this clause in the same way as a regular trigger clause.

B Start/Stop. Storage is controlled by the Start Storing and Stop Storing trigger actions in the Then
statement of the trigger clause.

Use the Start Storage/Stop Storage button in the Trigger Detail to select whether storage is initially
enabled. For example, if the button is set to Stop Storage, then the initial state is that no samples are
stored; storage will begin when the trigger action Start Storing occurs.
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Trigger Position for an LA Module

Overview

The Trigger Position selects the amount of pretrigger data to store and determines the position of the
trigger in the data record.

Behavior

Once triggered, a module continues to acquire data until it fills a specified amount of memory. The total
memory depth that the module fills is set in the Memory Depth field in the Setup window. The Trigger
Position field determines the proportion of data that is stored before and after the trigger. For example, if
the Trigger Position is set to 10% and the module triggers, then the module continues to acquire data until
the remaining 90% of memory is filled.

NOTE. Under some conditions, the module cannot meet the pre-trigger data storage requirements. For
example, if a trigger occurs immediately, the module cannot meet the pretrigger data storage requirement
unless it was set to 0%.

To Use

Set the Trigger position for a LA module in the toolbar of the LA Trigger window using the Trigger
Pos control.

Related Topics

LA Triggers (see page 145)
System Trigger Placement (see page 147)

Trigger Programming Tips for an LA Module

m  Use the EasyTrigger program list
When you create a trigger, start with the trigger program that is closest to your requirements and modify it.
B Create your own trigger program folder

Create a folder and save modules that have your own most-used trigger programs. Use the Comment box
to help you identify the trigger program later. To access previously saved trigger programs, click the Kl
button from the trigger toolbar, which displays the Load Trigger dialog box. Then click the Browse
button and navigate to your trigger program folder.

B Check the Overview
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After you create a trigger program, review the Overview pane on the PowerTrigger tab to ensure that all
states in the program are linked and that state actions, such as program triggers and arming signals, are
correctly placed.

®  Start and stop timers

Remember to explicitly start and stop PowerTrigger timers. They do not start and stop automatically.
= Use the Status Monitor to debug trigger programs

The status monitor displays the activity within each state.

m  Trigger state references

Do not delete PowerTrigger states to which you reference Go To State actions unless you change the
reference to another appropriate state or delete the Go To action.

m  Use event text that is always true

A PowerTrigger clause with an Anything event or another event that is always true, such as Group xyz
= XXXX, prevents any subsequent clauses from being evaluated. Such clauses should be considered as
default clauses; place them after all other clauses for a given state.

m  Use range recognizers

When using range recognizers, the individual probe channels must be in hardware order; otherwise the
trigger program can cause unexpected results. Range recognizers will only be allowed to encompass
signals on the first three modules of a merged set.

= Use of complex trigger events

If you are unsure that a complex trigger event will occur, you should first use a broadly defined trigger
condition and then subsequently add events to narrow the search. If your trigger program is too narrowly
defined or over specified, the trigger program may not acquire the desire data or may never trigger.

®  Use of counters when using asynchronous sampling at fastest sampling rate

For TLA7000 Series logic analyzer modules and TLAS000B Series logic analyzers, when using
asynchronous sampling and running at the fastest rate, a 2 ns delay is required to allow the counter event to
propagate through the system before the trigger state machine can respond.

Related Topic
Range Recognizers and Hardware Order (see page 152)

Range Recognizers and Hardware Order

152

When using range recognizers, the groups and signals must be in hardware order.

Groups must be used from the most-significant probe group to the least-significant group based on the
following order:

C3C2C1COE3E2E1E0A3A2D3D2A1 A0D1D0Q3Q2Q1Q0CK3 CK2 CK1 CKO
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Signals must be from the most-significant channel to the least-significant channel based on the following
order:

76543210

The above example assumes a 136-channel LA module. The missing channels in LA modules with
fewer than 136 channels are ignored. With merged modules, range recognition extends across the first
three modules; the master module contains the most-significant groups, while slave2 contains the
least-significant groups.

Related Topic
Signed Decimal Values (see page 153)

Signed Decimal Values

Signed Decimal Values can create confusing interpretations, especially when the listing display uses
signed decimal values.

The following is an example of a problem that can be caused when using signed decimal values in the
listing display in an If/Then statement:

If Group A3 < -128
Then Trigger

A3 is an 8-bit group, so it should never trigger since -128 is the smallest signed value possible; however,
-128 is also 80 Hex, so many values will cause the logic analyzer to trigger, all of which will appear as
larger values when displayed in the listing with a signed decimal radix.

In this example there is no way to program the range recognizer hardware to behave correctly and not
trigger.

Module Arming Using an LA

Overview
Using the arm feature, use one module to control when another module begins acquisition.

When module A arms module B, this means that module B does not begin looking for a trigger until it
receives an arm signal from module A.

Behavior

Arming is done through PowerTrigger actions specified in the Clause Definition dialog box. A module can
arm any other module, and set up an arming relationship between more than one set of modules. But only
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one module can arm another. The same arming action can, however, appear multiple times within the
same trigger program.

Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules and
set signals.

For TLA7000 Series logic analyzer modules and TLAS5000 Series logic analyzers, the trigger state
machine is disabled when arming a module but this does not restrict data storage. For TLA700 Series
logic analyzer modules, the trigger state machine is disabled when arming a module and does not store
data until the module is armed. The current setting of the Storage list box, located in the Trigger window,
determines whether data is stored.

Related Topics

Signals Properties (see page 367) (External signals)
Clause Definition Dialog Box (see page 163)

Internal Signaling

154

Overview

Internal signaling is for users with special trigger programming requirements. Internal signaling adds
flexibility to trigger programming, but also adds complexity. When using internal signaling take care that
the signals are correctly set and cleared, and that the trigger programs for all modules are compatible with
regard to signal usage. Also, set the correct internal signal attributes in the Signals tab.

Behavior

All LA modules can set and clear any of the four internal system signals. The DSO can monitor and set but
not clear any signal. The logical output of these signals can be used as an event in other modules’ trigger

programs. Connect the internal signals to the External Signal In and External Signal Out connectors on the
mainframe to use an external signal as a trigger event or to send a signal out when a trigger condition is met.

Internal Signaling (see page 155) is done through PowerTrigger actions specified in the Clause Definition
dialog box.

NOTE. Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules
and set signals.

Related Topics

Signals Properties (see page 367)
Clause Definition Dialog Box (see page 163)
Trigger Action Signal Restrictions (see page 155)
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Internal Signal Selection

Signals 1 and 2 are high-speed, ECL-rate signals, and are usually the preferred choice for both
internal and external signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and
2, but operate at the slower TTL rate.

Signals 1 and 2. 162 MHz maximum (internal), 62.5 MHz maximum (at External Signal Out
connector)

Signals 3 and 4. 12.5 MHz maximum

Trigger Action Signal Restrictions

There are some differences between modules in how they handle triggers, arming and internal signals.

LA modules, DSO modules, and external oscilloscopes have different numbers of signal inputs and
outputs. As a result, their signaling capabilities are different.

Conceptually, a module has three inputs and three outputs, as shown:

Inpuls Oulpul=

System Tngger System Tngger
Arm Module Arm
Signal Signal

In reality, the LA module has three inputs and two outputs, designated as shown:

Inpuls Oulpul=
System Tngger System Tngger
LA
Arm Module
Signal Signal
Arm

The DSO module has two inputs and a single output, as shown:
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Input=s Quipuls

System Tngger

DSO _
Arm Module | System Tnoger
Signal
Arm

The External Oscilloscope has one input and either zero or one output, as shown:

Inputs Outpuls
System Tngger Sy=stem Togger
External
Oscillo-
scope

This shows why Arming and Signaling are mutually exclusive on both the LA and DSO modules, and why
a DSO module does not allow you to set a system trigger and an internal signal at the same time.

Related Topics

Internal Signal Selection (see page 360)
Module Arming Using an LA Module (see page 153)
Signals Properties (see page 367)

Change Detect Dialog Box

156

Use this dialog box to select the groups that will detect a change in state for Transitional storage. Once
a change is detected in any of the selected groups, storage begins.

To open this dialog box, perform the following:

1. In the System window, click the Trigger button for the module.

2. Click the PowerTrigger tab.

3. Select Transitional in the Storage box, which is located in the toolbar.
4

Click the Change Detect button.
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TIP. To detect a change on a single channel, define a signal in the Setup window as a group.

On TLA7000 Series logic analyzer modules and TLA5000B Series mainframes, the first transition state
indication is always false. On TLA700 Series logic analyzer modules, the first transition state always
shows a transition indication (even if there are no probes plugged in). To avoid triggering on a false first
transition indication, set the first state to "If Anything Goto Next State". This will consume a state, but will
ensure that there is no false triggering on the first transition indication.

You cannot use transitional storage if your PowerTrigger program is set up with Group Changes or
Channel Goes events.

When global storage is set up to use transitional storage, to ensure that a false transition is not recorded, the
first state must be "If Anything Then Next State".

Select Signal Dialog Box

Use the Select Signal dialog box to select a specific logic analyzer channel. Use the following options,
available from the Select group box, to specify how the system displays signals in the dialog box.

By Group - displays signal organized by groups. Only groups that are defined in the Setup window can be
displayed using this option.

By Probe - displays signals that are alphanumerically organized by individual channels. All signals are
displayed when this option is selected, regardless of whether they are defined in the Setup window.

By Name - displays signals by the name assigned to them from the Setup window. Enter names for each
signal for names to display when using this selection option.

Related Topics

Selecting Channels for an LA trigger Channel Event (see page 96).
Routing a Signal from a Logic Analyzer Output (see page 68)

Transition Definition Dialog Box

Use this dialog box to define transition events used in the Clause Definition dialog box. Each transition
event displays values for valid groups defined in the Setup window. The value of each group is compared
against live data.

Disable the group in each transition event by removing the check mark adjacent to the group name; this
causes the transition event to ignore the data for the group. Disable or enable all groups by clicking either
the Clear All or Select All button. This either removes or adds check marks adjacent to each group
name. Rename the current transition event by clicking the Rename button and entering a new transition
name in the Rename group box.
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Change the group radix (see page 166) for each group by selecting the desired radix at the bottom of the
dialog box.

Conflicts are possible when groups share signals. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition.

The Trigger Conflict dialog box displays when a trigger conflict occurs, allowing you to select a trigger
replacement option to resolve the conflict.

Value settings closer to the top of the list override later settings.

To Use

Each transition event is identified by a unique name.

To open the Transition Definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button or the clause you are interested in defining.
4

Click Transition from the drop-down list available from the If section of the Clause Definition
dialog box.

5. Click the Define Transition button in the If section of the Clause Definition dialog box to display
the Transition Definition dialog box.

Related Topics

Add Transition Dialog Box (see page 158)
Defining Multiple Transition Recognizers (see page 95)

Add Transition Dialog Box

158

The Add Transition dialog box supplies words that are defined in the Transition Definition dialog box, and
are available for defining PowerTrigger Clause Definition If statements.

To Use

Use this dialog box to add a new transition event. Click Use Existing Transition as Template to copy the
settings from an existing word event.

To display the Add Transition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

2. Click the PowerTrigger tab.

3. Click either the If/Then or the Else If/Then button for the clause you are interested in defining.
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4. Click Transition from the drop-down list available from the If section of the Clause Definition
dialog box.

5. Click the Define Transition button in the If section of the Clause Definition dialog box to display
the Transition Definition dialog box.

6. Click the Add button to add a new transition event.

Related Topics

Defining Multiple Transition Recognizers (see page 95)
Transition Definition Dialog Box (see page 157)

Word Definition Dialog Box

Use this dialog box to define word events used in the Clause Definition dialog box. Each word event
displays values for valid groups defined in the Setup window.

The value of each group is compared against live data. Disable the group in each word event by removing
the check mark adjacent to the group name; this causes the word event to ignore the data for the group.
Disable or enable all groups by clicking either the Clear All or Select All button. This either removes or
adds check marks adjacent to each group name.

Change the group radix (see page 166) for each group by selecting the desired radix at the bottom of the
dialog box.

Each word event is identified by a unique name.

To Use

To open the Word Definition dialog box, perform the following:

1. From the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click either the If/Then or the Else If/Then button for the clause you are interested in defining.

Click Word from the drop-down list available from the If section of the Clause Definition dialog box.

L S

Click the Define Word button in the If section of the Clause Definition dialog box to display the
Word Definition dialog box.

Conflicts are possible when groups share signals. Conflicts are noted in the boxes. Conflicts do not
prevent acquisition.

The Trigger Conflict dialog box displays when a trigger conflict occurs, allowing you to select a trigger
replacement option to resolve the conflict.

Value settings closer to the top of the list override later settings.
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The Word Definition dialog box is also available from the EasyTrigger tab, depending on the program that
you select.

Add Word Dialog Box

Overview

Use this dialog box to add a new word event. Click Use Existing Word as Template to copy the settings
from an existing word event.

Behavior

The Add Word dialog box supplies words that are defined in the Word Definition dialog box, and are
available for defining PowerTrigger Clause Definition If statements.

To Use

To open the Add Word dialog box, perform the following:

1.

A S

From the System window, click the LA Trigger button.

Click the PowerTrigger tab.

Click either the If/Then or the Else If/Then button for the clause you are interested in defining.

Click Word from the drop-down list available from the If section of the Clause Definition dialog box.

Click the Define Word button in the If section of the Clause Definition dialog box to display the
Word Definition dialog box.

Click the Add button to add a new word event.

NOTE. The Add Word dialog box is also available from the EasyTrigger tab, depending on the program
that you select.

Detecting Violations

One of the logic analyzer’s most useful features is its ability to detect and trigger on both signal glitches
and setup and hold violations.

160
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Glitches

A glitch is a signal that makes a transition through the threshold voltage two or more times between
successive acquisition samples. Because glitches are often signal transitions that occur intermittently, they
can cause circuit malfunctions that are extremely difficult to diagnose.

Although you could try using a very fast sample rate to ensure that you never miss any glitches, a better
solution is to use the glitch-detection feature. The logic analyzer can trigger on a glitch, either alone or in
combination with other signal events. This capability is useful for catching intermittent glitches that might
not occur very often or appear only when a particular operation is taking place.

Capture noise spikes and pulse ringing using the glitch capture feature. The following figure shows data
captured by triggering on a glitch. In the Waveform window, a glitch captured by the logic analyzer is
indicated by a band of color.

Glitch mode affects the storage of glitches in memory, which allows you to display the glitches in the data
window. Selecting Glitch mode reduces the available memory depth by half.

Glitch storage is independent of glitch events. Therefore, trigger on a glitch even when you are not
storing glitches.

Clock[0] Ci: 0 CZ 0 Delta: O

LA 1: Sample

LA 1: Clock[0)

LA 7 Inputd]

LA T Output{0]

A1 Magnidu: Sample

LA 1: Magniviu: C
LA 1: Magniviu: D
LA 7 Magniviu: [

Setup and Hold Violations

A setup and hold violation is a data signal that transitions within the setup and hold time period. You could
identify setup and hold violations by looking at each clock edge and reviewing all relevant data signals.
However, it is faster and reliable to use Setup/Hold triggering to identify violations.

First select the correct sampling mode to use either the glitch detection or the setup and hold violation
features. Choose asynchronous sampling to use glitch detection; choose synchronous sampling or custom
sampling to use setup and hold detection.
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63-Sample Blocks Mode Details

162

Overview

The 63-Sample Blocks mode provides the ability to acquire data before and after desired points and to
limit acquired data to a minimum, enabling you to analyze a very long time window. Circumstances under
which Blocks mode is useful include the following:

B Troubleshooting interrupt or subroutine calls and returns
B Troubleshooting DMA data transfers

B Troubleshooting certain types of hardware timing problems when using asynchronous sampling

Behavior

From the Setup menu, the Acquire mode can be set to Samples, Samples + Glitches, Samples + Violations,
or 63-Sample Blocks. In Samples mode, only the samples selected by the trigger actions and qualifications
are sorted. In 63-Sample Blocks mode, you store 31 samples before and after the target sample, or a block
of 63 samples centered on the point where the sample is normally stored.

The ability to use blocks acquisition with either state (synchronous sampling) or timing (asynchronous
sampling) allows you to use this feature for both software and hardware timing analysis.

B [n 63-Sample Blocks mode only signal data is stored.
m  [f you store blocks, they will override other forms of data qualification.
B All samples in the block are always stored if post-fill has not matched any of its limits.

®  You cannot change block size; it is fixed in the hardware.

63-Sample Blocks Mode Example

The following example troubleshoots the stack operation on a microprocessor system during the start of an
interrupt routine that is repeatedly called, such as a video vertical retrace interrupt. In this example, the
group name used for data is DATA. The signal names used for an interrupt and an instruction fetch strobe
are INTR and IFETCH, respectively.

This example checks the stack push operation by storing the start and end of every interrupt routine until
the analyzer memory is filled. You first set the storage control to None (do not save anything unless
explicitly stored in trigger states) and specify the trigger state machine as follows:

STATE 1: IF channel INTR goes low, THEN goto state 2.
STATE 2: IF group DATA = A333 AND channel IFETCH = 1, THEN store sample AND goto state 3.
STATE 3: IF group DATA = 0551 AND channel IFETCH = 1, THEN store sample AND goto state 1.

This trigger setup stores one sample at the instruction (A333) starting the interrupt service routine, and one
sample at the instruction (0551) ending the routine.
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Since no trigger was set up in the example, set the trigger position to 100% and enable the status screen.
This will cause the memory to fill while waiting for a (never occurring) trigger. Then, after the memory is
full (state screen shows 0 remaining), you press the RUN/STOP button to force a manual trigger at the end
of memory. If MagniVu is displayed, the 1 us display is centered at the end of the regular data display.

In the Samples acquisition mode, only these instructions (A333 and 0551) are stored until memory is filled.
Unfortunately, this prevents you from seeing what happened in the stack push and pop at the start and end
of the routine. In the 63-Sample Blocks mode, because 31 samples before and 31 samples after each target
sample is stored, you can see the stack push and first few instructions at the start of the interrupt service
routine and the last few instructions and stack pop at the end of the routine.

Define Glitch Detection

Use this to select which groups should have glitch detection in the clause definition associated with a trigger
program. Once a glitch is detected in any of the selected groups, the glitch event condition has occurred.

Use synchronous sampling for the Glitch condition to appear in the If condition list. Otherwise, the
Samples + Violation option must be used.

For information on how to open the Glitch Detect dialog box, see Triggering a LA Module on a Glitch

(see page 97).

TIP. To detect a glitch on a single channel, define a signal in the Setup window as a group.

Clause Definition Dialog Box

Overview

Use this dialog box to define the If/Then clause (or Else If/Then) of your PowerTrigger program. The
clause definition contains the most vital part of the trigger state. (The trigger state is shown in the
Overview pane of the LA PowerTrigger tab). It is in this dialog box that you define the condition for an
event to occur before an action can take place. Use up to 16 clauses per state, depending on the number
and types of events monitored within a state.

The dialog box is divided into two parts, If and Then.

If

Use the first part to select the events you are interested in and the condition those events must meet
before any actions can take place.

For example, you may be interested in an address group reaching a certain value. The group is the event
and the value is the condition. After the condition occurs, the program executes the actions specified in
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the Then part of the dialog box. For information on trigger events refer to LA trigger Event Table (see
page 166).

Then

Use the Then part of the clause to define the action that occurs after the If part is true. For example, after
the If condition is met, the action you might want is to trigger the module or trigger all modules. Some
actions interact with others and some actions can only be used under certain conditions. For information
on actions refer to LA Trigger Action Table (see page 168). Up to eight simultaneous actions can be
specified for a clause.

To open Clause Definition dialog box from the System window, click the LA Trigger button. Then click
the If/Then button or the Else If/Then button, located on the LA PowerTrigger tab.

Keep the following in mind when using this dialog box:

m  Samples + Violations appear with synchronous or custom sampling. Samples + Glitches only appear
with asynchronous sampling.

m  Events can be ANDed or ORed with each other. To add another event, click Add while an event is
selected. Click the first And button to change to the Or expression. You can have up to eight events.

B Use an Anything or Nothing event as a placeholder. Anything is used when the events are combined
with And. Change the And to Or and the event changes to Nothing.

B When using events you should be aware of the number of event resources available for a trigger
program. For more information, refer to LA Trigger Resources (see page 169).

Related Topics

Storage Definition Dialog Box (see page 93)
Signed Decimal Values (see page 153)

Define Snapshot Dialog Box

164

Overview

TLA7000 Series logic analyzer modules and TLAS5000 Series logic analyzers support the use of a snapshot
to capture a given data sample and compare it with data that the trigger state machine subsequently
processes. Based on criteria that you specify, the result of the snapshot comparison can cause a predefined
event to occur. Set up the snapshot using the Define Snapshot dialog box, which allows groups to be
included or excluded from the snapshot definition. By default, all groups are included.

Behavior

Exclude a given group by clearing the check mark adjacent to the group name. In addition, exclude all
groups by clicking the Clear All button, which removes check marks adjacent to all group names.
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Four types of events operate on the snapshot. At any given time, only one of these events is true:

B Snapshot equals the current sample - A snapshot has been previously loaded and it matches the current
data sample from the target system.

B Snapshot does not equal the current sample - A snapshot has been previously loaded and it does not
match the current data sample from the target system.

B Snapshot is not loaded - A snapshot has not been loaded or is still in the process of being loaded.

= Snapshot is loaded - A snapshot has been loaded and is ready to compare acquisition data.

NOTE. Use of a snapshot event requires both an additional dedicated word recognizer and a timer. If
either resource is unavailable, a warning message displays and the event type reverts to its previous value.

Related Topics

Triggering an LA Module on a Snapshot Event (see page 100)
Trigger Program Structure for an LA Module (see page 181)

System Trigger and Reference System Trigger Relationship

Overview

The system trigger is the primary reference point for the entire data acquisition. In data windows, timing
and location information is relative to the system trigger. There is only one system trigger per acquisition.

Behavior

If you add reference data to your data window, add the system trigger for this reference data. In this case
you have two system triggers in the display: The active system trigger and the reference system trigger.

The active system trigger is identified by a large yellow T mark: AP The reference system trigger is
shown as a gray T mark fFk.

You may not be able to see the reference system trigger in some data windows. For example, you create
a reference system (Save System) that contains two LA modules, A and B. The time domain of both
modules’ acquired data do not overlap, and the system trigger is within module B’s time domain.

A data window created from module A will not contain a reference system trigger. If you open the Go

To dialog box, a reference system trigger will not be listed. However, because timing and location
information are relative to the system trigger, the Timestamp column of module A will be referenced to the
system trigger in module B.
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Group Radix

Use the group radix to display data in the LA Trigger window and in the Clause Definition dialog box in an
easy-to-read format. The following table lists common radixes used to view data.

Radix Valid characters
Binary 0,1, X

Octal 0-7,8, X
Decimal 09, %

Signed decimal 09,- 9%
Hexadecimal 0-9, A-F, $, X
Symbolic Symbol name
Behavior

A Symbol name refers to a set of characters defined in a symbol file.

The X and $ characters normally appear in the Trigger window. An X represents any character, often
known as a "don’t care" character.

The X can represent a binary, octal, or hexadecimal value depending on the radix selection. The $ character
appears when you select a radix where the binary combination contains one or more X characters. The
following example shows how a binary combination with an X character displays in different radixes.

Radix Display Value when X=0 Value when X=1
Binary 10101X11 10101011 10101111

Octal 25% 253 257
Hexadecimal A$ AB AF

Decimal $$$ 171 175

Signed decimal $999 -85 -81

Tip

To identify the contents of a $ character in the Trigger window, change the group radix to binary.

LA Trigger Event Table

The following LA trigger events are available in the If section of the PowerTrigger Clause Definition
dialog box.
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Event Description Interactions

Word Tests the groups for the word values Uses one trigger resource across all
defined in the Word Definition Dialog defined groups.

Box (see page 159).

Group Tests a specified group for a specific Only one change detection event
value, a range of values, or a value (group or signal) is available in a
change. trigger program. Range recognizers

use three trigger resources per
group event. Word recognizers or
change detectors use only one trigger
resource.

Channel Tests the specified signal for a value Only one change detection event
or a value change. (group or signal) is available in a

trigger program. Each event uses one
trigger resource.

Snapshot Compares the current acquisition Only one snapshot recognizer event
sample with a previously loaded is available in a trigger program. Uses
sample in the snapshot recognizer. two event lines and one timer.

Transition Tests the specified group for the Cannot use the following within the
transition values defined in the same trigger clause: Group Changes,
Transition Definition Dialog Box (see Unchanged Group, Signal Goes,
page 157). Signal Doesn 't Go, and Transitional

Storage capabilities.

Glitch Detects glitches in groups. You must Only available with asynchronous
define the groups in which to detect sampling. Uses one trigger resource.
the glitch (see page 163).

S & H fault Tests setup and hold parameters as Only available as an event with

defined in the Setup & Hold violation
dialog box.

synchronous or custom sampling.
Uses one trigger resource.

Counter and timer events

Tests the specified counter or timer
value.

Counter 1 and 2 events conflict with
Timer 1 and 2 events respectively.
They also conflict with their respective
counter and timer actions.

Signal Looks for one of the four system Only one signal event is available in
signals. a trigger program. Uses one trigger
resource.
Anything All sampled data makes this event Available with the AND conjunction.
true.
Nothing All sampled data makes this event Used as a placeholder with the OR

false.

conjunction.

NOTE. These event selections are also available from the EasyTrigger tab, depending on the EasyTrigger

program that you select.
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Related Topics

Signals Properties (see page 367)

Clause Definition Dialog Box (see page 163)

LA Trigger Resources (see page 169)

LA Trigger Action Table

LA Trigger Action Table

The following LA trigger actions are available in the Then section of the PowerTrigger Clause Definition

dialog box.
Action Description Interactions
Trigger Triggers the current module and When Trigger is used in the trigger

causes both MagniVu and main
memory postfill to begin.

program, Trigger All Modules cannot
be used.

Trigger All Modules

Also known as a System trigger. This
signal is also available at the System
Trigger Out connector.

When Trigger All Modules is used in
the trigger program. Trigger cannot be
used.

Wait for System Trigger Used for a module that does not Capable of receiving the following
trigger itself or any other module, three (mutually exclusive) trigger
but waits to be triggered by another actions: Trigger, Trigger all Modules,
module. or Wait for System Trigger.

Trigger Main Triggers the module, and causes main At most, one type of main triggering
memory postfill to begin. can be used in the trigger program

(Trigger, Trigger Main, or Trigger
System)
Trigger MagniVu Causes MagniVu memory postfill to Trigger MagniVu can be used in

begin.

combination with one of the main
memory trigger actions (Trigger,
Trigger Main, Trigger System, or Wait
for System Trigger)

Snapshot Current Sample

Reloads the snapshot recognizer.

Snapshot is not available for event
recognition while the snapshot is
loading its sample.

Go To

Causes a change to a different trigger
state.

Use only one in clause definition.

Counter and Timer actions

Starts, stops, resets, clears,
increments, or decrements counters
or timers.

Counter 1 and 2 actions conflict with
Timer 1 and 2 actions respectively.
The actions also conflict with their
respective events.

Set and Clear Signal

Sets or clears one of the four system
signals.

Use only one in a trigger program.
Mutually exclusive with Arm Module
action.
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Action

Description

LA Trigger Resources

Interactions

Arm Module

Sends an Arm signal to another
module. The other module begins
running its trigger program.

Can only arm one module in a trigger
program, but actions can be taken
throughout the trigger program.
Mutually exclusive with Set and Clear
Signal actions.

Store Sample

Stores exactly one sample.

Not available in Start/Stop storage
mode.

Start and Stop Storing Begins or ends storing of samples. Available only in Start/Stop storage
Used in conjunction with Start/Stop mode.
storage mode in the Trigger window.

Do Nothing Used as a placeholder when defining Does not override other actions
a complicated trigger program. specified in a clause.

Don'’t Store Does not store this sample. Not available in Start/Stop storage

mode.
Related Topic

Signals Properties (see page 367)

Clause Definition Dialog Box (see page 163)

LA Trigger Resources

Overview

A trigger resource is a hardware constraint. Use trigger resources as tools to build a trigger program. A
trigger program can use up to 16 trigger resources.

Behavior

A trigger resource can be used more than once in a trigger program. However some events use more than
one trigger resource. The following table lists the trigger events, the event operator, the number of trigger
resources, and resource restrictions for each trigger event.

Event Operator Trigger resources and restrictions
Word =, Is Not 1 trigger resource
Group (word recognizer) =, Is Not 1 trigger resource

(range recognizer)

<, <=,>= > |sIn, Is Not In

3 trigger resources

(change detector)

Changes, Unchanged

1 trigger resource, one change
detector allowed in a trigger program,
not available when transitional storage
is used

Channel (word recognizer)

1 trigger resource
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Event Operator Trigger resources and restrictions

(change detector) Changes, Unchanged 1 trigger resource, one change
detector allowed in a trigger program,
not available when transitional storage

is used

Snhapshot =, Is Not, Is Loaded, Is Not Loaded 2 trigger events and 1 timer event

Transition Occurs, Doesn't occur 1 trigger resource for each of the 16
available transition recognizers used.

Glitch 1 trigger resource, only available with
asynchronous sampling

S & H fault 1 trigger resource, not available with
asynchronous sampling

Counter >, <= 0 trigger resources, 2 counters or 2
timers

Maximum width 51 bits Maximum
sampling 500 MHz (TLA7000 Sereis
and TLA5000 Series), 250 MHz
(TLAT700 Series)

Maximum count
2,251,799,813,685,246

Timer >, <= 0 trigger resources, 2 counters or 2
timers
Maximum width 51 bits
Maximum sampling 500 MHz,
Maximum time 2,000,000 s or 23 days
Resolution 2 ns

Signal (Signal In) Is True, Is False 1 trigger resource, uses one of four
system signals
Anything/Nothing 0 trigger resources

EasyTrigger programs are designed to take into account resource limitations so that, in most cases, you do
not have to be concerned with resources.

For TLA7000 Series logic analyzer modules and TLAS5000 Series logic analyzers, when using
asynchronous sampling and running at the fastest sampling rate, a 2 ns delay is required to allow the
counter event to propagate through the system before the trigger state machine can respond.

Related Topics

LA trigger Event Table (see page 166)

LA Trigger Action Table (see page 168)

Clause Definition Dialog Box (see page 163)
Trigger Action Signal Restrictions (see page 155)
Internal Signaling (see page 154)
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Force Main Prefill

Overview

By default, the Force Main Prefill check box is selected, which defers execution of the trigger state
machine until the main memory prefill amount is met. Use the Memory Depth field, located in the LA
Setup window, to set the total memory depth that the module fills. Use the Trigger Pos slider or box,
located in the LA Trigger window, to set the main prefill amount that must be met before the trigger state
machine is activated.

Behavior

When you use Force Main Prefill functionality, you specify which data samples are stored by selecting the
desired sample type from the Storage drop-down list. Note that if you select either the None or Stop/Start
storage settings, the Force Main Prefill check box and related functionality become unavailable.

System triggers produced by other modules override force prefill functionality and immediately start
execution of the trigger state machine. An externally generated system trigger does not purge the force
prefill data samples stored in main memory. However, the TLA7000 Sereis logic analyzer modules or the
TLAS000 Series logic analyzer stops acquiring further prefill data samples and begins acquiring postfill
data samples until main memory allocated for postfill data samples is filled.

NOTE. To change the default setting for Force Main Prefill, from the System menu select Options, and then
click the Defaults tab.

Related Topics

LA Triggers (see page 145)
LA Trigger Action Table (see page 168)

MagniVu

MagniVu functionality is designed to acquire data at a high sample rate so to see the timing of signals

in much greater detail. This is useful when you are debugging hardware and needing higher resolution
data samples for viewing events that change very quickly. Although the logic analyzer hardware supports
storage at slower rates, data sampling is always performed at the maximum PowerFlex MagniVu sample
rate. MagniVu memory depth is set to a fixed 16K.

Related Topic
LA Trigger Action Table (see page 168)
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MagniVu Storage Rate

Overview

This is the rate at which MagniVu data is stored in memory. By slowing the MagniVu storage rate,
stretching the MagniVu memory over a greater span of time provides a lower resolution data sample from
a greater time period.

Behavior

The MagniVu storage rate cannot be set slower than the effective main memory rate, according to 1X, 2X
or 4X modes. The available rates are:

B 8 GHz <> 125 ps
B 4 GHz <> 250 ps
B 2 GHz <-> 500 ps
B 1 GHz<->1ns

The MagniVu storage rates are limited by the fastest storage rate of the main memory under 1X, 2X, and
4X modes. The slowest MagniVu Storage rate is half of the fastest storage rate of the main memory.

1X MagniVu storage selections 2X MagniVu storage selections 4X MagniVu storage selections
125 ps, 250 ps, 500 ps, 1 ns 125 ps, 250 ps, 500 ps 125 ps, 250 ps

NOTE. MagniVu storage rate adjustments do not affect setup and hold violation or glitch violation.

MagniVu Trigger Position

172

Overview

The MagniVu trigger position selects the amount of pretrigger MagniVu data to store and determines the
position of the trigger in the data record. Control the MagniVu trigger position independently of main
trigger position by a set of controls in the advanced toolbar.

Behavior

Once triggered, a module continues to acquire MagniVu data until it fills a specified amount of memory.
MagniVu memory depth is set to a fixed 16K. The Trigger Position field determines the proportion of data
that is stored before and after the trigger. For example, if the Trigger Position is set to 15% and the module
triggers, then the module continues to acquire data until the remaining 85% of memory is filled.
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The MagniVu trigger position controls operate the same as the controls for main memory trigger position.
They consist of a slider control, an edit box, and a spin control positioned beneath the main memory trigger
controls. They behave like the main memory counterparts, except that the MagniVu trigger position is
constrained by the MagniVu storage rate as follows.

Storage rate Resulting trigger position constraint
125 ps 0% to 58%, in 1% increments
250 ps 0% to 79%, in 1% increments
500 ps 0% to 89%, in 1% increments
1ns 0% to 94%, in 1% increments

NOTE. MagniVu data acquisition starts prior to the run line and fills memory before any possible trigger
event. Therefore, there is no MagniVu forced prefill control.

Related Topics

MagniVu (see page 171)
LA Triggers (see page 145)
LA Trigger Action Table (see page 168)

Multiple Samples per Clock Trigger Programs

Some trigger programs that rely on multiple samples per clock require special attention to work properly.
In some situations, it may be necessary for a data value to be present on the probe input for two or more
clock cycles for a word recognizer to detect it. In other situations, it may be necessary to use word
recognizers logically ORed together across the base and prime signals to detect a value.

When using multiple samples per clock, trigger programs only operate on the acquired data at normal
speed. In other words, when using multiple samples per clock, the current trigger machine state is
evaluated at the physical sample rate and not the logical sample rate.

To illustrate this point, consider the following two examples. In both examples, a minimum sample period
of 2 ns is assumed with asynchronous sampling.

Example 1 shows a situation where there are two samples per clock.

A3 Channels D3 Channels Timestamp
01 02 0 ns
03 04 2ns

The data was acquired with the trigger: If Group A3 equals 01, then Trigger.

However, if the "01" data value happened to be stored as the prime signal (D3"1), the instrument would not
have triggered, even though the value occurred on the A3 lines and was captured in the acquisition memory.
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To reliably trigger on an event that only lasts for 1 ns, use two word recognizers: one to watch the base
signal, and the other to watch the prime signal. The following trigger will always catch the 02 pattern
using Two Samples per Clock mode: If Group A3 equals 02 or Group D3 equals 02, then Trigger.

If the desired event for triggering is present for at least 2 ns, then it follows that the base signals will always
capture the event. In this case, the trigger will work correctly in the Two Samples per Clock mode.

Example 2 shows a situation where there are four samples per clock.

A3 Channels A2 Channels D3 Channels D2 Channels Timestamp
01 02 03 04 Ons
05 06 07 08 2ns

The data was acquired with the trigger: If Group A3 equals 01, then Trigger.

However, if the "01" data value happened to be stored as one of the prime signals, the instrument would not
have triggered, even though value occurred on the A3 lines and was captured in the acquisition memory.

To reliably trigger on an event that only lasts for 500 ps, use four word recognizers: one to watch the base
signal, and the others to watch the prime signal. The following trigger will always catch the 01 pattern
using Four Samples per Clock: If Group A3 equals 01 or Group A2 equals 01 or Group D3 equals 01
or Group D2 equals 01, then Trigger.

If the desired event for triggering is present for at least 2 ns, then it follows that the base signals will always
capture the event. In this case, the trigger will work correctly using Four Samples per Clock.

NOTE. Use the Trigger on group match or the Trigger on signal match EasyTrigger Programs (see
page 183) located under Match Events on multiple samples per clock. Set up this type of triggering on a
data value that you specify.

Entering a Symbol Plus an Offset in a Trigger

174

In a group value field that has a symbolic radix you can directly type in a symbol with an offset. For
example type into that field:

MyFunction+55

The application software will parse the symbol and the number and redisplay the result. The software
takes the offset as a HEX number. As in other places where you type in numbers, force the radix to
something else. For example:

MyFunction+\d10 ’decimal 10
MyFunction+\b1111 ’binary 1111
MyFunction+\033 ’octal 33

MyFunction+\haa ’hexadecimal AA

TLA Online Help



LA Trigger Information Triggering Problems

Triggering Problems

When trigger program is not being satisfied, check the following:
®m  The trigger program is correct.
m  Storage qualification is correct.

B The system under test or module does not have an exception or fault. The system or acquisition
module might have experienced a hardware or software exception or fault after the trigger condition
was satisfied.

B A clock is available. Click Status in the toolbar to open the Status Monitor and verify that a clock is
available. If no clock is available, check your clock connections.

If the previous suggestions do not fix the problem, try the following:
B Reload the support package to restore the logic analyzer to a default state.

B Possible loading problems might be remedied by removing one or more of the protective sockets from
the probe adapter. These sockets might add enough additional capacitance or delay to your system
under test to affect it.
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Serial Analyzer Trigger Window

The serial analyzer Trigger window is similar to a Power Trigger window on a logic analyzer module. You
use it to construct a trigger program (see page 354). The trigger program is made up of one or more trigger
states. Each state has one or more clauses. Each trigger state contains an area to enter a brief description of
the state. You can have up to eight trigger states in the trigger window.

Each clause has a trigger event section that specifies a trigger event that you are looking for. The second
part of the clause contains a trigger action section describing the appropriate action to take when the event
information has been satisfied. You can have up to eight trigger clauses per trigger state.

Some suggestions for using the Trigger window follow:
®  Click \* to collapse the current trigger state to provide more room on the screen.
®  (Click . ¥ to expand the current trigger state.

m  Look for the ¥ or \* to expand or collapse information in the current clause. They are indicators
that there may be more or less information to display on screen.

TIP. Configure the Setup window before the Trigger window, because the Setup window settings may
affect Trigger window selections.

Trigger Tool Bar

The trigger tool bar in the serial analyzer Trigger window has controls for common tasks. Icons at the left
side of the tool bar provide an easy means to do the following tasks:

= Click PF to set the default Trigger window.
= Click " to load a previously saved Trigger window.

= Click ¥T to save a Trigger window.

Use the On Run control to specify the storage control options. Select Start Storing to begin storing data
when you click the Run button. Select Don’t Store to not store data until the conditions have been met
in the trigger program.

Use the Store control to specify the amount of data to acquire. The data volume is expressed in terms
of symbols with a maximum of 32 M symbols. Use the Trig Pos control to specify where the trigger
will appear in memory (1% accuracy within the data record). Both of these controls perform the same
functions as in the serial analyzer Setup window.
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Creating a Serial Analyzer Trigger Program

Use the following guidelines to create a serial analyzer trigger program:
1.
2.
3.

Open the serial analyzer Trigger window.

In State 1, enter a meaningful description in the Description field.

In Clause 1, click Add Event, and select a trigger event from the drop-down list.

Creating a Serial Analyzer Trigger Program

Depending on the event, additional controls will appear. Select the information that you want from the

drop-down lists. For some packets (such as TLPs, DLLPs, Sequences, or Link Events), click B to

open a dialog box where you can further define the packet.

If necessary, click Add Event to add additional events to the current clause.

In the action area of the clause, select an action from the drop-down list and then fill out the necessary

information to complete the trigger action.

If necessary, add additional clauses and states to complete your trigger program.

TIP. Add states, clauses, events, and actions by right-clicking the mouse.

Serial Analyzer Trigger Events
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The following table lists the serial analyzer trigger events.

Event Description

Anything Recognizes any data.

TLP Recognizes the presence or absence of a specific TLP. Choose the TLP from
a list, or define a TLP.

DLLP Recognizes the presence or absence of a specific DLLP. Cchoose the DLLP
from a list, or define a DLLP.

Sequence Recognizes a specific ordered set or symbol sequence. Choose the Sequence
from a list, or define a Sequence.

Link Event Recognizes link events and link error signals. Choose the Link Event from a list,
or define a Link Event and specify which lanes to monitor.

Timer Recognizes a specified timer value. A maximum of four global counters or
timers are available.

Counter Recognizes a specified counter value. A maximum of four global counters or
timers are available.

Signal In Recognizes a signal from another module.
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Defining Packets in Trigger Windows

The serial analyzer lets you define packets for triggering on PCI Express data. Click B in the Event
section of the trigger program to open a dialog box to define the event.

1. Enter a meaningful name for the packet or select one from the drop-down list.
If you select a packet from the list, a copy is automatically created.
2. Fill in the information as needed to define the packet.

3. To change the radix of a particular field, right-click the mouse in the field and then select a radix
from the right-click menu.

4. Click close to save the changes.

NOTE. The X and $ characters appear whenever you define a TLP, DLLP, or a symbol sequence Event.
An X represents any character, often known as a "don 't care" character. The X can represent a binary,
octal, or hexadecimal digit depending on the radix selection. The $ character appears when you select a
radix where the binary combination contains one or more X characters. 1o identify the contents of a $
character change the radix to binary.
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Trigger Program Structure for an LA Module

A trigger program (see page 354) is made up of one or more states (see page 183) (up to 16). Only
one state is active at a time.

Each state is made up of one or more clauses (see page 182). If there are more than four trigger event
resources used in a state, you can have up to four clauses per state. If there are four or fewer trigger event
resources in a state, you can define up to 16 clauses per state. However, if you use a snapshot recognizer as
an event in your clause definition, your use of clauses per state is restricted as follows (note that neither
counters nor timers are included as trigger resources).

®  If you use a snapshot recognizer and more than two additional events, you can have up to two clauses
(and one counter or timer) per state.

B [fyou use a snapshot recognizer and no more than one additional event, you can have up to eight
clauses (and one counter or timer) per state.

During each clock cycle, all clauses within the active state simultaneously evaluate the acquired data.
The priority of evaluation of a clause is assigned from top to bottom. The If statement of a clause can
contain a single event, or it can contain multiple event conditions. When the correct event conditions (see
page 183) occur, the logic analyzer passes control to the actions specified in the Then statement. There
are several actions to choose from, including triggering the system, or transferring control of the trigger
program to another state.

If multiple clauses are true in the same clock cycle, only the clause with the highest priority that goes true
will have its actions executed.

NOTE. Avoid using the If Anything event in the top-most clause of a state with multiple clauses. Successive
If-Then clauses will never become active. If you decide to use the If Anything event, it should be in the
last clause of a state.

PowerTrigger Tab

The Overview portion of the LA PowerTrigger tab shows the relationship between states.
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l] M Arrows indicate the transfer of trigger program control
' between states. Marks indicate system-level actions that
B PE e could occur if a clause in that state goes true. Use the
trigger Overview to check that all states are connected.
+ With the exception of State 1, all states must have an arrow
State 1 leading to them (indicating activation by another state),
or they will not execute. These actions are defined in the
Clause Definition dialog box.
Ctate 2 Trigger Detail
The Trigger Detail, located in the right portion of the LA
PowerTrigger tab, shows summary information about the
clauses within the states. For lengthy trigger programs, click
S the State icon in the Overview to jump to the corresponding
1] PowerTrigger details. Click the If/Then icon to open the
Clause Definition dialog box, for complete information about

the clauses for that state.

TIP. To check the progress of your trigger program during acquisition, click the Status button in the
toolbar to display the status monitor.

To track a sequence of events, create trigger programs with multiple states.

To simultaneously monitor different events, create trigger programs with states containing multiple
clauses. Each clause can carry out different actions when the events occur within each state.

Related Topics

Clause Definition Dialog Box (see page 163)
LA Trigger Event Resources (see page 169)

Trigger Clauses

Trigger clauses are made up of two parts: An If statement that defines the data events to search for,
and the Then statement which specifies the actions taken when the If statement is true.

Clauses contain the most important part of the trigger program; they specify the data and conditions
to look for. Clauses also define the relationship between the states by specifying when control is
passed from one state to another state.
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Event Conditions
Event conditions are a logical combination of trigger events within a single clause.

B Ifyou set up a logical AND statement, all event conditions in the clause must be met before
the clause can execute the action.

m  Ifyou set up a logical OR statement, any one of the event conditions can be fulfilled before
the clause can execute the action.

B You cannot define both AND and OR statements, define one or the other.

Trigger States

Trigger states monitor and act on a sequence of data events. States break up the trigger program
into stages.

States make the trigger program easier to read and provide more program flexibility by providing a
method to define the program in greater detail. During acquisition, trigger program control passes
from one state to another. The contents of the active state are evaluated each clock cycle.

Each state contains up to 16 clauses.

EasyTrigger Program List

Overview

An EasyTrigger program list contains a collection of predefined trigger programs for the LA module. A
list of predefined trigger programs is available from the EasyTrigger tab of the Trigger window. These
predefined trigger programs are designed to hide program implementation details, allowing you to focus
on acquiring and displaying data. Use the PowerTrigger tab to view the selected trigger program’s inherent
trigger states and related clauses that define the data event, and possible resulting actions.

To Use

Use the predefined trigger programs as the basis for designing increasingly complex trigger programs
that meet your data requirements. Selecting a predefined trigger program from the EasyTrigger tab and
then displaying it using the PowerTrigger tab also allows you to modify the preexisting state and clause
definitions. After making trigger program modifications, save the resulting trigger program to a specified
folder for later reuse by clicking the button, which is available from the Trigger window toolbar.

Symbol Meaning

A B, C Replaces Events
Range A A Range value

N A count (counter)
T A time (timer)

TLA Online Help 183



LA Trigger Program EasyTrigger Program List

NOTE. When you use the PowerTrigger tab to make changes to a predefined trigger program, you can no
longer use the EasyTrigger tab to view the modified program. Attempting to do so will display a message
warning you that, if you proceed, your unsaved program changes will be lost. Only predefined trigger
programs can be viewed from the EasyTrigger tab.

After you become familiar with defining trigger states and related event and action clauses, use the
PowerTrigger tab to create new trigger programs that are specifically designed to your data requirements.

Related Topic
Loading a Trigger from the Trigger Tab Page (see page 94)
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Listing Window

Overview

Use the Listing window to view and evaluate acquisition data. This window displays the acquired data
as a result of what you specified in Setup and Trigger windows. To open a Listing window from the
Window menu, click Listing.

Columns

Data is presented as tabular text in columns. There are several types of columns; logic analyzer groups,
individual logic analyzer signals, DSO channels, Disassembly, Sample numbers, and Timestamp values.

®  Columns can be dragged and dropped. Click and drag the column label to where you want the column
displayed. An arrow shows where the column will be placed.

B Double-click a column label to open the Column Properties tab.

®  Add columns by clicking the Add Column toolbar button .

B Remove columns by selecting the column label and clicking the Cut toolbar button; paste the removed
column to the right of any selected column.

®m  Expand columns to show the individual signals in a group by clicking the + ELEI Collapse the
individual signals by clicking the - B

Marks

Marks are used to make time measurements, locate triggers, and mark specific samples for evaluation.

Marks you can move include Cursor 1, Cursor 2, and any marks you add. The numbers 1
and 2 on the mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and
the time difference (Delta Time) between the two are located on the Delta Time toolbar.

- ko =100ns
o D Cursor ] v| D Cursor 2 v| . Add any number of delta time toolbars by clicking the Add

+.
Delta Time button at the top of the Listing window. ol

Marks on the left side of the window are data area marks. These marks are in the portion of the
acquisition that is currently viewable. Use data area marks to move within the data area.

You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the right side are overview marks. These marks show where marks are located relative to the
entire acquisition. Use overview marks to move throughout the acquisition. For example, move Cursor
1 to a particular sample as shown in the Cursor 1 readout. Click the Go To toolbar button and select

Cursor 1. You can also click the right mouse button on any overview mark, and then click Go To Mark.
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System trigger @
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Module trigger ¥

Begin data and end data and ﬁ

Cursors 1 and 2

BT N = |

Listing Window

Double-click a mark to open the Marks properties tab; assign a unique name to the Mark in the

Mark Name field.

Add marks by clicking T (the Add Mark toolbar button). Remove a mark by selecting the mark and
using the Cut toolbar button. When you add or paste a mark, it appears in the center of the display.

Move to any mark using the Go To toolbar button.

The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger. The
active system trigger is indicated by a yellow T; the reference

system trigger is indicated by a gray T.

The system trigger appears even if no data from the module
that generated the system trigger is around it.

—and I

User mark —IEII

Lock Delta Time check box

The point at which the module triggered. Trigger marks
cannot be moved.

The start and end of a module’s data record. These data
marks cannot be moved.

Moveable marks used for visual reference and for data
measurements.

User-created marks. Use marks to make specific data easier
to identify and find.

Click this check box to lock the delta time value. When

you lock delta time, the marks move across the data
simultaneously, maintaining a fixed delta time.

Data Area

Enable Glitch storage in the Setup window before acquiring data.

The Data area can be split vertically by dragging the split box from the left end of the horizontal

scroll bar. This allows you to compare columns.

Qualification Gaps (see page 187) are indicated with a horizontal gray line above the first data after the

gap. Turn indicator gaps on or off from the Listing Window Properties tab.

Glitches are indicated by highlighted text of the complete sample, except for binary radixes. Only
the glitch bits are highlighted in binary. Select the color of highlighted glitch text from the Listing

window properties tab. Select radixes from the Column properties tab.

Memory differences (see page 187) and equalities (see page 187) are indicated by highlighted data. Enable
data comparison and select the color of highlighted data from the Listing window properties tab.

Before you acquire and compare data, enable the comparison in the Setup window and define both the
signals to compare and a valid data reference.
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Qualification Gaps

Positions between data samples where one or more samples have not been stored.

Data Differences

Highlighted data shows where there are differences between the two signals or groups being compared.

Data Equalities

Highlighted data shows where there are no differences between the two signals or groups being
compared.

Add Column/Waveform Dialog Box

Use to add a column to the Listing window, or a waveform to the Waveform window:
1. Select the data source and its associated group or signal to add it to the display.
2. Click the Add Data Source button to add a source to the selection box.

To open the Add Column or Add Waveform dialog box from the System window, click the appropriate
data window icon. Then go to the Edit menu and click either Add Column or Add Waveform.

TIP. To quickly add columns and waveforms, right-click in the Listing or Waveform window and select
either Add Column or Add Waveform.

Lock Windows Dialog Box

Overview

Use the Lock Windows dialog box to lock cursors and the display areas of selected data windows. Locking
windows provides an easy method to compare data in different windows.

Use the Lock Windows dialog box to select how windows are locked together with respect to cursors
and the center screen.

Behavior

To have the cursors and center screen of all locked windows go to the same time stamp position as the
selected reference window, click the No time offsets option button. To have each window’s cursor and
center screen retain its current position, click the Current time offsets option button.
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TIP. One way to jump over big time gaps in the Waveform window is to create a Listing window of the
same data, and then lock the two windows together. As you move the cursor through the Listing window,
the cursor in the Waveform window will track and jump over the "dead" space between samples.

To Use

To open the Lock Windows dialog box from the System window, click the Listing, Waveform, Protocol, or
Graph data window icon. From the System menu, click Lock Windows.

Export Data Dialog Box

Overview

Use the Export Data dialog box to export data from the current Listing window to an ASCII text file or
to a binary file.

Behavior

To export the listing data to a text file, click Options to define the format of the data. The data is saved in
a file with the .txt extension.

If you choose TLA Data Exchange the text format is predefined as follows. The first line displays vectors
and the second line contains the column headings Sample, Address, Data, and Timestamp.

If you choose to export the listing data to a binary file, the data is saved in a file with a .tbf (TLA binary
format) extension. Sample numbers and mnemonics groups are not exported; time stamps are listed in
picoseconds and are relative to the start of the acquisition. The binary option is available only when the
data window has a single data source.

To Use

To open the Export Data dialog box, open a Listing window. From the File menu, click Export Data.

TLA Binary File Format
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Overview

The TLA Binary File Format is used to export data from Listing windows in binary rather than ASCII
format. Use this format to export DSO data and MagniVu data in Listing windows, in addition to the
standard listing data.
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LA Module Binary Format

The binary data for an LA module is exported as a stream of bytes with the following characteristics:
®  The binary data uses big endian fields (the most significant bit is the left-most data bit).

®  Each group field is zero-padded to the nearest byte.

B Sample numbers and mnemonics groups are not exported.

®  Time stamp data is seven bytes wide and represents the number of picoseconds since the start of
the acquisition.

B The left-most column in the Listing window corresponds the first exported field of a sample.
B The first sample in the Listing window appears at the beginning of the exported file.

B MagniVu data follows the same guidelines as regular listing data.

DSO Module Binary Format

The binary data for a DSO module (in a Listing window) is exported as a stream of bytes with the
following characteristics:

m  The binary data uses little endian fields (the most significant bit is the right-most data bit).

B Each channel is a 16-bit value.

B Sample numbers, mnemonics groups, and time stamp values are not exported.

B The left-most column in the Listing window corresponds the first exported field of a sample.
B The first sample in the Listing window appears at the beginning of the exported file.

B MagniVu data follows the same guidelines as regular listing data.

B DSO data values are in twos-compliment format.

B The formula used for converting a channel field into a voltage is as follows:

((vertical Range in volts / 64512) X channel field) + Vertical offset in volts

Export Data Options Dialog Box

Overview

Use the Export Data Options dialog box to customize listing data for export. The settings are retained
after you close the dialog box.

To Use

To open the Export Data Options dialog box, open a Listing window. From the File menu, click Export
Data, and then click Options.
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1. Choose a field delimiter to separate the listing data columns.

2. Click the Include Unit Character check box to export data with measurement units. If you export data
without unit characters, time stamp values are in picoseconds and analog values are in volts.

3. Click the Fixed Data Radix check box to export data in the specified radix.

4. Click the Use Enhanced Column Headers check box to export group width and radix information in
column headers.

Compare Definition Dialog Box

Before you can compare data, use the Define Compare dialog box to specify the source of the reference
data, the number of samples to compare, and how to align the data. To enable the Compare Definition
dialog box controls, click the Enable Data Compare check box.

A summary of the samples being compared is displayed at the bottom of the dialog box. This area
shows the samples that are being compared in the current acquisition using the current compare range
and alignment settings.

To Use

1. From the toolbar, open the Setup menu and select your module.

2. In the Setup window, define a group (see page 22).
3. Create a Listing window.

4. In the toolbar, click the Define Compare button.
Behavior

Compare data in the following ways:

B Reference Data Source. Select a reference data source from any of the installed modules or from a
saved setup.

B Compare Data Region. Compare all data between the system under test and the reference data. You can
also compare a range of data with respect to the beginning of memory or around the trigger location.

B Data Source Alignment. Align and compare the data with respect to the beginning of memory or to the
trigger location. You can also specify the number of samples to offset the data.

®  Compare limitations. Compare only the main LA data. You cannot compare glitch data, disassembler
group data, MagniVu data, External Oscilloscope or DSO data.
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Repetitive Properties Dialog Box

Overview

Use the Repetitive acquisition features of the logic analyzer to automate repetitive and time-consuming
tasks. For example, specify the number of times that you want the logic analyzer to acquire data. With

each acquisition, save the data to a file for analysis. If desired, set up the logic analyzer to open a file or
execute a program when all of the acquisitions have been completed.

Behavior

Click the Save check box to save the setups or export data to a file. Specify to overwrite the file with each
acquisition or to save the data in separate files by entering a starting file suffix number.

During compare operations, you can acquire data until the compare conditions are met. Then click OK to
close the dialog box and save your settings.

The following is an example of such a setup where the acquired data is exported to a file for each
acquisition. When a data-mismatch occurs, the logic analyzer stops acquiring data and exports the data to a
file. The faulty data can now be analyzed by another application.

Repetitive Properties
Aftes Each Acquisition

Sa-.ee|E:-mrtData v| from | Listing 1 w |

Ta File: |E:‘-I-1}ID|:||:u'nerts‘uLED il bt | [ Browse, . I

(%) Save in same fle sach acquisition.

) Save in new file each scquisiion.  Starting file Sulfic |'|

Stop if Compare vath Beferenca i5; | Mot Equs
Stop After | 501 Acquisitions
When Stoppad

] Dper: <Mame of praaam or documents
|

NOTE. Click the Enable Data Compare check box, located in the Compare Definition dialog box, to stop
the acquisitions when the compare conditions are met.

After completing the repetitive operation, you can have the logic analyzer open a document or execute an
operation as defined in the Open dialog box. Click Open to access the Open dialog box.
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TIP. 1o improve the response time of the logic analyzer during repetitive operations, delete any
unnecessary data windows. This allows the logic analyzer to spend time on processing data rather than
redrawing data in data windows.

To open the Repetitive Properties dialog box from the System menu, click Repetitive Properties.

Related Topics

Compare Definition Dialog Box (see page 190)
Export Data Dialog Box (see page 188)
Open Dialog Box (see page 192)

Open Dialog Box

Overview

Use the Open dialog box to open a document or an application after fulfilling the requirements of a
repetitive operation.

To Use

Enter the path and name of the document or application that you want to open. If you do not know the
path name of the document or the application, click the Browse button to navigate to the document or
application.

B Use the Arguments list to enter any command line arguments that are required by the application or
document.

B Use the Initial Directory box to specify the default working directory for the application or document.
®  Click the Test Open button to verify the selections for the Open dialog box.

To access the Open dialog box from the System menu, click Repetitive Properties, and then click the
Open button.

Define Search Dialog Box

192

Overview

Use the Define Search dialog box to search for specific data within the current data window. Search
definitions can search any number of data sources at the same time. By default, searches begin from the
active cursor, but you can specify any cursor or mark to begin the search. All data sources begin searching
at the same point and continue until the number of occurrences specified is found. Neither hidden data
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nor suppressed data can be found by the search function. Suppressed data can be identified by gaps in
the sequence numbers.

Behavior
B Module sample numbers and stored time stamps can be searched.

®  All module signals and groups can be searched; each has unique conditions to aid you in searching.
Types are LA signals, LA groups, DSO channels, and disassembly.

m  Search for data differences and data equalities during compare operations.

B Add an unlimited number of events.

B After adding an event, click the AND/OR button to alternate between logic expressions.

m  The Radix for groups can be set independent from those used in Listing or Waveform windows.
B The polarity state set in the module setup applies to the search values.

B Searches on numeric disassembly groups with partial invalid bits (indicated by dashes) will match
across the entire unqualified value. Set invalid bits to "don’t care" values (X) for a proper match.

B Searches on numeric disassembly groups that contain all invalid bits always fail.

To Use
To open the Search Definition dialog box, open a data window and click i) in the toolbar.

Click cither the | ® Search Back or the =2 Search Fwd button to begin the search.

Click the Search Options... button to set the action that you want the logic analyzer to take when the
search is successful.

NOTE. Type the following meta-characters in the value box for text searches.

Character Matches

Zero or more characters

? Any single character

<or> One or more delimiters. A delimiter is any character that is
not: a-z,A-Z,0-9, _(underscore) or - (dash).

% Opcode mark. This character can only be used in a
disassembly mnemonics column search.

space One or more spaces

\ Makes the next character literal.
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Right-click in the Search area to activate a short cut edit menu. The short cut edit menu allows you to
add or delete data sources and events, to enable or disable searches and to cut, copy, or paste. Where you
right-click in the Search area determines which menu selections are active.

Clicking in the Search area will activate a > icon. Holding your cursor over the arrow activates the
short cut edit menu.

Related Topics

Column Properties Tab (see page 195)
Waveform Properties (see page 90)

Compare Definition Dialog Box (see page 190)
Search Definitions (see page 194)

Search Definitions Dialog Box

Overview

Use the Search Definitions dialog box to create new search definitions or load saved searches.

Behavior

Click the New button to add a new search to the selected data window. Click the Load button to open the
Load Search dialog box to select and load searches. Select a search, and then click the properties button, to
open the Define Search dialog box to set the criteria for the search.

Related Topic
Define Search Dialog Box (see page 192)

Time Alignment Dialog Box

Use to align the time of data sources. The data source’s alignment is offset by the adjusted time in all data
windows. LA and associated MagniVu (see page 361) data sources are always offset together.

Saved data and current data are time-correlated by aligning their system triggers. Manually adjust this
alignment using the Time Alignment dialog box.

To open this dialog box, open a data window. From the Data menu, click Time Alignment.
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Go To Dialog Box

Use to scroll the data window to a new position by selecting any current mark, column, or waveform.

To open the Go To dialog box, open a data window and then click the Go To toolbar button.

Related Topics

Adding a Mark to a Data Window (see page 136)
Adding a Waveform (see page 118)

Mark Opcode Dialog Box

Use this dialog box to place an opcode mark into a disassembly analysis. To do so, select an opcode from
the list and click OK. To remove an existing opcode mark, click Undo Mark.

NOTE. Load a support package to use this feature.

About Data Properties

Provides information about the data source used for the active data window.

Column Properties

Use the Column properties tab to format a column in the Listing window.

B (Click the Column drop-down list to view properties of another column. Note that changing columns
applies changes that you made to the previous column.

B Color selection changes the color of text in the column.

B Column data can be displayed with user defined foreground and background colors by setting up
the column to use TSF symbol file with color.

B The Show Column check box can be used to temporarily remove a column from the display, but
still retain its properties.
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®  Column selection of Sample or Timestamp provides controls for reference points (for example, you
may want to reference all time stamp values to the module trigger point rather than the beginning of
data).

m  Select the radix if the selected column is a data column. If you select Symbolic, controls appear
to aid you in finding the symbol file.

NOTE. Radix and Polarity selections for disassembly mnemonics cannot be changed. Polarity cannot be
changed for any disassembly column.

To open the Column properties tab, open a Listing window and double-click the column label.

Marks Properties

Use this to format any mark in the current data window or enter comments for any mark.

To open the Marks properties tab, open a data window and double-click the mark.

NOTE. Changing the selected mark applies any changes that you made to the previous mark.

Listing Window Properties

196

Use to format the current Listing window.

B Qualification gaps (see page 187) in the Listing window are indicated by a gray horizontal bar above
the first data after the gap.

®  Data Font Size allows you to select the size of the text within the columns and the column labels.

B Click Acq !=Ref to display data differences (see page 187) during data compare operations.

B Click Acq = Ref to display data equalities (see page 187) during data compare operations.

NOTE. To display differences and equalities, define a valid data reference and enable the comparison.

®  litches are indicated by highlighted text of the complete sample for all radixes except binary; in
binary radix the actual bits containing the glitches are highlighted.

NOTE. Select Glitches in the Storage box of the Setup window before acquiring data.
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®  Background allows you to select the color for the data area background.

B Selecting a different color scheme resets the colors shown in the Column tab, Marks tab, and Listing
Window tab to their default settings for that color scheme. Color schemes are defined in the Colors tab
of the Options dialog box.

NOTE. Default colors are set in the Defaults tab of the Application Options dialog box, available from
the System menu.

To display the Listing Window property tab from a Listing window, click in the toolbar, and then
click the Listing Window tab.

Related Topics

Defaults Tab (see page 370)
Color Tab (see page 369)

Disassembly Properties

Use to select the display format of disassembly groups.
Load a support package for this page to be active.

B [fyou have more than one disassembler loaded, select from all modules that have a disassembler
currently loaded.

®m  Select which disassembled data to display: Hardware (see page 198), Software (see page 198),
Control Flow (see page 198), or Subroutine (see page 198). Other display options may be available
depending on your support package.

m  Highlight lines appropriate for the current selection in the Show list box.

NOTE. The highlight controls are disabled if the Mnemonics column is colored the same as another column.

m  Select whether to continue disassembly analysis across storage qualification gaps (see page 187) in
the acquisition data.

Other selections are support package dependent. Refer to your instruction manual for specific selections
and choices.

To display the Disassembly Properties tab from a Listing window, click in the toolbar, and then
click the Disassembly tab.
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Hardware Disassembly

Shows bus cycles in the order they were sampled. The disassembler displays certain cycle type
labels in parentheses.

Refer to the support package manual for a list, and definition of, the labels.

Software Disassembly
Shows only executed instructions.

The displayed information resembles assembly language.

Control Flow Disassembly

Shows only calls, exceptions, returns, and branches; which are types of instruction that changes the
flow of control.

Subroutine Disassembly

Shows only the first fetch or subroutine call and return instructions.

Error Message Dialog Box

This dialog box displays error messages, usually in relation to disassembly support and symbol table
loading. The following are attributes of the Error Message dialog box:

®  Holds up to 100 messages.
B  The oldest messages are discarded when the message area fills.

B The most recent message is at the bottom.

NOTE. Closing the Error Message dialog box discards all messages, minimizing does not.

Define Suppression Dialog Box

The Define Suppression dialog box defines what module samples will be shown. This dialog box defines
how many samples will be shown for only the data sources in this display.

198 TLA Online Help



LA Listing Window Information Show Samples Dialog Box

Show Samples Dialog Box

The Show Samples Dialog Box shows preciously suppressed samples to be shown starting with the
current mouse position.

Show by Samples

Making this selection indicates that the selected number of samples will be shown starting from my
current mouse position within the view.

Show by Mark

Marking this selection causes all samples between the current mouse position and the selected mark to
be shown.

Apply to Mark

Normally the data source pointed to by the mouse pointer is the only source that will be acted on. If this
check box is selected the action will be applied to all data sources in this display.

Suppress Samples Dialog Box

The Suppress Samples dialog box suppresses samples from the view.

Suppress the <selection> <number> Samples

Making this selection indicates that the selected number of samples will be suppressed starting from my
current mouse position within the view.

Suppress to Mark <selection>

Marking this selection causes all samples between the current mouse position and the selected mark
to be suppressed.

Apply to all Data Sources in this Data Window

Normally the data source pointed to by the mouse pointer is the only source that will be acted on. If this
check box is selected the action will be applied to all data sources in this display.
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Sample Suppression Dialog Box

200

Use Sample Suppression to control how many samples are initially made available for display each time
you acquire new data. Sample suppression does not affect the number of samples stored during acquisition.

Control sample suppression in the following ways:
®  Show All acquired samples. Makes all acquired samples visible immediately following acquisition.

m  Show N samples around the trigger. Shows one block of samples with the trigger centered in the block
of samples. All other samples are suppressed.

B Reuse existing sample suppression relative to. Retains the setting currently being used to show data
in the Listing or Waveform window and applies it to newly acquired data. Suppression can be kept
relative to the trigger point or beginning of memory.

Changes made to the dialog box do not take effect until new data is acquired. Following acquisition, use
the Show or Suppress controls, in the Listing or Waveform windows, to view or suppress additional
data samples.

To access this dialog box, click the Suppress . . . button in the toolbar in the LA Setup window.
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Waveform Window

Use the Waveform window to display and evaluate acquisition data. You may display both analog
waveforms and digital waveforms. Each window contains a data area, a waveform label, marks, and
several toolbars that allow you to measure and manipulate your waveforms:

Waveforms

The following waveforms can appear in a waveform display. Click the buttons for more information on
each type of waveform.

Single-Signal LA Waveforms
Multi-Signal Busform LA Waveforms

Multi-Signal Magnitude LA Waveforms
DSO Waveforms

Sample Waveforms

Overlay Waveform

Time Gaps

Waveforms can be dragged and dropped. Click the waveform label and drag it to where you want to
display the waveform. An arrow shows where the waveform will be placed.

Double-click a waveform label to open the Waveform dialog box.
Add waveforms using the Add Waveform toolbar button.

Remove waveforms by selecting the waveform label and clicking the Cut toolbar button. Paste the
removed waveform below any selected waveform.

@ iview @ Magnivu T Activity OF value

To quickly display the waveform from an external oscilloscope, click the iView button.

To display MagniVu waveforms click the MagniVu button. To turn the iView or MagniVu display
off, click the button again.

To display the probe activity in the Waveform window, click the Activity button. Click the button
again to turn the probe activity display off.

To display the value of each group at Cursor 1, click the Value button. Click the button again to turn
the value display off.
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Waveform Window

Marks

Marks are used to make time measurements, locate triggers, and mark specific waveform events for
evaluation.

System trigger

2

Marks you can move include Cursor 1, Cursor 2, and any marks you add. The numbers 1
and 2 on the mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and

the time difference (Delta Time) between the two are located on the Delta Time toolbar.
Fas iy 1wl 7w |=100nz . o
D e v| D e v| . Add any number of delta time toolbars by clicking the Add

&

Delta Time button at the top of the Waveform window.

Marks on the top of the window are data area marks. Use moveable data area marks to move within
the data area. You cannot move System Trigger, Module Trigger, or Begin and End marks.

Marks on the bottom of the window are overview marks. These marks show where marks are located
within the entire acquisition. Use moveable overview marks to move throughout the acquisition. For
example, move Cursor 1 to a particular sample as shown in the Cursor 1 readout. Click the Go To
toolbar button and select Cursor 1. You can also use the right mouse button on any overview mark
and click Go To Mark.

Double-click a mark to open the Properties dialog box and display the Marks tab. Assign a unique
name to the Mark in the Mark Name field.

Add marks using the Add Mark toolbar button. Remove an added mark by selecting it and using the
Cut toolbar button. When you paste a mark, it appears in the center of the display.

Go to any mark using the Go To toolbar button.

The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger.

The active system trigger is indicated by a yellow T; the
reference system trigger is indicated by a gray T.

The system trigger appears even if no data from the module
that generated the system trigger is around it.

Module trigger
7.

The point at which the module triggered. Trigger marks
cannot be moved.

.|4

Begin data and end data

andﬁ

o

The start and end of a module’s data record. These data
marks cannot be moved.

Cursors 1 and 2

Moveable marks used for visual reference and for data

T = measurements.

B and ¥E

User mark User-created marks. Use marks to make specific data
S

easier to identify and find.
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Data Area

B The Data area can be split by dragging the split box from the top of the vertical scroll bar. This
allows you to compare waveforms.

m  Several situations can cause long periods of time (Time Gaps (see page 203)) to elapse between
acquired samples.

B Acquired glitches display directly on the affected waveform. Glitches display as a vertical bar behind
the sample data in the glitch color. Glitches are drawn as if they were behind the waveform. Disable
the display of glitches and select the color in the Waveform window.

B Memory differences (see page 187) and equalities (see page 187) in logic analyzer waveforms are
indicated by different colored text for each trace. Enable data comparison and select the color of
highlighted data from the Waveform window.

Highlighted data shows where there are no differences between the two signals or groups being
compared.

NOTE. Define the signals to compare, define a valid data reference, and enable the comparison in the LA
Setup window before acquiring data and viewing differences and equalities.

Related Topics

Waveform Properties (see page 90)
Waveform Labels (see page 213)
Marks Tab (see page 196)

Symbol Tables (see page 335)
Selecting Objects (see page 204)

Time Gaps

Several situations can cause long periods of time to elapse between acquired samples:

®  Qualification gaps (see page 187) in a single LA module record.

B Acquisition gaps between the last sample in one data source and the first sample in another data source.

As with any data samples, a horizontal vector is drawn from the last sample before a qualification gap to
the first sample after the gap. If the values of these two samples are different, the transition is drawn at
the sample after the qualification gap.

Qualification gaps within a module are compressed. If there are acquisition gaps when no modules are
acquiring (including reference waveforms), this time is eliminated.

Cursor time values that fall within an acquisition gap are forced to the closest valid display point. If
you place cursors on both sides of an acquisition gap, the displayed delta value is greater than the time
between the two data points.

TLA Online Help 203



Waveform Window Information Selecting Objects

Selecting Objects

Selected Objects

Select waveform labels, navigation marks, and data window regions in a Waveform or Listing window.
Only one of these elements can be selected at one time; however, several waveforms can be selected as
a single element.

For example, you can select three waveforms or a cursor, but you cannot select a waveform and a cursor
at the same time.

Active Objects

There is a distinction between selected and active. While you can only select one element (or set of
waveforms), there are element types for which one item is active at all times.

For example, there is always one active cursor (C1 or C2) and one active waveform. The active waveform
is the top waveform of a selected set of waveforms. Measurements pertain to this waveform.

Overlay Waveform

204

Overview

Overlay waveforms provide you with the ability to visually compare two or more waveforms by dragging
one waveform over the other. The overlay waveform can contain LA single-signal, DSO, external, and
clock waveforms.

LA waveforms have a horizontal resolution of one pixel per display point. A displayed point has three
possible states: high, low, or transition. When the sample period and time per division are set so that one
pixel is exactly one sample, every displayed sample is either high or low and may show a transition vector.
When the Time/Div is increased, the analyzer stretches out the waveform by padding between the samples.
At slower Time/Divisions, the data is compressed.

Vertical lines or vertical vectors are drawn at high-to-low and low-to-high transitions.

Acquired glitches are displayed directly behind the affected data points. Glitches are displayed as a vertical
line in the glitch color. Glitches are drawn as if they were behind the waveform. Disable the display of
glitches using the Waveform Window tab, which is located in the Waveform Properties dialog box.

Behavior

For DSO and external waveforms, each horizontal, pixel-wide time slice has either a point or a vertical
line to represent the vertical value of the acquired data sample. If the time per division is fast enough that
each display point represents one or fewer acquired points, the vertical value is represented by a point.
If the time per division is slower and multiple acquired data samples need to be represented within a
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pixel width, the vertical value is represented by a vertical line whose length and offset are determined
by the acquired data values.

When the time per division is decreased, waveforms are horizontally expanded, using (sine x)/x
interpolation to create display points between acquired sample points. A vertical value is calculated for
every horizontal time point between the acquired data points.

To Use

Select whether to display range readouts for the selected waveform, to display all DSO and external
waveforms range readouts, or to not display range readouts at all. Select the readout color. For each
waveform, two readouts display the maximum and minimum vertical input voltage settings. The readouts
may contain symbols indicating AC or Ground coupling, 50 Ohms input impedance, and the bandwidth
limit. The ground line is indicated as a horizontal dotted line. The trigger threshold is indicated with a

T and an up arrow if the threshold is above the maximum voltage or a down arrow if the threshold is
below the minimum voltage.

Waveform size is dependent on the signal size and the input voltage range set in the DSO setup window.
The entire input voltage range is used to set the default minimum and maximum values of the vertical
range. Set the vertical range values from the Waveform Properties dialog box by clicking the Waveform
tab, and then clicking the Options button.

To display no more than one data sample per display point, add a sample waveform from the same data
source and decrease the time per division until you can see individual clock tick marks.

Related Topics

Creating an Overlay Waveform (see page 135)

Removing Waveforms from an Overlay Waveform (see page 139)
Waveform Properties (see page 90)

Sample Waveforms (see page 212)

Overlay Waveform Properties

Overview

The Waveform tab displays overlay waveform properties when you double-click the label of an overlay
waveform in the Waveform list box. The following graphic displays the resulting content of the Waveform
tab.

TLA Online Help 205



Waveform Window Information Overlay Waveform Properties

Properties - Waveform 1

nboid [ shs | avelom wrdon

Wavsfom: | Ovelay 2 \.:
ight: 120 |3
Dlvmrlaw aarafiom Namir Dwerlyy 2 | Gty Lt
‘Wayntoms Svadlable o whavelpoms
[ L& 1- Sarngle - LT A3

L& 1= CEn| L 1; A2
L 1- Sagrivia Magaia Sai

P
050 1 Sample
050 1: Chanmel1
D50 % Cheswsl2 | *
| 0k ] | Caned ] Apply Help
Behavior

The following are properties associated with overlay waveforms:
®  Overlay Waveform Name: permits you to rename overlay waveforms.

B Waveforms Available lists all of the individual waveforms and overlay waveforms. Move and copy
waveforms in this list to the Overlay Waveforms list using the Move and Copy buttons. Remove
buttons from the Overlay Waveforms list and return them to the Waveforms Available list using

the —if: button.

B Overlay Waveforms lists the waveforms currently in the selected overlay waveform group. Move
and copy waveforms from the Waveforms Available list to this list using the Move and Copy buttons,
respectively. Remove waveforms from the Overlay Waveforms list and return them to the Waveforms
Available list using the << | button.

To Use

To change waveform properties, from the System window click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics

Waveform Properties (see page 90)

Individual Waveform Properties (see page 207)

Individual Waveform Properties within an Overlay Waveform (see page 209)
Waveform Window Properties (see page 90)

Color Settings (see page 369)

Waveform Options (see page 214)

Measurement Setup (see page 388)
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Setting the Overlay Waveform Offset

1. In the System window, click the Waveform window icon.

2. Double-click the desired waveform label to display the Waveform Properties dialog box, and then
click the Waveform tab.

3. Set the desired pixel value in the Offset list box and click the Apply button.

NOTE. Offset can only be specified for waveforms that are members of an overlay waveform.

Alternate Method
1. In the System window, click the Waveform window icon.
2. Highlight the desired waveform label.

3. Use the vertical scroll bar to set the waveform offset.

Individual Waveform Properties

Overview

The Waveform tab displays individual waveform properties when you double-click the label of a single
waveform in the Waveform list box. The following graphic displays the resulting content of the Waveform
tab.
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Behavior

The following are properties associated with individual waveforms:

Source. displays the data source of the selected waveform. The source file (or current system), module
name, and signal information are displayed. Depending upon the way the signals were originally
added, the information will be a group-based signal name (for example, Address (31-0)), a single
signal name, or a probe-based name (A2-4, A3(7-0)). If the module is a secondary module of a merged
pair, an S is prepended to probe-based names. If the module is part of a three-way merge, S and S2
are prepended to probe-based names. If the module is part of a five-way merge, S, S2, S3 and S4 are
prepended to probe-based names. No text is displayed for multiple waveform selections.

Color. permits the selection of either a fixed waveform color or a waveform color that is the same as

another waveform, which is designed to promote comparison of waveforms. If you are selecting a fixed
color, select a color from the list. Select the color scheme using the Waveform window tab. Select the
colors of each color scheme by clicking Options from the System menu and then clicking the Color tab.

Radix. controls the radix for LA group data displayed as busform or cursor value readouts. Radix is
only enabled when a single LA group waveform is selected. Set the default radix by clicking Options
from the System menu and then clicking the Defaults tab.

Show Waveform. temporarily hides a waveform without deleting it. This check box determines if the
waveform is visible in the data window. If a waveform is not visible, you cannot search for it.

Use Polarity. enables the display of waveform signal polarity as defined in the Setup window. This
check box is only enabled for LA waveforms.
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®  Readouts. determines whether waveform readouts are displayed and their color. Readout options only
display for logic analyzer, DSO and external waveforms.

B Measurements. displays the user defined measurement selections for DSO waveforms. Click the
Measurement Setup button to modify the list of selected measurements.

To Use

To change waveform properties from the System window, click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics

Waveform Properties (see page 90)

Overlay Waveform Properties (see page 205)

Individual Waveform Properties within an Overlay Waveform (see page 209)
Waveform Window Properties (see page 90)

Color Settings (see page 369)

Waveform Options (see page 214)

Measurement Setup (see page 388)

Individual Waveform Properties within an Overlay Waveform

Overview

The Waveform tab displays the properties of an individual waveform within an overlay waveform, when
you double-click the label of a waveform, from within an overlay waveform, in the Waveform list box.
The following graphic displays the resulting content of the Waveform tab.
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Behavior
The following are properties associated with individual waveforms within an overlay waveform:

B Offset. allows you to visually compare two or more waveforms by specifying their vertical position in
the Waveform window.

B Source. displays the data source of the selected waveform. The source file (or current system), module
name, and signal information are displayed. Depending upon the way the signals were originally
added, the information will be a group-based signal name (for example, Address (31-0)), a single
signal name, or a probe-based name (A2-4, A3(7-0)). If the module is a secondary module of a merged
pair, an S is prepended to probe-based names. If the module is part of a three-way merge, S and S2 are
prepended to probe-based names. No text is displayed for multiple waveform selections.

B Color. permits the selection of either a fixed waveform color or a waveform color that is the same as
another waveform, which is designed to promote comparison of waveforms. If you are selecting a fixed
color, select a color from the list. Select the color scheme using the Waveform window tab. Select the
colors of each color scheme by clicking Options from the System menu and then clicking the Color tab.

B Radix. controls the radix for LA group data displayed as busform or cursor value readouts. Radix is
only enabled when a single LA group waveform is selected. Set the default radix by clicking Options
from the System menu and then clicking the Defaults tab.

®  Show Waveform. check box determines if the waveform is visible in the data window. If a waveform
is not visible, you cannot search for it. Use this box to temporarily hide a waveform without deleting it.

m  Use Polarity. check box enables the display of waveform signal polarity as defined in the Setup
window. This check box is only enabled for LA waveforms.

B Readouts. determines whether waveform readouts are displayed, as well as their color. When
selected, the Show readouts when selected check box allows waveform readouts to display only
when the associated waveform label is highlighted. Note that Readout Options only displays for
logic analyzer, DSO and external waveforms.

B Measurements. displays the user defined measurement selections for DSO waveforms. Click the
Measurement Setup button to modify the list of selected measurements.

To Use

To change waveform properties, from the System window click a Waveform window icon, double-click
the label of a waveform, and then click the Waveform tab.

Related Topics

Waveform Properties (see page 90)

Individual Waveform Properties (see page 207)
Overlay Waveform Properties (see page 205)
Waveform Window Properties (see page 90)
Color Settings (see page 369)

Waveform Options (see page 214)
Measurement setup (see page 388)
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Multi-Signal Busform LA Waveforms

Busform waveforms can contain group value readouts. If the width between transitions is sufficient, a
value is displayed. If the width is not sufficient, no readout is shown in that segment. The readout is
displayed in the selected radix.

Acquired glitches are displayed directly behind the affected waveform. Glitches are displayed as vertical
lines in the glitch color. Glitches are drawn as if they were behind the waveform and any readouts. Disable
the display of glitches using the Waveform Window tab, which is located in the Waveform Properties
dialog box.

TIP. To display no more than one data sample per display point, add a sample waveform from the same
data source and decrease the time per division until you can see individual clock tick marks.

Waveform height is set from the Waveform tab, which is located in the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by setting up the
busform to use a TSF symbol table with color.

Related Topic

Sample Waveforms (see page 212)

Multi-Signal Magnitude LA Waveforms

Overview

In Magnitude mode, the vertical placement of a data point in waveforms represents the numeric value
of the group. By default, the possible range of values (determined by the group width) is scaled to the
selected waveform size.

Behavior

When the time per division is decreased, waveforms are horizontally expanded, using linear interpolation
to create display points between the acquired sample points. A vertical value is calculated for every
horizontal time point between the acquired data points.

When the time per division is increased, waveforms are horizontally compressed and decimated. The
minimum and maximum values are used as the endpoints of the vertical line that represents the data values
for that time point. The cursor readout displays the value of the top endpoint.

If you compress the waveform, the minimum and maximum values at each display point are displayed to
create a vertical line at each horizontal data point.
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To Use

Change the waveform minimum and maximum values by accessing the Waveform tab, located in the
Waveform Properties dialog box, and clicking the Options button. Select the radix used in cursor
measurements.

TIP. 1o display no more than one data sample per display point, add a sample waveform from the same
data source and decrease the time per division until you can see individual clock tick marks.

Waveform height is set in the Waveform tab of the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by setting up the
busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms (see page 212)

Sample Waveforms

Select sample waveforms in the Add Waveform dialog box. Each module has its own sample waveform.
A sample waveform consists of a row of short vertical marks on the time axis at each display point that
represents an actual acquired sample for the module.

When the display is expanded, points without a sample are empty. When the display is compressed, the
sample waveform looks like a thick horizontal line.

Two time stamp values are displayed at the edges of the sample waveform.
If the sample waveform is the active waveform, the Measurement Bar readouts are empty.

The waveform size is fixed.

Single-Signal LA Waveforms

212

Single-signal LA waveforms have a horizontal resolution of one pixel per displayed point. A displayed
point has three possible states: high, low, or transition. When the sample period and time per division are
set so that one pixel is exactly one sample, every displayed sample is either high or low and may show a
transition vector. When the Time/Div is decreased, the analyzer stretches out the waveform by padding
between the samples. At slower Time/Divisions, the data is compressed.

For example, if the time per division is set so that two acquired samples must be represented in each
horizontal pixel width and both of the acquired samples in a pixel are high, the displayed sample is high. If
both samples are low, the displayed sample is low. If the two acquired samples are a high and a low, in
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either order, the display will be a vertical line representing both samples. At even slower time per division
settings, more acquired samples are represented by each displayed point.

Vertical lines or vertical vectors are drawn at high-to-low and low-to-high transitions.

Acquired glitches are displayed directly behind the affected data points. Glitches are displayed as a vertical
line in the glitch color. Glitches are drawn as if they were behind the waveform. Disable the display of
glitches using the Waveform Window tab, located in the Waveform Properties dialog box.

TIP. To display no more than one data sample per display point, add a sample waveform from the same
data source and decrease the time per division until you can see individual clock tick marks.

Waveform height is set from the Waveform tab, which is located in the Waveform Properties dialog box.

Waveforms can be displayed with user defined foreground and background colors by selecting "Color Same
As" on a LA busform waveform, and then setting up the busform to use a TSF symbol table with color.

Related Topic
Sample Waveforms (see page 212)

Waveform Labels

Overview

Waveform labels serve as handles to mark the waveform location and name of each waveform. The label
allows you to adjust the position and other properties of waveforms.

The waveform name is the logic analyzer group or signal name, the oscilloscope channel name, or the
name for a special waveform type. The name is prepended with the module name when there are multiple
modules, the waveform is included as part of a waveform overlay, and with the file name of the data source
file if the waveform is a reference waveform. If the name will not fit in the label, characters on the left,
which are the most likely to be redundant, are clipped until the name fits in the label.

To Use

Select and drag one or more waveform labels. When you drag a label, a drop marker indicates where the
label will be dropped. If there are waveforms beyond the top or bottom edge of the data area, dragging a
label past that boundary will scroll the display.

Change the width of the label area by dragging the border between the label area and the data area. Change
the height of a label by clicking and dragging its bottom edge. Double-clicking a waveform label opens the
Properties dialog box and displays the Waveform tab, which contains the settings for that waveform.
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Waveform Options

214

Waveform Options allows you to set waveform characteristics that are specific to a waveform type.

Waveform Limits sets the minimum and maximum values that will be displayed in the selected waveform.

Behavior

B Max Value sets the maximum value displayed in the waveform.

B Min Value sets the minimum value displayed in the waveform.

m  For DSO waveforms, Lock to Setup determines if the Max and Min values are reset when the DSO
setup parameters are changed. When checked, the values are reset to the maximum and minimum
values possible with the current range and offset settings. Checked is the default.

m  For LA group waveforms, Lock to Setup determines the minimum and maximum values based on

the number of signals in the group. When not checked, you can specify a subset range of the group
min and max.

LA Waveform Style selects the style of displayed LA data. These controls are disabled unless a single LA
group waveform is selected.

®  Busform displays LA group data as a bus form.
B Magnitude displays LA group data as a graph display (Magnitude mode).
m  Signed data selects whether acquisition data is interpreted as signed or unsigned. Signed data is
only active for magnitude style LA waveforms.
®  Draw Interpolation inserts vectors between data points, thereby approximating a magnitude waveform.
To Use

To change waveform options from the System window, click a waveform data window icon, double-click a
waveform label, click the Waveform tab, and then click the Options button.

Related Topics

Setting Waveform Options (see page 124)

Setting the Waveform Style (see page 84)

Setting the Waveform Limits (see page 85)
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Histogram Window

Overview

Use the Histogram window to set up, capture, and display performance analysis data from an LA module
group, counter, or timer. Each Histogram window displays address ranges and the corresponding counts,
percentages, and histogram bars based on the defined ranges and selected data source.

Before you can acquire and display histogram data, set up the LA module using the LA Setup and LA
Trigger windows. Use the Setup window to set up the groups, sampling, and memory requirements. Use the
Trigger window to set up a trigger program, counters, and timers. You should configure the Setup window
before the Trigger window, because some of the Setup window settings affect Trigger window selections.

Use the New Data Window wizard to create a Histogram window for the first time.

Statistics
The Histogram statistics provide an overview of the data.

B The number of displayed lines depends on the data source. Statistics for a group use only one line.
Statistics for counters or timers use two lines.

B The Percentages Based On list shows the number of data samples depending on whether you select
All Samples (see page 216) or Matched Samples (see page 216).

m  If the data source is a counter or timer, the second line lists the minimum, maximum, and average
values of the counter or timer.

Header Control
Use to resize columns, sort ranges, and specify the magnification value for the histogram bars.

m  Resize columns by dragging and dropping the column separators in the Histogram Header Control.

NOTE. Dragging a column separator behind another column separator may hide a column.

B When ranges are displayed as symbols, sort the ranges by ascending or descending alphabetical
order by clicking the Range heading.

B When ranges are displayed as bounds, sort the ranges by increasing or decreasing lower bounds by
clicking on the Range heading.

B Click the Count heading or the Percentage heading (%) to sort between increasing and decreasing
counts.

B Change the magnification or the histogram bars by clicking on the bar heading and selecting a new
value from the displayed list.
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Data Area

Displays ranges, counts, percentages, and histogram bars.

Resize the data area by turning the toolbar and the statistics on or off.

Split the Histogram window horizontally by dragging the split box from the top of the vertical
scroll bar.

All ranges are displayed in columns. When ranges are used as a timer, the bounds include a time
unit suffix.

A clip indicator (<) in a text column indicates that only part of the row can be displayed. To view
the entire row, resize the column by dragging the column header.

Counts, percentages, and histogram bars are updated as new data becomes available.
Sort ranges, counts, and percentages by clicking the column headers.

Changing the ranges in the Histogram Properties updates the new ranges with zero counts.

Related Topics

Defining Histogram Ranges (see page 221)

Data Source Property Page (see page 217)

Histogram Range Properties (see page 218)

Histogram Window Properties (see page 216)

All Samples

The total number of samples analyzed that matched a define range and all samples that fell outside
of the defined ranges.

Matched Samples

The total number of samples analyzed that matched a defined range. These samples exclude any
samples outside of the defined ranges.

Histogram Window Properties

Overview

Use the Histogram Window properties tab to change and view the properties of the Histogram window.

216
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Behavior

m  Range Labels control the labels in the Range column in the data area. When the ranges are defined
from a symbol file, select Symbols or Bounds. The Symbols selection is unavailable when the ranges
are not defined in a symbol file. There is no limit to the number of symbolic ranges for histogram data.

m  Data Fonts Size selects the size of the data in the Histogram data area. Change the data font size as
necessary to view the data.

B Radix determines the format of range labels when Range Labels is set to Bounds. The Radix is only
present when the data source is a group or a counter.

B Background selects the color of the data area background.
m  Foreground selects the color of the text in the data area.
m  Bar color selects the color of the histogram bars.

®m  Seclecting a different color scheme resets the colors shown. Color schemes are defined in the Colors
page of the Options property sheet.

®  Data is accumulated until you clear the data.
B Analyze live data or saved data.
m  Use up to 32 bits of data in an address group.

B Enable or disable group polarity.

NOTE. Default colors are set in the Defaults page of the Applications Options property sheet, available
from the System menu.

To Use
To display the Histogram Window properties, open a Histogram window, right-click the window and select

Properties, or click (the Property toolbar button), and then click the Histogram Window tab.

Data Source Properties

Overview

Use the Data Source properties tab to display information about the current data source (see page 218) or
to select a new data source for the Histogram window.

Behavior

If you change the groups in the Setup window or if you change counters or timers in the Trigger window,
the histogram data source may become invalid. The data analysis will stop until you define a new data
source or until you restore the current data source.
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The Use Polarity box controls whether or not polarities are applied to the group data.

Changing the histogram data source generates new range definitions; existing counts are lost.

To Use

To display the Data Source properties, open a Histogram window, click (the Property toolbar button),
and then click the Data Source tab.

Select the LA module from the drop-down list. (If the data source is not included in the drop-down list,
click Add Data Source to add data from a saved setup.

Click either the Group (see page 218) or Counter/Timer buttons to use for the histogram data. The name of
the data is displayed in the drop-down list next to the buttons. The button selections are active when valid
data is available based on the groups and trigger setups.

Histogram Data Source

A histogram data source consists of histogram data from an LA module. The data can be from a valid
group or from a counter or a timer defined in the Trigger window. DSO modules and MagniVu data
are not allowed as data sources for Histogram windows.

Histogram Group

A group can consist of a single data channel or up to 32 data channels. Groups are defined in the
Setup window.

Ranges Properties

218

Overview

Use the Ranges properties tab to define the data ranges for the Histogram window. To define ranges,
specify a data source for the Histogram window.

Behavior
B The Default Ranges button creates default histogram ranges based on the data source.

B The Define Ranges Using list specifies how the ranges will be defined: Linear Generation (see
page 219), Log Generation (see page 219), or Symbolic (see page 219).

B The Symbol File button opens the Load Symbol File dialog box to load a range symbol file when using
symbolic range generation. Use the Symbol File list to select one of the loaded symbol files.
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®  The Number of Ranges specifies the number of ranges available with Linear Generation or Log
Generation. When used with Linear Generation, the number or ranges can be changed. The Boundl
and Bound?2 controls determine the maximum number of ranges.

B The Radix controls the format of the Bound1 and Bound2 controls. In Log Generation, the Radix also
controls how ranges are generated. Changing the radix also changes the display radix in the Histogram
Window properties tab. The Radix control is not present when the data source is a timer.

®  The Boundl and Bound2 controls limit the overall boundaries or size of the ranges. The limits depend
on the data source. When used with a symbol file the bounds are limited by the smallest and largest
symbol file boundaries. When used with linear or log generation, the lowest bound is 0 and the
highest bound is limited by the data source size.

®  The Range Size shows the size of a single range when used with Linear Generation.

B Use Time Units to format the timer values.

To Use

To display the Ranges properties, open a Histogram window, click (the Property toolbar button), and

then click the Data Ranges tab.

Related Topics

Defining Histogram Ranges (see page 221)
Load Symbols Options Dialog Box (see page 341)

Linear Generation

The histogram ranges are evenly distributed from the highest range boundary to the lowest range
boundary.

Log Generation

The histogram ranges are distributed over a logarithmic scale.

Symbolic Range Generation

The histogram ranges are defined in a range symbol file. The highest and lowest ranges depend on the
maximum and minimum boundaries for the ranges defined in the symbol file.

Histogram Scale Dialog Box

Use this dialog box to change the scale (magnification) of the histogram bars for the current Histogram
window. Change the scale factor from the Histogram window or from this dialog box.
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To open the Histogram Scale dialog box from the Histogram window, go to the View menu and click Scale.

Histogram Add Counts Dialog Box

Use this dialog box to add data from an LA module or from a saved setup. Select the data from a module
in the displayed list, or click Add Data Source to add data from a saved setup. Select a group, a counter,
or a timer from the group list.

To open the Histogram Add Counts dialog box from the Histogram window, go to the Data menu and
then click Add Counts.

Export Histogram Dialog Box

Use this dialog box to export Histogram window information to a file. Specify the export file path and the
rows of the histogram information. The exported data will be saved in the specified format. The dialog box
uses any export options specified in the Export Histogram Options Dialog Box.

To open the Export Histogram dialog box from the Histogram window, go to the File menu and then
click Export Histogram.

Related Topics

Exporting Histogram Data (see page 73)
Export Histogram Options Dialog Box (see page 220)

Export Histogram Options Dialog Box

Use this dialog box to customize the export histogram operation. Specify file formatting options and how
to export the bounds. Select the label button to export the bounds as a string ("00-FF") or click the numbers
button to export the bounds as two delimited numbers.

To open the Export Histogram Options dialog box from the Histogram window, click Export Histogram
from the File menu, and then click the Options button.
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Measuring Histogram Data

Overview

There are two basic ways of using the Histogram window to analyze data. One is to provide a graphic
overview of the address activity of software execution. The other is to use counters or timers to measure
specific events.

To use counters or timers to measure events, set up the counters or timers in the Trigger window. Select the
data source in the New Data Window wizard when you create a Histogram window or select the source
from the Data Source properties tab for an existing Histogram window.

Viewing Address Activity

To provide an overview of the address activity of a software routine, define a set of ranges (numeric,
logarithmic, or symbolic). Set up the Trigger window to look for data within the defined ranges. The data
is processed and displayed in the Histogram window for the current acquisition.

If you set up the logic analyzer to repetitively acquire data, the sampling errors will decrease over time as
you acquire more data. The resultant data provides a stable display in the Histogram window to view the
overall activity of the software.

Use this method of analyzing data to determine which sections of code are being accessed or not accessed.
You can also determine the time spent in a routine relative to other areas of code.

Measuring Counter or Timer Events

To measure an event, define a starting point, a target event, a counter or a timer, and a stopping point in
the Trigger window. Use the Data Source properties tab to select the counter or timer as the data source
for your analysis. When you acquire data, the Histogram window displays the minimum, maximum,
and average value of the counter or timer data.

Related Topics

Defining Histogram Ranges (see page 221)
Selecting the Histogram Data Source (see page 222)

Defining Histogram Ranges

1. In the System window, click the Histogram data window icon.
2. From the Edit menu, click Properties.

3. Click the Ranges tab in the Properties dialog box.
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From the Define Ranges Using list, click Linear Generation, Log Generation, or Symbols.
If using Symbols, select a symbol file.
Select a radix.

Specify the bounds.

ol A L

Click OK.

TIP. Define the data source before you define the ranges.

Click to open the Properties dialog box.

Click Default Ranges to return to the default range settings.

Selecting the Histogram Data Source

In the System window, click the Histogram data window icon.

From the Edit menu, click Properties.

Click the Data Source tab in the Properties dialog box.

Select the new data source from the list or click Add Data Source to add data from a saved data source.

Select the group or a Counter/Timer source if defined in the Trigger window.

Click OK.

AL

TIP. Click = 1o open the Properties dialog box.

Set up the groups in the Setup window and the counters or timers in the LA Trigger window before you
select a histogram data source.
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Source Window

Overview

The Source window displays source code that you wrote, correlated with the executed (disassembled) code
acquired by the logic analyzer and displayed in the Listing window. Monitor actual code execution and
correlate it directly with your source code statements. The logic analyzer links the Source and Listing
windows, and provides additional tools to help you view the code and data.

Behavior

The Listing window displays an execution trace of the object code derived from the source files. The
relationship between the acquisition data and the specific source is determined by examining the debug
information stored in the executable file that was created by code creation tools such as compilers, linkers
and loaders. The specific file being displayed, the cursor positions, and user-defined marks in the file are
automatically updated as you use the controls in the Source window and the associated Listing window.

The source statements in each of the source files displayed in the Source window have associated address
ranges that define the memory locations occupied by the microprocessor instructions that implement the
statement. The address ranges determine the mapping from samples in the Listing window to statements in
the Source window. The address ranges must be absolute. The Source window does not support code that
is dynamically relocatable. The address group that you use depends on whether you use a disassembler.
The disassemblers typically set up address groups for the specific support package.

Because Source windows interact with associated Listing windows, you may want to display both windows
at the same time. Moving the cursors in the Source window moves the cursors in the associated Listing
window, and moving the cursors in the Listing window moves the cursors in the Source window.

Source Window Structure

The Source window consists of three main components; the Source toolbar, the Source control bar and
the Source data area.

B The Source toolbar provides access for tools to change the appearance of the data area and to search
for data. A Scan Listing field specifies the search direction in the Listing window when you move the
cursors in the Source window.

®  The Source control bar provides means for stepping through data, stepping between marks, and
scrolling through data. These controls directly affect the active cursor in the associated Listing window
and indirectly affect the active cursor in the Source window.

B The source data area displays the contents of the source file. This area is also used to display diagnostic
messages if the Source window is unable to display a source file. When the window displays a source
file, the header displays the path of the file.
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Marks and Cursors

Marks and cursors identify specific statements in source files. Marks consist of horizontal lines and may
include highlighted blocks of text signifying individual source statements.

B Marks you can move are: Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1 and Cursor 2 are located at the top of the
window. The numbers in the readouts indicate the line number position of the cursor in the source file.

®  Only one of the two cursors is active at a time. An active cursor appears as a solid horizontal line; an
inactive cursor appears as a dashed line.

B Marks on the left side of the window are data area marks. These marks are in the part of the source file
that is currently visible in the window. Use data area marks to move within the data area.

®  Marks on the right side are overview marks. These marks show where marks are located within the
entire source file. Use overview marks to move throughout the source file.

m  Marks are only visible in the currently displayed source file. Marks and cursors in other source files
are not shown in the overview area.

®  Double clicking a mark opens the Marks properties tab; assign a unique name to the Mark in the
Mark Name field.

B Add marks using the Add Mark toolbar button. Remove a mark by selecting it and using the Cut
toolbar button. When you add or paste a mark it appears in the center of the display.

B Add a mark at a specific source statement by right-clicking the source statement and then selecting
Add Mark Here from the menu. If the line in the source window contains multiple source statements,
you can add marks to the individual statements.

B Move to any mark, including those is other source files, by using the Go To toolbar button.

B Marks are saved in the Source window with system setups so they can be made available for use
when you load a saved system.

Cursors 1 and 2 Moveable marks used for visual reference and for data

B measurements.

——and =

User mark Usgr-creqted rparks. Qse marks to make specific data

easier to identify and find.

Related Topics

Listing Window (see page 185)

Moving Through Source Files (see page 225)

Symbol Files (see page 335)
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Symbols Dialog Box (see page 340)

Moving Through Source Files

Overview

Move through source files from the Source window or from the Listing window. Moving a cursor in one
window will cause the corresponding cursor to move to a corresponding location in the other window.

Use the Step Forward or the Step Backward buttons to step through source statements in execution order
in the Source window. Use the Next Mark or the Previous Mark buttons to jump to the next or previous
executed source statement that has a user-defined mark.

fod ] | G N
N |

Step F orwand Wext Mark
Step Backward Previous Mark

Use the cursor controls in either window to move the cursors. Move the cursors in either window by
clicking and dragging the cursor handles or by adjusting the cursor list box controls.

For more information on moving the cursors, click one of the buttons below.

B Source-Relative Cursor Positioning
m Listing-Relative Cursor Positioning

Behavior

There are situations when you move the cursor in the Listing window to a location where there is no
corresponding source statement. The cursor in the Source window remains at the current location and
changes the color of the Source window to signify an uncorrelated state (see page 226) exists between
the Source and Listing windows. When this happens click the Step Forward or the Step Backward
buttons to search for an executable source line in the Listing window; this correlates the active cursors
in both windows.

Clicking the Step Forward or Step Backward buttons forces the Listing window to search for a data sample
that corresponds to the next or previous line of executed source code. The line of executed code may be
in a different source file. If this happens, the Source window will display the required file or prompt

you for a path name. The ability to locate source files depends on the Search Path List and Suffix List
defined in the Source Files properties tab.

Related Topics
Step Forward and Step Backward Buttons (see page 227)
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Next Mark and Previous Mark Buttons (see page 227)
Active Cursor Readout (see page 228)
Source Files Properties (see page 233)

Uncorrelated State

The Source window enters an uncorrelated state when the active Source window cursor is moved to a
statement that was not executed and captured in the acquisition memory. An uncorrelated state also
occurs when the active Listing window cursor is moved to a sample with an address for which there is
no corresponding symbol information in the loaded symbol file.

When the Source window becomes uncorrelated, the window displays text in a different color: the
uncorrelated color. Change the color of the uncorrelated state in the Source Window properties tab.

To return the Source window to a correlated state, click the Step Forward or the Step Backward
button in the Source window.

Scan Listing Mode

Overview

The Scan Listing box is used to specify which direction to search in a Listing window when you move the
cursor in the Source window.

Behavior

The following options for the Scan Listing field are available:

Later — The Listing window scans samples executed after the sample identified by the active cursor.
Earlier — The Listing window scans samples executed before the sample identified by the active cursor.

Ask — When you change the position of the active cursor in the Source window, the Scan Listing dialog
appears and prompts you to specify the scan direction.

Auto — The Source window automatically selects the scan direction in the Listing window. The scan
direction is based on the relative position of the new and old cursor.

Moving the cursor between statements in the Source window does not necessarily move the cursor in the
same direction in the Listing window. This can happen, for example, if the statement in the new location
was executed both before and after the statement in the old location, such as when the statement is in a loop.
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Step Forward and Step Backward Buttons

Overview

Use the Step Forward and Step Backward Buttons to trace the order of execution of source statements.
Click the Step Forward button to move to the next executed source statement. Click the Step Backward
button to move to the previous executed source statement.

Behavior

When you click the Step Forward or Step Backward buttons, the Source window tells the Listing window
to search forward or backward beginning at the active Listing cursor for the next or previous executed
source statement. When a match is found, the Listing window positions the active Listing cursor to the
matching sample. The Source window converts the address from that sample to a file name and line
number, and then updates the active Source cursor position to the corresponding source statement. The
statement may be located in a source file that is different than the original displayed file. In this case, the
new file is displayed and the cursor is placed on the proper statement.

A single line in the Source window may consist of more than one statement on a single line, for example:
for (i=0; i < NUM_STATES; i++)

The ability of the Source window to discriminate between multiple statements on the same line depends
on the amount of information provided by the code-generation tools. If there is enough information to
identify multiple statements per line, the Source window cursors will include character highlighting to
identify individual statements on a line.

Related Topics

Moving Through Source Files (see page 225)
Next Mark and Previous Mark Buttons (see page 227)

Next Mark and Previous Mark Buttons

Overview

Use the Next Mark and Previous Mark buttons to move the active cursor in the Source window to the next
or previous user-defined mark position (if any marks have been defined). Next and previous refer to the
execution sequence and not to the position of the mark in the window.

Behavior

The Next Mark and Previous Mark buttons operate similarly to the Step Forward and Step Backward
buttons. However, rather than stepping through every executed statement, efine marks in the Source
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window as breakpoints and then step between marks in execution order to move though the source code.
Use the Next Mark and the Previous Mark buttons to get around loops or acquired code that you are not
interested in viewing.

When you click the Next Mark or Previous Mark buttons, the Source window tells the Listing window
to search for addresses corresponding to the marked source statements. When a corresponding sample
is found, the Listing window positions it’s active cursor to the matching sample. The Source window
converts the address to a file name and line number, updates the active Source cursor position, and then
displays the corresponding source statement.

If the code generation tools provide column information for symbol files, mark individual statements of
multiple statement lines in the source code. Use the Next Mark and Previous Mark buttons to step between
the marks and highlight the individual statements.

The Next Mark and Previous Mark buttons are not active if there are no marks defined in the Source
window.

Related Topics

Moving Through Source Files (see page 225)
Step Forward and Step Backward Buttons (see page 227)

Active Cursor Readout

Overview

The Source window Active cursor readout displays the address of the source statement at the active
cursor. The address shown is the low address bound of the source statement as indicated by the loaded
symbol file, not the value of the address group in the listing window. The radix of the address is always
hexadecimal. If you position the cursor on a nonexecutable statement, such as a comment or white space,
the address of the next executable statement is displayed.

Behavior

Use the Active cursor readout to jump to a new location in the source file. Enter an address in this field and
the active cursor moves to the corresponding statement. If you enter an address that does not correspond
directly to the address of a source statement, the next statement is used and the address adjusted.

Copy and paste the readout value into other locations such as in the event portion of the Clause Definition
dialog in the LA Trigger window.
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Source Files Edit Dialog Box

Overview

The Source window uses a single file name to locate the source files. Use the Source Files Edit dialog box
to specify a list of paths to the locations of source files in the file system. You can also specify a list of
source file suffix entries in the Source Files properties tab.

Behavior

The appearance of the dialog box depends on which option (Search Path List or Suffix List) is selected
in the Source Files properties tab. If the Search Path List is selected, the title of the dialog box displays
Modify Search Path List; if the Suffix List is selected, the title of the dialog box displays Modify Suffix
List. The selection box is blank if you clicked Add to access the dialog. If you clicked Edit to access the
dialog, the selection contains the highlighted entry from the Source Files properties tab.

To Use

When you enter the dialog box to add or edit the search path, enter a path in the Selection field. Often the
source files will be located on a networked drive. Click Browse to specify a search path to the networked
drive or to any other directory in the file system.

When specifying the search path, use an asterisk (*) as the final component of a search path directory.
For example, to specify the following path:
C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character.

For example, the use of an asterisk in the following is invalid:
C:\MySources\*\*
or

C:\MySources\abc*

NOTE. When you specify a search path or file suffix, make sure that the source file you are looking for
has a unique file name or file suffix. When searching for source files it is possible to load the wrong file if
there is another file with the same name and suffix in the directories specified by the search path. The
Source window loads the first file that matches the search criteria.

To open the Source Files Edit dialog box from a Source window, click the Properties toolbar button, click
Source Files, and then click either Add or Edit.
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Related Topic

Source Files Properties (see page 233)

Source Go To Dialog Box

Use the Source Go To dialog box to move in the source code. Double-click a cursor or mark from the
displayed list to go to the mark in the Source window.

To open this dialog box, open a Source window and click fﬁl

Scan Listing Direction Dialog Box

Use the Scan Listing Direction dialog box to specify the direction to search for samples in the associated
Listing window. This dialog box displays when the Scan Listing field in the Source window is set to Ask
and you move the cursor in the Source window by dragging the cursor, adjusting the cursor line number,
or doing a search.

Click << Earlier to search for samples from the present active Listing cursor position towards the beginning
of data. Click Later >> to search forward from the active Listing cursor.

Related Topic
Scan Listing Mode (see page 226)

Source Window Search Dialog Box

230

Overview

Use the Source Window Search dialog box to search for text patterns in the current file or in all source files
identified by the loaded symbol file.

Behavior

When searching for data in multiple files, the search operation follows the order of files as listed in the
Source Window properties tab in the Displayed Source File list. When you search for data in all files and
one or more of the files cannot be found, the Source File Locator dialog box displays asking you to
specify the file location.

If the search is not completed in a set amount of time, the Search Progress dialog box displays the status of
the search operation. Allow the search to continue or click the Abort button to halt the search.
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To Use

To open the Source Window Search dialog box, open a Source window and click i .

Enter an ASCII value in the pattern field and click the search direction. The search string can include
leading and embedded white space. Trailing white space is ignored.

Related Topic

Source Window Properties (see page 232)

Source File Locator Dialog Box

The Source File Locator dialog box appears when a source file cannot be located. This may happen
under the following conditions:

®  When you first attempt to create a new Source window

B When you move the active cursor in either the Source window or the Listing window
B When you do a text search

B When you select a different source file while in the Source Window properties tab

This dialog box appears when the Source window searches for source files and is unable to find the files as
specified in the Search Path List and Suffix Lists specified in the Source Files properties tab.

Specify the path of the source file or click Browse to select a path.

In some cases, there might not be an available source file to load. If this happens, provide an empty
placeholder file to prevent the Source File Locator dialog box from appearing.

TIP. When specifying the search path use an asterisk (*) as the final component of a search path directory.
For example, if you specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character, and the wild card character
may only be used as the last character in the search string. For example, the use of an asterisk is invalid
in the following:

C:\MySources\*\*
or

C:\MySources\abc*
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NOTE. The wild card character may only be used in the source path, and only as the last character in
the search string.

Related Topics

Source Files Properties (see page 233)
Source Files Edit Dialog Box (see page 229)

Source Window Properties

232

Overview

Use the Source Window properties tab to change the appearance and content of the Source window.

Behavior

®  Display Line Numbers turns line numbers on or off. Turn the line numbers off if you need more
room to display the source file.

B Font Size selects the size of the displayed text and the line numbers.

B Tab Spacing specifies the spacing between tab columns.

NOTE. You may need to adjust the tab spacing if the highlighting is incorrect. Use the same tab spacing
values as in the editor that you used to create the source files. If you are unsure of the actual setting, you
may need to experiment with tab settings until the highlighting is correct.

m  Foreground Color specifies the color of displayed text and line numbers.
®m  Background Color specifies the color for the data area background.

B Uncorrelated Color specifies the color of the text in the Source window when the active cursor position
in the Source window does not correlate to the active cursor position in the Listing window.

®  Color Scheme sets the colors shown in the Source window. The color scheme can be user-defined
colors, as specified in the Color tab. Access the Color tab by selecting Options from the System menu.

m  Displayed Source File lists the source file currently displayed in the Source window. To view the
entire path name of the source file, click the About Data tab. The path name also appears in the
source code column header in the Source window.

To Use

To open the Source Window properties tab, open a Source window and click in the toolbar.
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TIP. Double-click the header in the data area to open the Source Window properties tab.

Source Files Properties

Overview
Use the Source Files properties tab to define the location of source files in the file system.

The Source Files properties tab lists the directories to search for the source files in the file system. It also
lists the file suffixes to try attaching to the file names provided by the compiler (used for compilers that
do not include the source file suffix).

Behavior

The Source window uses the file path and file suffix in combination to locate the correct source file. It
searches for the file name in each directory indicated by the file path list in the order specified. If a
file name does not have a suffix, then suffixes from the suffix list are tried until a match is found or all
file path and suffix combinations are exhausted.

B Select Search Path List to specify source file locations; select Suffix List to specify possible file
suffixes.

®  Click Add to add items.
B Click Edit to edit the selected items.
B Click Delete to delete a selected entry from the list.

B Check the box at the bottom of the Source Files properties tab to save the file paths and suffixes
as defaults.

When specifying the search path, use an asterisk (*) as the final component of a search path directory.
For example, if you specify the following path:

C:\MySources\*

The MySources directory and all directories (one-level deep) within MySources will be searched.
However, you cannot use the asterisk as a general-purpose wild card character.

For example, the use of an asterisk is invalid in the following:

C:\MySources\*\*

or

C:\MySources\abc*

Specify the complete absolute (not relative) path name for the file in the Search Path List. Otherwise the
Source window will not locate the source file. Make sure that the source file you are looking for has a
unique file name. When searching for source files it is possible to load the wrong file if there is another file
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with the same name in the directories specified by the search path. The Source window always loads the
first file that matches the search criteria.

The format of the file path information can take the form of a file path, a file path list file, or both. Each
entry is prefaced with either Path: or Path File: to indicate which type of information it contains. For
example:

Path: C:\Program Files\TLA700\Samples\Source Files
Path File: C:\My Documents\filePathList.txt

Note that the file path list can contain numerous file paths, which are searched according to the order in
which the paths appear in the file. In addition, both file paths and file path lists can be listed in the Source
Files tab of the Properties dialog box. In this case, the paths will be searched according to the position of
the entry in the Source Files tab, and according to the order in which the paths appear in the file path list file.

NOTE. When using file path list files to define the location of source files in the file system, either DOS or
UNIX end of line controls are acceptable.

Because some compilers do not include a source file suffix, you may also need to specify the correct file
suffixes in the file suffix list (examples of correct file suffixes are: .c .cpp , and .s). The Source window
always loads the first file that matches the criteria in the file suffix list.

The logic analyzer searches for files using both lists from top to bottom. Therefore, you should place the
most likely search path and file suffix at the beginning of the lists.

To Use

To view the Source Files properties, open a Source window, click in the toolbar, and click the
Source Files tab.

NOTE. The wild card character may only be used in the source path, and only as the last character in
the search string.

Related Topics

Source Files Edit Dialog Box (see page 229)
System Source Files Properties (see page 366)

Source Window Data Properties

Overview

Use the Data properties tab to specify Source window attributes. Specify the Listing window, data source
group (Listing window column), and symbol file.
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Behavior

When working with disassembled data, the quality of a disassembler ’s fetch prediction and queue tracking
will determine the quality of the source correlation. You should consider using Mark Opcode to fix
any disassembly problems across gaps.

TIP. Load your microprocessor support package and set the Listing window disassembly mode to Software
before you create the Source window. The software disassembly mode filters out non-instruction cycles to
make it easier to view and trace data in the Listing window.

To Use
m  Select a Listing window from the list of all currently available Listing windows containing data.

B Select a data source from the selections based on the Listing window. The data source can be data
from an installed module or from a saved data file.

B Select a column (data group) from the selected data source. In most cases, you will want to select a
microprocessor address column. Timestamp columns, Sample columns, and groups without assigned
data signals are not available as data groups for this purpose.

m  Select a symbol file that contains the source code symbols from a list of all loaded symbol files. Valid
symbol files include those that correspond to the data group column (when used with a symbolic
radix). The symbol file can be the executable file that has been compiled and linked for debug or a
TSF format file.

B [fthe symbol file has not yet been loaded, click Symbol File to browse and load a symbol file.

™

To view the Source window Data properties, open a Source window, click in the toolbar, and click

the Data tab.

Related Topic
Tektronix Symbol File Format (TSF) (see page 344)

Source Window Marks Properties

Use the Marks properties tab to format marks in the Source window. Enter comments for any marks that
you have added. Changing a mark in the Source window does not affect the marks in the Listing window.

To view the Source window Marks properties, open a Source window, click in the toolbar, and click
the Marks tab.

TIP. Open this property page by double-clicking a mark in a Source window.
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Source-Relative Cursor Positioning

Overview

Source-relative cursor positioning refers to updating the Listing window cursor position as a result of
changing the position of the active cursor in the Source window.

Behavior

When you move the Source window active cursor to a new statement, the Source window determines
the address range of the source statement based on information from the loaded symbol file. The Source
window uses the Scan Listing mode setting to determine the search direction in the Listing window.

The Listing window searches the acquisition data for a matching address. When the matching address is
found, the active cursor in the Listing window is moved to the matching sample. If the Source window
cursor is moved to a nonexecutable statement, such as a comment, the address of the next executable
statement is used.

To Use

Move the Source window cursor directly in the Source window using the following methods:
B Clicking or dragging the cursor handles

®m  Using the cursor list box controls

®  Entering an address in the Active Cursor Readout

B Right-clicking the mouse and selecting Move Cursor 1 (or 2) Here

B Doing a search

Listing-Relative Cursor Positioning
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Overview

Listing-relative cursor positioning refers to updating the Source window cursor position as a result of
changing the position of the active cursor in the Listing window.

Behavior

When you move the Listing window cursor to a new sample, the active Source window cursor attempts to
move to a corresponding source statement in the Source window. The Source window uses information
from the loaded symbol file to convert the address of the Listing cursor position to a source file name and
statement (line number) location. The Source window then updates the active Source window cursor
position and displays the corresponding source statement.
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To Use

Move the Listing window cursor using the following methods:

®  Clicking the Next Mark or Previous Mark buttons in the Source window

m  Clicking the Step Forward or Step Backward buttons in the Source window
m  Directly by using the controls in the Listing window

® Indirectly by locking cursors to another Listing or Waveform window

Tracing the Execution of Source Code

1. In the System window, click the Source data window icon.

2. Click :I (Step Forward) or :I (Step Backward) to move the cursor to the next or previous
executed statement.

3. The cursors in the Source window, and in the associated Listing window, will advance to the next or
previous executed source code statement.

Getting Out of a Loop in a Source Window

This procedure assumes that you have a Source window and a Listing window open.
1. In the Source window, locate the code for the loop.
2. Position the cursor on an executable statement outside of the loop.

3. Right-click the mouse and click either Move Cursor 1 Here or Move Cursor 2 Here (depending
on which cursor is active).

Setting a Trigger from Source Window Data

This procedure assumes that you have a Source window and a Listing window open.

1. In the Source window, position a cursor on the statement of interest so that the address displays in
the Active Cursor Readout.

2. Select the address in the Active Cursor Readout by double-clicking the left mouse button.

3. Copy the address to the clipboard by selecting Copy Text from the Edit menu, or by typing the
CTRLA+C key combination.

4. Open the Trigger window for the LA module.
5. Click the If-Then button to open the Clause Definition dialog box.
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6. Click Group and paste the address into the group value field by selecting Paste Text from the File menu
or by typing the CTRL+V key combination. The radix for the group value must be set to Hex.

7. Click OK.

When you start the acquisition, the logic analyzer will be set to trigger on the group address.
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Packet Structure Description Language

Overview

Packet Structure Description Language or PSDL is used for describing and creating protocols. It is based
on the Abstract Syntax Notation One (ASN.1). A complete description of the syntax and notation used can
be found in the International Telecommunication Union X.680 document. For a high level overview on
PSDL syntax and notation, select one of the related topics.

Use PSDL to define packet structures in the Protocol Editor pane of the Protocol Designer Window.
The PSDL files have the .spz protocol file suffixes. For more information on PSDL, click on one of
the links below.

Syntax

Overview

Use PSDL to edit standard protocols or create your own. The symbols and conventions used in the PSDL
are described in the related topics. PSDL uses Abstract Syntax Notation One (ASN.1).

An ASN.1 item consists of a sequence of characters listed in the ASN.1 Character table.
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ASN.1 Characters

AtoZ atoz Oto9

General rules for ASN.1 items are as follows:

B PSDL is case sensitive.

®m  Most items appear on a single line and do not contain white space.

®  Line length is unrestricted.

E Jtems in production sequences may appear on more than one line.

m Jtems in production sequences may be separated by white space, empty lines, or comments.

B Jtems must be separated from each other by white space, newline, or comment if the following item
begins with a character that is allowed in the preceding item.

For information on the following syntactical items, click one of the related topics.

Related Topics

ASN.1 Types (see page 247)

Length and Value Expressions (see page 255)
Packet Structure (see page 241)

PSDL Additions to ASN.1 (see page 252)
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PSDL Types (see page 252)

Tags (see page 255)

Miscellaneous Commands (see page 255)
Type Definitions (see page 246)

Value Definitions (see page 254)

Packet Structure Definition

PacketDef: DescrList PacketTypeDef TypeValueDefList (see page 246)

DescrList: empty (see page 247)
| Descr DescrList

Descr: DESCRIPTION "::=" cstring (see page 251)
BIT_ORDER "::=" BitDecodeOrder
| DECODING_RULES "::=" EncRules

EncRules: BER
| BASIC_PER_ALIGNED
| BASIC_PER_UNALIGNED

PacketTypeDef: PACKET "::=" typereference (see page 247)

Operators

The assignment operator (::=) defines a type reference (assigning a name to a type definition):
TypeRefName ::= Type

Type can be another type reference or a basic type (such as BYTE HEX, BIT BIN, or
PSDL _SEQUENCE).

The semantic of a type reference is that it can be replaced by its definition. For example, given

TypeRefl ::= BIT_DEC { LENGTH(4) }

TypeRef2 ::= BYTE_DEC { LENGTH(2) }

TypeRef3 ::= PSDL_SEQUENCE {
fieldl TypeRefl,
field2 TypeRefl,
field3 TypeRef2

}
Packet ::= TypeRef3

The definition of the Packet is equivalent to:

Packet ::= PSDL_SEQUENCE {
fieldl BIT_DEC { LENGTH(4) 1},
field2 BIT_DEC { LENGTH(4) 1},
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field3 BYTE_DEC { LENGTH(2) }

NOTE. In the above statements, fieldl, field2, field3 are the field names of three components that constitute
the Packet Structure.

The field name is required if the value of a field is to be used in the LENGTH expressions of other fields,
for example:

PSDL_SEQUENCE {
Tength BYTE_DEC{ LENGTH(2) } "Length Field",
data BYTE_HEX { LENGTH(length - 2) } "Data Field"

}

It is a good idea to always specify an internal name. It can be omitted, because the standard ASN.1 syntax
allows it to be omitted.

The expression syntax of LENGTH expressions is:

EXpr: "(" Expr ")"
| Expr "+" Expr
Expr "-" Expr
Expr "*" Expr

I

I

| Expr "/" Expr

| Expr "%" Expr

| number

| identifier

| PACKET_LENGTH

| REST_LENGTH

| ALIGN "(" Expr ")"

The "identifier" refers to a field name, PACKET LENGTH is the total length of the frame,

REST LENGTH is the length of the not yet decoded frame, and BYTE HEX { LENGTH(ALIGN(4)) }
tells the decoder to make the field long enough so that it ends on a four byte boundary (for bit strings, the
alignment is counted in bits).

The VALUE expression tells the encoder how to compute the value of a field. For example,

PSDL_SEQUENCE {
dat_len BYTE_DEC { LENGTH(2) } VALUE(LENGTH(data)),
data BYTE_HEX { LENGTH(dat_Tlen) } USER_DATA

}

This specifies that the value of ’dat_len’ is the length of the data field. Because you are in a decoding only
environment, you will never have to deal with VALUE expressions.
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Control Statements

The syntax for a PSDL tag is as follows:

PsdiTag: ’'[’ offset ’,’ Tagval ’]’ or
[’ ABSOLUTE offset ’,’ Tagval ’]’
offset: decimal_value

Tagval: binary_value or hex_value

The units for the offset are bits for binary_value and bytes for hex_value.

The offset is relative to the point in the packet data stream that has to be decoded next, unless ABSOLUTE
is specified, which means relative to the start of the frame. Offsets can be negative, therefore it is possible

to match bits before the point in the packet data stream that will be decoded next. The following example
shows PSDL_CHOICE statements:

IpContents ::= PSDL_CHOICE {

[50 ABSOLUTE, ’00000000000000’B] user_data BYTE_HEX { LENGTH(total_Tlength -
(ihT * 4)) } USER_DATA "Data",

[50 ABSOLUTE, ’x’B] frag_data BYTE_HEX { LENGTH(total_length - (ih1l * 4))
} "Fragment Data"

}

In the above structure, if bits 50 through 63 (counting from 0) relative to the start of the frame are all zeros,
then user_data is selected, otherwise frag_data is selected.

The PSDL_CHOICE statement can be used like an If-Else statement. You cannot refer to fields directly in
PSDL_CHOICEs. In other words, you cannot use field names here.

Avoid a given number of bytes or bits in a packet being decoded by skipping the bytes or bits in the
packet data stream.

To skip bits or bytes, use the key word NODISPLAY. NODISPLAY means that the field is not shown in
the monitor window. It can be used as follows:

BIT_BIN { NODISPLAY LENGTH(3) }

This skips three bits from the point in the packet data stream that was already decoded, and continues
decoding.

BYTE_HEX { NODISPLAY LENGTH(1) }

This skips one byte from the point in the packet data stream that was already decoded and continues
decoding.

Loop Statements

Decode fields with loop statements using the UNTIL (’xxxx’H) statement. You can have up to 4 bytes
within the UNTIL statement.
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Phrase: :=BYTE_ASCII { UNTIL(C’ODOA’H) }

This statement tells the compiler to start decoding the packet data from hexadecimal bytes to ASCII
characters until it sees the data ‘0x0D’ immediately followed by ‘0x0A’.

Use the UNTIL statement in PSDL octet/bit strings instead of the LENGTH expression. The UNTIL
statement specifies that the field extends up to the point where the UNTIL pattern matches. The following
example shows a field that extends up to (and includes) the next CR/LF.

BYTE_ASCII { UNTIL(’ODOA’H) }

The UNTIL statement can also be used for PSDL_SETs to specify where the set ends. The following
example shows a set of ElemType fields that end at the first null byte (not part of the set).

PSDL_SET UNTILC’00’H) { [0, ’xx’H] set_elem ElemType }

This can be mixed with a LENGTH expression. For example:

PSDL_SET OF LENGTH(10) UNTILC'00’H) { ... 1}

This means the set ends either after 10 octets or if a null byte is encountered, whichever happens first.

The UNTIL statement can also be used with a PSDL_SET statement as

HeadSet ::= PSDL_SET UNTIL(’ODOA’H)
{

[0, ’xx’H] param_1line ParamLine

3

ParamLine: :=BYTE_ASCII { UNTIL(’ODOA’H) }

The above statement sets a loop for the ‘ParamLine’ field type, which continues until the packet data
equals ‘0x0D’ immediately followed by ‘0x0A’.

Sample PSDL Program

244

The following sample program and its explanation are intended to give you a high-level overview of a
protocol definition file in PSDL.

For the purposes of this example, assume that the Packet A structure below has two header fields, Address
and Length, followed by the Information field.

Address Length Information
1 byte 2 bytes variable Tength (rest of frame)

The protocol definition file is shown below.

DESCRIPTION: := "Packet A"
DECODING_RULES: :=BER
PACKET: := PacketA
PacketA::= PSDL_SEQUENCE {
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address Address "Pkt_Address",
length Length "Pkt_Length ",
info Information " Pkt_Information "

b
Address::= BYTE_HEX{LENGTH(1)}
Length::= BYTE_HEX{LENGTH(2)}

Information::= BYTE_HEX {LENGTH(REST_LENGTH)}

Packet Description

The DESCRIPTION is assigned to the packet description string that specifies the protocol name whose
definition is written and other details such as: RFC details, Standard details, or Version details. The
description string appears with the protocol filename in various "Protocol Designer" dialog boxes (Open
Protocol dialog, Save Protocol dialog). Refer to Packet Structure Definition below for information
on specifying the description.

Decoding Rules

This is an optional field. The DECODING RULES:s assigned to the type of decoding rules. Refer to
Packet Structure Definition below for information on specifying the description.

Packet Structure Definition
Consider the following line of code:
PACKET: := PacketA

This statement specifies which type in the type definition list defines the packet structure. If this statement
is omitted, the first type definition is considered to be the packet type (in this example the PACKET
statement can be omitted).

Consider the next few lines of code:

PacketA::= PSDL_SEQUENCE {
address Address "Pkt_Address",
length Length "Pkt_Length",
info Information "Pkt_Information"

}

In the preceding code, the PacketA structure is defined as having the following three fields: "address",
"length", "info". The address field is of type "Address" with field label "Pkt Address". Similarly, the

length field is of type Length with field label "Pkt Length" and the info field is of type "Information"

with the field label "Pkt Information".

For more information, refer to Protocol Stack, SPZ Files, Packet Structure Overview (see page 259).
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Related Topic
Defining a Protocol (see page 261)

Type Definitions

246

TypevalueDefList:
Typevaluebef
| TypeDefList TypevalueDef

TypevalueDef: TypeDef
| valueDef (see page 254)

TypeDef: typereference (see page 247) "::=" AsPhType
| DefaultTag

DefaultTag: EXPLICIT TAGS
| IMPLICIT TAGS
| AUTOMATIC TAGS

AsPhType: AsTag (sce page 255) AsType (see page 247) Open UserbData (see page 255)
| PhType Open UserbData (see page 255)

CompTypeList: CompType

| CompTypeList "," CompType

CompType: NamedType
| NamedType OPTIONAL

| NamedType DEFAULT value
| COMPONENTS OF SsubType

AltTypelList: AltType
| AlTtTypeList "," AltType

AltType: NamedType
NamedType: PhTag OptIdentifier SubType AttributeList

optIidentifier: identifier (see page 247)
| empty (see page 247)

SubType: AsPhType

OptSizeConstraint:
Constraint
| SizeConstraint
| empty (see page 247)
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Type References

Name
The name used for type references is typereference.

Rules
B A type reference consists of one or more letters, numbers, and hyphens.

B The first character must be upper case and a hyphen cannot be used as the last character.

Identifiers

Name
The name used for identifiers is identifier.

Rules
B An identifier consists of any number of letters, digits, or hyphens.
B The initial character is upper case.

B A hyphen cannot be the last character nor be followed by another hyphen.

Empty Item

Name
The name used for empty items is empty.

Rules

B Contains no characters

ASN.1 Types

AsType: AsSequence

| AsSequenceof

| AsChoice

| AsSet

| Assetof

| AsAnyDefbyCase

| Asgllipsis

| AsTerminal
OptConstraintList
| typereference (see page 247)
OptConstraintList
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AsSequence: SEQUENCE "{" CompTypeList "}"

AsSequenceoOf: SEQUENCE OptSizeConstraint OF
OptIdentifier SubType AttributeList

AsSet: SET "{" CompTypeList "}"

AsSetof: SET OptSizeConstraint OF
OptIdentifier SubType AttributeList

AsChoice: CHOICE MsgChoiceInd "{" AltTypeList "}"

OptConstraintList:
empty (see page 247)
| OptConstraintList Constraint

AsTerminal: BOOLEAN
| OCTET STRING
| REAL
| AsInt
| ASEnum
| AsBitsStr
| NullType
| ANY DefinedBy
| OBJECT IDENTIFIER
| NumericString
| PrintableString
| Teletexstring
| videotexString
| visibleString
| IA5String
| GraphicString
| Generalstring
| BMPString
| Universalstring
| UTF8String

AsInt: INTEGER "{" NumberList "}"
| INTEGER

ASEnum: ENUMERATED "{" EnumNumberList "}"

AsBitStr: BIT STRING "{" NamedBitList "}"
| BIT STRING

EnumNumberList: NamedEnumNumber

| EnumNumberList "," NamedEnumNumber

NamedEnumNumber: didentifier (see page 247) EnumNumber

EnumNumber: "(" Intval ")"
| empty (see page 247)
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NumberList: NamedNumber

| NumberList "," NamedNumber

NamedNumber: identifier (see page 247) NamedNumberval

NamedNumberval: "(" signedNumber ")"
| empty (see page 247)

NamedBitList: NamedB1it
| NamedBitList "," NamedBit

NamedBit: identifier (see page 247) " ("number ")"

DefinedBy: DEFINED BY identifier (see page 247)
| empty (see page 247)

AsETlTl1ipsis:
NullType: NULL

Type: BuiltinType
| ConstrainedType

BuiltinType: NullType

ConstrainedType: Type Constraint

constraint: "(" constraintSpec ExceptionSpec ")"
constraintSpec: SubtypeConstraint

ExceptionSpec:
| empty (see page 247)

ExceptionIdentification

ExceptionIdentification:
SignedNumber

SubtypeConstraint:
ElementSetSpecs

ElementSetSpecs: RootElementSetSpec
| RootElementSetSpec "," "..."
| "..." "," AdditionalElementSetSpec

| RootElementSetSpec ", - ,
AdditionalElementSetSpec

RootElementSetSpec:
ElementSetSpec

AdditionalElementSetSpec:
ElementSetSpec

ElementSetSpec:
Unions

Unions: Intersections
| UElems UnionMark Intersections
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UElems: Unions

Intersections: IntersectionElements

| IETems IntersectionMark IntersectionElements

IETems: Intersections

IntersectionElements:
Elements

Elems: Elements

UnionMark:
| UNION

IntersectionMark: "A"
| INTERSECTION

Elements: SubtypeETlements
| "(" ElementSetSpec ")"

SubtypeElements: Singlevalue
| valueRange
| PermittedAlphabet
| SizeConstraint

Includes: | empty (see page 247)

valueRange: LowerEndpoint ".."
LowereEndpoint: Lowerendvalue

| LowerEndvalue "<"
Upperendpoint: Upperendvalue

| "<" UppereEndvalue
LowerEndvalue: value

| MIN
UppereEndvalue: value

| MAX
SizeConstraint: SIZE Constraint
PermittedAlphabet:

FROM Constraint

SingleTypeConstraint:
constraint

valueConstraint: Constraint
| empty (see page 247)

PresenceConstraint:
| empty (see page 247)

Singlevalue: value

250
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ASN.1 Types
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value: Builtinvalue
| Referencedvalue

Builtinvalue: Integervalue
| Booleanvalue
| Characterstringvalue

Integervalue: SignedNumber
| identifier (see page 247)

Booleanvalue: TRUE
| FALSE

Characterstringvalue:
RestrictedCharacterstringvalue

RestrictedCharacterstringvalue:
cstring (see page 251)

SignedNumber: number (see page 251)
| "-" number

Referencedvalue:
Definedvalue

ASN.1 Types

Character String ltem

Name
The name used for character string items is cstring.

Rules
B A cstring consists of any number of graphic symbols and spacing characters.

B A cstring may span more than one line of text.

B Control characters cannot be represented in a cstring.

®  White spaces that appear immediately before or after the end of the cstring have no significance.

Number Item

Name
The name used for number items is number.

Rules
B A number consists of one or more digits.

B The first digit cannot be zero unless the number item is a single digit.
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PSDL Additions to ASN.1

AsAnyDefbyCase: ANY DEFINED BY identifier (see page 247) CASE "{" OptCaseList "}"

OptCaselList: CaselList
| empty (see page 247)

CaseList: CaseElement
| CaseList CaseElement

CaseElement: 1IdentOrNum EN TRY SubType
| Asellipsis

IdentorNum: didentifier (see page 247)
| number (see page 251)

PSDL Types

PhType: PhSequence
| PhChoice
| PhsetLencCnt
| PhSetuntil
| PhTerminal OptConstraintList

PhSequence: PSDL_SEQUENCE "{" CompTypeList "}"
PhChoice: PSDL_CHOICE MsgChoiceInd "{" AltTypeList "}"
PhsetLenCnt: PSDL_SET OF LengthCount "(" Expr ")" oOptuntil

MsgChoiceInd "{" CompTypeList "}"

Optuntil: empty (see page 247)
| UNTIL "(" EndTag ")"

LengthCount: LENGTH
| COUNT

PhsetUntil: PSDL_SET UNTIL "(" EndTag ")" "{" CompTypeList "}"

PhTerminal: MAC_ADR
| IP_ADR

| IPV6_ADR

| SPC

| SLS

| CIC

| BCD_STRING "{" Decod Lengthspec "}"

| BYTE_HEX "{" offset Decod LengthuntilSpec CommSpec "}"

| BYTE_BIN "{" offset Decod Lengthuntilspec CommSpec "}"
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| BYTE_DEC "{" Reverse Offset Decod LengthuntilSpec CommSpec "}"
| BYTE_SDEC "{" Reverse Offset Decod LengthuntilSpec CommSpec "}"
| BIT_HEX "{" Decod LengthSpec CommSpec "}"

| BIT_BIN "{" Decod LengthSpec CommSpec "}"

| BIT_DEC "{" Reverse Decod LengthSpec CommSpec "}"

| SESSION_LI "{" Decod "}"

| ASN1_TAG "{" Decod "}"

| ASN1_LI "{" Decod CommSpec "}"

| BYTE_ASCII "{" offset Decod Lengthuntilspec CommSpec "}"

| BYTE_EBCDIC "{" offset Decod LengthuntilSpec CommSpec "}"

| BREAK_LAYER

offset: empty (sce page 247)
| RELATIVE TO END

Decod: empty (see page 247)
| NONDISPLAY
| NONDEC
| BitDecodeOrder

Reverse: empty (see page 247)
| REVERSE

LengthuntilSpec: LengthSpec
| UNTIL "(" EndTag ")"

LengthSpec: LENGTH "(" Expr ")"

val: hstring (see page 254)
| bstring (see page 254)
| number (see page 251)
| SignedNumber
I

cstring (see page 251)

CommSpec: empty (see page 247)

| COMMENT " (" cstring (see page 251) ")"
| COMMENT " (" CommList "," cstring (see page 251)")"
| COMMENT " (" CommList ")"

commList: Comment

| commList "," Comment

comment: [" val "]" cstring (see page 251)
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Hexadecimal String Iltem

Name
The name used for hexadecimal string items is hstring.

Rules

B An hstring consists of any number of the following characters: ABCDEF0123456789,
preceded by a single quote and followed by ‘H.

B White space and newlines are allowed, but within an hstring have no significance.

Binary String ltem

Name
The name used for binary string items is bstring.

Rules

m A bstring consists of any number of zeros or ones, preceded by a single quote and followed by ‘B.

B White space and newlines are allowed within a bstring, but have no significance.

Value Definitions

valueDef: ddentifier valueNotation

valueNotation: INTEGER "::=" number (see page 251)
| OCTET STRING "::=" hstring (see page 254)
| visiblestring "::=" cstring (see page 251)
| OBJECT IDENTIFIER "::=" "{" ObjIdCompList "}"

ObjIdCompList: ObjIdComp
| ObjIdCompList ObjIdComp

ObjIdComp: identifier (see page 247) Rest
| number (see page 251)

Rest: empty (see page 247)
| Il(ll NumOrId ll)ll

NumOorId: number (see page 251)
| identifier (see page 247)
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Length and Value Expressions

Expr: "(" Expr ")"
| Expr "+" Expr
Expr "-"
Expr "*" Expr

I

I

| Expr "/" Expr

| Expr "%" Expr

| number (see page 251)
I

I

I

I

identifier (see page 247) must not contain
PACKET_LENGTH

REST_LENGTH

ALIGN " (" Expr ")"

Tags

PhTag: "[" Tagoffset Tagval "]"
| "[" Tagoffset ABSOLUTE Tagval "]"
| empty (see page 247)

Tagoffset: Intval

Tagval: hstring (see page 254)
| bstring (see page 254)

AsTag: empty (see page 247)
| "[" class number "]" ImpleExpl

Class: empty (see page 247)
| UNIVERSAL
| APPLICATION
| PRIVATE

ImplExpl: empty (see page 247)
| IMPLICIT
| EXPLICIT

EndTag: hstring (see page 254)
| bstring (see page 254)

Miscellaneous Commands

AttributeList: empty (see page 247)
| Attribute AttributeList
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Attribute: ShortName
| ShortName "/" LongName

| PROTECTED
| MULTIPLE

ShortName: cstring (see page 251)

LongName: cstring (see page 251)

Intval: Sign Unsignedintval

unsignedIntval: number (see page 251)

BitDecodeOrder: MSBF

| LSBF

MsgChoiceInd: empty (see page 247)

| MSG

Sign: "+"

| empty (see page 247)

Open: empty (see page 247)

| OPEN

UserData: empty (see page 247)

| USER_DATA

| USER_DATA " (" didentifier ")"

Reserved Words (Ab to Con)

256

Reserved Words (Ab to Con)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

ABSENT ABSOLUTE ALIGN

ANY APPLICATION ASN1_LI

ASN1_TAG AUTOMATIC BASIC_PER_ALIGNED
BASIC_PER_UNALIGNED BCD_STRING BER

BIT BIT_BIN BIT_DEC

BIT_HEX BIT_LENGTH BIT_ORDER
BMPString BOOLEAN BREAK_LAYER

BY BYTE_ASCII BYTE_BIN
BYTE_DEC BYTE_EBCDIC BYTE_HEX
BYTE_LENGTH BYTE_SDEC CANONICAL_PER_ALIGNED
CANONICAL_PER_UNALIGNED CASE CER

CHOICE CIC COMMENT
COMPONENT COMPONENTS CONDITIONAL
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Reserved Words (Cou to Max)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

COUNT DECODING_RULES DEFAULT
DEFINED DER DESCRIPTION
DISP_GROUP ENCODING_RULES END

ENTRY ENUMERATED EXCEPT
EXPLICIT FALSE FRAME_BEGIN
FRAME_END FROM GENERIC_TYPE
GROUP GeneralString GraphicString
IA5String INDENTIFIER IGNORE
IMPLICIT INCLUDES INTEGER
INTERSECTION IP_ADR IPV6_ADR
ISO646String LENGTH LSBF
MAC_ADR MANDATORY MAX

Reserved Words (Min to Ta)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

MIN MSBF MSG
MULTIPLE NODISPLAY DONDEC
NUL NumericString OBJECT
OCTET OF OPEN
OPTIONAL OVERLAY PACKET
PACKET_LENGTH POS PRESENT
PRIVATE PROTECTED PSDL_CHOICE
PSDL_SEQUENCE PSDL_SET PrintableString
RANGE REAL RELATIVE
REST_LENGTH REVERSE SEQUENCE
SESSION_LI SET SIZE

SLS SPC STATION
STRING T61String TAGS
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Reserved Words (To to Wi)

This topic is a list of reserved words for PSDL. This list represents reserved character sequences. White
space does not occur in these sequences.

TO TRUE TeletexString
UNION UNIVERSAL UniversatString
UNTIL USER_DATA USER_PART_ID
UTF8String VALUE VideotexString
VisibleString WIDTH

Lexical Iltems

258

Overview

In addition to reserved words there are other lexical items used in PSDL. The conventions and syntax
regarding their usage vary based on the item. Click the name for details on each item.

Lexical item Name

Type references typereference (see page 247)
Identifier identifier (see page 247)

Value references valuereference (see page 259)
Module references modulereference (see page 258)
Empty item empty (see page 247)

Number item number (see page 251)
Character string item cstring (see page 251)

Binary string item bstring (see page 254)
Hexadecimal string item hstring (see page 254)

Module References

Name
The name used for module reference items is modulereference.

Rules
® A module reference consists of one or more letters, numbers, and hyphens.

B The first character must be upper case and a hyphen cannot be used as the last character.

B A module reference is distinguished from a type reference by the context in which it is used
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Value References

Name
The name used for value reference items is valuereference.

Rules

B A value reference consists of any number of letters, digits, or hyphens and is distinguished from
an identifier by the context in which it is used.

Protocol Stack, SPZ Files, Packet Structure Overview

The PSDL programming is similar to ASN.1 programming that defines a protocol definition. The protocol
file has the .spz file extension.

Prerequisites

To write protocol files, you need to be familiar with the following concepts:

The protocol stack definition to which the packet structure maps; the stack definition should follow
the packet structure.

The packet structure that encapsulates the protocols of higher layers

Knowledge of all fields of the protocols mentioned in the stack and the relation between protocols

Protocol Stacks

A protocol stack is made up of protocols at different layers. The most common four layers in a network

stack are:

®  Link Layer

m  Network Layer

B Transport Layer

m  Application Layer

Stacks are defined using the protocol layers. Each layer (box) is a protocol. There can be many protocols
in a given layer. For example, transport layer protocols are TCP and UDP, and link layer protocols are
PPP and Ethernet.
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RIF_R1 DNS_R1 SHKP_R1
Errre—— e ———

Differences Between Link Layer Packets and Packets at Higher Layers

A link layer packet structure maps an entire protocol stack. The link layer packet header contains the
network layer packet headers. The network layer packets contain the transport layer packet header and the
application header and data.

Other packets (above Link layer) map a part of the stack. For example, a PPP packet is a link layer
protocol that maps the entire stack, and a TCP packet is a transport layer protocol that maps a part of the
stack file (TCP->Telnet, TCP->FTP).

What is Defining a Protocol?

Defining a protocol means writing the protocol packet header definition using PSDL. Each protocol file
in the stack has the .spz extension. For example, a PPP protocol file definition consists of the following
PPP header fields: Flag, Address, Control, and Protocol. Similarly, an Ethernet protocol file definition
consists of the following header fields: SFD, Destination, Source, and Type/Length. A TCP protocol file
definition consists of TCP header fields.

Defining a Protocol Structure

Use a top-down approach to define the packet structure. Note all of the possible packet formats that map
the stack. For example, consider the stack in the last illustration.

The possible packet formats of PPP frames are shown below (the square brackets refer to a packet header
that contains another packet):

m PPP[IP[ UDP [ HTTP ]]]. In this example, PPP encapsulates an IP header, which in turn
encapsulates a UDP header. The UDP header encapsulates HTTP.

®m PPP[IP[UDP[SNMP]]]
= PPP[IP[TCP[FTP]]]

= PPP[IP [ TCP [ TELNET ]]]
= PPP[IP[UDP[DNS]]]
= PPP[IP[UDP[RIP]]]
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Start defining the protocol by writing the .spz file in the Protocol Editor.

Related Topic
Defining a Protocol (see page 261)

Defining a Protocol

Use the following guidelines to define a protocol:

Describe the protocol

Normally, this will be a single string assigned to the DESCRIPTION keyword using the following syntax:
DESCRIPTION: :=<string>

For example:
DESCRIPTION: :="IP - Internet Protocol, RFC791"

Specify the Decoding Rules
In the next few lines, specify the decoding rule using the DECODING RULES keyword.
DECODING_RULES ::= <rule name>

The rule name can be one of the following: BER, DER, CER, BASIC PER ALIGNED,
BASIC PER_UNALIGNED, CANONICAL PER_ALIGNED, or CANONICAL PER UNALIGNED.

For example:
DECODING_RULES ::= BER

Consider the following stack definition:
Protocol4

Protocol3

Protocol2

MyProtocol

The bottom-most layer is MyProtocol. A MyProtocol packet encapsulates higher layer protocols in the
data field (the packet header consisting of Protocol2, Protocol3, and Protocol4).

Start writing a protocol definition for MyProtocol using PSDL.
DESCRIPTION: :="IP - Internet Protocol, RFC791"
DECODING_RULES ::= BER

Hand the Length of the Protocol Packet to the Protocol Layer
To hand the length of the MyProtocol packet to the MyProtocol layer, use the following syntax:

PACKET ::= PSDL_SEQUENCE OF LENGTH " ("PACKET_LENGTH")" "{"PacketName"}"
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Specify the PacketName. It can be the protocol name with a Packet suffix (for example, HTTP_Packet, or
IP_Packet). The following example uses MyProtocol Packet as the PacketName:

PACKET ::= PSDL_SEQUENCE OF LENGTH ( PACKET_LENGTH ) { MyProtocol_pPacket }

Further Define the Packet Using PSDL Structures

Continue defining the packet using the following syntax:

PacketName ::= PSDL_SEQUENCE
II{II
<field name> <type name> <field label>
ll}ll

The <field name> variable is a user-defined string starting in lower case letters. This variable is optional
and is used to improve the readability of the specification.

The <type name> variable is a user-defined string for the field type and begins with an upper-case letter.

The <field label> variable is an optional user-defined string (normally the packet field name) that will be
displayed in the field column of the decode view.

For example:

MyProtocol_Packet ::= PSDL_SEQUENCE
{
fieldl Fieldl "Fieldl",
Tength Length "Length",
address Address "Address",
type Type "Type",
payload Payload "Payload"
}

In the example above, MyProtocol Packet is a structure with five components. The first component

is called field1 (starts with a lower-case letter) and denotes the data type field Fieldl (starts with an
upper-case letter). The second component is called length and denotes the data type field Field1. Here
the packet decoder takes the data bytes from the packet at the beginning of the packet and relates them
to the defined MyProtocol structure. It takes the first byte at the beginning of the packet, relates it to
Fieldl, the next byte to Length, the next two bytes to Address, and the following nibble to Type. It then
assigns the remaining items to Payload.

Specify the Type and Size of Each Field
Specify the type and size of each field as shown below:

Fieldl ::= BYTE _HEX { LENGTH(1)} Length ::= BYTE _HEX { LENGTH(1) } Address ::=
BYTE_HEX { LENGTH(2) } Type ::= BYTE_BIN { LENGTH(4) } Payload ::= BYTE_HEX { LENGTH
(REST_LENGTH) } USER_DATA

In the above example, Fieldl is a byte-oriented data type (BYTE_*) with the size of one byte. Similarly,
Length and Address are byte-oriented data types with the sizes of one byte and two bytes. Type is a
bit-oriented data type (BIT *) with a size of four bits. The Payload data type is a byte-oriented hex
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string within the MyProtocol layer. When you tag the Data field with USER_DATA, this indicates that
the contents of the field have to be handed to the next protocol layer.

The line BYTE_HEX { LENGTH (REST LENGTH) } USER DATA means hand the rest of the frame to
the next protocol layer (for example, Protocol2).

Note that PACKET LENGTH and REST LENGTH can only be used in length expressions such as:
TypeBla ::= BYTE_HEX {LENGTH(REST_LENGTH) }

Related Topics

Sample PSDL Program (see page 244)
Create New Protocol Files (see page 287)

TLA Online Help 263



Packet Structure Definition Language (PSDL) Defining a Protocol

264 TLA Online Help



Protocol Analysis Protocol Window

Protocol Window

Overview

The Protocol window supports protocol decoding across multiple levels of a stack. Use the Protocol
window to view and evaluate acquisition data. The Protocol window has three panes: Packet View, Decode
View, and Hex View. Each pane displays the acquisition data at different resolution levels. To open a
Protocol window from the Window menu, click New Data Window and then select Protocol from the list.

Acquisition data is typically analyzed one block of samples at a time. This makes the analysis faster and
uses less memory. The range of samples currently analyzed is displayed in a readout in the Packet View
title bar. To change the position and size of the block of samples to analyze, go to the Protocol Framing
Options properties tab (see page 271).

NOTE. Load either a protocol support package into your system or a user-defined framer before you can
add a Protocol window. The Protocol window requires the framing setup from the protocol support
package or user-defined framer to display the protocol.

Packet View

The Packet View displays all the packets of the current acquisition along with the Time stamp information.
Erroneous packets are displayed in red.

Marks

Marks in the Packet View pane help you to navigate through the data displayed in that pane. There are two
cursor marks, a System Trigger mark, and an unlimited number of user-assigned marks. Marks are used to
measure time, and mark specific samples for evaluation.

B Add user marks by clicking the “+ button.

B Delete user marks by right-clicking the mark handle, and then selecting Delete from the right-click
menu.

B Marks you can move are Cursor 1, Cursor 2, and any marks you add. The numbers 1 and 2 on the
mark handles denote the cursor marks. Readouts for Cursor 1, Cursor 2, and the time difference (Delta
Time) between the two are located at the top of the data area.

B Marks on the left side of the window are data area marks. These marks are in the portion of the
acquisition that is currently viewable. Use data area marks to move within the data area.

®  The System Trigger mark is fixed, you cannot move it.

B Marks on the right side are overview marks. These marks show where marks are located relative to
the entire acquisition. Use overview marks to move throughout the acquisition. For example, move
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Cursor 1 to a particular sample as shown in the Cursor 1 readout. Click the Go To toolbar button and
select Cursor 1. Right-click the mouse on any overview mark, and then click Go To Mark.

B Move to any mark using the Go To toolbar button.

Decode View

The Decode View decodes the protocol parameters of the packet selected in Packet View and displays
them line by line. Each protocol parameter size is displayed as well as any comments contained in the
description file associated with the protocol. The protocol stack that is currently in use determines which
protocol parameters are shown.

Hex View:

Choose one of the following formats to display the packet selected in Packet View in the Hex View pane:
B Hex

B ASCII

= HEX+ASCII

= BINARY

If you select an individual protocol parameter in Decode View, the corresponding values are highlighted in
Hex View.

Related Topic
Protocol Design (see page 279)

Compilation Result Pane

266

Overview

The Compilation Result pane is where the results of compiling are displayed.

Behavior

Double-clicking an error message in the Compilation Result pane highlights the line with the error in the
Protocol Editor pane.

Related Topic
Protocol Editor Pane (see page 281)
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Frames and Framers

The following information provides high-level answers to questions regarding frames and framers.

What is Framing?

Frames are logical groupings of information sent as data layers. Frames are basically data and control
information that flow between link layer devices and physical layer devices. The cells or packets received
from network layers are transformed into frames by link layer devices and passed on to physical layer
devices. This entire process is known as framing.

What is a Generic Framer?

A generic framer is an application that processes acquired data from the logic analyzer (data and control
information) from any bus that carries packetized data. It works on any type of bus that connects the
link layer and physical layer devices.

What is a Bus-Specific Framer?

A bus-specific framer is an application that processes acquired data from the logic analyzer (data and
control information) from a particular bus that only carries packets. Tektronix supplies framers for the
SPI-3 TX and RX , SPI-4.2 LVDS, and LVTTL TX and RX buses.

What is the Difference Between Generic Framers and Bus-Specific Framers?

Bus-specific framers require their corresponding support packages. The packets created by the bus-specific
framers are exact packets. Generic framers add more information to the packets that need to be decoded
using protocol definition files. As a result, you may not get exact packets if you use a generic framer.

What are the Limitations of the Generic Framer?
The generic framer has the following limitations:

B Scrambling is not supported.

B Fragmentation is not supported.

B Encoded data will be framed "as is."

®  Transmit and receive busses cannot be linked.

B Only multiples of 8-bit bus widths are supported.

®m  In some cases, additional information is added to the packets depending on the specified field
conditions. You can further decode the packet using protocol definition (Protocol Designer).
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When Should You Use the Generic Framer?

When setups do not have associated bus-specific framers, the Define Bus check box in the New Protocol
Window wizard is automatically selected. If a specific framer is available, the Define Bus box is cleared.
However, you can enable the check box even if a specific framer is available.

Use the generic framer when the information (cells, packets, and control words) flowing on a bus is
captured and framed by the logic analyzer. The Protocol window displays the decoded framed packets.

Protocol Filter Setup Dialog Box

Overview

The Protocol Filter Setup dialog box allows you to selectively filter specific packets from the acquired
data. Choose to filter all packets based on the protocols and their fields.

Behavior

The filter options are active when you select the Enable Filter check box. This dialog box contains all
the Filter Options: Fields, Operation, Value, and Format. Select an item from the Fields, identify the
Operation, and specify the Value and the Format.

The Protocol drop-down list shows all the protocols contained in the stack. When you select a protocol,
its fields are listed in the Field box. When you select an item from the Field box, its value (if any),
is displayed in the Predefined Values.

Select the Enable Fields check box to filter the packets based on the specific fields. If you clear the Enable
Fields check box, filter the data based on the selected protocol.

Specify the values in any of the following formats: Decimal, Hex, ASCII or Binary.

To Use

Click *° (the Filter Setup toolbar button) to access the Filter Setup dialog box.

Use this dialog box to define operations and value for the filter. By default, the filter is not enabled. To
enable the filter, select the Enable Filter check box.

Related Topic
Filtering the Protocol Display (see page 278)
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Protocol Properties: About Data Tab

Overview

The Protocol Properties: About Data tab provides information about the data source used for the active
data window.
To Use

From the Protocol window, click the button and then click the About Data tab. This is a read-only tab.

Protocol Window Properties Tab

Overview

The Protocol Window properties tab allows you to view or change the default settings of Protocol window.

Behavior

Change the background color settings of all three panes and enable or disable the grid lines in the Packet
View pane.

To Use

From the Protocol window, click the button and then click the Protocol Window tab. Click the

Background drop-down list to select a background color. Use the Grid Lines check box to enable or disable
the grid lines in the Packet View and Hex View panes.

Protocol Column Properties

Overview

The Column properties tab allows you to view or change the column settings in the Packet View pane of
the Protocol window.

TLA Online Help 269



Protocol Analysis Protocol Color Properties Tab

Behavior

The drop-down Column list shows all columns from the current acquisition. Select the column that you
want to view or change from the drop-down list. Use the width box to change the width of the selected
column; enter a value or use the arrows to change the width.

To hide a column, clear the Show Column selection. The column properties are retained when you want
to display the column again.

Specify a fixed column color by selecting Fixed in the Color section and then selecting one of the fixed
colors. Use the same color as an existing column by selecting Same As in the Color section and then
selecting the column from the drop-down list.

When you select the time stamp column, use the Time Stamp Reference selection to set the reference point
for calculating time stamps. The Time Stamp Reference selection is only available for time stamp column.

To Use

From the Protocol window, click one of the columns and then click button. The selected column
appears in the Column drop-down list. If necessary select the column that you want to update and use the
other settings in the dialog box to change the column width or color.

Protocol Color Properties Tab

Overview

The Protocol Color Properties tab allows you to view or change the color settings of the protocols in the
Packet and Decode View pane of the Protocol window.

Behavior

The Protocol Color Properties tab lists all the protocols present in the current acquisition and the available
color options. Select a color for each protocol. The selected color is used for display in the Decode View

of the Protocol window. A preview is displayed in the Protocol Properties Color tab. This tab allows you

to set default colors for all the protocols.

To Use
From the Protocol window, click the button, and then click the Color tab. Select the protocol from the

Protocol list. Use the Color for Protocol drop-down list to select the color for the protocol. Click the Set
all to default button to change the color to black for all protocols.
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Protocol Marks Properties Tab

Overview

The Protocol Marks properties tab allows you to view or change the color settings of marks placed in the
Packet View pane. Associate a comment for each mark. The Protocol Marks properties tab lists all the
marks and cursors placed in the Packet View. Selecting Show Hairline allows you to enable or disable
the hairline properties.

Behavior

Marks in the Packet View pane help you to navigate through the data displayed in that pane. There are two
cursor marks, a System Trigger mark, and an unlimited number of user-assigned marks. Marks are used to
measure time and mark specific samples for evaluation.

To Use

From the Protocol window, click the button to display the Protocol Properties dialog box, and then
click the Marks tab. Use the Marks drop-down list to select a mark. Use the color drop-down list to select
the color for the mark. Enter any comments into the comment text box. Use the Show Hairline check box
to enable or disable the hairline properties of the mark.

Protocol Framing Options Properties Tab

Overview

The Protocol Framing Options Properties Tab allows you to set the range of samples in the acquisition
memory to analyze and frame. This tab also allows you to set bus-specific settings, such as the port
address, bus width, and other settings for the packet data bytes that have to be framed. Enter framing
options for the framer support provided for the specific communication bus, such as the port address.

Behavior

Analyzing data can be memory intensive. It is best to analyze acquisition data in blocks of approximately
100, 000. Use the Start and Number of Samples settings to specify the ranges of samples to analyze.
Experiment to find the optimum block size for your situation. The samples are analyzed when you exit
the property sheet.

If the bus definition for acquiring data is user-defined, there are no framing options on the Framing
Options tab.

If you select Frame Across Gaps, the acquisition will not be considered for framing.
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To Use

From the Protocol window, click the button to display the Protocol Properties dialog box, and then
click the Framing Options tab. Enter the port address in the Port Address text box and other options
pertained to the bus-specific framers. Use the Enable Gaps check box to enable and disable gaps.

Protocol Search Dialog Box

Overview

The Protocol Search dialog box allows you to search in the Packet View pane of the Protocol window.

Behavior

This dialog box contains all the Search Options. Select a protocol from the Protocols drop-down list. The
Search Options are: Fields, Operation, Value, and Format. Select an item to search for from the Fields,
identify the Operation, and specify the Value and the Format.

Specify the Value in Decimal, Hex, ASCII, or Binary formats. Clear the Enable Fields check box and
search on the selected protocol. The search is completed once for each packet of data. If the search is
successful, the packet is highlighted in the Packet View pane and the corresponding packet information
displays in the Decode View pane.

To Use

From the Protocol window, click the ) button to open the Define Search dialog box.

Use this dialog box to define operations and specify the value for the search. Select either <<Back or
Forward>> buttons to search before or after the current cursor position.

Export Protocol Data Dialog Box

272

Overview

The Export Data dialog box allows you to export data to a text file in a location that you choose. Choose
options that customize what will be exported.

Behavior

Use the Export Data dialog box to export data from the current Protocol window to an ASCII text file.
Export the following Protocol data:

B All packets from the acquisition
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B A range of packets between two selected marks
B A range of packets between two packet indices

To export the protocol data to a text file, click Options to define the format of the data. The data is saved in
a file with the .txt extension.

To Use

Place the cursor in the Protocol window, and click Data> Export to display the Export Data dialog box.

New Protocol Display Window

Overview

Use this dialog box to create a new Protocol Display window. To access the dialog box from the Window
menu, select New Data Window....

Behavior

Select Data From if you want to use a data source from the current system. If the data source you want is
not listed, click the Add Data Source button to add a data source from the TLA system or logic analyzer
file to the current system. Click the Browse button to search for a desired TLA system file.

Select No data to create an empty Protocol Display window.

Checking the Define Bus check box activates the Select Bus dialog box. Use this dialog box when you
want to select a different bus from the data source. Create a new bus or modify an existing bus to meet
your needs.

NOTE. If your data source does not have a framer associated with it, the Define Bus check box is
automatically selected. Choose an existing bus or define a new one.

To Use

Specify the data source for your new data window or select No data: Check the Define Bus check box to
define your own bus or clear the check box if you want to use the bus from the data source. Click Next,
and then enter a name for the new Protocol window. Click Finish to create the new window.

Related Topic
Creating a New Protocol Display Window (see page 277)
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Select Bus Page

Overview

The Select Bus page allows you to select a Bus from a list of Available Bus Definitions. Create a new bus
or edit an existing bus.

Behavior

Clicking either the New...or Edit... button will activate the Define Bus Dialog Box. Clicking Next
attaches the selected bus to the data source.

To Use

To attach an available bus to your data source, select the bus definition from the list and click Next. If
you want to define a new bus, click New.... To modify an existing bus, select that bus from the list of
available busses, and then click Edit....

Define Bus Dialog Box

274

Overview

Use the Define Bus dialog box to modify an existing bus or create a new one. Select groups from
drop-down lists and then define the data patterns by entering data in the adjacent boxes.

Behavior

The Bus Name text box contains information on a bus that you can edit. For a new bus nter a unique name
in the text box. By default, MyBus displays in the Bus Name text box for a new bus; the text description is
optional. The Field Definition area describes the details of the bus. Use the drop-down lists to define the
field, group name, operation, value, and radix. The Field drop-down list shows all of the groups available
in the Setup window; the group that you select will become the data group of the bus. Use the Group Name
drop-down list to select the group and pattern for the selections for the field selections.

If the packet length is fixed, enter the packet length in bytes in the Packet Length box at the bottom
of the dialog box.

Enter Binary or Hexadecimal values for Data Valid, Error Condition, Start of Packet, or End of Packet.
Use don’t care values.

Fields
B The Data field is a required field.
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®m  The Start of Packet (SOP) is an optional selection. Use it to define the SOP condition of the bus. Enter
the data pattern in the Value box. An SOP or EOP condition is expected for packets.

B The End of Packet (EOP) is an optional selection. Use it to define the EOP condition of the bus. Enter
the data pattern in the Value box. When designing the data groups in the Setup window, you need to
maintain the bit and byte order such that the least-significant byte follows the most-significant byte.

B The Data Valid condition is optional and is used for defining the Data Valid condition of the bus.
®  The Abort Condition is optional and is used for defining the Abort condition of the bus.

®  The Port Address is optional and only applies to the inbound port address. Select any group for the
port address. Enter a mask value for the port address.

B The Port Address Condition is an optional selection. If you enter a port address condition, enter a
port address in the Value box.

To Use

Enter a name and a description for the bus. Use the drop-down lists to define the field, group name, and
operation. If you are comparing the operation against a value, enter the value and the radix. Click the
Add button to add the definition to the list. Modify an operation by selecting the operation, making
the change, and then clicking the Modify button.

Stack Definition Pane

Overview

The Stack Definition pane allows you to create or modify protocol stacks and displays the properties of
the selected protocol. A protocol stack is made up of protocols at different layers. There can be many
protocols at a given layer.

Directly below the Stack Definition pane is the Stack Protocol Information pane, which displays the
properties of the selected protocol within the stack.

Behavior

The Stack Definition pane allows you to open, edit, and save protocol stacks as well as adding and deleting
protocols to a stack. In the Stack Definition pane, define and modify relations between the protocols
in a stack.

The Stack Protocol Information pane displays the properties of the selected protocol in the Stack Definition
pane. The application displays properties of the selected protocol classified as name, description, compile
file name with date and time, source file name with date and time, type of relation, and relation parameters.
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Select Stack Dialog Box

Overview

Use this dialog box to select and apply a stack for the current acquisition.

Behavior

The stack that you select has a relationship between the defined protocols. Select only a single stack. The
stack that you select will be applied to the current acquisition when you click OK. To search for a stack,
enter a stack name in the Search box and then click the Next button.

To Use

From the Protocol window, click Select Stack in the Data menu. Click the stack that you want to use and
then click OK to apply the stack for current acquisition.

Select Stack Page

Overview

Use this wizard page to select a stack from the list of available stacks.

Behavior

Selecting a stack from the list applies the stack to the data source defined in the previous wizard page.

To Use

Select a stack from the list and then click the Next button to continue defining the Protocol window.

Generic Framer Example

276

This example shows how the generic framer works for Utopia3 support packages.

Data Acquisition

The logic analyzer acquires the Utopia signals using synchronous sampling. Data and control signals are
acquired on every rising edge of the clock. The control signals are Enb* and SOC. Set up the Data group
and the Control group on the logic analyzer (as described in the following procedure).
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Framing
1. In the Define Bus dialog box, enter the Bus name, description, and then select the data group.

2. For the Start of Packet (SOP), select the Control group that contains the SOC and Enb* signals. For
example, if the Control group has the Enb* and SOC signals, enter the value of 01 for the SOP (the
Enb* signal is low and the SOC signal is high to show the start of the cell).

3. Enter the packet length in bytes. For Utopia the packet length can be 52, 53, 54, or 56. However the
packet length will be fixed for a system.

4. Acquire the data using the logic analyzer.

The Generic Framer looks for the 01 pattern in the SOP control group. When the pattern is matched,
the framer starts to fill the cells. The data from the present sample is considered as the Start of the cell.

5. Create your own protocol (for example, Utopia3) and stack using the Protocol Designer for further
decoding of the Utopia3 cells.

A typical Utopia3 cell format consists of the Header with 6 bytes followed by the payload with 48 bytes.
The payload is called SAR (Segmentation and Reassembly) PDU (Protocol Data Unit); it will have
AAL type data.

Limitation

You will be unable to decode beyond SAR PDU. (This limitation also applies to Utopia2 and
Utopia3 support packages and dedicated framers for Utopia2 and Utopia3.)

Setting Up the Protocol Window

Follow these steps to set up the Protocol window: This procedure assumes that a support package is
already loaded on the logic analyzer.

1. From the Window menu, select New Data Window or click the New Data Window icon in the toolbar.
2. In the New Data Window dialog box, select the type of data window as Protocol and click OK.

3. Select Data From, and then select a data source from the list. If the source you want is not listed, click
Add Data Source. Select No data to create an empty window.

4. If you want to define a bus to attach to the data source, select Define Bus, or clear the check box
to use the bus from the data source.

5. Select a stack from the predefined list.

6. Enter a name for the new Protocol window and click the Finish button to view the Protocol window.

Selecting Stacks

Follow these steps to select the stack:
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Place the cursor in the Protocol window and click Data > Select Stack.
The Select Stack Dialog Box lists all stack files available in a predefined folder.

Click the stack that you want to apply for the current acquisition.
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Click OK to apply the stack for current acquisition.

Filtering the Protocol Display

Follow these steps to filter the Protocol Display:

1. Place the cursor in the Protocol window and click Data > Filter Setup to display the Protocol Filter
Setup dialog box.

Enable or disable the filter using the Enable Filter check box.
Select a protocol from the Protocols drop-down list.
Select which fields you want to filter from the Fields text box.

Select the operation to be used to compare field values from the Operation group box.

AU T

Specify the value or select predefined values and the format for the selected field. The packets that
have the specified options are filtered and displayed in the Packet View.

.

Clear the Enable Fields selection to filter the packets based on the selected protocol.
8. Click OK.

Viewing Decoded Data in a Protocol Window

Follow these steps to view protocol decoding in a Protocol window:
1. Acquire data or load a reference memory.
2. Ifyou already have a stack defined, create a new protocol window.

3. If you do not have a stack defined, invoke the Protocol Designer window, define the protocols and
compile. If required, use one of the defined protocols from the Add New Protocol dialog boxes under
the stack editor and define the stack.

4. Apply the stack file to the window and define the framer options. The desired packets from the
acquisition (or reference memory) will be framed and decoded.
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Protocol Setup Window Properties

Overview

The Protocol tab allows you to set up the name, description, and the color of the selected protocol.

Behavior

The Protocol tab displays the current name, description, conditions of protocol relations, and the color of
the selected protocol. You cannot change the conditions of protocol relations in this tab page. Select a
display color and set the default color. The Preview pane displays a preview of the selected color.

To Use

1. In the Stack Definition pane, right-click the protocol you want to edit. The Protocol right-click menu
appears.

2. From the Protocol shortcut menu, select Protocol Setup... to display Protocol Setup dialog box.

Protocol Relations Properties

Overview

The Relations tab allows you to define and modify relations between protocols in a protocol stack.

Behavior

The relations are viewed from a higher-order level in the protocol stack and are therefore called "on
top of relations".

Add protocols from the Available Protocols to Current Relations list to create relations between the
protocols. Define the type of relation as Unconditional, Single Parameter, and Raw Data.

m  Use Unconditional to specify that the protocol defined as "on top of" is to maintain all protocol
data without restriction.

B Use Single Parameter if you want the current protocol to receive data only if a certain parameter of the
carrier protocol accepts one or more values. Enter the exact condition in the Name and Value fields.

B Use Raw Data as a condition for transfer of the protocol data. Enter the values of the data frame to be
checked in the Byte offset, Value and Bit offset fields.
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To Use

1. In the Stack Definition Pane, right-click the protocol you want to define. The Protocol right-click
menu appears.

2. From the Protocol shortcut menu, select Modify Relations.... The Protocol Setup dialog box appears,
displaying the Relations tab.

Stack Definition Display Properties

Overview

The Display properties option allows you to set the foreground color for the protocols.

Behavior

Selecting Set to default will change the foreground color of all the protocols to black.

To Use
1. Right-click in the Stack Definition Pane.
2. Select Display Properties.... The Display Setup dialog box appears.

3. Change the properties as necessary.

Protocol Designer Window

The Protocol Designer is an Integrated Development Environment (IDE) that combines the functionality
of a protocol and stack editor with a protocol compiler. There are four panes in the Protocol Designer
window. Two of the panes are editors: the Stack Definition pane and the Protocol Editor pane. In the Stack
Definition pane, add protocols, define a stack, and create relations between the protocols in a stack.

The Stack Protocol Information pane displays detailed information on a selected protocol including the
relations of that protocol in the stack. The Compilation Result pane displays the results of compiling a
protocol. To open the Protocol Designer window, click the Protocol Designer button on the toolbar.
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NOTE. Tektronix recommends that you create and save new protocols and stacks using the Protocol
Designer tool rather than another editor. You should open and edit existing protocol and stack files using
the Protocol Designer. Avoid editing files directly in the Protocol folder and Stack folder.

Protocol Editor Pane

Overview

The Protocol Editor pane allows you to modify existing protocols or create new ones.

Behavior

Use the Packet Structure Description Language (PSDL) (see page 239) for defining and creating the
protocols.

Display several protocols in the Protocol editor at the same time. However, you can only edit or compile
one protocol at a time.

When you compile the protocols from the Protocol Editor pane, the results of the compilation are displayed
in the Compilation Result Pane (see page 266).

NOTE. Tektronix recommends that you use the Protocol Editor pane to edit existing protocol or stacks
rather than using other editors.
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Add Protocol Dialog Box

Overview

The Add protocol dialog box allows you to add protocols from the list of compiled protocol files (.tpa).

Behavior

The list displays descriptions for all available protocols. If you select a protocol description, the associated
protocol description file is displayed below the list.

Enter a search string in the Search field to find a certain protocol.

Click Next to search the list for more protocols that match the search string. When you have reached the
end of the list, the search will continue from the beginning.

To Use
1. In the Stack menu, click Add New Protocol... to add protocols to the stack.

2. In the Add Protocol dialog box, select a protocol to add and click OK.

Replace Protocol Dialog Box

Overview

The Replace protocol dialog box allows you to replace one protocol with a different version of the same
protocol or with a different protocol.

Behavior

The properties (relations and display) of the respective protocols remain the same when replaced with a
different version of the same protocol.

To Use
1. Right-click the protocol you want to replace..
2. From the Protocol shortcut menu, select Replace Protocol... to display the Replace with dialog box.

3. Select the replacement protocol and click OK.

282 TLA Online Help



Protocol Analysis Save Protocol or Stack Dialog Box

Save Protocol or Stack Dialog Box

Overview

This dialog box is used to save a stack or protocol file. To access this dialog box from the toolbar in the
Protocol Designer window, select Save, and then choose either Save Stack As... or Save Protocol As....

Behavior

Saving by using a name from the list causes the previously saved file to be overwritten.

To Use

Type the name you want to use to save the Stack or Protocol file and Click Save.

Open Protocol or Stack Dialog Box

Overview

Use this dialog box to open a previously saved stack or protocol. To access this dialog box from the toolbar
in the Protocol Designer window, select Open, and then choose either Stack... or Protocol....

Behavior

When you select an available stack or protocol file and click Open, the selected file displays in the
corresponding editor pane. Enter a name (either complete or partial) in the Search field and click Next
to search for that file.

To Use

From the Protocol Designer window, click Open and then select either Stack... or Protocol.... Select the
available Stack or Protocol file that you want to open. Search for the file by typing a name in the Search
text box and then clicking Next.

Delete Protocol or Stack Dialog Box

Overview

Use this dialog box to delete a previously saved stack or protocol. To access this dialog box from the
toolbar in the Protocol Designer window, select Open, and then choose either Stack... or Protocol....
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Behavior

When you select an available stack or protocol file and click Delete, the selected file will be deleted
from the editor pane. Enter a name (either complete or partial) in the Search field and click Next to
search for that file.

To Use

From the Protocol Designer window, click Delete and then select either Stack... or Protocol.... Select the
available Stack or Protocol file that you want to delete; select multiple files and delete them in one step.
Search for the file by typing a name in the Search text box and then clicking Next.

Import Stack Dialog Box

Overview

Use this dialog box to import a stack exported from another Tektronix logic analyzer or computer.

Behavior

This dialog box operates the same as most Open dialog boxes except that it looks for Stack files with
the .pde file extensions.

To Use
1. Open the Import Stack dialog box, open a Protocol Designer window.
2. From the Stack menu, select Import.

3. Navigate the file system to locate the stack and click Open.

Export Stack Dialog Box
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Overview

Use this dialog box to export an opened stack and all of the protocols that belong to the stack to a .pde file
and then use the stack and protocols on another Tektronix logic analyzer or computer.

Behavior

This dialog box operates the same as most Save dialog boxes except that it saves Stack files with the
.pde file extension. The Export selection in the Stack menu is disabled if there is no open stack in the
Protocol Designer window.
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To Use

Open the Export Stack dialog box, open a Protocol Designer window.

Open a Stack Definition (click the Open button, select Stack, and select an available stack from the list).
From the Stack menu, select Export.

Navigate to the location where you want to save the file.

Enter a file name and enter comments as needed in the comment box.
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Click the Save button to export the file to the desired location.

Add Protocols

1. From the Stack menu, select Add New Protocol... to add protocols to the stack.
2. In the Add Protocol dialog box, select a protocol to add and click OK.

NOTE. Search for the protocols that you want to add by using the Search field, and then clicking Next
to find the next occurrence of the search string.

Define Relations Between Protocols

1. In the Stack Definition pane, right-click the protocol for which you want to define relations. The
Protocol shortcut menu appears.

2. In the Protocol shortcut menu, select Define Relations. The Protocol Setup dialog box appears,
displaying the Relations tab.

3. Select the protocols from the Available Protocols list and click Add.
4. The Current Relations list displays the added protocols and the existing relations.

5. To remove any protocol from the Current Relations list, select the protocol, and then click the Remove
button.
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6. In the Type of Relation options do one of the following:

= Select Unconditional to specify that the protocol defined as "on top of" is to maintain all protocol
data without restriction.

= Select Single Parameter if you want the current protocol to receive data only if a certain parameter
of the carrier protocol accepts one or more values. Enter the exact condition in the Name and
Value fields. Enter hexadecimal values preceded by 0x or binary values preceded by 0Ob.

= Select Raw Data as a condition for transfer of the protocol data. Enter the values of the data frame
to be checked in the Byte offset, Value, and Bit offset fields. Enter hexadecimal values preceded
by 0x or binary values preceded by 0Ob.

7. Click Up or Down to determine the order of the relations, and then click OK.

Go To Protocol Dialog Box

1. Right-click in the Stack Definition pane. The Protocol shortcut menu appears.
2. In the Protocol shortcut menu, select Go to Protocol. The Go to Protocol dialog box appears.

3. From the Go to protocol drop-down list, select the protocol that you want to view, and then click OK.

Delete Protocols

1. In the Stack Definition pane, right-click the protocol you want to remove. The Protocol shortcut
menu appears.

2. In the Protocol shortcut menu, select Remove Protocol to display a message to confirm the deletion.

3. To delete, click Yes. To cancel, click No.

Define Protocol Setup

1. In the Stack Definition pane, right-click the protocol you want to define. The Protocol shortcut menu
appears.

2. In the Protocol shortcut menu, select Setup to display Protocol Setup dialog box.
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3. In the Protocol tab, do the following:

Change the name of the protocol in the Name text box, if required.

Enter a description in the Description text box.
Use the Color drop-down list to select the foreground color.

Click Default to set the color of the protocol to default.

4. Click OK.

Create New Protocol Files

Create New Protocol Files

1. From the Protocol Designer window, click the New toolbar button, and then select Protocol to open a
blank protocol definition file in the Protocol Editor.

2. Define your protocol in PSDL Language (see page 239).

List the description of the protocol. For example: DESCRIPTION::="IP — Internet Protocol,

RFC791"

Specify the decoding rule to be used. For example: DECODING RULES ::=BER

Define the length of each packet in the protocol. For example: PACKET ::=PSDL_SEQUENCE

of LENGTH (PACKET _LENGTH){ PPP_Packet}

Define the sequence. For example: PPP_Packet::= PSDL_SEQUENCE "{" <field name (see

page 288)> <type name (see page 287)> <field label (see page 288)>"}"

Specify the type and size of each variable in the sequence.

NOTE. Tagging the Payload variable with USER _DATA indicates that the contents of that variable are to
be handed to the next protocol layer.

3. Click the Save toolbar button and select Save Protocol As... to display the Save Protocol dialog box.

4. Type a name for the protocol in the Name field and click Save.

5. Click the Compile toolbar button to compile the protocol. After compilation, the Protocol Designer
saves the protocol in .tpa file format.

NOTE. Any errors in the compilation are displayed in the Compilation Result pane.

Type Name

Type name is a user-defined name for the type of a variable. It always begins with an uppercase
character.
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Field Label

The field label is a user-defined, optional name that is displayed in the Field column of the Decode
view. It is usually the same as the packet field name.

Field Name

The field name is a user-defined, optional field that is assigned to increase the specification readability.
The field name always starts in lower case.

Create New Stack Files
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Click the New toolbar button, and then select Stack to display the Stack Definition pane with the Base
layer and stack protocol information.

From the Edit menu, click Add New Protocol to add protocols to the stack.
In the Add Protocol dialog box, select a protocol to add and click OK.

Create (see page 285) or modify (see page 71) relations between the protocols.

The Stack Definition pane displays the protocol and protocol relations.
To save the stack, select Save Stack As From the File menu. The Save Stack dialog box appears.

Type a name for the stack in the Stack Name field, and then click Save.

Replace Protocol Files

288

In the Stack Definition pane, right-click the protocol you want to replace. The Protocol shortcut
menu appears.

In the Protocol shortcut menu, select Replace Protocol to display Replace with dialog box.

Select the replacement protocol from the Available Protocols list and click OK.
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Deskew Analysis Window

In the toolbar, click the S/H Analysis button.

Overview

The Deskew Analysis window provides the controls necessary for setting up the Deskew Analysis tool,
displaying the analysis results, and applying the results for use with normal acquisitions. The Deskew
Analysis works independently of the current logic analyzer sampling and trigger program settings.
When you set up and perform the analysis, the current sampling and trigger program settings are not
disturbed. However, apply the results to the synchronous sampling selections to improve the ability of
normal acquisitions to find stable data. Apply the Deskew Analysis setup and hold violation settings to
the trigger program violation settings.

Behavior

Use the Deskew Analysis window to select the analysis type, initiate analysis, apply analysis results, clear
analysis results, and reset the setup to factory default settings.
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In addition, use controls in this window to customize the colors of elements contained in the results area.
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Toolbar

Click the Define Setup icon, = , to open the Deskew Analysis Setup dialog box to define a new setup or
edit an existing setup. Once you have defined the setup, close the dialog box and then click the Analysis

Type button % - to select an analysis type. To begin the analysis, click the Analyze button. If you want
to apply the results to one of the synchronous sampling modes, click the Apply button. Similarly when
doing a Setup/Hold analysis, Apply the settings by clicking the Apply button.

Analysis Display Area

The Clock and Scale area displays clock and scale information. A representation of the reference clock 0
point (the point at which the Deskew Analysis reference clock changes) displays on the top, along with a
representation of the analysis range. You can manually set the analysis range from 16 ns before the clock
edge to 8 ns after the clock edge using the controls under the Analysis tab under the Deskew Analysis
Setup Dialog Box (see page 293) (the Clock 0 point is not required as part of the analysis range). The
Clock 0 point enables you to characterize a signal with respect to the reference clock edge. The clock tick
intervals of the displayed search range will reflect the MagniVu resolution of the module being analyzed.

The Analysis Results area displays the Data Valid window or Setup/Hold Violation window analysis
results in graphical format.

Data Valid Window Analysis Mode

In the Data Valid Windows analysis mode, each selected signal is analyzed with respect to the reference
clock edge to determine the regions where the data is stable. This mode determines the transitions between
adjacent MagniVu data samples. If two adjacent samples have the same polarity, they are considered
stable with respect to each other. The Deskew Analysis scans samples throughout the analysis range, two
samples at a time; the results area graphically shows the data valid windows as bars or windows. The bars
or windows appear as elongated eyes. The regions between the data valid windows are regions of invalid
or unstable data (represented by horizontal black lines).

The purpose of the data valid window analysis is to find regions where the data is stable and to pick a
suggested sample point for each analyzed signal. Apply the suggested sample points to the signal setup
and hold settings for synchronous sampling by clicking the Apply button in the toolbar.

After making all of the settings in the Deskew Analysis Setup dialog box, click the Analyze button to start
the data valid window analysis. When the analysis is done, the results appear in the Analysis Display area.
The suggested sample points found by the analysis appear as diamond markers. Readjust the markers by
dragging them or by selecting values to the right of the display area.
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TIP. To set the Deskew Analysis in the data valid window mode, select Data Valid Window Analysis from
the Analysis Type button in the toolbar.

Setup and Hold Violation Window Analysis Mode

In Setup and Hold Violation Window analysis mode, selected signals are collectively analyzed for setup
and hold violations. This analysis mode operates identically to the setup and hold violation trigger
programs that analyze groups for violations. The purpose of the analysis is to determine if the data is
stable in the regions that you analyzed.

The analysis proceeds throughout the defined setup and hold violation window analysis range for each
signal. If any violations are found, they are reported on the entire set of signals being analyzed. Once
the analysis completes, Apply the range settings to the setup and hold violation trigger settings for each
signal in the application by clicking the Apply button in the toolbar.

Change the setup and hold violation range values by doing one of the following:

B Manually dragging each setup and hold violation window bar and resizing it to the MagniVu resolution
of the module being analyzed. (Make sure that you select the Setup/Hold Violation Window check box
in the AutoDeskew Properties (see page 295) dialog box to drag and resize the window bar.)

B Selecting values for each signal in the controls to the right of the display area.

B Using controls in the Deskew Analysis Setup dialog box under the Analysis tab to set the setup and
hold violation range.

Display graticule lines on both the top and bottom of each group’s results by selecting the Show Graticule
option in the Deskew Analysis Properties dialog box.

Tiock B
Channes i'.'ns ’4: ] -’Se'c. -rl rs I!ns -|2rs ;:’m iu. I' ] 5|L"s .}5 I:e 5 { == Hokd

L 1 s el[77e e
23 T | [

TIP. To set Deskew Analysis in the Setup and Hold Violation Window mode, select Setup/Hold Violation
Window Analysis from the Analysis Type button in the toolbar.

Channel Column

The Channel column displays the group, probe, or user name of the displayed signals. The names depend
on how the signal is selected in the Deskew Analysis Setup dialog box.

Suggested Sample Point Column

For each signal, the Suggested Sample Point column displays the position of the suggested MagniVu
sample found by the Data Valid Window analysis. Adjust the suggested position for each signal using
the controls for this column. The Deskew Analysis must be in the Data Valid Window analysis mode to
enable and display this column.
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Setup and Hold Columns

For each signal the Setup and Hold column displays the setup and hold analysis range values used for the
Setup and Hold Violation analysis. Adjust the setup and hold values for each signal using the controls to
the right of the display area.

Deskew Analysis Legend

The legend displays information for the analysis windows. Use the Deskew Analysis Properties window to
change the color associated with any of the analysis windows. Double-click on the colored square for any
item in the legend to open the Deskew Analysis Properties dialog box.
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Related Topics

Deskew Analysis Properties Dialog Box (see page 295)
Deskew Analysis Setups Dialog Box (see page 296)

Load Deskew Analysis Setup Dialog Box

Overview

The Load Deskew Analysis Setup dialog box allows you to load a Deskew Analysis setup from any
saved system setup file. When you select a Deskew Analysis setup, the load operation replaces all the
current Deskew Analysis settings.

Behavior

The operation of the Deskew Analysis Setup dialog box depends on what you select to load. If you select
a module, then the selected setups are added to the module. If you select a setup, then the loaded setup
replaces the one in the Deskew Analysis Setups dialog box.

Use the File Name box to enter the file name containing an Deskew Analysis setup to load or use the
Browse button to browse the file system for a setup. The modules and setup, when found, will be listed in
the Modules and their Setups text box. Select any setup listed in this box. Once you highlight the desired
setup, load the setup by clicking the Load button.

The Modules and their Setups box allow you to highlight a single selection or multiple selections, based
upon the following scenarios:
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B When you select a setup, the Modules and their Setups box allows you to select only one setup and,
once loaded, it replaces the selected setup.

B When you select a module, the Modules and their Setups box allows you to select multiple setups
to be loaded. This operation loads a copy of the selected setups and adds it to the list of setups for
the selected module.

Click the Load button to load your selected Deskew Analysis setups. The loaded Deskew Analysis setup
either creates a new setup or replaces an existing setup. If the Deskew Analysis setup being loaded uses
groups or signals not included in the module, they are discarded and a message informs you of the setup
revision. When loading, a Deskew Analysis setup will overwrite an existing setup; a message informs
you of the impending change. Choose to either continue loading the setup or cancel the operation. Setup
naming conflicts are resolved by appending a number to the setup name.

Related Topic
Deskew Analysis Setup Dialog Box (see page 293)

Deskew Analysis Setup Dialog Box

Overview

Use the Deskew Analysis Setup dialog box to edit the settings of a selected setup, add a new setup, and
specify analysis parameters (such as signals and sampling).

Behavior

The Deskew Analysis Setup box displays all module or instrument names and the name of any setups
they contain. Modules that contain one or more setups are listed in < modulename > - <Deskew Analysis
setup name> format.

Click the New Setup button to open the New Deskew Analysis Setup dialog box, to use to specify a
new setup. To change the name or description of an existing setup, use the Deskew Analysis Setups
Dialog Box (see page 296).

The Deskew Analysis Mode group box allows you to specify the mode in which the setup will be used.
Choose between Manual mode and Custom mode.

The Manual mode allows you to define the Signal setups and the Sampling setups in their respective tabs.
In addition, it disables the Deskew Analysis Configurations box, the Deskew Analysis Settings box,
and the Reload Custom Settings button.

The Custom mode derives the settings from the loaded support package if the package includes Deskew
Analysis support (not all support packages have such support). Selecting Custom enables Deskew Analysis
configurations, Deskew Analysis settings and the Reload custom settings button. Custom is disabled unless
a support package with Deskew Analysis support is loaded in the selected module.

The following selections are available when you select the Custom mode:
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®  Reload custom settings
The reload custom settings button reloads the settings from the loaded support package.
B Deskew Analysis configurations

Deskew Analysis configurations lists all of the configurations defined in the loaded support package.
Create a configuration for each physical configuration of the SUT. If the loaded support package
includes the Deskew Analysis support with multiple configurations, select the configuration from
this list.

B Deskew Analysis settings

Deskew Analysis settings lists all of the settings available for the selected configuration. For each
configuration there will be one or more settings. Each setting defines the signals to analyze, a sampling
specification, and a range over which each signal will be analyzed. Using a custom setting allows
you to override the signals to be analyzed, but there is no way to adjust the analysis sampling or

the data valid window analysis range.

Signals Tab

Use the Signal tab to select the signals that you want to analyze and the signals that will have their data
valid window analysis results applied. The data valid window analysis results are applied when you click
the Apply button and specify the settings in the Apply dialog box.

Use the Signals tab to list signals by group, by probe, or by a user-defined name. Then specify the signals
that you want to analyze by selecting the check box associated with each group or signal in the Analyze
column. To specify the signals for which the analysis results will be applied when you click the Apply
button, select the check boxes associated with each group or signal in the Apply column. To select or clear
all Analyze or Apply check boxes, select the check box located next to the Analyze or Apply column title.
By default, when you select an Analyze check box, the related Show check box is selected.

Sampling Tab

Use the Sampling tab to set up the definitions for the Data Valid Window and Setup and Hold Violations
Window analysis. The Sampling tab contains inputs that you use to specify the clock, clock transition
edge, and qualifiers to use for the analysis.

NOTE. When you choose Custom mode, sampling definitions are derived from the support package.
All the controls that normally display on the Sampling tab are hidden. The system displays a message
indicating that the sampling definitions will be handled by the Deskew Analysis setup you selected from
the loaded support package.

Analysis Tab
Use the Analysis tab to specify parameters for Data Valid Window and Setup/Hold Violation analysis.

The Data Valid Window group box contains the Start (Setup) and End (Hold) controls that specify the
beginning and end of the analysis range for all signals. Positive values represent times before the clock
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edge, while negative values represent times after the clock edge. In the Deskew Analysis Manual mode,
the start and end times are applied to all analysis signals and cannot be adjusted on a per-signal basis. In
the Custom mode, these controls are disabled. However, the individual values show the aggregate analysis
range over all signals specified in the loaded custom setting.

Use the Analysis Quality options to control the amount of time that Deskew Analysis uses to perform

the data valid window analysis. Each selection displays the number of samples tested for each pair of
MagniVu bits within the analysis range. For example, if your logic analyzer has 125 ps resolution, the
number of such tests performed over a 24 ns range is 192. The number of samples that are examined
depends on the Deskew Analysis sampling setting. In Deskew Analysis Manual mode using one clock,
the number of acquisition samples examined corresponds to the number of clock edges. In the Custom
mode, the sampling can be very complex such that the number of acquisition samples does not necessarily
correspond to simply looking at a single clock edge.

The Setup/Hold Violation Window group box includes the Start and End controls that specify the setup
and hold violation window analysis range for all signals. Positive values represent times before the clock
edge, while negative values represent times after the clock edge. These controls are not affected by the
Deskew Analysis Custom settings. Use the Stop Analysis Condition options to specify when to stop the
analysis. Select Run to let the analysis continue until you click the Abort button in the progress dialog box.

Deskew Analysis Properties Dialog Box

Overview

The Deskew Analysis Properties dialog box contains controls that affect the display properties of the
Deskew Analysis window.

Behavior

By selecting properties from this dialog box, you control which windows display in the analysis results
area of the Deskew Analysis window, and the colors used to display them. The property selections will not
display in the window if you do not select the check box.

The Show Graticule box allows you to indicate whether to display the graticule and specify the graticule
color. Define the following settings for the Deskew Analysis window:

B The Invalid Data Region check box allows you to display the invalid data region using the specified
color.

B The Data Valid Window check box allows you to display the Data Valid Window using the specified
color.

B The Suggested Sample Point check box allows you to display the suggested sample point for each
signal using the specified color.

B The Setup/Hold Violation Window check box allows you to display the Setup/Hold Violation window
for each signal using the specified color.
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®  The Current Sample Point check box allows you to display the current sample point for each signal
using the specified color. The actual sample point depends on the current sampling type.

B The Current Sampling Mode group box allows you to select synchronous sampling. The mode you
choose controls the current sample point displayed in the Deskew Analysis window.

Related Topic
Deskew Analysis Window (see page 289)

Deskew Analysis Setups Dialog Box

296

Overview

The Deskew Analysis Setups dialog box displays the setups available in all physical modules. View saved
setups that were downloaded from a module that was loaded from another system.

Behavior

You use the Setups group box to manage Deskew Analysis setups. This includes creating, duplicating,
deleting, and renaming setups. The type of setup you highlight in the Setup box (module vs Deskew
Analysis setup) determines the functionality associated with the following toolbar icons. Right-click a
setup to open a menu to manage the setups.

Click the New button to open the New Deskew Analysis Setup dialog box. Use this dialog box to create
and name a new setup. When a module or an instrument is highlighted in the Setup box, the new setup is
attached to that module or instrument. When a setup is highlighted, the new setup is associated with the

highlighted setup. Use the New Deskew Analysis Setup dialog box to rename an existing setup.

Click the Load button to open the Load Deskew Analysis Setup Dialog Box (see page 292). Use this
dialog box to load a setup from a saved system file. When a module is highlighted in the Setup box, the
loaded setup is added as a new setup to the selected module or instrument. When a setup is highlighted,
the loaded setup replaces the highlighted setup.

When a module is highlighted in the Setup box, the Cut button is disabled. When a setup is highlighted,
clicking Cut copies the selected setup to the clipboard and removes it from the module. You cannot
remove the last setup.

When a module is highlighted in the Setup box, the Copy button is disabled. When a setup is highlighted,
clicking Copy copies the selected setup to the clipboard.

When a module or an instrument is highlighted in the Setup box, clicking the Paste button creates a
new setup from the clipboard contents and attaches it to the selected module or instrument. The logic
analyzer will add an integer to the clipboard setup name; change the description as needed. When a setup
is highlighted, clicking the Paste button replaces the highlighted setup with the contents of the clipboard.
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Related Topic
Load Deskew Analysis Setup Dialog Box (see page 292)

Apply Deskew Analysis Results Dialog Box

Overview

The Apply Deskew Analysis Results dialog box allows you to apply the Data Valid Window analysis
results to current sampling mode or the Setup/Hold Violation Window analysis settings to the setup and
hold storage violation or setup and hold event violation trigger settings. Apply the data valid window
analysis result to only the current sampling mode.

Behavior

The analysis results are applied only to those signals that you select in the Signal Setup tab of the Deskew
Analysis Setup dialog box.

Selecting the Apply Suggested Setup/Hold Window Settings option enables the Sampling Mode box.
Depending on the sampling, the setup and hold alignment values that you specified in the Deskew
Analysis Setup dialog box will be applied to the setup and hold storage violation and event violation. The
suggested sample points are actual MagniVu samples, while the setup and hold alignment values in the
sampling dialog boxes are probe-tip values. Deskew Analysis does the necessary conversion between the
suggested sample points and the setup and hold alignment values. The applied changes will display in
the Deskew Analysis window.

If you select the Four Samples per Clock mode, then the Second Edge Delay group options are enabled.
When you select the Set External Setup/Hold Values, the suggested sample points are used to set the Four
Samples per Clock setup and hold alignment values. The applied changes will display in the Deskew
Analysis window.

When you select Set External Second Edge, the suggested samples are used to set the External Second
Edge Delay values. Deskew Analysis makes the necessary adjustments to the suggested sample point
position to meet the constraints for a second edge delay value if the suggested sample point position
violates those constraints. The applied changes will display in the Deskew Analysis window, but you can
move the suggested sample point positions to meet any constraints.

Selecting the Apply Setup/Hold Violation Settings option disables the Sampling Mode box and Second
Edge Delay group. This option applies setup and hold violation settings. Adjust the setup and hold
settings on a per-signal basis if they are not consistent with the per-signal alignments of the current
synchronous sampling mode.

Related Topic
Deskew Analysis Setup Dialog Box (see page 293)
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Data Measurements Overview

298

Data measurements can be taken on Waveform and Listing windows.

Overview

Select the data measurements that to take on an active window from a list of available measurements.
Data measurement results are displayed in the Statistics page of the Measurement tab and updated each
time you run an acquisition. You can configure data measurements without the acquisition data and
quickly perform counts and averages on your data set. Data measurements can be exported to a file and
saved with your TLA system.

Behavior

When system changes are made that affect the measurement results an icon appears in the Info column
on the Statistics page.

To perform measurement analysis on virtual data, use the Recalc button. Clicking Run does not have any
affect on the measurement analysis results if you are using virtual data.

Changes in the TLA setup or system will effect the data measurements in the following ways:
®  If you delete a group, the measurement using the group is also deleted.

B [f the active window that had data measurements taken on it is deleted from the system, all the
measurements done on that window are also deleted.

B [fyou merge data sources, all measurements taken on that window are removed.
B [fyou return to a default setup, all data measurements are removed.

®  Loading a TLA data window that had data measurements taken, restores the measurements that
were taken on this window.

®  Data measurements to not include suppressed or filtered samples.

B [f the radix of any group is changed, the results and statistics for measurements done on that group
is also updated.
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m  Measurement results are cleared when the module is turned off and Run is clicked.

B [f the module is turned on in the System Window, measurement results are updated when you click
Run.

LA Measurement Setup

Overview

The Setup page contains the controls necessary to add a new measurement. Enable or disable the
measurements listed and specify whether to refresh the measurements results on successive acquisitions or
accumulate results and statistics over multiple acquisitions.

Behavior

The Setup page is affected by the active data window. If no data window is active, then the Measurement
tab is unavailable.

Removing a signal or group from a data window causes the associated measurement to be removed
from the Setup page.

The icons in the Add Measurement group box display measurements that are available to add. Create
new measurements by dragging and dropping the measurement icons onto the data window display area.
These measurements are then added to the Measurement grid. Create measurements by right-clicking
and selecting Add LA Data Measurement from the right-click menu.

For a definition of each measurement, click one of the measurement type buttons:

The Measurements grid contains all the measurements that are added to the active data window.
Selected measurements are enabled. Clearing the Enable check box disables the measurement. When a
measurement is disabled, it will not be computed.

Rename the measurement in the Name column if you so choose. The Source column reflects the signal
or group on which the measurement is done. You cannot edit the Source column. The Gate column
offers three choices: Display, Cursors, and Full Record for gating. Measurement analysis is immediately
performed whenever this column is changed.

The type of measurement gating determines what samples are used in the measurement analysis.

Gating type Measurement analysis

Full Record—spans across the full memory depth Samples in the full memory depth are used for data analysis.

Display— spans across the visible region Samples in the visible portion of the data window are used
for data analysis.

Cursor— spans between Cursor1 and Cursor2 Samples between Cursor1 and Cursor2 are used for data
analysis.

Measurement analysis is performed when:
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®  The Gate option on the Setup page is changed.

B The Gate option is set to Display and you zoom on the active data window.

B The Gate option is set to Display and data is suppressed or suppressed data is shown.

m  The Gate option is set to Display and data is filtered.

B The Gate option is set to Cursors and you change the cursor positions on the active data window.

When measurement analysis is in progress, abort the analysis by clicking the Cancel button. Recalculate
a completed analysis by clicking the Recalc button. This button toggles between Cancel and Recalc,
depending on the state of the analysis.

To Use

Select a measurement by dragging and dropping an icon from the Add Measurement group box to a
data window.

Select the Enable check box from the Measurements grid to enable the measurement. To disable the
measurement, clear the check box. Enable or disable all measurements by clicking the Enable All or
Disable All button. Delete all measurements from the Measurements grid by clicking the Delete All
button, or right-click and delete them individually.

The Clear Values button removes the results. If you want to accumulate results over several acquisitions,
select the Accumulate check box. To refresh the results each time the measurements are analyzed, clear
the Accumulate check box.

Data Measurement Statistics

300

Overview

This page displays the measurement results and statistics for the active data window. When the active
window changes so will the Statistics page. If the active data window does not have any measurements,
then the Statistics page is empty. The measurements are displayed in the order in which they are added.

For a definition of each available statistic, click here (see page 112):

Behavior

Removing a signal or group from a data window causes the associated measurement result to be removed
from the Statistics page.

None of the columns are editable; auto size the column by clicking the right border.

The Info column indicates that the results are outdated due to TLA system or setup changes. Data can
be outdated for the following reasons:

®m  Group definition was changed

B The measurement was aborted while the analysis was in progress
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®  There is no data for analysis

B The results and statistics are cleared

To Use
Click Export to export the data to a file; export in either .TXT or .CSV file format.

To refresh outdated results, click the Run button in the TLA System window to acquire new data or click
the RECALC button on the Measurement Setup page to recalculate the measurements on existing data.

Click the Clear Values button to remove all the measurement results and statistics from the Statistics page.

Graph Window

Overview

Use the Graph window to display data in an X-Y graph format. Use this format to identify valid data in
patterns such as tracking the flow of digitized analog values throughout your target system by looking at
data values written to a set of memory addresses.

Axis readout bars provide information on the data in the Graph window. Customize the readouts using
the Graph Window property page. A legend at the bottom of the graph display provides an overview of
the contents of the Graph window. A progress bar below the legend shows the status of the graph when
it takes time to update the graph data.

Data Series
Graph data is represented by a data series, a collection of related data points plotted in a graph.
®  Each data series in the window can have unique color or patterns.

m  Each data series can have a unique title. Specify the minimum and maximum data ranges for the
series as well as an offset for each axis.

B Add a new data series by clicking the Add Series toolbar button L4

B Remove a data series by selecting it, and then clicking the Cut toolbar button. Paste the removed
data series by clicking the Paste toolbar button.

Marks

Use marks to take measurements, locate triggers, and mark specific events for evaluation.

B Marks you can move are cursors X1, Y1, X2, Y2, and any marks you add. The numbers 1 and 2 on
the marks handles denote the X-axis (vertical) and Y-axis (horizontal) cursor marks. Readouts for
the cursors, and the time differences (Delta Time) between the cursors are located at the top of the
data area.
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Graph Window

B Marks on the top and right sides of the window are data area marks. These marks are in the portion of
the acquisition that is currently viewable. Use data area marks to move within the data area.

B You cannot move System Trigger, Module Trigger, or Begin and End marks.

m  Marks on the bottom and left sides are overview marks. These marks show where marks are located
relative to the entire acquisition. Use overview marks to move throughout the acquisition.

B Double-click a mark to open the Marks properties page. Assign a unique name to the Mark in the

Mark Name field.

B Add marks by clicking

T (the Add Mark toolbar button). Remove a mark by selecting the mark and

using the Cut toolbar button. When you add or paste a mark, it appears in the center of the display.

System trigger

2

Module trigger
T

Begin data and end data
i}

Cursors 1 and 2
Ol M|

User mark
[ Marki ]

Lock Delta Value check box

m  Toolbar Area

The system trigger is the reference point for the acquisition.
Timing and location information is relative to the system
trigger. Trigger marks cannot be moved.

Under some conditions the system trigger associated with a
module’s data might not be displayed in the data window. If
the system trigger was caused by another module, whose
data is not included in the current display, then the system
trigger is not shown. Nevertheless, all time measurements
still relate to that system trigger, even if it is not shown.

The system trigger associated with the current data is called
the active system trigger. The system trigger associated
with saved data is called the reference system trigger.

The active system trigger is indicated by a yellow T; the
reference system trigger is indicated by a gray T.

The point at which the module triggered. Trigger marks
cannot be moved.

The start and end of a module’s data record. These data
marks cannot be moved.

Moveable marks used for visual reference and for data
measurements.

User-created marks. Use marks to make specific data
easier to identify and find.

Click this check box to lock the delta values. When you
lock delta values, the cursors move across the data
simultaneously, maintaining a fixed delta time.

Toolbar buttons allow you to customize the Graph window. Access most of the Graph window

controls directly from the toolbar buttons.
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Graph Window

Click the Add Series toolbar button to open the Add Series
Dialog Box to add a new data series from different data
sources.

Click the Add Mark toolbar button to add a mark to the data
points in the series.

Use these buttons to cut, copy, and paste the individual data
series multiple data series, or marks.

Click the Go To button to open the Go To dialog box to
easily go to a mark or data series.

Click the Properties button to open the Graph window
property pages to change the properties of the data or the
graph.

Click this button to enable or disable the automatic update
tool. When you select Enable Auto Update, the current
data in the window is automatically updated when new
acquisition data is available.

Click the Hit Frequency toolbar button to display the data
points using the colors defined in the Hit Frequency property
page. The color of the data points depend on the number
of hits.

Click the Persistence toolbar button to retain the previous
graph data along with the current graph data.

Zoom Graph window data similar to data in a Waveform
window. The horizontal and vertical axis each has their own
zoom controls. Click on one of the zoom buttons to zoom
either in or out. Click and drag the mouse over the area that
you want to zoom; when you release the mouse button,
zoomed data will appear in the center of the Graph window.

Use the Abort toolbar button to stop the processing of data
in the graph. The data series will not be updated. You may
want to abort the data processing if the data takes too long
to process due to size and other reasons.
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= Add a data series to the graph; add marks; and cut, copy, and paste a data series.

= Enable automatic updates, the hit frequency mode, and the persistence mode by clicking the
appropriate toolbar buttons.

= Use the zoom toolbar buttons to zoom in and out on the horizontal and vertical axis, or zoom to
the current selection. When you use the zoom buttons, the display centers at the current location.

= Click the Abort toolbar button to abort any updates that may take a long time due to the amount of
memory involved with the graph data.

Graph Window Properties

Overview

Use this property page to change the default appearance of the Graph window.

Behavior

Use the controls in this property sheet to help you do the following tasks:

Display the graph graticule
Specify the color, style, and line thickness of the graticule

Specify the minimum and maximum ranges of the X-axis and Y-axis as well as specifying the values
per division

Label the X-axis and Y-axis

Specify the readout radix

Turn the graph readouts on or off

Specify the color of readouts

Specify the background color of the graph

Enable or disable automatic updates of the graph. (Enable or disable the automatic updates by clicking
the toolbar button in the Graph window.)

Series Data Properties

Overview

Use this property page to change the default settings of an individual data series.
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Behavior

Use the Series drop-down list to select the series that you want to display in the Graph window. The text
below the Series List displays the data source (logic analyzer module and slot location). Change the title of
the series by entering a new title in the Title box. Otherwise, you can use the default name.

The logic analyzer obtains the axis data range values from the selected series. Adjust these values or add
an offset value to either axis by entering values in the boxes.

Normalize the data range for each axis. When you normalize the data ranges, you rescale the data in the
ranges. For example, if you normalize all of the X-axis data to 1, all of the data would fall in proportion
to its original values, between 0 and 1. This can be useful when you want to redraw the X-axis and
Y-axis for normalized data series where you want to analyze vector displacement, which uses the origin
of the graph (0,0) as part of the data measurement. The default range values are —1 and 1, but you can
change these values as necessary to meet your needs.

Series Format Properties

Overview

Use this property page to define the appearance of the selected data series.

Behavior

The controls in this property page allow you to select one or more data series to specify the line type and
data point type. Define the color and thickness of the lines or data points. A sample image of the selected
data series gives a preview of the data series format.

To Use

Select the series that you want to change from the Series List. Click the Series Type drop-down list to
select the series type, straight lines with data points, straight lines without data points, curved lines with
data points, curved lines without data points, or data points only. Define the lines as dotted, dashed, or
solid. Select the type of data points, dots, plus signs (+), or asterisks (*). Change the thickness of the lines
and marks as well as specify the colors of the lines and data marks.

If you select a series type without data points, the data point elements are disabled. Similarly, if you select
a series type with data points only, the line elements are disabled.

Hit Frequency Properties

Overview

Use this property page to define the colors for hit ranges.

TLA Online Help 305



Analysis Tools New Graph Data Window

Behavior

This window uses color schemes to help you determine the frequency of hits. The color schemes are
similar to those used by Tektronix TDS oscilloscopes. For example, if you select a temperature color
scheme, colors move from dark (cool) to bright (hot). Alternately, if you select a spectral color scheme, the
colors move from bright to dark. The colors are fixed when you select a predefined color scheme.

The color ranges move from the maximum number of hits to minimum as indicated in the property page. If
you click Invert Colors, the ranges move from the minimum number of hits to maximum.

To Use

Use the drop-down list to select a color scheme. Use the Default button to return the colors to their default
settings. After you close the property sheet, click the Hit Frequency button on the toolbar to display the
data points in the graph based on the number of hits.

New Graph Data Window

Overview

Use this page to create a new Graph window and specify the data source for your new window.

To Use

®  Click Data from to select a data source from the current system. If the data source you want is not
listed, click the Add Data Source button to add one from the TLA system or logic analyzer file to the
current system. Click the Browse button to search for a desired TLA system file.

B Click No data to create an empty Graph window. After the window displays, add data series from
different sources.

Related Topic
Adding a New Series (see page 308)

New Graph Window Select Series

Use this page to specify the X-axis and Y-axis for the new Graph window.
For either axis, select one of the following:
m  Sample Number. Use the drop-down list to select Begin, Trigger, or End.

®  Row Number. This selection is the same as the Sample Number but does not include any gaps due
to filtering.
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B Timestamp. Use the drop-down list to select either an Absolute timestamp or the Previous timestamp.
B Value of Group. Use the drop-down list to select an Address, Data, or Control group.

The axis label will be the same as the type that you specify from the above list. After you set up the new
window, use the Graph Window (see page 301) to further define each axis of the graph.

NOTE. Once you have specified the axis type using the wizard, you cannot change the type without
creating a new Graph window.

Related Topic
Add Series Dialog Box (see page 307)

New Graph Window name

Enter a name for the new Graph window or use the default name. Then click the Finish button to create
the new Graph window.

Add Series Dialog Box

Overview

Use this dialog box to add a data series to the existing graph from different data sources.

Behavior

The default X-axis and Y-axis data sources depend on the initial graph. You specify these when you create
a new data window using the New Data Window wizard.

Add a new series from different data sources such as a logic analyzer module or a reference memory.
However, the data source must be from the same Data Source type. For example, you cannot add an
address group to the X-axis if the Data Source type was set up as a sample number. To change the Data
Source type, create a new Graph window.

The appearance of the dialog box changes depending on the Data Source type. For example, if you defined
the X-axis Data Source type as Row Number, the selection is fixed to that type and is grayed out. If you
defined the X-axis as a group, use the drop-down list to select the individual group or click the Add Data
Source button to search the file system for a group.
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To Use

Define the series for each axis and then click the Add Series button to add the series to the Series list. The
series will be displayed in the form of X-axis versus Y-axis. To remove a series from the graph, select
the series in the Series list and then click the Remove Series button.

To access this dialog box, click the Add Series button in the Graph window toolbar.

NOTE. Ifyou have an empty Graph window and you click the Add Series toolbar button, you will launch
the Axis Type wizard to select the data source, define the X-axis and the Y-axis, before opening the Add
Series dialog box.

Graph Window Go To Dialog Box

Overview

Use this dialog box to locate a mark or a series in the Graph window.

Behavior

Use to scroll the Graph window to a new position by selecting any current mark or series. Select Mark
to display a list of all marks related to the Graph window. Select Series to display a list of all series
related to the Graph window.

To Use

Double-click on the desired mark or series in the list. The dialog box closes and displays the mark or series
in the center of the window.

To open the Go To dialog box, open a data window and then click the Go To toolbar button.

Adding a New Series

308

1. In the System window, click the Graph data window icon.

2. From the Edit menu, click Add Series.

3. Select the Data Source.

4. If the data source you want is not listed, click Add Data Source to open the Add Data Source dialog
box and browse the file system to locate the data source.

5. Select the series and click Add.

6. Click OK.

TLA Online Help



Analysis Tools Taking Cursor Measurements

TIP. Click W to add a series.

Taking Cursor Measurements

In the Graph window use the X and Y cursors to take measurements:
1. Move each cursor to the points you want to measure.
2. The measurements are displayed in the cursor readouts.

3. Use Lock Delta Time to lock the cursors together.

Going to a Specific Series

1. In the System window, click the Graph data window icon.

2. Click b in the toolbar of the Graph window to open the Go To dialog box.
3. Select Series to display a list of all series in the Graph window.
4. Double-click the series that you want to see.

The series that you selected will display in the center of the Graph window.

Going to a Specific Graph Window Mark

1. In the System window, click the Graph data window icon.

2. Click G in the toolbar of the Graph window to open the Go To dialog box.
3. Select Mark to display a list of all marks in the Graph window.
4. Double-click the mark that you want to see.

The mark that you selected will display in the center of the Graph window.

Zooming a Graph

The zoom behavior is controlled by the System Options: Preferences (see page 86) settings. The default
setting is to zoom immediately. Zoom a Graph window three different ways:

B Zoom both the X-axis and Y-axis
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B Zoom the horizontal (X) axis

B Zoom the vertical (Y) axis

To zoom a Graph window using the default zoom setting (immediately), perform the following steps:
1. In the System window, click the Graph data window icon.

2. Click and drag the mouse over the area that you want to zoom. When you release the mouse button,
the Graph window will zoom the area of interest and center it in the window.

Viewing Persistence Data

1. In the System window, click the Graph data window icon.

Click = in the toolbar of the Graph window to open the Graph window property pages.
Click the Series Data tab.
Enter an offset value for the X-axis or Y-axis data range.

Click OK to close the dialog box.

AN S o

Click the Hit Frequency toolbar button to enable the Hit Frequency mode (button should appear
depressed).

7. Click the Run button to start an acquisition.

The number of hits will increase due the overlapping of data on the same region.

NOTE. The Persistence data will not be visible when you resize the Graph window or scroll data in the
Graph window.

iVerify Window
From the toolbar, click the iVerify button.

Overview

iVerify allows you to generate eye diagrams, or voltage/time graphs, for both individual signals and
groups of signals. Use the controls in the iVerify window to set up iVerify; and to analyze, display,
and perform measurements on the eye diagrams.
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iVerify Toolbar

Click the Define Setups icon , 52 , to open the iVerify Setups dialog box to define a new iVerify setup or
edit an existing setup. Once you have defined the setups, close the dialog box and click the Analyze button
to begin building the eye diagram. The eye diagram will be drawn, based on the eye coloration selections
made in the Eye Coloration tab of the iVerify Properties dialog box.

Click the Measurement icon, “** | to display a list of measurements for the eye diagram. Click a
measurement button to perform a measurement on the eye diagram. Click the button a second time to turn
off the measurement. When the measurements are made, the corresponding cursors are drawn on the eye
diagram. In case of histogram, the cursor is drawn on the eye diagram and the corresponding histogram is
drawn on top or left of the eye diagram, depending on whether it is a horizontal or vertical histogram.

Selecting any measurement from the Measurement icon in the toolbar will overlay the measurement
diagram on the eye diagram and display the corresponding measurement tab.

Measurement Information View

This area of the iVerify window provides general information about the eye diagram. In addition, it
provides information about each measurement on the eye diagram. Measurement information parameters
and measurement results are shown in separate tabs.

®  General tab

When analysis is complete, the General tab displays peak-to-peak information. In addition, it displays
information pertaining to your cursor’s present position over the eye diagram such as the time and volt
value, number of hits, and displays the highlighted signal.

® 4 Point Mask tab

The 4-Point Mask tab displays 4 point mask measurement information, such as the mask coordinate
values and the number of hits for each signal within the 4 point mask.

B 6 Point Mask tab

The 6-Point Mask tab displays 6 point mask measurement information, such as the mask coordinate
values and the number of hits for each signal within the 6 point mask.

®  Eye Limit Cursor tab

The Eye Limit Cursor tab displays Eye Limit Cursor measurement information, such as the cursor
position and the eye height and width.

®  Upper Lower Mask tab

The Upper Lower Mask tab displays upper mask and lower mask measurement information, such as
the upper mask voltage value, lower mask voltage value, the number of hits for each signal in the
masking region, and upper violation and lower violation.

®  Slope tab

The Slope tab displays information about the slope measurement such as the upper point coordinates,
lower point coordinates, and slope value.
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®  Horizontal Histogram tab

The Horizontal Histogram tab displays the voltage level of the histogram cursor value. In addition,
it displays information pertaining to the cursor’s present position over the eye diagram, such as the
number of hits for each signal over the time level.

B Vertical Histogram tab

The Vertical Histogram tab displays the time level of the histogram cursor value. In addition, it
displays information pertaining to the cursor’s present position over the eye diagram, such as the
number of hits for each signal at that voltage level.

Display Time and Voltage Ranges

Use the Display Time Range and Display Voltage Range to select the horizontal and vertical display settings
for the eye diagram. These controls do not affect the acquisition of data from the external oscilloscope.

The Min and Max boxes allow you to set the minimum and maximum time value from where iVerify
will plot the data. These boxes allow you to choose start and end points for the eye display from the
data acquired by the external oscilloscope. Use the Min and Max controls to choose the time period of
interest from all data acquired by the external oscilloscope. By default, the external oscilloscope displays
all acquired data.

The Per Div boxes allow you to divide the eye display area into equal horizontal and vertical divisions and
spread the values accordingly.

The Offset box allows you to move the eye diagram to the left or right by the values specified in the Offset
edit controls. Use this offset to measure the time between two points.

NOTE. The Min and Max time controls are relative to the clock shown above the diagram display area.

Related Topics

1Verify Properties Dialog Box (see page 316)
1Verify Setup Dialog Box (see page 314)

iVerify Setups Dialog Box

Overview

The iVerify dialog box displays iVerify setups that are available in all physical TLA7000 Series logic
analyzer modules. View saved iVerify setups that were downloaded from a module loaded from another
system.
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Behavior

Use the iVerify Setups group box to manage iVerify setups. This includes creating, duplicating, deleting
and renaming setups. Right-click an iVerify setup to open a menu to manage the setups.

Click the New button to open the New iVerify Setup Dialog Box. Use this dialog box to create and name a
new 1Verify setup under a selected module. When a module is highlighted in the Setup box, the newly
added iVerify setup is attached to that module.

Click the Load button to open the Load iVerify Setup Dialog Box (see page 313). Use this dialog box
to load an iVerify setup from a saved file. When a module is highlighted in the Setup box, the loaded

setup is added as a new setup to the selected module. When an iVerify setup is highlighted, the loaded
setup replaces the highlighted setup.

When a module is highlighted in the Setup box, the Cut button is disabled. When a setup is highlighted,
clicking Cut copies the selected setup to the clipboard and removes it from the module. You cannot
remove the last setup.

When a module is highlighted in the Setup box, the Copy button is disabled. When a setup is highlighted,
clicking Copy copies the selected setup to the clipboard.

When a module is highlighted in the Setup box, clicking the Paste button creates a new setup from the
clipboard contents and attaches it to the selected module. The logic analyzer will add an integer to the
clipboard setup name; change the description as needed. When a setup is highlighted, clicking the Paste
button creates a new setup from the clipboard contents and attaches it to the selected module.

Related Topics

Load iVerify Setup Dialog Box (see page 313)
iVerify Setup Dialog Box (see page 314)

Load iVerify Setup Dialog Box

Overview

The Load iVerify Setup dialog box allows you to load an iVerify setup from any saved system setup file.
When you select an iVerify setup, the load operation replaces all the settings. However, when you select a
module, a new iVerify setup is added.

Behavior

The operation of the iVerify Setups dialog box depends on what you select to load. If you select a module in
the iVerify Setups dialog box, select multiple setups in their individual setup boxes. If you select a setup in
the Load iVerify Setup dialog box, then the loaded setup replaces the one in the iVerify Setups dialog box.

Use the File Name box to enter the file name containing a module setup or use the Browse button to browse
the file system for a setup. The modules and their setups, when found, will be listed in the Modules and
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their Setups text box. Select any setup listed in this box. After you highlight the desired setup, load the
setup by clicking the Load button. The loaded setup either creates a new setup or replaces an existing one.

If you select a module in the iVerify Setups dialog box, the Modules and their Setups box allows you to
select multiple setups. However, if you select a setup in the iVerify Setups dialog box, then the Modules
and their Setups box allows you to select only one setup.

If you select a setup from the iVerify Setups dialog box, and then select a setup from the Modules and their
Setups box and click the Load button, a system confirmation message displays. Click OK to confirm that
you intend to replace the current setup with the setup you selected in the Modules and their Setups box.

NOTE. An error message displays if the setup you are trying to load uses groups or signals that are not
included in the selected module. Also, an error message displays when you try to load a module without
any saved data.

Related Topic
1Verify Setups Dialog Box (see page 312)

iVerify Setup Dialog Box

314

The iVerify Setup dialog box allows you to edit the settings of a selected iVerify setup or add a new
iVerify setup. In addition, this dialog box allows you to define various analysis parameters through the
respective tabs. Note that only TLA7000 Series logic analyzer modules and related setups display in
the iVerify Setup dialog box.
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Behavior

Use the Setup Name box to select the modules and the iVerify setups that they contain. Modules that
contain one or more iVerify setups are listed in <modulename > - <iVerify setup name> format.

The Description box allows you to enter a new description for, or change the existing description of, the
loaded iVerify setup. Click the New Setup button to open the New iVerify Setup dialog box, which
you use to specify a new iVerify setup.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.

Related Topics

1Verify Setup Dialog Box: Channel Tab (see page 323)

1Verify Setup Dialog Box: Clock/Qualifier Tab (see page 324)
iVerify Setup Dialog Box: Analysis Configuration Tab (see page 321)
1Verify Setup Dialog Box: Inter-Probing Tab (see page 325)
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iVerify Properties Dialog Box

The iVerify Properties dialog box shows the properties of the iVerify Window. These properties include
information about the logic analyzer and external oscilloscope modules, functionality that you use to set eye
diagram colors, and functionality that you use to color the measurement diagrams and set their properties.

Behavior

The contents of the iVerify Properties dialog box are logically organized into three tabs. Click the tabs to
navigate to the contents for each iVerify Properties tab.

Related Topics
About Data Tab (sece page 316)

1Verify Window Tab (see page 317)

Eye Coloration Tab (see page 319)

iVerify Properties - About Data Tab

316

The About Data tab contains information about both the logic analyzer and the external oscilloscope for
the current acquisition. This information includes the version and quantities of logic analyzer modules

installed in the mainframe, the type of external oscilloscope, signal information, and other configuration
information. Click the tabs in the graphic to navigate to the help contents for each iVerify Properties tab.
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Behavior

The About Data tab contents is read-only information.

Related Topics

iVerify Properties Dialog Box (see page 316)
iVerify Window Tab (see page 317)
Eye Coloration Tab (see page 319)

iVerify Properties - iVerify Window Tab

The iVerify Window tab allows you to color the measurement drawings that are overlaid with the eye
diagram. It also allows you to specify the position and color of the measurement drawings.
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The Show Graticule box allows you to indicate whether to display the graticule and specify the graticule
color. Define the following settings for the eye diagram:

m  Select the background color of the eye diagram.

®m  Select the color of the clock edge in the eye diagram.
m  Select the color for the highlighted signal.

m  Select the color of the measurement lines.

The controls that are available in the Measurement group box depend on your Option selection. The
following selections are available:

® 4 Point Mask. The 4 Point Mask option allows you to view or edit the mask coordinate values and the
line color for this measurement in the Measurement group box.

B 6 Point Mask. Selecting the 6 Point Mask option allows you to view or edit the mask coordinate values
and the line color for this measurement in the Measurement group box.

®  Eye Limit Cursor. Selecting the Eye Limit Cursor measurement option allows you to view or edit the
time, voltage, and line color for this measurement in the Measurement group box.
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m  Upper/Lower Mask. Selecting the Upper/Lower Mask measurement option allows you to view or
edit the upper and lower mask positions and the line color for this measurement in the Measurement
group box.

m  Slope. Selecting the Slope measurement option allows you to view or edit point 1, point 2, and line
color for this measurement in the Measurement group box.

B Horizontal Histogram. Selecting the Horizontal Histogram measurement option allows you to view or
edit the scale, voltage and line color for this measurement in the Measurement group box.

B Vertical Histogram. Selecting the Vertical Histogram measurement option allows you to view or edit
the scale, time, and line color for this measurement in the Measurement group box.

Related Topics

1Verify Properties Dialog Box (see page 316)
About Data Tab (see page 316)
Eye Coloration Tab (see page 319)

iVerify Properties - Eye Coloration Tab

The Eye Coloration tab allows you to set coloration for the eye diagram. Click the tabs in the graphic to
navigate to the help contents for each iVerify Properties tab.

Select a color scheme that controls the colors of the eye diagram or, if you choose the color setting of
User Defined, individually set the colors used in the eye diagram.
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The Color Scheme drop-down list shows all the color schemes to apply to the eye diagram. A description
of the color scheme selections follows:

Temperature Grading. Using Temperature Grading, the areas of the eye with the highest sample
density appear in warmer colors (red shades), and the areas of lowest sample density appear in cooler
colors (blue shades). Temperature Grading is the default eye diagram color scheme.

Spectral Grading. Using Spectral Grading, the areas of the eye with the highest sample density appear
in blue shades, and the areas of lowest sample density appear in red shades.

Monochrome Gray. The Monochrome Gray color scheme displays the eye diagram in shades of gray.
The areas of the waveform with the highest sample density appear in lighter shades of gray, and the
areas of lowest sample density appear in darker shades of gray.

Monochrome Green. The Monochrome Green color scheme displays the eye diagram in shades of
green. The areas of the waveform with the highest sample density appear in lighter shades of green,
and the areas of lowest sample density appear in darker shades of green.

User Defined. Selecting the User Defined color scheme displays the eye diagram in shades of the color
that you select from the Scheme Definition group box.

Using the color boxes contained in the Scheme Definition group box, individually assign colors that will
indicate sample density in the eye diagram. However, this group box is enabled only when you select the
User Defined color scheme.
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Click the Default button to return the eye diagram coloration to the Temperature Grading color scheme,
which is the default color scheme.

Click the Invert Colors button to swap the colors that indicate the highest and lowest sample density.

Related Topics

iVerify Properties Dialog Box (see page 316)
About Data Tab (see page 316)
1Verify Window Tab (see page 317)

iVerify Statistical Analysis Dialog Box

Overview

The iVerify Statistical Analysis dialog box displays information regarding measurements that you
performed. This dialog box numerically represents the contents of the measurement data contained in the
iVerify window.

Select the measurements to be performed from the toolbar of the iVerify window or by selecting Data >
Measurements from the iVerify menu bar.

Behavior

The iVerify Statistical Analysis dialog box content is read-only information.Save the statistics to a text file
by clicking the Save As button and then saving the file in a desired location.

Related Topics

iVerify Window (see page 310)
1Verify Properties Dialog Box (see page 316)

iVerify Setup Dialog Box: Analysis Configuration Tab

Use the Analysis tab to select the necessary settings for the external oscilloscope which will be used for
analysis. This tab allows you to set up the time and voltage settings, and time limit for analysis.

The Horizontal Range group box contains Min and Max controls that you set to affect the frequency
horizontal scale parameters in the external oscilloscope.
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iVerify Setup Dialog Box: Analysis Configuration Tab
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The values that you enter in the Min and Max fields are rounded as necessary to the closest horizontal
scale, which is between -40s and 40s.

The Horizontal Range group box contains a read-only Resolution box that internally calculates and
displays the horizontal resolution for both the given number of clocks and horizontal scale.

The Vertical Range group box contains controls that affect the voltage range for the oscilloscope signals.
The Range box allows you to select from predefined voltage ranges for the external oscilloscope signals.
If you select the range setting of User Defined, use the Min and Max controls to specify the minimum
and maximum voltage limits for the external oscilloscope. Otherwise, these controls are read-only. The
values that you enter in the Min and Max fields are rounded as necessary to the closest vertical scale,
which is between 5 V and -2.5 V.

The Approximate Stop Condition group box contains the After control, which allows you to limit the
time that the iVerify takes to perform analysis.

The Oscilloscope Acquisition Mode group box allows you to use the FastAcq acquisition mode of the
oscilloscope if it is available on the external oscilloscope.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.
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Related Topics

1Verify Setup Dialog Box (see page 314)

1Verify Setup Dialog Box: Channel Tab (see page 323)
iVerify Setup Dialog Box: Clock/Qualifier Tab (see page 324)
iVerify Setup Dialog Box: Inter-Probing Tab (see page 325)

iVerify Setup Dialog Box: Channel Tab

The Channels tab allows you to select both the signals that you want to analyze and the signal data that
will display in the eye diagram, which is located in the iVerify window.

Use the Channels tab to list signals by group, by probe, or by name. Then specify the groups or signals that
you want to analyze by selecting the check box associated with each group or signal in the Analyze column.

iVerify Setup - LA 1 - DefaultSetup

L] Select Al
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To specify the groups or signals for which the analysis results will be displayed in the eye diagram, select
the check boxes associated with each group or signal in the Apply column. By default, when you select an
Analyze check box, the related Show check box is selected.

TLA Online Help 323



Analysis Tools iVerify Setup Dialog Box: Clock/Qualifier Tab

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message displays.

Related Topics

iVerify Setup Dialog Box (see page 314)

iVerify Setup Dialog Box: Clock/Qualifier Tab (see page 324)
1Verify Setup Dialog Box: Analysis Configuration Tab (see page 321)
1Verify Setup Dialog Box: Inter-Probing Tab (see page 325)

iVerify Setup Dialog Box: Clock/Qualifier Tab

324

Use the Clock and Qualifier tab to set up the clock signal and qualifier signal and the edge that will be routed
to the oscilloscope for analysis. Any of the signals displayed can be selected as a clock signal or qualifier.

The Channels to be Used as Clock group box contains a Select list which you use to arrange the signals
that display in the clock list.
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If you choose By Probe, the clock list will display all signals regardless of whether they are part of a group
that is defined in the LA Setup window.

If you choose By Name, the clock list will display only the signals that have been assigned custom names
in the LA Setup window.

Select the reference clock edge by clicking the clock edge icon until it displays your preference: rising edge
or falling edge. Then select the signal to be used as a clock that is routed to the oscilloscope for analysis.

Select the Select Qualifier check box when you want to send a qualifier to the oscilloscope along with the
clock signal. When this check box is selected, the analysis of signals selected in the iVerify setup occurs in
the oscilloscope only if the qualifier is valid in the same timeframe.

The Channels to be Used as Qualifier functions similarly to the Channels to be Used as Clock group
box. Select the high or low condition of the qualifier by clicking the qualifier edge icon until it displays
your preference: high level or low level. Then select the signal to be used as a qualifier that is routed to
the oscilloscope for analysis.

NOTE. If you have a five-module setup, you cannot select any status bits.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.

iVerify Setup Dialog Box (see page 314)

1Verify Setup Dialog Box: Channel Tab (see page 323)

iVerify Setup Dialog Box: Analysis Configuration Tab (see page 321)
1Verify Setup Dialog Box: Inter-Probing Tab (see page 325)

iVerify Setup Dialog Box: Inter-Probing Tab

The Inter-Probing tab displays optimum analog routing information that you make between the logic
analyzer and external oscilloscope to achieve analysis results for the selected signals. The logic analyzer
modules that are displayed on this tab depend upon the signal selections that you made in the Channels tab
of the iVerify Setup dialog box.
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iVerify Setup - LA 1 - DefaultSetup |X|
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Behavior

The Inter-Probing tab is a read-only tab.

NOTE. You need to provide information in the Channels, Clock and Qualifier, and Analysis Configuration
tabs before viewing the Inter-Probing tab. This is because the optimum analog routing information
contained in the Inter-Probing tab depends upon the information contained in these tabs. If the setup that
you have specified is physically invalid, an error message appears.

Related Topics

iVerify Setup Dialog Box (see page 314)

1Verify Setup Dialog Box: Channel Tab (see page 323)

iVerify Setup Dialog Box: Clock/Qualifier Tab (see page 324)
iVerify Setup Dialog Box: Analysis Configuration Tab (see page 321)
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Microprocessor and Bus Support Package Basic Operation

Microprocessor and bus support packages are used to disassemble data from microprocessor and bus based
systems. For information on a specific support package, refer to the documentation that came with the
support package.

The support can be used to perform timing analysis.

To acquire and display timing data, you need to change the sampling selection and trigger program. The
support includes a saved system setup file to view data in a Waveform window.

Related Topics

Sampling (see page 14)
LA module Trigger Window (see page 143)

Load Support Package

Loads the selected support package onto the selected logic analyzer module. The destination module must
have sufficient signal width for the support package to load.

From the File menu, click Load Support Package.

Group Definitions for Microprocessor and Bus Support

Each support package contains group definitions. Many supports have groups defined for: Address, Data,
and Control signals, and additional groups defined for other signals. If you want to know which signal is in
what group, refer to the signal assignment tables in the support instruction manual.

Microprocessor and Bus Support Package Triggering

All the Trigger window selections available with your analyzer are also available with the support

package. However, if the support package displays exception cycle types, the cycle types are computed
and cannot be used to control triggering.

A control group symbol table, which includes special symbols for triggering, is supplied with many
support packages.

Trigger on pattern or range symbol values. However, only the = and Is Not operators in the Clause
definition dialog box can use pattern symbol values. All operators can use range symbol values.
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Disassembly Display Formats

Four different display formats offer optional selections to modify the way disassembled data is displayed.
This makes it easier to analyze data.

The display formats are: Hardware (see page 198), Software (see page 198), Control Flow (see page 198),
and Subroutine (see page 198). Other display options may be available depending on your support package.

To select a disassembly display format:

1. Open a Listing window.

2. From the View menu select Properties.
3. Click the Disassembly tab.
4

Go to the Show box and select the display format.

Saved System Timing Format File

In the Waveform window, every signal shows as a waveform, and groups show as busforms.

The support package includes a saved system setup file to use to view data in the Waveform window. To
load this file, do the following:

1. Go to the File menu and select Load System.
2. Click Browse.
3. Move through the directory structure as follows:
C:\Program files\TLA700\Supports\(support package folder)\timing.tla

4. Click Yes or No to indicate whether or not you want to save your current system.

NOTE. A message may appear stating that the configuration of the file does not match your configuration.
Click OK and follow the directions in the Load System Options dialog box, or click Help in the dialog box
for more information.

5. Click the waveform data icon after it appears in the System window to view the timing file.

Custom Sampling

When your instrument has a support package loaded, a custom sampling tab is available in the LA Setup
window. The name of the support package appears on the tab label.
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Use Custom sampling to select sampling options associated with the support package. It gives special
access to the advanced sampling features of the logic analyzer to track the complex behavior of a digital
device or bus protocol. The available selections vary with each support package. Custom sampling can
enable and disable a variety of microprocessor-specific clock cycle types (such as DMA cycles). For
additional, information see the instructions that accompanied your support package.

Clocking Problems

If you have clocking problems check the following:

B A clock is available. Click Status in the toolbar to open the Status Monitor and verify that a clock is
available. If no clock is available, check your connections.

B The system under test is powered on and running. Verify the system is not halted.
B Custom is the sampling selection in the Setup window.

B Connections between the acquisition module and the probe adapter are correct. Check for activity in
the Signal Mapping area of the Setup window.

The clock and probe connections between the interface housings and probe adapter are correct (module
name, clock, section names, and signal numbers match), are properly oriented, and are fully engaged.

The connections between the interface housings and acquisition module probe cables have matched color
labels, matched slot numbers, and are properly keyed.

The connections between the acquisition module probe cables and probe connectors have matched color
labels, matched slot numbers, and are properly keyed.

m  The configuration of jumpers or switches on the probe adapter is correct. Refer to the support product
instruction manual for configuration information.

If the previous suggestions do not fix the problem try the following:
Reload the support package to restore the analyzer to a default state.

If there are loading problems, remove one or more of the protective sockets from the probe adapter. These
sockets might add enough additional capacitance or delay to your system under test to affect it.

If the analyzer is still not performing correctly after trying these solutions, there might be a problem with
your system under test. Perform timing analysis on your system to ensure the signals are valid when the
probe adapter samples them.

Incorrect Data

If the data acquired is obviously incorrect, check that:

B The correct support application is loaded into the system.
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®  [f the microprocessor has an internal instruction cache, you should disable it. The support product
instruction manual contains information on when and how to disable the instruction cache.

B Custom Sampling is selected in the Setup menu.
B The connections between the acquisition module and the probe adapter are correct:

B The clock and 17-channel probe connections between the interface housings and probe adapter are
correct (module name, clock, section names, and signal numbers match), are properly oriented, and
are fully engaged.

B The connections between the interface housings and acquisition module probe cables have matched
slot numbers, and are properly keyed.

B The connections between the acquisition module probe cables and probe connectors have matched
slot numbers, and are properly keyed.

B The configuration of jumpers or switches on the probe adapter is correct. Refer to the support product
instruction manual for configuration information.

If the previous suggestions do not fix the problem, try reloading the support package to restore the analyzer
to a known state.
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Extended Diagnostics Properties

Use to run extended diagnostics for the following purposes:
B Incoming inspection. Run these diagnostics when first receiving the analyzer.
m  Functional procedure. Run these diagnostics after the analyzer or module has been repaired.

B Suspected problem. Run these diagnostics if you think your analyzer is not performing correctly.

NOTE. Disconnect all probes from the analyzer before running the diagnostics.

Test Name
This column has an indented hierarchical structure.
All Modules, All Tests — Runs all tests in the list.

TLA700 System — Selects all mainframe tests.

Last Result

This column shows the pass or fail result of the most recent test. When a test is running, the word
"Running" displays until the test is complete and results show. When a series of tests is running and

an individual test is complete, results are displayed and the next test is executed. The result Unknown
indicates that a particular test is in question. Run the diagnostic again. If Unknown appears again, contact
your local Tektronix service representative.

Fail Count

This column shows the number of times a test has failed since the RUN button on this page was clicked.
This count is mainly used when the run mode is set to Continuous. One Time and Until Fail run modes
always display a count of one. All values are cleared when you click the RUN button.

Contact Technical Support for questions regarding diagnostic test results.

To Use

To open the Extended diagnostics tab from the System menu, click Calibration and Diagnostics and then
click Extended Diagnostics.
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Related Topics

Running Extended Diagnostics (see page 133)

Troubleshooting Triggering

Overview

If the logic analyzer does not trigger, you should check the following:

m  Check that your target system is powered on.

B Check the System window to verify that required modules are turned on.

®  [fthe module has correctly sampled data, acquired the specified events, triggered, but has not stopped,
the module probably has not acquired enough additional data to fill acquisition memory. Click Stop to
manually stop the acquisition, and then change the Module Memory Depth (see page 27) (reduce)
or Trigger Position (see page 151) (increase).

LA Triggering

The following conditions apply to the logic analyzer only:

332

Check the Status Monitor for a clock warning. If the logic analyzer does not receive a synchronous
clock, the Status Monitor displays the following message: External Clock Source Idle.

Check for signal activity at the probe tip. If there is no activity, check the probe connections.

Check the clock signal to ensure that the logic analyzer actually receives clock data. Problems with
the clock signal can impact setups using synchronous sampling, custom sampling (microprocessor
support packages only), or storage qualification.

Similar to the previous item, check clock qualifier signals and clock equations.
Check the threshold voltages.

If the logic analyzer is correctly sampling data and the data events have occurred, but the trigger
program did not generate a trigger, check the trigger program itself. The trigger program might not be
reaching the state that generates the trigger. Use the Status Monitor to track trigger program progress
and identify the state in which trigger progress stops.

Check the complexity of your trigger program. If your trigger program is too narrowly defined,

or over-specified, the trigger program might not acquire the desired data or might not trigger. A
less-specific trigger program might acquire the desired data and also verify that you have set up the
proper sampling and threshold levels.
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Oscilloscope Triggering
The following condition applies to the oscilloscope module only:

B Check the trigger Mode setting. If Mode is set to Normal, and the data does not meet the trigger
conditions, the module will not trigger. (Conversely, if Mode is set to Auto, the module will trigger
after a set length of time, even if the specified data does not occur.)

Arming or Intermodule Triggering
The following conditions apply only if you are using arming or intermodule triggering:

B [nternal signal logic function. If your trigger depends on setting an internal signal, and that signal has
been set to Wired-And, all modules in the system must set the signal or it cannot assert.

®  If any modules are turned off, check that the trigger program is not waiting for input from an inactive
module.

First Transition Indication Problems

m  Because the logic analyzer does not clear the first transition indication, check that the modules always
show a first transition indication (even if there are no probes attached).

B To avoid triggering on a false first transition indication, set the first state to " If Anything, Go to Next
State." This will use a state, but it ensures that you do not trigger on a false transition indication.

Related Topic
Troubleshooting LA Power Trigger Programs (see page 105)

TLA Online Help 333



Troubleshooting/Diagnostics Troubleshooting Triggering

334 TLA Online Help



Reference Symbol Files

Symbol Files

Overview

Symbol files are files of alphanumeric symbol names and associated data values. Symbol files are used to
map a group value to a text string and/or color. For example, a symbol file could map an address group
value to a function name. This is faster and easier to interpret than a numeric value.

Behavior

The logic analyzer uses two kinds of symbol files: Pattern Symbol Files and Range symbol files. The
range symbol files can contain Function Symbols (see page 337), Variable Symbols (see page 338), Source
Code Symbols (see page 338), and Color Symbols (see page 347). The following table shows the types
of symbol files and the windows in which they are commonly used.

Window Pattern Range symbol files

?ﬁ’:;bd Functions Variables Source code Color
Listing Yes Yes Yes Yes Yes
Waveform Yes Yes Yes Yes Yes
Histogram No Yes Yes No No
Source No No No Yes No
Trigger Yes Yes Yes Yes No

Often, the application software will define symbols for you. For example, when you load a microprocessor
support package, a symbol file is also loaded (typically, to the control group). These symbols represent
data values that correspond to bus cycle types.

Symbol files work like look-up tables. For example, if the address of a printer I/O port is F734BC, define
a pattern symbol, printer-port, corresponding to that value for use in the Trigger window. Then, in the
[f/Then Clause dialog box, specify the symbol name as the word recognizer value and cause the module
to trigger when printer-port (F734BC) appears on the address bus. Specify symbolic display radix for
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the address group and the symbol name printer-port will be displayed in the Listing window every time
F734BC appears on the address bus.

Symbol Value Width

Overview

Symbol values are limited to a width of 32 bits. If your application uses groups wider than 32 bits (for
example, in the Trigger window), you could experience some unexpected results when using symbols
with those groups.

Behavior

For triggering purposes, if the symbols are wider than 32 bits, zeros are added to the most-significant bits.
In pattern symbols, don’t cares (Xs) are added to the most significant bits. Refer to the tables below for
examples on how the Trigger window handles symbols wider than 32 bits.

Pattern example Value Symbol
32-bit example FFFFAB23 10-3
40-bit example (32-bit with padding XXFFFFAB23 10-3

for most-significant bits)

Range example Lower bound Upper bound Symbol
32-bit example FFFF0055 FFFFACO0 Sym 12
40-bit example (32-bit with 00FFFF0055 00FFFFACO00 Sym 12
padding for most-significant

bits)

Range Symbol Files

336

Overview

Range symbols define a range of 32-bit addresses represented by a contiguous set of integers, marked
by specific lower and upper bounds. The types of range symbols are: Function Symbols (see page 337),
Variable Symbols (see page 338), Source Code Symbols (see page 338) (source), and Color Symbols

(see page 347).

Behavior

The various range symbols may overlap each other. When overlaps occur, and the logic analyzer needs
to convert a numeric value to a symbol, it may need to choose between the symbols. The logic analyzer
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assigns a preference order to symbol types with function symbols having the highest precedence, followed
by variable symbols, and then source symbols. Color symbols are looked up separately and may overlap
with any of the other types.

Most TLA applications will typically not display source symbols when function symbols are present
because of the preference rule (source symbols are covered or overlapped by function symbols). There
may be situations when you prefer the source symbols. Use the Load Symbols Options dialog box to
specify that function symbols should not be read when loading the symbol files.

Pattern Symbol Files

Pattern symbols consist of data patterns of up to 32 bits. Each bit in a pattern symbol can be 0, 1, or X
(don’t care). Pattern symbols are used when a group of signals define a logical state. Each pattern symbol
may also have a color associated with it.

For example, a microprocessor has a set of pins that indicate the type of bus cycle in progress. A
memory-read cycle is indicated when the RD~ and MREQ~ pins are 0 (logic low) and the BUSAK~ and
M1~ pins are 1 (logic high).

Define a pattern symbol name called mem-read that corresponds to bit pattern 1100 and mark all memory
read bus cycles in the Listing window. For other bus cycles the logic state of these pins is also important
and define different bit patterns for each cycle type.

Function Range Symbols

Overview

Function range symbols define the beginning and ending addresses where instructions that implement a
function (subroutine) are located in memory.

Functions are composed of multiple source statements. The address range of a function symbol can overlap
a set of ranges defined by one or more source symbols. A partial range file with functions is shown below:

#+ Function

# Symbol Name Low High
#
displayBanner 006035ba 00603675
buildmMenus 00603676 006036e5
displayLCDmenu 006036e6 0060372f

Behavior
The first line tells the file reader that the following symbols represent functions.

The next two lines are comments used as headers.
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The symbol name can contain up to 220 ASCII characters. However, the file name may be truncated when
displayed. To include embedded spaces in the symbol name, enclose the symbol name in double quotes.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds.

Variable Range Symbols

Overview

Variable range symbols define the beginning and ending addresses where the value of a variable is located
in memory. Variable symbols can also be overlapped by either function or source symbols. A partial
range file with variables is shown below:

#+ variable

# Symbol Name Low High
#
menu 00000100 00000102
userMenul 000004c0 000004c?2
binBits 000004d4 000004d6

Behavior

The first line tells the file reader that the following symbols represent variables. If this line is not included,
the file reader will assume that the symbols represent functions rather than variables.

The next two lines are comments used as headers.

The symbol name can contain up to 220 ASCII characters; however, the file name may be truncated when
displayed. To include embedded spaces in the symbol name, enclose the symbol name in double quotes.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds. If the variable is a single byte in memory, the
lower and upper bound values are equal.

Source Range Symbols

338

Overview

Source symbols are similar to function range symbols, except that the address range for a source symbol
describes the location of the instructions that implement only one source statement. Source symbols also
contain the following information that defines the location of the source code associated with a symbol:

®  Source file name

TLA Online Help



Reference Symbols

®  Source line number
B An optional column range
A partial range file with source symbols is shown below:

#+ Source stoplite
# Line Low High Beg End Symbol Name
# === —_——— —_——— —_—————————===

27 006043ec 006043ef 0 25 # stoplite_27_25

35 006043f0 006043f5 0 23 # stoplite_35_23

47 006043f6 006043ff 0 30 # stoplite_47_30

48 00604400 00604409 0 30 # stoplite_48_30

49 0060430a 00604413 0 30 # stoplite_49_30

50 00604414 0060441d 0 30 # stoplite_50_30
0 #

51 0060441le 00604427 0 30 # stoplite_51_30

Behavior

The first line tells the file reader that the following symbols represent source code. The first line also
specifies the name of the source file (stoplite). If this line is not included, the file reader will assume that
the symbols represent functions rather than variables and source symbols. Each set of symbols for a unique
source file must be introduced with an initial source directive to specify the file name for the symbols.

The next two lines are comments used as headers.

The line number specifies the line of the source file containing the source statement. Line numbers are
always expressed in decimal.

The Low and High columns describe the lower and upper bounds. The bounds represent the range of
addresses occupied by the instructions that implement a single source code statement. The radix of the
bound is defined in the file header. The value of the bounds can range from 0x00000000 to OxFFFFFFFF.
The bounds are inclusive; the specified range includes both bound values, as well as all addresses between
the bounds. If the source symbol is a single byte in memory, the lower and upper bound values are equal.

The Beg and End columns are optional. When present, they define the beginning and ending column
position for the source statement. This makes it possible to define the exact location of the statement
on the line.

The symbol name appears as a comment at the end of the line. The file reader ignores the symbol name
because it is a comment. When the logic analyzer exports range symbol files, the symbol name is a
concatenation of the symbol file name, line number, and column number (if present). This is the symbol
value that the logic analyzer displays for addresses that fall within the lower and upper bound for a
source file.

Symbols

Symbols simplify tasks, such as setting up triggers or identifying specific values within the data. When
you program a trigger or view data, it is cumbersome to remember which numeric group values correspond
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to particular machine instructions or code modules. The logic analyzer makes this task more manageable
by allowing you to assign symbolic names or mnemonics to group values.

For example, assign the symbol WRITE to the control bus event that causes the target system to write to
a memory location. Then, if you want to trigger when a write cycle occurs, enter WRITE in the trigger
program in place of the actual data value.

Symbols Dialog Box

340

Overview

Use the Symbols dialog box to provide an overview of all currently loaded symbol files. Use the dialog
box to do the following:

B Display symbol status and content information of currently loaded symbol files
B Load symbol files

®  Reload symbol files

®  Unload symbol files

®  Export symbol files

Status Information
The following status information is available for each currently loaded symbol file:

B Last Loaded - Describes the last time the file was loaded into the TLA application software. It also
includes error and warning messages associated with the last load.

m  File Modified - Displays the time the file was last modified. It also displays a message if the file might
need to be reloaded (such as when the file is modified after it was first loaded).

B Format Loaded - Displays the format of the loaded file.

B Can Be Unloaded - Describes if the file can be unloaded or if the file is currently in use. Symbol files
can only be unloaded if no data windows or setups are using them.

Content Information
The following content information is displayed:

= Symbol Type - Shows whether the file is a pattern symbol file or a range symbol file. If the file is a
range file, this field also lists the types of symbols loaded.

B Total Symbols - Shows the number of symbols loaded from the file.
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®m  Total Source Files - Lists the number of source files referenced by source code symbols loaded from
the file.

B Range - Lists the minimum and maximum address values and offset information.

Behavior

Click Load to load a new symbol file. You do not need to load all symbol files with the Symbols dialog
box. Symbol files can be loaded through other windows. Display information on all symbol files currently
used by the logic analyzer by selecting any loaded symbol file.

NOTE. When you load a symbol file, the symbols are placed in memory. Because symbol files consume
memory, you should unload unused symbol files to keep memory available for your main application.

Click Unload to unload a symbol file from the application software.

NOTE. The Unload button is inactive when the loaded symbol file is in use.

Click Export to save the current file as a TSF-format symbol file. View the exported symbol file with
applications such as Wordpad. Edit the symbol file by saving it under a new name and using a text editor,
such as Wordpad, to make any changes. Save the edited file in ASCII format and then load the edited
symbol file.

To Use

To open the Symbols dialog box from the System menu, click Symbols.

Related Topic
Load Symbols Options Dialog Box (see page 341)

Load Symbols Options Dialog Box

Overview

Use the Load Symbols Options dialog box to specify options for range symbol files before loading

them into the system. Specify any of the following symbol file formats (check with your Tektronix
representative for a complete listing of available formats): OMF51 (see page 342), OMF86 (see page 342),
OMF166 (see page 342), OMF286/386 (see page 343), COFF (see page 343), IEEE695 (see page 343),
and ELF/DWARF or ELF/STAB (sce page 343).

In addition to the above formats, use the Tektronix Symbol file Format (see page 344) if your code
generation tools do not operate on any of the listed formats.
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Behavior

Select one or more of the symbol types to load. If you want to use the symbol file with the Source window,
be sure to include the Source Code as the symbol type.

The Bound 1 and Bound 2 fields define the range of symbol addresses that will be loaded. Enter any
hexadecimal values from 0 through FFFFFFFF. Values outside of these limits are ignored.

NOTE. If the lower bound of an overlapping range symbol is within the Bound 1 and Bound 2 limits and
the higher bound is not, the entire symbol will be valid. However, if the higher bound is within the Bound 1
and Bound 2 limits and the lower bound is not, the entire symbol will be ignored.

Select either Default Offset or Custom Offset to apply an offset to the symbol values. If you select Default
Offset, the default offset is read from the source file and applied to each symbol in the file. If you select
Custom Offset, add or subtract the specified offset value to each symbol in the file as it is loaded. Choose
any 32-bit hexadecimal value from 0 to FFFFFFFF.

When you enter bound values, enter the values without an offset value. If your application adds an offset,
subtract the offset value before you enter the bound values.

To Use

To open the Load Symbols Options dialog box from the System menu, click Symbols and then click the
Load button. Then select a symbol file and click Options.

Related Topic
Symbol Files (see page 335)

OMF51 File Format

This format holds symbolic information and executable images for an 8051 or equivalent
MiCroprocessor.

OMF86 File Format

This format holds symbolic information and executable images for an 8086 or equivalent
microprocessor. It is also used for code intended to run on 80286, 80386, or higher-level
microprocessors in real or 8086-compatible mode.

OMF166 File Format

This format holds symbolic information and executable images for the Siemens (Infinion) C166 or
microprocessor family, or compatible microprocessor.
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Exporting Symbol Tables

OMF80286 and OMF80386 File Formats

These formats hold symbolic information and executable images for 80286, 80386, or equivalent
microprocessors. They are also used for executable images intended to run on the 8086 or other
microprocessors in the 80x86 families.

COFF File Format

The Common Object File Format (COFF) contains a number of variations and extensions, such as
ECOFF, XCOFF, and COFF2.

This flexibility enables the file format to be used with a wide variety of different microprocessors.
Some code-generation tool vendors also extend this format in nonstandard ways that may make their
files unreadable by Tektronix Logic Analyzers.

IEEE695 File Format

This object file format refers to the IEEE695 specification. This format is used primarily by compilers
for a wide variety of Motorola microprocessors, as well as Motorola-compatible microprocessors
from other vendors. This format provides for the inclusion of column information in source symbols,
but not all compilers use this capability.

ELF/DWARF and ELF/STABS File Formats

Elf is an object file format used primarily with PowerPC microprocessors. The Dwarf 1, Dwarf 2 and
Stabs names refer to the format of the portion of an EIf file that contains debug information. This
format provides for the inclusion of column information in source symbols, but not all compilers use
this capability.

NOTE. Although Dwarf I and Dwarf 2 debug formats are able to support symbol values in excess of
32 bit resolution, the Logic Analyzer will use only the least significant 32 bits. The logic analyzer will
issue a warning if any symbols exceeding 32 bits in size are encountered while loading the symbol file.

Exporting Symbol Tables

Use this export dialog box to export symbol tables in the TSF format. The TSF format is ASCII, which
makes it more suitable for display and modification. The exported file can also be reloaded if desired.

Related Topic

Symbols Dialog Box (see page 340)
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TLA Symbol File Format Overview

The logic analyzer can extract range symbol information directly from object files.

Users whose code generation tools do not generate some file formats can use TLA Symbol File (TSF)
format (a text format). The logic analyzer uses the TSF format when it exports symbol files. The logic
analyzer can also read files in this format.

TLA symbol files consist of alphanumeric symbol names and associated data values. The files contain a
header line and lines defining the symbol names and values. Fields on a line are separated with white space
(blank spaces or tabs). The formats for the pattern symbol files and the various range symbol files differ; if
you need to use pattern symbols and range symbols, use separate files.

Both TLA range and pattern symbol files have a .tsf file name extension (filename.tsf).

The first few lines of a TSF symbol file are typically comment lines describing when and how the file was
generated.

# TLA Symbol File
# Created on Friday, May 29, 1998 at 09:52:03
# From file: "c :\quickstart\tla7qgs.x"

All lines in a TSF file that begin with a number sign (#) character are treated as comments, unless the very
next character is a plus sign (+). The plus sign signifies a file reader directive. The number sign character
can also initiate a comment on the end of a symbol definition or other uncommented lines. All text between
the number sign and the end of the line is treated as a comment and ignored.

Related Topics

TLA Symbol File Format - TSF Headers (see page 344)
TLA Symbol File Format - TSF Pattern Symbols (see page 345)
TLA Symbol File Format - TSF Range Symbols (see page 346)

TLA Symbol File Format - TSF Headers

344

A TSF header identifies the file format version to potential file readers. It specifies whether the file contains
pattern or range symbols, the radix used to specify symbol values, and an optional offset amount to be
added to each symbol value (for range symbol files).

The TSF Header is a file directive, which means that the following information begins with the special
character combination of a number sign character followed immediately by a plus sign (#+). This is not
a comment line. The special character sequence is used to mark instructions to the file reader; these
instructions are called file directives.

The following examples show sample file headers for a pattern symbol file and a range symbol file. The
first two lines are comments included for readability; they are not required as part of the file header.

# TSF Format Type Display Radix File Radix
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#
#+ Version 2.1.0 PATTERN HEX HEX

# TSF Format Type Display Radix File Radix Offset
#
#+ Version 2.1.0 RANGE HEX HEX 00000000

The File Format Version number contains three fields. The first two fields are the format major and minor
version numbers. The logic analyzer will only read TSF files where the major and minor version number
of the file is less than or equal to that of the TLA TSF symbol file reader. The third field denotes minor
format changes, which do not impact the file reader.

The File Format Version number is followed by a key word, PATTERN or RANGE, which signifies the
type of symbols found in the file. TSF files can contain either type of symbols, but no single file can
contain both. The header specifies the type for all symbols in the file.

The Display Radix field sets the default radix that will be used to display the numeric symbol value. For
range symbol files, this field must be one of the key words: HEX, DEC, OCT, or BIN. For pattern symbol
files, only the key words HEX, OCT, or BIN are allowed.

The File Radix field specifies the radix used by the symbol values in this file. Like the Display Radix
field, the File Radix field must be one of the key words: HEX, DEC, OCT, or BIN for range symbol files,
or HEX, OCT, or BIN for pattern symbol files.

The Offset field specifies an offset value and is applicable only to range symbol files. The offset value is
specified in the radix indicated by the File Radix field. This offset value will be added to the lower and
upper bounds of each range symbol that is read from the file. The offset is a 32-bit value, so it can have
any value between 0x00000000 and OxFFFFFFFF. If the sum of the offset and a range symbol bound value
exceeds the 32-bit limit of OXFFFFFFFF, the overflow bit is discarded. Negative offsets are specified

by using a twos complement value for the offset.

Related Topics

TLA Symbol File Format Overview (see page 344)
TLA Symbol File Format - TSF Pattern Symbols (see page 345)
TLA Symbol File Format - TSF Range Symbols (see page 346)

TLA Symbol File Format - TSF Pattern Symbols

Each pattern symbol in a TSF pattern file consists of two fields. The first field is the symbol name, and the
second is the symbol pattern. The symbol name is a sequence of ASCII characters of up to 220 characters
in length, although it is impractical to display symbol values much longer than 32 characters. Symbol
names longer than 220 characters will be truncated during loading. The characters in a symbol name can be
any character with an ASCII value between 0x21 (the exclamation point character, !) and 0x7E (the tilde
character, ~). Use symbol names with embedded spaces by enclosing the Symbol Name in double quotes.

# Symbol Symbol Optional Foreground
# Name Pattern and Background Color
#
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NUL X0000000

SOH X0000001 @red @yellow
STX X0000010

"ETX 0x03" X0000011

The symbol pattern consists of numerals in the radix specified by the File Radix field in the header, and Xs
signifying don’t-care values. The number of bits represented by each character position in the pattern
depends on the selected radix. For a HEX radix, each character represents 4 bits. For an OCT radix, each
character represents 3 bits; for a BIN radix, each character represents one bit.

Symbol order in a TSF pattern file is important. When selecting the symbol to display for a particular
value, the logic analyzer scans the list of pattern symbols from top to bottom. It selects the first symbol for
which all non-don’t-care bits of the symbol match the corresponding bits of the target symbol.

Related Topics

TLA Symbol File Format Overview (see page 344)
TLA Symbol File Format - TSF Headers (see page 344)
TLA Symbol File Format - TSF Range Symbols (see page 346)

TLA Symbol File Format - TSF Range Symbols

346

There are four different types of range symbols:

= Function (see page 349)

B Variable (see page 351)

B Source (see page 349)

m  Color (see page 347)

Each of these types define a range of 32-bit addresses associated with some entity.

Function range symbols define the beginning and ending addresses where instructions that implement a
function are located in memory.

Variable range symbols define the beginning and ending addresses where the value of a variable is located
in memory.

Source range symbols are similar to function range symbols, except that the address range for a source
symbol describes the location of the instructions that implement just one source statement. (Source
symbols also contain file name, line number, and an optional column range that define the location of the
source code associated with the symbol.)

Color range symbols define a display color for any value that falls within a range.

Each of the types of range symbols appears in a separate section of the file. Each section begins with a file
directive indicating the type of symbols that follow. The sections may appear in any order, and can be
broken up and separated by other sections if necessary.
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The first section might be variables, followed by functions, then followed by another variable section.
Each section is also optional, however some logic analyzer applications are will not use the symbol file
if the appropriate type of symbols are not present. For example, the source window will only correlate
with a listing window if the symbol file contains source symbols.

Range symbol names follow the same rules as pattern symbol names. The symbol name is a sequence
of ASCII characters of up to 220 characters in length, even though it is impractical to display symbol
values much longer than 32 characters.

Symbol names longer than 220 characters will be truncated during loading. The characters in a symbol
name can be any character with an ASCII value between 0x21 (the exclamation point character, !) and
0x7E (the tilde character, ~). Use symbol names with embedded spaces by enclosing the Symbol Name
in double quotes.

Range symbol address ranges can overlap. This overlap sometimes produces unexpected results. When
overlaps occur, and the logic analyzer needs to convert a numeric value to a symbol, it must choose
between the overlapping symbols. When choosing between overlapping symbols, the logic analyzer
assigns a precedence order to the symbol types. Function symbols have the highest precedence, followed
by variable symbols, and then source symbols.

Related Topics

TLA Symbol File Format Overview (see page 344)
TLA Symbol File Format - TSF Headers (see page 344)
TLA Symbol File Format - TSF Pattern Symbols (see page 345)

TSF Range Symbols - Color

Color range symbols define the beginning and ending group values where a color is displayed. Any
group value in the acquisition falling within this range will be shown in the defined color. The value
range of a color symbol can overlap with the set of ranges defined by one or more Function, Variable,
or Source symbols. In many instances, a Color symbol will use exactly the same range bounds as a
Function or Variable symbol.

A partial range file with colors is shown below:

#+ Color
# Color Low High
#

@magenta 006035ba 00603640
@yellow @navy 00603541 00603675
@default @green 006036e6 0060372f

The first line tells the file reader that the following symbols represent colors. The next two lines are
comments used as headers. The first color name specifies the foreground color, and the second optional
color name specifies the background color. The available color names (keywords) are:

@bTack, @blue, @cyan, @lime, @magenta, @red, @yellow, @white, @navy, @teal,
@green, @purple, @maroon, @olive, @gray, and @silver.
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348

The special color name @default gives the default text coloring specified by choosing a color in the Column
tab of the Listing Window Property Sheet or the Waveform tab of the Waveform Window Property Sheet.

The Low and High columns describe the lower and upper bounds. The bounds are expressed as 32-bit
values; the radix is specified in the header. The bounds are inclusive; the specified range includes both
bound values, as well as all values between the bounds.

There is a different TSF symbol file syntax for adding color to range and pattern symbol files. For pattern
symbol files, color is an attribute of existing pattern symbols. It is placed on the same line as the rest of the
symbol, and to the right of the pattern definition. For range symbol files, color symbols are added in a
separate section of the symbol file, just like Function, Variable, and Source symbols. This allows the color
information to be independent of the other defined range symbols.

A partial TSF Pattern Symbols file is shown below:

# Symbol Name Pattern Color
#
NUL X000 0000

SOH X000 0001 @blue

STX X000 0010 @white @red
SBZ X000 0100 @default @teal

Each Pattern symbol in a TSF Pattern file consists of three fields. The first field is the Symbol Name, the
second is the Symbol Pattern, and the third is Symbol Color.

The Symbol Color specification may contain zero, one, or two color keywords. If only one color is
given, it specifies the foreground color of the data. If two colors are given, they specify the foreground
color followed by the background color.

To supply a background color, provide a foreground color. If you want to use the group’s defined color
from the Column or Waveform Property Page, use @default as the foreground color.

In addition to specifying the colors by name, specify the color symbols using the RGB hexadecimal format.
For example the earlier example of the partial range file with colors is shown below using the RGB format:

#+ Color
# Color Low High
#

@FFOOFF 006035ba 00603640
@FFFFO0 @000080 00603541 00603675
@default @008000 006036e6 0060372f

Similarly the partial TSF Pattern Symbols file using RGB is shown below:

# Symbol Name Pattern Color
#
NUL X000 0000

SOH X000 0001 @OOOOFF

STX X000 0010 @ FFFFFF @FF0000
SBZ X000 0100 @default @008080
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Related Topics

TLA Symbol File Format - TSF Range Symbols (see page 346)
TSF Range Symbols - Function (see page 349)

TSF Range Symbols - Variable (see page 351)

TSF Range Symbols - Color (see page 347)

TSF Range Symbols - Function

The file directive "#+ Function" introduces the function symbol section of a TSF Range file. The file
directive tells the file reader that the following symbols represent functions, as opposed to variables or
source statements. If no symbol type file directive is given, the function symbol type is assumed.

#+ Function

# Symbol Name Low High
#
dispTayBanner 006035ba 00603675
buildMenus 00603676 006036e5
displayLCDmenu 006036e6 0060372f

Function symbols consist of three fields: the symbol name, the lower bound, and the upper bound.

The lower and upper bound values are each 32-bit values, defined by numerals in the radix specified by the
File Radix field in the file header. These values define the lower and upper limits of the range of addresses
occupied by the instructions that implement a function. Both values are inclusive, which means that the
specified range includes both of the bound values, as well as all of the addresses between them.

Related Topics

TLA Symbol File Format - TSF Range Symbols (see page 346)
TSF Range Symbols - Variable (see page 351)

TSF Range Symbols - Source (see page 349)

TSF Range Symbols - Color (see page 347)

TSF Range Symbols - Source

The file directive "#+ Source" introduces the source symbol section of a TSF range file. The file directive
tells the file reader that the following symbols represent source statements, as opposed to functions or
variables. The source file directive must be followed by a file name, which specifies the name of the source
file containing the following source statements. Each new set of symbols for a unique source file must

be introduced with an additional source file directive to specify the file name for those symbols. If no
symbol type file directive is given, the function symbol type is assumed.

#+ Source stoplite
# Line Low High Beg End Symbol Name
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# ==== e —
27 006043ec 006043ef stoplite_27_25
35 006043f0 006043f5 stoplite_35_23
47 006043f6 006043ff stoplite_47_30
48 00604400 00604409 stoplite_48_30
49 0060440a 00604413 stoplite_49_30
50 00604414 0060441d stoplite_50_30
51 0060441e 00604427 stopTlite_51_30
52 00604428 00604431 stoplite_52_30
56 00604432 00604437 stoplite_56_17
59 00604438 00604439 stopTlite_59_18
60 0060443a 00604445 stoplite_60_37
61 00604446 0060444d 33 stoplite_61_33
59 0060444e 0060444f 35 39 # stoplite_59_35
59 00604450 00604455 19 34 # stoplite_59_19

[eNeNoNoNoNoNoNoNoNoNoNe)
w w
o o

HOoH H K OH H K HH KR H

71 00604456 00604457 0 37 # stoplite_71_37
74 00604458 0060445f 0 35 # stoplite_74_35
77 00604460 00604467 0 36 # stoplite_77_36
80 00604468 0060446f 0 36 # stoplite_80_36
83 00604470 0060447b 0 43 # stoplite_83_43
87 0060447c 00604483 0 34 # stoplite_87_34
71 00604484 0060448d 0 37 # stoplite_71_37
84 0060448e 00604490 0 29 # stoplite_84_29

The source symbols section consists of five fields for each source statement: line number, lower address
bound, upper address bound, beginning column value, and ending column value.

Source symbols do not have a name in the same sense as function or variable symbols, because there is
no name associated with each of the executable statements in a source file. Instead, a source symbol
has a file name, specified in the source directive, and a line number. The line number specifies the line
of the source file that contains the source statement. Line numbers are always in decimal, regardless
of the file radix in the header.

The lower and upper bound values for a source symbol are similar to those of function and variable
symbols. For source symbols, these bounds represent the range of addresses occupied by the instructions
that implement a single source statement.

The bound values are defined in the file radix specified in the header and can range in value from
0x00000000 to OxFFFFFFFF. The lower and upper bound addresses are inclusive, just like other symbols.
A source symbol for an instruction occupying a single memory location has matching lower and upper
bound values.

The beginning and ending column fields of a source statement are optional. When present, and non-zero,
they define the beginning and ending column position for the source statement.

The beginning and ending column values define the location of the statement in the line. This is especially
useful when there are multiple statements on a single line, because it makes it possible to define a separate
symbol for each statement. When the column information is not present, or is set to zero, the symbol is
assumed to correspond to the entire line.
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Only a few compilers generate column information, but when the information is present in the symbol file,
the logic analyzer uses the column information to provide highly accurate source code correlation. The
example source symbols on the previous page show typical column values.

In most cases only one of the column values is non-zero. This is because those lines contain only one
statement, and the compiler specified only the column at which the statement ended. Some compilers
specify only the beginning column position for such lines, in which case the beginning value would
be non-zero and the ending value zero.

Note that there are three symbols corresponding to line 59 of the file. Line 59 of the original source
file contains the following statement:

for (i = 0; i < NUM_STATES ; i++)

This one line contains three separate statements. The first statement is the initialization (i = 0), the second
statement is the test (i < NUM_STATES), and the third statement is the increment (i++).

Although all three statements appear on the same line, each generates a separate set of instructions, and
the symbols in the example define unique address ranges for each. This enables the Source window to
accurately indicate which of the three statements on the line is associated with any given address.

Each of the source symbols in the example includes a comment at the end of the line showing a symbol
name. Since this is a comment, it is ignored by the symbol file reader, and is optional. When symbol files
are exported by the logic analyzer, they contain comments that show the derived symbol name created by
the logic analyzer itself. The name is a concatenation of the symbol file name, line number, and column
number (if present). This is the symbol value that the logic analyzer will display for addresses that fall
within the lower and upper bounds of a source symbol.

Related Topics

TLA Symbol File Format - TSF Range Symbols (see page 346)
TSF Range Symbols - Function (see page 349)

TLA Symbol File Format - TSF Range Symbols (see page 346)
TSF Range Symbols - Color (see page 347)

TSF Range Symbols - Variable

The file directive "#+ Variable" introduces the variable symbol section of a TSF Range file. The file
directive tells the file reader that the following symbols represent variables, as opposed to functions or
source statements. If no symbol type file directive is given, the function symbol type is assumed.

#+ variable

# Symbol Name Low High
#
menu 00000100 00000102
userMenul 000004c0 000004c?2
binBits 000004d4 000004d6
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Variable symbols consist of three fields: the symbol name, the lower bound, and the upper bound. Variable
symbols are just like function symbols except that they define the address range occupied by a variable
instead of function. The lower and upper bound values of a variable symbol are inclusive, meaning

that they are themselves a part of the range. For variables occupying only a single byte in memory, the
lower and upper bound values are equal.

Related Topics

TLA Symbol File Format - TSF Range Symbols (see page 346)
TSF Range Symbols - Function (see page 349)

TSF Range Symbols - Source (see page 349)

TSF Range Symbols - Color (see page 347)

System Window

352

Access all other setup windows, trigger windows, and data windows from the System window. The System
window also shows the analyzer configuration, arming, and triggering relationships.

Logic Analyzers

An icon represents each installed instrument. Inside each
icon are specific controls to do the following tasks: Logic I THTH

Analyzer St 12 [
B Open the properties tab by double-clicking an open oon] == -
area inside the icon. o
COff| Setup| Trig

B Open the logic analyzer Setup window by clicking the
Setup button.

L& 1

B Open the logic analyzer Trigger window by clicking the
Trigger button.

B Turn the logic analyzer on or off by clicking the On/Off
button.
= Name the logic analyzer by entering text in the text box.

Click the logic analyzer to see which data windows contain
data for the logic analyzer.

Active Logic Analyzer

The logic analyzer highlighted by the pointer in the System window is the active logic analyzer.

Identifying Modules

If you are unsure which physical module an icon represents, double-click the icon to open its System
Properties dialog box. The System Property dialog box lists information about the module, including the
mainframe slot number in which the module is installed.
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Disabling Modules
To disable a module, click the module’s On/Off button.

When you disable a module, first verify that no other trigger program is dependent on the module’s output.

Data Windows

An icon represents each data window. Use the New Data Window dialog box to create Histogram or
Source windows or other windows. To create a new data window click "l in the toolbar.

NOTE. Change the default data window for logic analyzer in the Defaults property page. From the System
menu, select Options and click the Defaults tab to display the Defaults tab.

Inside each data window icon are specific controls to do
the following:

e
= Open a data window by clicking its icon located above e

the text box. ListingT

B QOpen the Properties dialog box to access the product's
properties tabs by double-clicking the mouse in an open
area close to the icon.

®  See which data windows are associated with a logic
analyzer (or data window), by clicking the logic analyzer
(or data window text box). White arrows appear, linking
the logic analyzers and data windows.

Renaming a Window

Rename the window by selecting the current window label and typing over it. Window names must be
unique and the window name is limited to the space available.

Triggering and Arming Relationships

A logic analyzer that is programmed to cause a system i

trigger (see page 354) has a trigger indicator symbol T LB |

on the right edge of the logic analyzer icon. A black arrow

from one logic analyzer to another indicates one module is hﬂﬂilc TR Biﬂit.ﬁ" il

programmed to arm (see page 354) another through the RAWEel: ol e sElicnpe St !

first module’s trigger program (see page 354). The example oun| S8t Bl =k e

shows a logic analyzer module arming the DSO module. ©0ff| Setup| Trig ©0ff| Setup| Trig
L& 1 D501
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Related Topics

Triggering other Modules from an LA (see page 104)
Arming other Modules from an LA (see page 104)

Armed Module

An armed module is a module that begins running its trigger program once it has received an arm
signal from another module. This allows the armed module to run its trigger program when a
condition is met in the other module’s trigger program.

System Trigger (Trigger All Modules)

The system trigger is an overriding command that causes all modules to acquire their post trigger
data, regardless of whether they have been armed or have fulfilled their own trigger conditions.
The system trigger is the primary data acquisition reference point. In data windows, timing and
location information is relative to the system trigger.

When the system trigger occurs, the trigger signal will appear at the external System Trigger Out
connectors of the instrument.

Trigger Program

The trigger program is a series of conditions, similar to software code that defines the data you want
to capture and view. The trigger program also specifies actions that are expected when conditions
(data events) are true.

The trigger program filters acquired data to find one or more specific data events. The trigger
program can accept signals from other modules or signals from external test equipment through the
external System Trigger In or the External Signal In connectors. Similarly, the trigger program

can also send signals from the module to external equipment through the System Trigger Out and
the External Signal Out connectors.

New Listing/Waveform Data window

Use this dialog to create a new Listing or Waveform window. Click one of the following selections to
specify the data source for your new data window:

B Click Data from to select a data source from the current system. If the data source you want is not
listed, click the Add Data Source button to add one from the TLA system or logic analyzer file to the
current system. Click the Browse button to search for a desired TLA system file.

B Click No data to create an empty Listing or Waveform window. After the window displays, add
columns or waveforms from different sources.
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®  Click Same columns/windows as active data window to add the columns or waveforms from the
active window to your new data window.

B (Click MagniVu columns/waveforms based on the active data window to view MagniVu data
(higher resolution) of the same columns or waveforms as the active window.

Related Topic
Adding a Waveform (see page 118)

New Data Window Name

Enter a name for the new data window or use the default name. Then click the Finish button to create
the new data window.

Name Data Window Dialog Box

Use to specify a new name for a data window. This dialog box displays when you attempt to name a
data window that is not unique.

Load System Options Dialog Box

Use to load part of a saved system file into the current system. This is useful when you need to use
portions of a saved system file with the current system. A saved system consists of one or more modules,
data windows, and links to data sources in other TLA files. A saved module consists of the module’s
setup and trigger settings as well as data.
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Load System Options 2X

Dirag modules i the saved spstem onto desired modules m the curent
syztem, Feference data sources and data windows in the saved systemn waill
alza be bbaded.

Protocof
JELIHRE P LAV ot
i=H T i b | o=z %
[ |
L& 1 Dso CSaT154

o

From a saved module file, load any of the following:
B An LA module trigger program

® A module setup and trigger program

®  Saved data from the module

From a saved system file, load any of the following:
B Any previously listed module choices

B Full system setup, including data windows

®  Saved data from one or more modules

Behavior

Load System Options Dialog Box

The Load System dialog box is automatically opened when you perform a Load System and the saved
system file does not match the current logic analyzer configuration (and both systems contain at least

one module).

When necessary, the analyzer adjusts the following setup parameters to match hardware limits:

B Memory depth
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®m  Trigger position. Relative position is maintained
B Sample period

If you try to load a module that is not compatible with the saved module, the cursor changes to a no drop
shape. The following might cause the saved file to be incompatible:

B The width of the current module is less than the width of the saved module.

B The module type is not the same. Use a saved DSO module for a DSO, and a saved logic analyzer
module for a logic analyzer.

If you load a saved system with a different module configuration than your current system, the logic
analyzer displays a dialog box similar to the following:

The zaved zuztem configuration doss not match the current
gystem configuration.

todules in the zaved systern will be mapped to modules in the
current spstem az shown below, Any modules in the saved
gygtem that are not mapped will not be loaded. Any modules in
the current zpstem that aren't mapped to will be defaulked and
dizabled.

Prezz OF. to load with theze mappings. Presz Load Options to
load with your own mappings.

L& 1 [Slatz 3-4] will not be loaded. Y
LA 2 [Slotz B-E] will be loaded onto [Slotz 8-3],

LA 3 [Slatz 7-8] will not be loaded.

0S50 1 [Slatz 3107 will ot be loaded.

LA 4 [Slotz 17-12) will not be loaded.

TDSR104B [GRIE 1 Migw) will not be loaded. hd

| 0k | [ Load Options

Click OK to accept the suggested configuration. If you click Cancel, the logic analyzer displays the Load
System Option dialog box. Use this dialog box to load specific modules from the saved system.

NOTE. Ifyou load a setup that you saved with suppressed samples, the suppressed samples are not present
in the setup.

An unmerged module can be loaded into a merged module. The master of the merged pair must have a
width equal to or greater than the unmerged module. A merged module can be loaded into a merged
module, provided the master and slave of the destination has a width equal to or greater than the master
and slave of the saved pair.
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To Use

To open the Load System Options dialog box:

1. Go to the File menu from any window.

2. Select Load System.

3. Select a TLA system file. The Options button becomes active when a system file is selected.
4. Click Options.

To load a saved module, drag the module icon from the top of the Load System Options dialog box to
a module icon at the bottom of the dialog box.

NOTE. The module icon does not move, however the cursor changes shape to indicate a drag function.

Related Topics

Saving a System (see page 80)
Merge Modules Properties (see page 365)

Status Monitor Dialog Box

358

To open the Status Monitor dialog box, click the Status button on the toolbar.

i

The Status Monitor is used to determine the status of your acquisition while it is running.

The Run animation control indicates when the system is in the acquisition mode by changing from
to il when the Run button is clicked.

When you hover your mouse pointer over the icon, a tool tip box provides you with the acquisition
status of your installed modules as shown below.

M Status Monitor

System Statuz: [dle

todule Mame Statuz

L& Idl=
DS01 Idl=
CSA7154 Daone
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The Status Monitor dialog box contains a summary area at the top that lists a one-line summary of each
module installed.

The Status Monitor dialog box shows the following:

m  Status of the acquisition: Idle, Waiting for Trigger, or Triggered.
®  The Start Time of the acquisition.

B The name of the module.

B The status of memory for all modules during acquisition is shown on the left of the status dialog
box. Blocks are filled in to the left of the T (trigger position). Blocks are filled to the right of the T
after the module is triggered.

m  The number of repetitive acquisitions when in Repetitive mode.
B The trigger state of the logic analyzer module trigger program that is executing.
B The number of samples remaining to be filled in memory.

m  The value of each logic analyzer counter and timer when appropriate. Only shown for logic analyzer
modules.

B The state of the module’s intermodule output signal, shown as Sig/Arm Out.
m  The status of data comparison during logic analyzer memory compare operations.

B Clock warning when the logic analyzer senses no clock activity. If this message appears, check for a
missing clock signal or for an error in the sampling setup.

The Status Monitor dialog box is resizable.

Related Topic
About Data Properties (see page 195)

External Signal Selection

When using the External Signal In and External Signal Out functions, select an internal signal.
B Select None to prevent signals from being sent or received at the external connector.

B Select 10 MHz clock to send a 10 MHz clock signal to the External Signal Out connector. This
signal will be available continuously at the connector until explicitly disconnected by changing the
External Signal Out selection in the Signals tab.
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NOTE. The 10 MHz clock signal is interrupted briefly during the following actions: Load System, Default
System, diagnostic execution, and calibration.

m  Select Signal 1-4 to assert External Signal Out when the specified signal is true. Signals 1 and 2 are
high-speed, ECL rate signals, and are usually the preferred choice for both internal and external
signal applications. Signals 3 and 4 are functionally equivalent to signals 1 and 2, but operate at
the slower TTL-rate.

Signals 1 and 2 162 MHz maximum
62.5 MHz maximum (at External Signal Out connector)
Signals 3 and 4 12.5 MHz maximum

Internal Signal Selection

Signals 1 and 2 are high-speed, ECL-rate signals, and are usually the preferred choice for both
asynchronous and synchronous signal applications. Signals 3 and 4 are functionally equivalent to signals 1
and 2, but operate at the slower TTL rate.

Signals 1 and 2 162 MHz maximum (internal)
62.5 MHz maximum (at External Signal Out connector)
Signals 3 and 4 12.5 MHz maximum

Selection Dialog Box

Use the Selection dialog box when you want to do one of the following tasks:

B Add a data source from a TLA system or module file to the current system. Click Browse to search
for the required file.

B Load a data window from a TLA system file.

®  Load a module setup onto a selected module in the current system.

®  Load triggers. Click Browse to select a trigger from your modified trigger list.

B Load a trigger setup onto a selected logic analyzer module in the current system.

B [oad a search definition onto a selected data window in the current system. Click Browse to select
a previously saved search definition.

360 TLA Online Help



Reference MagniVu Data

MagniVu Data

Overview

MagniVu data is the result of asynchronous digital oversampling architecture. This data is automatically
acquired whenever you perform an acquisition. This means that, even if you specify synchronous
acquisition, view the asynchronous resolution data at any time without having to reacquire.

Behavior

MagniVu acquisition rates differ based on the module that you have. The acquisition rate is selectable,
based on your MagniVu Storage Rate (see page 172), and is constrained by both PowerFlex, and the
current maximum acquisition rate for main memory.

Related Topic
Adding MagniVu Data to a Listing or Waveform Window (see page 77)

System Trigger (Trigger All Modules)

The system trigger is an overriding command that causes all modules to acquire their post trigger data,
regardless of whether they have been armed or have fulfilled their own trigger conditions.

The system trigger is the primary data acquisition reference point. In data windows, timing and location
information is relative to the system trigger.

When the system trigger occurs, the trigger signal will appear at the external System Trigger Out
connectors of the analyzer.

High-Level Language support

Correlate the High-Level Language (HLL) source code that you wrote with the disassembly listing,
showing how the code was executed on your target system, and then acquired by the logic analyzer.
The correlation is based on symbolic information that is extracted from your object file or load module.
Configure the logic analyzer to access your source files.

Step through each executed source statement in the Source window and view the results in a correlated
Listing window.

Set user-defined marks as break points within the code and then trace the execution of the code between
the marks.

TLA Online Help 361



Reference Start-Up Properties

The following file formats are supported: OMF51 (see page 342), OMF86 (see page 342), OMF166 (see
page 342), OMF286/386 (see page 343), IEEE695 (see page 343), COFF (see page 343), ELF/DWARF
and ELF/STABS (see page 343).

In addition to the file formats listed below, Tektronix also provide the Tektronix Symbol File Format (TSF)
(see page 344), a text format. For information on any other file formats, contact your local Tektronix
representative.

Start-Up Properties

Use to select which system to open after you power on the analyzer. You are presented with the following
choices:

Last System file opened in previous session. The TLA application automatically loads at start-up the
last saved system file that you explicitly loaded.

Default System. The TLA application loads the default setups for all modules at start-up.
Saved System. The TLA application loads a saved system file that you specify at start-up.
The default system also consists of the following:

B Default setups for all modules.

B Default settings for internal signals specified in the System Configuration dialog box.

B One data window for each module. A Waveform window is created for each DSO module. A data
window of the default type, as specified in the Defaults tab, is created for each logic analyzer module.
Only data sources from the physical modules in the current system are included.

®  All usable modules are on.

To open the Start-Up tab from the System menu, click Options and then click Start-Up.

Related Topic
Defaults Properties (see page 370)

Power-On Diagnostics Properties

Overview

Use to view the results of the power-on diagnostics. The Test Name column lists the mainframe, slot
number and name of installed modules, and specific tests.
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Behavior

If any test failed, the Power-On Diagnostics page opens as the first active window and the first failed test is
highlighted. If a test fails, either select the Extended Diagnostics tab and rerun the test, or dismiss this page
by clicking the Close button. If you dismiss this page, the application finishes loading.

NOTE. Mainframe power-on diagnostics only run when the system powers on.

If a module is not recognized, the module type area is filled in with any available information or the
word Unknown is displayed.

To Use

To open the Power-On Diagnostics tab from the System menu, click Calibration and Diagnostics and then
click Power-On Diagnostics.

Related Topics

Running Extended Diagnostics (see page 133)
Contacting Tektronix )

Self Calibration Properties

Overview

Use to run calibration procedures on installed modules, either individually or as merged pairs. You should
run these procedures after repair and at least once a year for the logic analyzer module. The DSO module
requires self-calibration if the ambient operating temperature has changed more than 5 °C since the

last calibration or once a week if the vertical settings of 50 mV full scale or less are used. A warning
message to calibrate appears if ambient temperature goes out of tolerance. Perform self-calibration after
a 30-minute warm up.

NOTE. Merged modules must be calibrated individually and as a set.

Status list

The following is a list of status messages:

B Running. The calibration procedure is being executed. The text blinks to indicate progress.
m  Calibrated. The module calibrated successfully.

B Fail. The module did not calibrate. Contact your local Tektronix service representative.
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®  No Calibration Required. The module either does not need to be calibrated or it does not have
any self-calibration functions.

B Unknown. Try to calibrate again. If the module has the same status, contact your Tektronix service
representative.

To Use

To open the Self Calibration tab from the System menu, click Calibration and Diagnostics, and then
click Self Calibration.

Related Topics

Power-On Diagnostics Properties (see page 362)
Extended Diagnostics Properties (see page 331)
Calibrating Modules (see page 61)

Contacting Tektronix )

Mainframe Properties

Use this information when you contact Technical Support.

To open the Mainframe tab from the System menu, click System Properties and then click Mainframe.

Modules Properties

Shows information about modules installed in the analyzer.
1. From the System menu, click System Properties.

2. Click the Modules tab.

Module Specifics Properties

Provides information about a selected module. You use this information when contacting Technical
Support.

1. From the System menu, click System Properties.

2. Click the tab of the module for which you want information.

364 TLA Online Help



Reference

Merge Modules Properties

Overview

Merge Modules Properties

Merge up to five logic analyzer modules to increase width. Merged modules function as a single unit and
the data it acquires is automatically time-correlated. This is useful when analyzing buses or devices with a
high count. Some microprocessor supports require merged modules.

Behavior

Modules must be physically connected and in the same mainframe before they can be merged by software.
Modules must be adjacent and connected as described in the user manual. Only modules that have been
physically connected and are capable of being merged are shown in the Merge Modules tab with a merge
button. Refer to Merging Modules (see page 55) for the rules on merging modules.

The state of the button indicates whether the modules are currently merged, as shown:

-System Configuration

Signals e |

o T AT LI LV w WHIHT
=7 ol 5| o et sl=l 7 =T

| | | | [

L& 1 L& 2 L& 3 | |DSO1 Y

-~ “""«.:; 7 %

B i (i

I:E al

TLATAAZ TLATNA4 TLATAB4 TLATDY TLATAAZ
Slots 34 Slotz 56 Slhals 7-8 Slots 510 Shots 11-12

ok || Ccance Apply Help
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To Use

To open the Merge Modules tab from the System menu, click System Configuration and then click Merge
Modules. To merge or unmerge modules, click the merge button between the module icons.

Related Topics

Merging Modules (see page 55)
Self Calibration Properties (see page 363)
Merged Module Synchronous Sampling (see page 27)

Preferences Properties

Use the preference properties page to specify user preferences, such as hiding the Status bar, displaying
confirmation messages, specifying click and drag zoom behavior, or showing the Easy Setup dialog. These
settings cannot be modified anywhere else in the application.

To access user preferences from the System menu, click Options to display the Options dialog box.
Then click the Preferences tab.

System Source Files Properties

366

Overview

The System Source Files tab defines the default location of source files for new Source windows. The
settings you specify in this tab will be the default settings used to locate source files when you first create a
Source window. Specify a list of directory paths and a list of possible file suffixes.

Behavior

When specifying the search path, use an asterisk (*) as the final component of a search path directory.
For example, if you specify the following path, C:\MySources\*, the MySources directory and all
directories (one-level deep) within MySources will be searched. However, you cannot use the asterisk
as a general-purpose wild card character. For example, the use of an asterisk in C:\MySources\*\* or
C:\MySources\abc* is invalid.

Specify the complete absolute (not relative) path name for the file in the Search Path List. Otherwise the
Source window will not locate the source file. Make sure that the source file you are looking for has a
unique file name. When searching for source files it is possible to load the wrong file if there is another file
with the same name in the directories specified by the search path. The Source window always loads the
first file that matches the search criteria.
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NOTE. This tab is similar to the Source Window Source Files tab. The information that you supply in this
property page will be used as default settings for new Source windows. The information that you supply
for the Source Window Source Files tab is only used for the current Source window.

To Use

To open this page from the System menu, click Options and then click Source Files.

Select Search Path List to specify source file locations.

B Select Suffix List to specify possible file suffixes. The default suffixes are .c and .s.
B Click Add to add items.

B Click Edit to edit the selected item.

B Click Delete to delete a selected item from the list.

Related Topic

Source Window Source Files Properties (see page 233)

Signals Properties

The logic analyzer has four internal signals to use to set up trigger conditions between modules, or to send
or receive signals external to the logic analyzer. Use the Signals tab in conjunction with the module trigger
programs to configure these signals for your application. The trigger programs and external signal input
determines when the signals occur. The Signals tab specifies signal characteristics. To configure signals
for your application from the System menu, click System Configuration, and then click the Signals tab.
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Internal Signals

All logic analyzer modules can set and clear any of the four internal signals. The DSO can set but not clear
any signal. The logical output of these signals can be used as an event in other trigger programs. Connect
the internal signals to the External Signal In and External Signal Out connectors on the mainframe, so to
use an external signal as a trigger event or send a signal out when a trigger condition is met.

Internal signaling is for users with special trigger programming requirements. Internal signaling adds
flexibility to trigger programming, but also adds complexity. When using internal signaling, take care
that the signals are correctly set and cleared, and that the trigger programs for all modules are compatible
with regard to signal usage. Also, correctly set the internal signal attributes in the Signals tab of the
System Configuration dialog box.

Internal signaling is done through trigger actions specified in the Clause Definition dialog box and the
DSO Trigger tab.

NOTE. Arming and internal signaling are mutually exclusive. You cannot simultaneously arm modules
and set signals. Test for a set signal (for example, If Signal X Is True), but unless you have designated an
external signal for this purpose, you will be unable to set the signal when using the arming feature.

External Signals

The logic analyzer can send and receive signals external to the logic analyzer using the mainframe External
Signal In and External Signal Out connectors. Use the External Signal In function to include a signal from
your system under test or other test equipment as part of the trigger program. Use the External Signal Out

function to send a signal to the system under test or other test equipment from a trigger program.
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The connection from the module to the external connector is made by one of the four internal signals.
Designate which internal signal is to be used for this purpose.

The external signal connectors are located at the rear of the portable mainframe and at the front of the
benchtop mainframe. The external signals all operate at TTL voltage levels.

The polarity for External Signal In is always set to Low TRUE. You have a choice of low or high true for
External Signal out. For a high true signal, clear the selection Low TRUE.

Signal Logic Function

To use internal signals, select which internal signal logic function is appropriate for your trigger program.
Signals 1 and 2 (high speed) can only be asserted by one module each. For signals 3 and 4 the modules
can be wired-OR or wired-AND. Selecting the OR function means that any module can assert the signal.
Selecting AND means that all modules must set the signal for it to be asserted. The same logic applies to
clearing signals.

System Trigger Connectors

The System Trigger In/Out Connectors group box contains readouts that reflect the current state of the
System Trigger In and System Trigger Out connectors. Set the threshold for the System trigger in
connector.

NOTE. Only modules that are on can send arming or internal signals.

To Use

To open the Signals tab from the System menu, click System Configuration and then click Signals.

Related Topics

Clause Definition Dialog Box (see page 163)
DSO Trigger Settings (see page 377)
External Signal Selection (see page 359)
Internal Signal Selection (see page 360)

Color Properties

Use to create, remove, and modify color schemes.
1. Select an Element you want to change from the list and then select a color from the color matrix.

2. Click Save As to enter a new name for your scheme or click OK in the Save Scheme dialog box to
keep the existing name and redefine the defaults for it.
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NOTE. You cannot redefine or remove factory defaults.

A default color scheme can be assigned for new data windows from the Defaults tab, which is located in
the Options dialog box.

From the System menu, access the Color settings by clicking Options and then clicking the Color tab.

Related Topic
Defaults Tab (see page 370)

Software Properties

Shows what TLA software is installed in the analyzer.
1. From the System menu, click System Properties.

2. Click the Software tab.

Defaults Properties

Use to specify defaults used throughout the application. The settings you enter here will be the default
settings used when creating new data windows.

To access these settings from the System menu, click Options and then click the Defaults tab.

Save Color Scheme Dialog Box

Use to save a new color scheme set in the Color tab of the Options dialog box.

To open this dialog box from the System menu, click Options, click the Color tab and then click Save As.

Related Topic
Color Properties (see page 369)

Presets Properties

Use the Options Presets to view and modify preset names and values. The presets are used as list entries
in list box controls for selecting trigger thresholds, vertical range, vertical offset, and probe thresholds.
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Modify all preset names and values. Preset names are limited to 12 characters. Click Reset All to return
all preset names and values to the factory settings. If you enter a value that is out of the range shown
below, the value is set to the nearest in-range value.

To change options presets from the System menu, click Options and click the Presets tab.

Tools Properties

Overview

The Tools tab of the Options dialog box allows you to define up to 16 external applications (or tools) that
may be launched from within the TLA application.

These tools can be associated with any program that runs under the Windows operating system or any type
of document that Windows knows how to open. When a tool is defined here, it is automatically added

to the Tools sub-menu of the System menu in the TLA menu bar. Also, a toolbar button for each tool

is added to the TLA Toolbar.

Once a tool has been defined, run the program by choosing its name from the Tools menu or clicking
on its toolbar button.

To Use
®  Click the Add button to add a new tool.

m  Click the Edit button to edit the properties of the selected tool, including its Menu Name, Command,
Arguments, Initial Directory, and Run Minimized status.

m  Click the Delete button to delete a selected tool from the list.
m  Click the Move Up arrow button to move the selected tool up one position in the list.
B (Click the Move Down arrow button to move the selected tool down one position in the list.

To open the Tools property page, from the TLA menu bar select System ® Options, and select the Tools tab.

NOTE. Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties
(App Options) dialog box for the commands to work.

Related Topic
Tool Properties Dialog Box (see page 372)

TLA Online Help 371



Reference Tool Properties Dialog Box

Tool Properties Dialog Box

Overview

Use the Tool Properties dialog box to specify the properties of an external tool.

To Use

Specify the name of the tool in the Menu Name box. This is the name that is displayed in the Tools menu.
Placing an ampersand before a letter in the tool name makes that letter an accelerator key.

Enter the path and name of the document or application that you want to open in the Command box. Click
the Browse button to open a Windows file browser to help find the application. If a document is entered
here, the executable to open the document is found based on its registered Windows file type. For example,
a document with a .txt extension is opened with Notepad.

Use the Arguments box to enter any command line arguments that are required by the application.
Use the Initial Directory box to specify the default working directory for the application.

Click Run Minimized to specify that the application will run in a minimized window.

Click the Test Run button to launch the tool with the current dialog settings.

To open the Tools property page, from the TLA menu bar select System ® Options, and select the Tools
tab. Click the Add button, or select the tool you want to modify and click the Edit button.

NOTE. Arguments and commands with embedded spaces must be enclosed in quotes in the Tool Properties
(App Options) dialog box for the commands to work.

Related Topic
Tools Properties (see page 371)

General Purpose Data Window Shortcuts

372

To Press

Switch data windows CTRL+Tab

Scroll data up 10 pages Shift+Page Up
Scroll data down 10 pages Shift+Page Down
Scroll data to the top of the window Shift+Home

Scroll data to the end of the window Shift+End

Move active cursor up one page CTRL+Page Up
Move active cursor down one page CTRL+Page Down
Move active cursor to top of the data CTRL+Home
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To

Press

Menu Shortcut Keys

Move active cursor to end of the data

CTRL+End

Move active cursor up 10 pages

CTRL+Shift+Page Up

Move active cursor down 10 pages

CTRL+Shift+Page Down

Move active cursor to the top of data

CTRL+Shift+Home

Move active cursor to the end of data

CTRL+Shift+End

The movement shortcuts follow these general rules:

B Arrows with no modifier keys scroll the data

B Arrows with the CTRL key move the active cursor

m  The Shift key provides 10 times the movement

Related Topics

Listing Window Shortcuts (see page 375)

Waveform Window Shortcuts (see page 374)

Source Window Shortcuts (see page 376)

Histogram Window Shortcuts (see page 377)

Menu Shortcut Keys (see page 373)

Menu Shortcut Keys

Use the following shortcut keys for manipulating menus, editing windows, and moving around in data

windows.

File Menu

To Press
Return the system to the default setups CTRL+D
Load a saved system CTRL+O
Save a system setup CTRL+S
Print the active window CTRL+P
Edit Menu

To Press
Cut a selected item to the clipboard CTRL+X
Copy a selected item to the clipboard CTRL+C
Paste items from the clipboard CTRL+V
Undo edit CTRL+Z
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Waveform Window Shortcuts

374

Waveform Window Shortcuts

Data Menu

To Press
Search backward CTRL+B
Search forward CTRL+F
System Menu

To Press
Display the Status Monitor CTRL+M
Run or Stop CTRL+R
Window Menu

To Press
Create a new data window CTRL+N

Related Topics

Waveform Window Shortcuts (see page 374)

Listing Window Shortcuts (see page 375)

Histogram Window Shortcuts (see page 377)

Source Window Shortcuts (see page 376)

General Purpose Data Window Shortcuts (see page 372)

To Press

Go to next Sample Suppression change CTRL+0

Go to previous Sample Suppression change CTRL+9

Go to next trigger CTRL+T

Display Go To dialog box CTRL+G

Move Cursor 1 to center of window CTRL+1

Move Cursor 2 to center of window CTRL+2

Zoom in CRTL+I

Zoom out CTRL+U

Add a mark CTRL+K

Add a waveform CTRL+W

Scroll data left 50 pixels Shift+Left arrow
Scroll data right 50 pixels Shift+Right arrow
Move active cursor left five pixels CTRL+Left arrow
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Listing Window Shortcuts

To Press

Move active cursor right five pixels CTRL+Right arrow
Move active cursor left 50 pixels CRTL+Shift+Left arrow
Move active cursor right 50 pixels CTRL+Shift+Right arrow

The movement shortcuts follow these general rules:

B  Arrows with no modifier keys scroll the data

m  Arrows with the CTRL key move the active cursor

®  The Shift key provides 10 times the movement

Related Topics

Listing Window Shortcuts (see page 375)
Menu Shortcut Keys (see page 373)

General Purpose Data Window Shortcuts (see page 372)

Listing Window Shortcuts

To Press

Go to next Sample Suppression change CTRL+0

Go to previous Sample Suppression change CTRL+9

Go to next trigger CTRL+T
Display Go To dialog box CTRL+G

Move Cursor 1 to center of window CTRL+1

Move Cursor 2 to center of window CTRL+2

Add a mark CTRL+K

Add a column CTRL+L

Scroll data up 10 samples Shift+Up arrow
Scroll up 10 lines Shift+Up arrow

Scroll data down 10 samples

Shift+Down arrow

Scroll down 10 lines

Shift+Down arrow

Move active cursor up one sample

CTRL+Up arrow

Move active cursor up one line

CTRL+Up arrow

Move active cursor down one sample

CTRL+Down arrow

Move active cursor down one line

CTRL+Down arrow

Move active cursor up 10 samples

CRTL+Shift+Up arrow

Move active cursor up 10 lines

CRTL+Shift+Up arrow

Move active cursor down 10 lines

CTRL+Shift+Down arrow

Move active cursor down 10 samples

CTRL+Shift+Down arrow

TLA Online Help

375



Reference Source Window Shortcuts

The movement shortcuts follow these general rules:
B Arrows with no modifier keys scroll the data
m  Arrows with the CTRL key move the active cursor

B The Shift key provides 10 times the movement

Related Topics

Waveform Window Shortcuts (see page 374)

Histogram Window Shortcuts (see page 377)

Source Window Shortcuts (see page 376)

General Purpose Data Window Shortcuts (see page 372)
Menu Shortcut Keys (see page 373)

Source Window Shortcuts

To Press

Display Go To dialog box CTRL+G

Move Cursor 1 to center of window CTRL+1

Move Cursor 2 to center of window CTRL+2

Add a mark CTRL+K

Step Forward CTRL+H

Step Backward CTRL+J

Scroll data up 10 lines Shift+Up arrow

Scroll data down 10 lines Shift+Down arrow
Move active cursor up one line CTRL+Up arrow
Move active cursor down one line CTRL+Down arrow
Move active cursor up 10 lines CRTL+Shift+Up arrow
Move active cursor down 10 lines CTRL+Shift+Down arrow

The movement shortcuts follow these general rules:
B Arrows with no modifier keys scroll the data
m  Arrows with the CTRL key move the active cursor

B The Shift key provides 10 times the movement

Related Topics

Listing Window Shortcuts (see page 375)
Waveform Window Shortcuts (see page 374)
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General Purpose Data Window Shortcuts (see page 372)
Menu Shortcut Keys (see page 373)

Histogram Window Shortcuts

To Press
Scroll up 10 ranges Shift+Up arrow
Scroll down 10 ranges Shift+Down arrow

The movement shortcuts follow these general rules:
B Arrows with no modifier keys scroll the data

B The Shift key provides 10 times the movement

Related Topics

Listing Window Shortcuts (see page 375)
General Purpose Data Window Shortcuts (see page 372)
Menu Shortcut Keys (see page 373)

DSO Trigger Settings

Overview

The DSO Trigger tab contains all controls for setting DSO trigger events and actions. Threshold changes
are recognized and executed immediately during acquisitions. Execution of all other controls is delayed
until the next acquisition.

Behavior

Use Mode to select whether the DSO waits for a trigger (Normal) or forces a trigger after a set length of
time has passed without a trigger (Auto).

Use Action to select what happens when a trigger is recognized. The trigger event either triggers the DSO,
triggers all modules, triggers and sets a signal, or triggers and arms another module.

Action Target selects the event or the condition Trigger Action will act on:
B Trigger & Set Signal. A Set Signal action allows you to set signal 1, 2, 3, or 4.

m  Trigger & Arm. An Arm action allows you to arm other installed modules. The default is the module
in the lowest-numbered slot that can be armed.

Use Trigger position to set the amount of data in the data record that occurs before the trigger.

Use Event Type to select the type of event the DSO will recognize as a trigger.
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Related Topic
System Trigger and Reference System Trigger Relationship (see page 165)

Select Status Bits Type Dialog Box

Use the Select Status Bits Type dialog box to select the logic analyzer’s status bits for additional triggering
and data display.

Depending on your logic analyzer module, select one or more status bits for triggering and display. The
status bits of a module (or master module in a merged set) are available for use in the Signal Mapping area
of the LA Setup window. In most cases, use the status bits like any other signal bit such as comparing data,
naming signals, and assigning the bits to a group.

However, because the status bits are not real data signals, you cannot access certain properties of the status
bits such as thresholds, iCapture, and multiplexed (demux) sampling.

The available status bits depend on the logic analyzer module.

Saved Triggers

Overview

When saving from the Easy Trigger tab, use the Save dialog box to save your TLA file, which contains
trigger state information as well as information about the currently selected Easy Trigger program. If you
do not use an Easy Trigger program as the basis of your modified trigger design, but instead use the Power
Trigger tab to develop your trigger program, only a TLA file with the state information is saved.

To Use

Saving your trigger program requires that you specify both a file name and the name of the folder where
you would like your customized trigger programs to reside. Enter comments about trigger program
construction or functionality.

To open the Save dialog box from the File menu, click Save Trigger. Alternatively open the Save dialog

box by clicking the LT button from the toolbar.

Sampling and Digitizing a Signal

Overview

Acquisition is the process of sampling the input signal, digitizing it, and assembling it into a waveform
record. The order and method of accomplishing these functions is different in the LA and DSO modules.
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Logic Analyzer

The logic analyzer converts incoming data into binary using a comparator with a user-selectable threshold
voltage.

If the incoming signal is above the threshold voltage, the signal is converted to a one. If the incoming

signal is below the threshold voltage, the signal is converted to a zero.
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After digitizing the incoming data, the logic analyzer samples it at regular intervals. The sampled and
digitized points are stored in memory along with the corresponding timing information.

Oscilloscope

The oscilloscope converts incoming data into 8-bit digital values.
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After digitizing the incoming data, the oscilloscope samples the voltage levels at regular intervals. The
sampled and digitized points are stored in memory along with the corresponding timing information.

Intermodule Interactions and Time Correlation

Each module has its own setup, trigger, and sampling functions. (Logic analyzer modules can include
microprocessor support as part of their setup.) Each module also acquires and stores its own data.

Acquisition

When you start an acquisition, all modules start acquiring data together. (Exceptions are when one module
has been programmed to arm another or when a module has been turned off.) Modules stop acquiring
data individually, according to their trigger programming. You also have the option of setting the logic
analyzer to operate in repetitive mode, in which the modules acquire data and update the data windows
continually until you manually stop the acquisition.
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Triggering

Modules readily communicate with one another by means of their trigger programs. Specify functions
such as the following:

B Trigger all modules (system trigger)
B One module arms another

B Modules respond to events declared by another module (internal signals)

Analysis

After the modules have captured and stored data, view the data in a Listing or Waveform window. All data
is time-correlated in the display, regardless of its source. Due to the precise time stamp information stored
with the data and the tightly-integrated communication between modules, the logic analyzer interleaves
data acquired from various sources. Because time stamp information is always stored with the data, you
can also compare saved data and current data with no loss of accuracy.

MagniVu data is also time-correlated with regular data. Because MagniVu data is always present, you can
easily compare a normal acquisition with the MagniVu counterpart.

Related Topics

Trigger Programs (see page 181)
MagniVu Data (see page 380)

High Speed Timing

The logic analyzer provides high-speed timing support through MagniVu data. The MagniVu data is stored
in a separate memory that is parallel to the main memory. All data from the sampler goes directly to the
MagniVu memory. The MagniVu memory also works like a circular buffer.

Unlike the acquisition memory, the MagniVu memory does not qualify data storage through the trigger
function block. Like normal acquisition data, MagniVu data can be displayed in the Listing or Waveform
windows.

MagniVu data is continuously acquired on all signals at the fastest sample rate possible for your LA model.
Some LA models allow you to adjust the trigger position.

Related Topic
Adding MagniVu Data to a Listing or Waveform window (see page 77)
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Listing Data Concepts

In many cases, you will use the logic analyzer to observe the data flow in the target system. The data
recorded by the logic analyzer can be displayed in a listing format, as shown:
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Listing data is a table of sequential operations performed by the target system. In the Listing window, each
data sample is displayed sequentially. Because each data sample includes time stamp information, it is a
straightforward process to display acquisitions from multiple data sources. Samples from all specified
data sources are interleaved in chronological order. For clarity, each line in the table represents a single
data sample from a single data source.

You control the presentation of the data by selecting the display radix of the columns. Make other format
selections such as font size, color, and column width. Use filters to display specific data.

Expand or collapse the Group column to display the individual signals.

Include data acquired by the external oscilloscope in the Listing window. As with any module, the data
samples from the oscilloscope are time-correlated with the other data and appear on separate lines.
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Waveform Data Concepts

382

Use the logic analyzer to observe the timing relationships between signals by displaying the recorded
signal activity as a series of waveforms in the Waveform window. The following figure shows waveform
data from a logic analyzer.
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Waveform window

Each waveform is initially displayed in a separate track, but all waveforms are time-aligned horizontally
and displayed in the same time scale. The inclusion of time stamp information with the stored data samples
makes it easy to display time-correlated acquisitions from multiple data sources.

You control the horizontal scale of the acquired data in the display. (You do not, however, change setup
parameters by changing settings in the waveform display.) Change the signal group radix, waveform color,
and waveform height. Like the Listing window, use filters to display specific data.

When viewing logic analyzer data, view the data as individual signals. Display the logic analyzer data in
groups of signals known as busforms. Use the busforms to display when data changes with respect to
clock or control signals. Another method of displaying logic analyzer data is to overlay waveform signals.
Use overlay waveforms to visually compare two or more waveforms at the same time.

When you are interested in displaying the value of a group of signals over a period of time, use magnitude
mode. For example, using magnitude mode, view the signals connected to a 16-bit digital counter. The
magnitude waveform appears as a sawtooth waveform as the counter values increase from the minimum
value (00) to the maximum value (FF).
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LA Versus DSO Module and External Oscilloscope Waveforms

A logic analyzer waveform appears to have zero-length rise and fall times. This is because the logic
analyzer is recreating the waveform from the samples stored in memory, which are either a one or a zero.

No electronic signal is perfectly digital in nature; there is always some analog component. Consider a
fast-rising pulse with ringing on the front edge, or glitches that can occur in a noisy circuit.

If you suspect problems caused by analog signal characteristics, such as signal voltages higher or lower
than specified voltage levels or slow transition times, you should use a DSO module or an external
oscilloscope to observe the voltage characteristics of the signal.

Related Topic
Sampling Resolution (see page 383)

Sampling Resolution

The accuracy of the waveform recreated from the sampled data depends on the sample rate used to record
the incoming signals.

This is due to the fact that the waveform recreated by the logic analyzer is based on the sampled signals
stored in memory. If the sample rate is too low the recorded data will produce an inaccurate display.

Example 1: Slow sample clock
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Example 2: Fast sample clock
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Related Topic

Signal Resolution and Signal Duration (see page 384)
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Signal Resolution and Signal Duration

There is an important relationship between the Sampling Resolution (see page 383) of the recorded
signal and the duration in terms of elapsed time.

Because the depth of the acquisition memory sets the total number of samples that can be recorded by the
logic analyzer, increasing the sample rate provides better signal resolution but reduces the duration of the
acquired signal. A faster sample rate will record a smaller portion of the signal, but with higher resolution.

It is important to remember that by using the MagniVu (see page 361) data feature, you can view
high-resolution data centered around the logic analyzer trigger. This allows you to zoom in on the data
while still maintaining visibility of a more extended signal duration.

Displaying Waveforms

Waveforms are rarely displayed in a one-to-one ratio between the sample points and pixels. Waveforms
are usually displayed in a compressed or expanded format.

As a general rule:
B Waveforms are compressed when the time per pixel is greater than the time per sample.
B Waveforms are expanded when the time per pixel is less than the time per sample.

For compressed DSO waveforms, the display shows the lowest and highest points that occupy a given
pixel column joined by a vertical line.

For expanded LA waveforms, the display points between the actual sample points are calculated.

For expanded DSO waveforms, Sin(x)/x interpolation computes the display points between the actual
values acquired.

Autoset (DSO Module)

384

Autoset automatically chooses the DSO setup values, based on the input signal at the time you click
Autoset. If you move the probe to another signal, click Autoset again to reset the setup values.

Autoset works best on repetitive signals that have 0 Volt offset. If the Autoset setup does not display the
waveform as you want it, change the setup manually.

Autoset sets up all input signals, the horizontal, and the trigger regardless of which Autoset button
is clicked.

Autoset makes the following selections automatically.

Vertical range: A setting that does not clip the waveform

Sample period: Period of the input signal divided by 100
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Input coupling: DC

Vertical offset: 0.0v

Bandwidth: Full

Trigger level. Center of the input signal range
Trigger type: Edge

Trigger slope: Positive

Trigger coupling: DC

Trigger action: Trigger (module)

NOTE. If an acquisition is in progress, Autoset displays the Finishing Acquisition message box. Autoset
uses Init @ 50% to adjust the trigger level to the center of the input signal range. Autoset does not alter
any acquisition data or windows until the next acquisition.

To use Autoset from the System window, click the DSO Setup button, and then click the Autoset button.

DSO Module Horizontal Settings

Horizontal settings control the rate at which the data is sampled and the amount of data acquired.

The sample period sets the interval between successive samples in a waveform record. Choose a sample
period that is fast enough that the waveform will not be aliased, and slow enough to provide the waveform
record length that you need. For best fidelity of repetitive waveforms, you should set the sample period to
at least five times that of the waveform.

Memory depth sets the total number of data samples to be acquired. If you do not need to use the full
memory depth to acquire data, select a smaller memory depth to get faster acquisitions.

To open the horizontal page from the System window, click the DSO Setup button, and then click the
Horizontal tab.

Related Topic
Autoset (see page 384)

DSO Module Vertical Input Channel Settings

Overview

Channel settings adjust the vertical input parameters.
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The vertical input voltage range control sets the attenuator full-scale voltage. If the range is selected from
the list, it forces an offset value into the Offset control. Select from the list of standard presets by clicking
Options from the System menu, and then clicking the Presets tab.

Resolution

For best vertical resolution, set the range slightly larger than the expected input signal. Autoset
automatically sets the range for best vertical resolution on signals with 0 offset.

Offset

The vertical input voltage offset is the offset voltage applied to the input signal. If the attached probe can
be offset, it is applied at the probe tip. Otherwise, offset is applied at the BNC. If Range is changed
using the preset list, Range also sets the Offset.

Bandwidth

Bandwidth is the range of frequencies that can be acquired and displayed accurately. Your bandwidth
selection sets the upper limit of frequencies that will be acquired and displayed. Bandwidth filters reduce
unwanted noise and aliasing, but can substantially change waveform fidelity.

m  Select the 20 MHz filter to set the upper limit of frequencies that are acquired to 20 MHz. The 20 MHz
filter does not provide complete anti-aliasing protection at slower sample rates.

m  Select the 250 MHz filter to set the upper limit of frequencies that are acquired to 250 MHz.

B Select the Full bandwidth for best fidelity of signals with high frequency components. The Full
bandwidth filter passes the full analog bandwidth.

Coupling

Coupling selects how the input signal is coupled to the vertical input channel.

m  Use DC coupling to see the entire waveform (both AC and DC components).

B Use AC coupling to view only the AC components of the waveform (DC components are blocked).

m  Use GND coupling to display a zero-volt waveform.

Signal Name

The Signal Name you enter becomes the new name for the waveform when it is displayed.

Termination

Select the vertical termination impedance appropriate for the input signal.
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NOTE. Termination is at the BNC connector, not the probe tip. Input signal and vertical range and offset
are limited by 50 W termination.

Probe Calibration

Probe calibration optimizes the signal path for this probe/channel/module combination.
Execute Probe Cal if any of these conditions have occurred:

B The ambient temperature has changed more than 5 degrees Celsius.

®  The DSO notifies you that the probe is not calibrated.

B More than 1 month has passed since the probe was calibrated.

To open a vertical channel setting page from the System window, click the DSO Setup button, and then
click a vertical channel tab.

Related Topics

Calibrating Probes (see page 61)
Autoset (see page 384)

DSO Module Setup

Before acquiring and displaying a waveform, first set up the DSO. Use the DSO Setup window to set the
vertical, horizontal, and trigger parameters manually, or use Autoset for a quick, automatic setup based on
the input signal.

NOTE. You cannot change setup parameters by changing the data display. Once you acquire data, you
can manipulate the display, but that will not change the input settings used to acquire the data. Return
to the DSO Setup window to alter input settings.

To open the DSO Setup window from the System window, click the DSO Setup button.
Click the following selections for more information:

= Autoset

m  DSO Vertical Input Channel Settings

® DSO Horizontal Settings

® DSO Trigger Settings
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Overview

DSO Measurement Setup

Use the Measurement Setup dialog box to select the measurements that will be performed on the DSO
or external oscilloscope waveforms and to select the new measurement setup parameters. Click the
Measurement Setup button in the Waveform Properties dialog box to access the Measurement Setup

dialog box.

Measurement Setup - DSO 1: Channel2
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Behavior

B Available Measurements lists all of the available measurements that are supported on the DSO
waveform. When you select an available measurement, a graphic and a brief description of the
measurement are displayed beneath the Available Measurements list box. The following table lists

the available measurements and provides a description of each.

m  Selected Measurements displays up to three DSO waveform measurements that you select. Change the

list of selected measurements using the Add >> and Remove << buttons.

®  Base-Top Determination allows you to select the method for determining the base and top for a
selected measurement: automatic, histogram, or min-max. The default setting is automatic, which lets
the logic analyzer choose between histogram and min-max for the waveform under test.
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DSO Measurement Setup

®  The Reference Levels group box enables you to select either absolute or percentage-based reference
levels for the measured waveform. After selecting the type of waveform reference level, set the High-,
Low-, and Mid-Reference levels or use the defaults.

®  The Gating group box enables you to select the gating method for the measured waveform. Select the
entire waveform, window boundaries, or cursors to be used as the gating limits.

Available measurements

Description

High

The value used as 100% whenever high-reference,
mid-reference, or low-reference values are needed, such as
in fall time or rise time measurements. This method can be
calculated using either the min/max or histogram method.

Low

The value used as 0% whenever high reference, mid
reference, or low reference values are needed, such as
in fall time or rise time measurements. This value can be
calculated using either the min/max or histogram method.

Amplitude

This voltage measurement is the high value less the low
value measured over the entire waveform or gated region.

Maximum

This voltage measurement is the maximum amplitude. It is
typically the most positive peak voltage and is measured
over the entire waveform or gated region.

Minimum

This voltage measurement is the minimum amplitude. It is
typically the most negative peak voltage and is measured
over the entire waveform or gated region.

Peak to Peak

This voltage measurement is the absolute difference
between the maximum and minimum amplitude over the
entire waveform or gated region.

Positive Overshoot

This voltage measurement is measured over the

entire waveform or gated region and is expressed as:
Positive Overshoot = (Maximum - High) +
AmpTitude x 100%

Negative Overshoot

This voltage measurement is measured over the entire
waveform or gated region and is expressed as:

Negative Overshoot = (Low — Minimum) + Amplitude x
100%

Mean

This voltage measurement is the arithmetic mean over the
entire waveform or gated region.

RMS

This voltage measurement is the true Root Mean Square
voltage over the entire waveform or gated region.

Rise Time

This timing measurement is the time required for the leading
edge of the first pulse in the waveform or gated region to
rise from the low reference value (default = 10%) to the high
reference value (default = 90%) of the final value.

Fall Time

This timing measurement is the time required for the falling
edge of the first pulse in the waveform or gated region to fall
from the high reference value (default = 90%) to the low
reference value (default = 10%) of the final value.
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Available measurements

DSO Measurement Setup

Description

Positive Width

This timing measurement is the distance (time) between the
mid reference (default = 50%) amplitude points of a positive
pulse. The measurement is made on the first pulse in the
waveform or gated region.

Negative Width Measurement

This timing measurement is the distance (time) between the
mid reference (default 50%) amplitude points of a negative
pulse. The measurement is made on the first pulse in the
waveform or gated region.

Period The time required to complete the first cycle in a waveform
or gated region. Period is the reciprocal of frequency and is
measured in seconds.

Frequency This timing measurement is a measure of the first cycle in a

waveform or gated region. Frequency is the reciprocal of
the period; it is measured in Hertz (Hz) where one Hz is
one cycle per second.

Positive Duty Cycle

This timing measurement is the ratio of the positive pulse
width to the signal period expressed as a percentage. The
duty cycle is measured on the first cycle in the waveform or
gated region. Positive Duty Cycle = (Positive Width) +
Period x 100%.

Negative Duty Cycle

This timing measurement is the ratio of the negative pulse
width to the signal period expressed as a percentage. The
duty cycle is measured on the first cycle in the waveform or
gated region. Negative Duty Cycle = (Negative Width) +
Period x 100%.

Area

Area is a voltage-over-time measurement. The
measurement is the area over the entire waveform or gated
region expressed in volt-seconds. The area above the
common reference point is positive and the area below the
common reference point is negative.

Cycle Area

The voltage over time measurement. The measurement is
the area over the first cycle in the waveform or the first cycle
in the gated region expressed in volt-seconds. The area
above the common reference point is positive and the area
below the common reference point is negative.

Cycle Mean

This voltage measurement is the arithmetic mean over the
first cycle in the waveform or the first cycle in the gated
region.

Cycle RMS

This voltage measurement is the true Root Mean Square
voltage over the first cycle in the waveform or the first cycle
in the gated region.

Burst Width

This timing measurement is the duration of a burst and is
measured over the entire waveform or gated region.
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Reference levels Description

High Reference This defines the high reference level of a waveform; the
default level is 90%. This reference level is used with the
Low Reference level in the calculation of rise and fall times.
To change this level, touch the control and then set the level
with the multipurpose knob.

Mid Reference This defines the middle reference level of a waveform; the
default value is 50%. This reference value is primarily used
for making measurements between edges such as pulse
widths. To change this level, touch the control and then set
the level with the multipurpose knob.

Low Reference This defines the low reference level of a waveform; the
default level is 10%. This reference level is used with the
High Reference level in the calculation of rise and fall times.
To change this level, touch the control and then set the level
with the multipurpose knob.

Related Topics

Waveform Options (see page 214)
Setting Up Waveform Measurements (see page 126)
Removing Selected DSO Waveform Measurements (see page 127)

Oscilloscope Waveforms

Overview

Oscilloscope waveforms have a horizontal resolution of one display point per pixel width. Each horizontal,
pixel-wide time slice has either a point or a vertical line to represent the vertical value of the acquired data
sample. If the time per division is fast enough that each display point represents one or fewer acquired
points, the vertical value is represented by a point. If the time per division is slower and multiple acquired
data samples need to be represented within a pixel width, the vertical value is represented by a vertical line
whose length and offset are determined by the acquired data values.

Behavior

When the time per division is decreased, waveforms are horizontally expanded, using sine x/x interpolation
to create display points between the acquired sample points. A vertical value is calculated for every
horizontal time point between the acquired data points.

When the time per division is increased, waveforms are horizontally compressed and decimated. The
minimum and maximum values are used as the endpoints of the vertical line that represents the data values
for that time point. The cursor readout displays the value of the top endpoint.
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To Use

Select whether to display range readouts. Select the readout color. For each waveform, two readouts show
the maximum and minimum vertical input voltage settings. The readouts may contain symbols indicating
AC or Ground coupling, 50 Ohms input impedance, and the bandwidth limit. The ground line is indicated
as a horizontal dotted line. The trigger threshold is indicated with a T and an up arrow if the threshold is
above the maximum voltage or a down arrow if the threshold is below the minimum voltage.

Waveform size is dependent on the signal size and the input voltage range. The entire input voltage range
is used to set the default minimum and maximum values of the vertical range. Set the vertical range
values using the Waveform Options dialog box. You access it from the Waveform Properties dialog box
by clicking the Waveform tab, and then clicking the Options button.

To display no more than one data sample per display point, add a sample waveform from the same data
source and decrease the time per division until you see individual clock tick marks.

Related Topics

Waveform Options (see page 214)
DSO setup (see page 387)
Sample Waveforms (see page 212)

Logic Thresholds

Logic Threshold sets the voltage level that determines whether input signals are high or low (1 or 0). Select
from a list of presets and Init @ 50%.

The list for each signal contains presets from Options, Presets, Logic Threshold. The default threshold
value is the midpoint of the vertical range of the trigger signal. The minimum and maximum threshold
values are the Vertical Offset +/- the Vertical Range of the trigger signal. The probe type, the vertical
range, and the trigger coupling all affect the threshold value.

Init @ 50% sets the threshold value to the midpoint of the trigger signal.

Probe Calibration

392

Overview

The Probe Calibration dialog box controls all DSO probe calibration cycles and directs you to perform any
necessary steps. Calibrate all attached probes or only the probe on the selected channel.

Start a calibration cycle, view the progress of calibration, and see the results of calibration. Once
calibration starts, the calibration cycle of a single probe cannot be stopped. After a calibration cycle
completes, view the status of probe calibration.
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Behavior

Instructions direct you to attach probes to the calibration fixture and the input channel.
Channel status shows the current probe and its calibration status.

B Channel number shows the channel number of the probe.

B Probe Calibration Status shows the calibration status for attached probes.
Calibrate Chan starts probe calibration for the selected channel.

Calibrate All starts probe calibration for all channels that can be calibrated. To stop calibration when
calibration for the current probe is complete, click Abort.

To Use

To open the Probe Calibration dialog box from the System window, click the DSO Setup icon, click a
channel tab and then click the Probe Cal button.

Related Topic
Calibrating Probes (see page 61)
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$ character, 166
63-Sample Blocks, 25
63-Sample Blocks mode, 162

A

about data, 195
accelerator keys, 374
Acquisition, 203
gaps, 203
memory status, 358
sample, 293
storage, 151
Acquisition mode, 25
Acquisition options, 25
Acquisition overview, 59
Active cursor readout, 228
Active module, 352
Activity, 358
Add Column/Waveform Dialog
Box, 187
Add Protocol Dialog Box, 282
Add Protocols, 285
Add Transition dialog box, 158
Add Word dialog box, 160
Adding, 308
data source to an active Listing
window, 75
data source to an active
Waveform window, 135
histogram data from another
source, 222
MagniVu data to a Listing or
Waveform window, 77
mark to a data window, 136
new graph, 308
Opcode Mark, 114
reference data to a Listing
window, 114
reference data to a waveform
window, 131
state to a trigger program, 94
waveform, 118
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Alignment of time, 194
Analog multiplexing, 57
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changing signal routing, 69
setting up, 57
signal routing from the logic
analyzer, 49
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specifying physical
connections, 51
Analog outputs, 29
analog routing, 325
Analog signal routing from the
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analyze data, 221
Apply Deskew Analysis Results
dialog box, 297
Applying filters to data
windows, 35
Argument and command
entry, 372
Tool Property dialog box, 372
Arming, 367
a module using an LA
module, 153
interaction, 367
other modules from an LA
module, 104
ASN.1 Types, 247
additions to PSDL, 252
PSDL, 247
Asynchronous, 14
digital oversampling, 361
Asynchronous sampling, 14
Autoset
DSO, 384
serial analyzer, 44
average, 300
Axis Type Wizard, 65
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Background color, 123
Background color for Listing
window, 196
Base signal, 18
Bi-directional storage
serial analyzer, 47
Binary file format, 188
Bus support triggering, 327
Bus-specific framers, 267
Busform, 128
displaying LA data as a
busform, 214
selecting the radix of busform
readouts, 86
waveforms, 211
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Calibrating, 61
modules, 61
probes, 61
Calibration, 363
DSO probes, 61
probe calibration (DSO
module), 392
self calibration
properties, 363
when using a three way
merge, 363
Change detect, 156
Changing
color, 88
data series range, 88
defaults, 87
graphs, 88
If/Then clauses, 94
position of cursors, 78
signal routing, 69
start-up defaults, 87
waveform properties, 124
window properties, 70
zoom options, 86
Channel Activity Indicators, 46
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Channel change
triggering on, 102
Channel settings
DSO, 385
Channel-lane assignment
serial analyzer, 45
chart, 301
Choosing system to open at
startup, 362
Clause
defining If/Then or Else
If/Then, 163
Clock, 383
fast sample clock
example, 383
serial analyzer, 45
signal out, 367
slow sample clock
example, 383
SUT, 45
clock warning, 332
Code loop, 237
COFF file format, 341
Collapse signals, 138
Color, 370
background, 123
change of marks, 196
graticule, 123
properties, 35
scheme for active data
window, 122
selecting the active data
window, 122
tab, 369
Coloring data, 118
Column, 269
Add Column/Waveform
dialog box, 187
changing properties, 269
going to a specific
column, 115
properties, 195
selection, 195
showing and hiding, 269
tab, 195
Columns in a Protocol
window, 265
Comment Lines, 39
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limitations, 190
Compare Definition Dialog
Box, 190
Comparing data, 62
Compilation Result Pane, 266
Conditional storage, 150
Configuration, 364
mainframe, 364
software, 370
Configure, 4
Configuring external and internal
signals, 367
Connect, 5
Connections, 3
Connectors, 367
mainframe, 367
Contacting Tektronix, 1
Control Lines, 40
Control statements, 243
PSDL, 243
Controlling whether a waveform
is visible, 121
count measurement, 299
Counters, 105
problems, 105
triggering an LA module on
counter values, 99
Create New Protocol Files, 287
Create New Stack Files, 288
Creating
custom color schemes, 62
overlay waveform, 135
symbol files, 116
cursor position, 78
cursor readout, 228
Cursors, 141
Cursors locked together in
different data windows, 187
Custom color schemes, 62
Custom sampling, 328
Customer feedback, 1
Cycle marking, 195

D

Data, 195
compare, 190
determining the data
source of the selected
waveform, 85
examining the listing data, 11
font size, 196
incorrect after
acquisition, 329
MagniVu, 361
measurements setup, 111
name, 355
points, 203
properties, 195
searching on selected data, 12
triggering on group data
values, 101
value triggering, 101
viewing sample data, 9
when to store, 96
data area, 9
Data Samples, 385
data series, 307
data source, 221
determining, 85
measuring, 221
properties, 217
time alignment, 194
Data sources, 190
Data storage
serial analyzer, 45
Data Valid Window, 289
Data window
creating a New Data
window, 273
locked, 187
New Data Window name, 355
System window, 352
Decimal values, 153
signed, 153
Decode View, 265
Default setup, 362
default system, 362
Defaults, 87
changing, 87
properties, 370
tab, 370
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Define Bus dialog box, 274
define compare, 190
define filters, 32
Define protocols, 286
Define Search Dialog Box, 192
Define Snapshot dialog box, 164
Define Suppression dialog
box, 198
Defining, 261
compare parameters, 62
data to search for, 192
histogram ranges, 221
If/Then clauses in a trigger
program, 94
multiple transition
recognizers, 95
protocol with PSDL, 261
source data to search for, 83
Definition of MagniVu data, 361
Delete Protocol or Stack Dialog
Box, 283
Delete Protocols, 286
Delimiter, 73
When exporting data from a
Listing window, 73
Delta, 128
time measurements, 129
volts measurements, 128
waveform measure-
ments, 129
Deskew Analysis, 289
Properties, 295
Setup, 293
Setups, 296
Window, 289
Deskew panel, 16
destination signal, 29
Detecting violations, 160
Determining acquisition
status, 358
Developing custom color
schemes, 62
Diagnostics, 331
Digital signal routing, 68
from a logic analyzer
output, 68
to an oscilloscope input, 68
Digitizing a signal, 378
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Disabling modules, 352
Disassembler, 114
adding opcodes, 114
Disassembly, 328
display formats, 328
properties, 197
selecting display formats, 328
tab, 197
using microprocessor and bus
support packages, 327
Displaying
disassembled data, 197
DSO data, 140
glitches, 120
graticules, 123
magnitude, 125
marks in a data window, 137
violations in a waveform
window, 122
waveform readouts, 120
waveforms, 121
Dragging marks, 137
Drawing Style dialog box, 305
DSO, 61
Autoset, 384
calibrating probes, 61
compressed waveform
format, 384
cursors, 141
displaying DSO data, 140
expanded waveform
format, 384
horizontal settings, 385
setting up, 387
storing DSO data, 140
trigger settings, 377
vertical, 385
waveforms, 391
DSO probe, 61
DSO trigger, 377
dual channel measurements, 112
Dwarf file format, 341
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EasyTrigger, 183
library, 183
list contents, 183
program list, 183
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Edit Protocol Files, 70
Edit Relations Between
Protocols, 71
Edit stack files, 71
Editing, 72
Editing a Tool on the Tools
Menu, 71
editing symbol files, 72
Electrical idle
serial analyzer, 46
timeout setting, 46
Elf/Dwarf file format, 341
Elf/Stabs file format, 341
Enhanced column headers, 189
Entering a symbol plus an offset
in a trigger, 174
Error Message Dialog Box, 198
Event target value limit, 106
event type, 169
Examining a waveform, 9
Example, 11
viewing a magnitude
waveform, 11
Executing an operation after an
acquisition, 60
Expand signals, 138
Export, 272
protocol data, 73
Export data, 188
Export Data dialog box, 188
Export Data Options Dialog
Box, 189
Export Histogram dialog box, 220
Export Histogram Options dialog
box, 220
Export Stack Dialog Box, 284
Exporting, 343
data from a Listing
window, 73
group width and radix
information, 189
historgram data, 73
protocols, 284
signal setups, 37
stacks, 284
symbol tables, 343
Extended Diagnostics, 331
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External oscilloscope, 48
communication, 47
setup window, 48
External Signal Selection, 359
External signals, 367
EyeFinder, 289
EyeScan, 310

F

Feedback to Tektronix, 1
feeds, 29
File, 341
format, 341
Filters, 268
applying, 35
copying, 112
creating, 113
dialog box, 32
loading, 34
opening, 113
protocol, 268
Filters dialog box, 32
Force Main Prefill, 171
Format, 195
column, 195
file, 328
listing window, 381
TLA Data Exchange, 188
Formatting
disassembled data, 197
Listing window, 196
Framers, 267
Frames, 267
full screen, 9
Function range symbols, 337
Functional procedure, 331

G
Gaps, 203
time, 203
General purpose data window
shortcuts, 372
Generic Framer Example, 276
Generic framers, 267
limitations, 267
usage, 267
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Getting out of a loop in a Source
window, 237
Glitch
detect (LA), 160
glitch detection, 160
Glitches, 185
in a Listing window, 115
LA, 185
triggering an LA module, 97
Global storage, 139
note on using transitions, 139
Go to (moving to a mark), 78
Go To dialog box, 230
Go To Protocol Dialog Box, 286
Going to a specific column, 115
Going to a Specific Graph Window
Mark, 309
Going to a specific mark, 137
Going to a Specific Series, 309
GPIB, 48
Graph Window, 304
adding data series, 65
creating, 306
labeling, 88
properties, 88
Graticule, 90
selecting the color, 123
showing, 123
graticule display, 366
Group
color, 35
data range triggering, 101
effects on data source, 217
radix, 166
ranges, 105
triggering an LA module, 103
Group cards, 28
Group definitions
bus supports, 327
microprocessor and bus
support, 327
microprocessor supports, 327
Group width information, 189
exporting, 189
Grouping signals, 28
Guidelines for merging
modules, 55

H

Hardware order, 152
Height, 90
Hex View, 265
High Speed timing, 380
High-Level Language
support, 361
Highlight controls, 197
Highlight Signal dialog box, 28
Highlighting
disassembled data, 197
lines, 197
signals, 28
Histogram, 221
data page, 64
defining ranges, 221
exporting data, 73
options page, 64
selecting data source, 222
Histogram window, 220
color selection, 216
data area, 216
font size, 216
Histogram add counts dialog
box, 220
Histogram data source, 217
Histogram scale dialog
box, 219
Histogram window
shortcuts, 377
property page, 216
radix, 216
Hit Frequency Properties, 305
HLL support, 361
Horizontal
scale (time per division), 141
setting up the DSO, 126
settings(DSO), 385
host name, 7
Hot keys, 372

iCapture, 29

iConnect Analog Feeds dialog
box, 29

Identifying modules, 352

IEEE69S5 file format, 341

TLA Online Help



[f/Then clause
changing an, 94
import, 36
Import signal setups, 37
Import Stack Dialog Box, 284
Incoming inspections, 331
Incorrect data after
acquisition, 329
Individual waveform
properties, 207
Individual waveform properties
within an overlay
waveform, 209
Information, 370
about current data, 195
about installed software, 370
about modules, 364
about the mainframe, 364
Information Lines, 42
Input
DSO settings, 385
Installed software informa-
tion, 370
inter-probing, 325
intermodule interaction, 379
Intermodule signals, 367
Internal, 360
signal selection, 360
signaling, 154
Internal signals, 99
configuring, 367
triggering an LA module, 99
iVerify, 321
Setup dialog box, 325
Setups dialog box, 312
Statistical Analysis dialog
box, 321
iVerify measurement
properties, 316
iVerify Properties, 316
About Data tab, 316
Eye Coloration tab, 319
iVerify Window Tab, 317
iVerify Properties dialog box, 316
Eye coloration, 316
iVerify Setup dialog box Channel
tab, 323
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iVerify Setup dialog box
Clock/Qualifier tab, 324

iVerify window, 310

iView external oscilloscope
setup window, 48

J

jitter, 108
Jumping over "dead" space
between samples, 187

K

Key, 377
shortcut, 375
Keystroke Entry field, 28

L

LA
module memory depth, 27
module setups, 56
trigger actions table, 168
trigger events, 166
trigger resources, 169
triggers, 145
waveforms, 211

LA Busform, 128

LA channels
selecting for an LA trigger

channel event, 96

LA module
arming, 104
merging, 55

LA Probe Signals/Names
table, 18
LA Setup window, 13
LA versus DSO module
waveforms, 383
Labeling a graph, 88
Labels, 213
LAN, 6
Language, 361
high-level language (HLL)
support, 361
Length and Value Expres-
sions, 255
PSDL, 255

Index

Lexical Items, 258
PSDL, 258
Limits, 214
Linked cursors, 187
Listing data concepts, 381
Listing window, 185
adding a data source, 75
adding reference data, 114
properties, 196
showing glitches, 115
showing qualification
gaps, 114
tab, 196
use, 185
Listing-relative cursor
positioning, 236
Listing/Waveform data page, 354
Load, 327
support package, 327
system options, 355
Load Deskew Analysis Setup
dialog box, 292
Load iVerify Setup dialog
box, 313
Load Symbols Options dialog
box, 341
Loading
a MagniVu data source to
a Listing or Waveform
window, 77
a saved module, 75
a saved system, 74
an LA module with saved
trigger settings, 75
filters, 34
merged modules, 355
part of a saved system, 355
portions of a saved system, 74
saved data to an active Listing
window, 75
saved data to an active
Waveform window, 135
source code symbol
information, 77
the timing format file, 328
Lock delta time, 129
Lock windows, 187
Lock Windows dialog box, 187
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Locking windows, 136
Logic analyzer, 130
measurements, 130
trigger window, 143
Logic thresholds, 370
Logic thresholds for a DSO, 392
Loop, 237
Loop statements, 243
PSDL, 243
Lower threshold, 370

Magnitude, 214
Magnitude mode, 382
Magnitude waveform
viewing, 11
MagniVu, 77
data, 361
data source to a Listing or
Waveform window, 77
LA trigger action table, 168
signal resolution/signal
duration relationship, 384
storage rate, 172
trigger position, 172
Main window, 352
Mainframe, 364
properties, 364
Making graticules visible, 123
Making violations visible in a
Waveform window, 122
Mark, 195
next and previous, 227
opcode, 195
selection, 308
Mark Opcode dialog box, 195
Marking cycles, 195
Marks, 201
properties, 196
tab, 196
Marks in a data window, 136
adding, 136
Marks in a Protocol window, 265
max, 112
Measurement Setup, 299
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Measurements, 126
count, 106
data, 298
jitter, 108
min/max, 108
multiple, 129
on DSO data, 388
on LA data, 299
time, 109
Measuring, 129
delta time, 129
delta volts, 128
histogram data, 221
time, 128
voltage, 127
Memory, 91
selecting depth, 91
storing DSO data, 140
Memory depth, 91
for an LA module, 91
LA, 27
most effective use of, 91
Menu shortcut keys, 373
Merged module synchronous
sampling, 27
Merged modules, 363
loading, 355
note on calibration, 363
properties, 365
Merging LA modules, 55
Meta-characters, 192
Microprocessor and bus support
package basic operation, 327
Microprocessor support, 327
triggering, 327
min, 112
Miscellaneous PSDL
commands, 255
Modify, 229
color schemes, 369
location of cursors using the
overview mark bar, 78
search path list, 229
suffix list, 229

Module, 153
active, 352
arming using an LA
module, 153

disabling, 352

identifying, 352

merged, 365
Module specifics properties, 364
module trigger, 146
Modules, 61

calibrating, 61

merging, 55

properties, 364

triggering from an LA, 104
More waveforms, 118

Moving
cursors, 78
marks, 137

to a mark (Go To), 78

to a specific column, 115
Multi-signal

busform LA waveforms, 211

magnitude LA

waveforms, 211

waveforms, 211
Multiple acquisitions, 60
Multiple Samples per Clock

Trigger Programs, 173

N

Name
waveform, 213

Name Data Window dialog
box, 355

network, 5

Network preferences, 5

network properties, 7

Next Mark and Previous Mark
buttons, 227
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Object file format, 341
Object selection, 204
offline, 3
Offset, 370
entering a symbol plus an
offsetina LA trigger, 174
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OMF166 file format, 341
OMF286 file format, 341
OMF386 file format, 341
OMF51 file format, 341
OMF&G6 file format, 341
On Run control
serial analyzer trigger
window, 177
Opcode, 195
Opcodes, 114
adding, 114
Open dialog box (repetitive
properties), 192
Opening, 60
a document after an
acquisition, 60
a document or program after
an acquisition, 60
a saved data window, 135
Operators, 241
PSDL, 241
Options, 214
collapse signals, 138
expand signals, 138
powering on and off, 9
setting waveform
options, 124
Organizing signal groups, 22
outputs, 29
Overlapping symbols, 336
Overlay waveform, 204
properties, 205
setting the offset, 207
Overview mark bar, 78

P

Packet structure definition, 241
PSDL, 241
Packet Structure Description
Language, 239
Packet View, 269
column properties, 269
Pattern Generator, 89
Run Properties dialog box, 89
Pattern symbol, 337
file header, 117
files, 337
PG Run Properties dialog box, 89
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Placement of system triggers, 147
Placing marks in a data
window, 136
Polarity, 90
of LA signals, 18
population, 112
Positioning the trigger, 96
Postscript, 79
Power on and off options, 9
Power-On Diagnostics, 362
PowerTrigger, 158
detail, 149
properties, 149
tab, 149
tab overview, 149
troubleshoot, 105
Preferences properties, 366
Preprogrammed LA triggers, 183
Presets, 370
Presets tab, 370
Prime signal, 18
Print dialog, 79
Printing, 73
Probe
calibration (DSO), 392
signal grouping, 28
status (DSO), 392
problems, 329
sampling, 329
triggering, 175
programming tips for triggering
an la module, 151
properties, 90
column, 195
graph window, 88
network, 7
protocol, 265
protocol display, 269
protocol framing, 271
protocol, 287
create new, 273
exporting, 284
importing, 284
saving, 284
Protocol Designer window, 280
Protocol Editor pane, 281
Protocol Filter Setup Dialog
Box, 268

Index

Protocol information pane, 275
Protocol properties, 269
protocol relations, 285
Protocol Search Dialog Box, 272
Protocol Setup window, 279
Protocol stacks, 284
importing, 284
Protocol window, 265
Define Bus dialog box, 274
frames and framers, 267
generic framer example, 276
properties, 269
Select Bus page, 274
Select Stack dialog box, 276
PSDL, 259
ASN.1 additions, 252
ASN.1 types, 247
control statements, 243
defining a protocol, 261
length and value
expressions, 255
lexical items, 258
loop statements, 243
miscellaneous
commands, 255
operators, 241
overview, 259
packet structure, 241
reserved words, 256
sample program, 244
spz file extensions, 259
syntax, 239
tags, 255
type definitions, 246
types, 252
value definitions, 254

Q

Qualification gaps, 185
showing, 196
showing in a Listing

window, 114

R

Radix, 195
Radix of column, 195
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Radix information, 189
exporting, 189
Range, 370
recognition problems, 105
recognition triggering, 101
recognizers, 152
recognizers and hardware
order, 152
symbol file header, 117
symbol files, 336
range recognizers, 166
Range symbols, 338
Function, 337
Source, 338
Variable, 338
Ranges properties, 218
Readout radix, 86
Readouts, 214
displaying, 120
Reference, 378
digitizing a signal, 378
sampling a signal, 378
Reference clock
serial analyzer, 45
Reference data, 131
adding to a Listing
window, 114
Reference system trigger, 165
Release notes, 1
remote, 3
Removing
data from a Listing or
Waveform window, 138
LA signals, 18
selected DSO waveform
measurements, 127
waveforms from an overlay
waveform, 139
Removing a Tool from the Tools
Menu, 72
Renaming, 352
a window, 352
Repeating acquisitions, 60
Repetitive acquisition data, 81
saving, 81
repetitive acquisition mode, 59
Repetitive mod, 59
Repetitive operations, 192
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Repetitive Properties Dialog
Box, 191
Replace Protocol Dialog Box, 282
Replace protocol files, 288
Reserved words, 256
PSDL, 256
Routing a signal from a logic
analyzer output, 68
Routing a signal to an oscilloscope
input, 68
Rules for merging modules, 55
Running, 133
extended diagnostics, 133
multiple acquisitions, 60

S

Sample
suppression, 91
waveforms, 212
Sample Signal setup file, 38
Sample Suppress dialog box, 200
Samples + Glitches, 25
Samples + Violations, 25
Sampling, 329
a signal, 378
asynchronous, 14
custom, 328
LA setup window, 13
merged module external, 27
problems, 329
resolution, 383
support package, 328
synchronous, 14
Save
color scheme, 370
dialog box, 79
module, 79
system, 79
trigger program, 378
Saved
data, 75
module, 75
system, 355
system timing format file, 328
trigger, 75
Saved setups, 55
loading to an LA module, 55

Saving
a module, 80
a system, 80
data, 80
LA setups, 56
protocols, 283
repetitive acquisition data, 81
repetitive module setups and
data, 81
repetitive system setups and
data, 82
stacks, 284
Scale, 219
horizontal, 141
in Histogram window, 219
Scan Listing, 230
dialog box, 230
mode, 226
Scan listing direction, 230
Scrolling, 126
between samples in a
Waveform window, 126
through source data, 225
search, 6
Search Definition, 192
search options, 82
Search path, 233
Search Progress dialog box, 230
Search protocol display, 84
Searching
for signal names, 28
for source data, 83
in data windows, 192
on selected data, 12
Seconds per division, 141
Seeing
glitches in a Listing
window, 115
qualification gaps, 114
Select Axis Type, 65
Select Bus Page, 274
Select Signal dialog box, 157
Select Stack Dialog Box, 276
Select Stack Page, 276
Selected waveform, 85

TLA Online Help



Selecting

background color, 123

channels for an LA trigger
channel event, 96

disassembled data, 197

disassembly display
formats, 328

graticule color, 123

objects in a Listing
window, 204

radix of busform readouts, 86

the active data window
color, 122
violation color, 121
waveform color, 119
when to store data, 96
Selecting memory depth, 91
a general approach, 91
Selecting Stacks, 277
selecting trigger
external oscilloscope, 131
Selection dialog box, 360
Self calibration, 363
note on 3-way merge, 363
Sending stacked marks to the
back, 137
Serial analyzer
Ack button, 43
activity indicators, 43
Autoset, 44
bi-directional storage, 47
Channel-lane assignment, 45
Data storage, 45
electrical idle, 46
left side controls, 44
link status, 44
On Run control, 177
Reference clock, 45
setup window, 42
Status area, 43
timestamp averaging, 47
transition detectors, 46
trigger events, 178
trigger tool bar, 177
trigger window, 177
Server, 5
Set thresholds, 13
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Setting
a trigger from Source window
data, 237
default trigger tab, 87
overlay waveform offset, 207
system trigger source, 148
trigger position, 96
waveform limits, 85
waveform options, 124
waveform style, 84
Setting up
analog feeds, 66
analog multiplexing, 57
data measurements, 111
Protocol window, 277
system inter-probing, 67
the DSO, 387
transitional storage for the LA
module, 92
waveform measure-
ments, 126
Setting up external oscilloscope
communication, 47
Setup
for saving repetitive module
setups and data, 81
for saving repetitive system
setups and data, 82
Measurement, 388
Setup and hold, 92
storage, 92
Setup and Hold Storage dialog
box, 92
Setup and hold triggering, 94
Setup and hold violation, 97
triggering an LA, 94
Setup Properties, 279
Setup window, 48
iView external
oscilloscope, 48
logic analyzer, 13
serial analyzer, 42
Setups, 74
Setups for an LA module
loading, 55
saving, 56
Shortcut keys, 374
Show Samples Dialog Box, 199

Index

Show waveform, 90
Showing glitches in a Listing
window, 115
Showing qualification gaps in a
Listing window, 114
Signal, 384
base, 18
duration, 384
prime, 18
resolution, 384
Signal grouping table, 22
Signal Import and Export
Formats, 36
Signal names for an LA, 18
Signal polarity (LA module), 18
Signal routing, 50
from the logic analyzer, 49
to the oscilloscope, 50
Signal routing to the
oscilloscope, 50
Signal setups
exporting, 37
import behavior, 36
importing, 37
Signals
selecting, 96
Signals in and out, 154
Signals properties, 367
Signed, 214
data, 214
decimal values, 153
Single channel
triggering on a, 94
single run acquisition, 59
Single-run mode, 59
Single-signal LA waveforms, 212
Snapshot event, 100
triggering on an LA, 100
Software, 370
properties, 370
Source, 338
data page, 66
range symbols, 338
Source code, 77
Source code loop, 237
Source files, 225
Source options page, 66
source signals, 29
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source statement, 223
source symbols, 338
Source window, 237
Data properties, 234
Marks properties, 235
properties, 232
shortcuts, 376
Source File Locator dialog
box, 231
Source Files Edit Dialog
Box, 229
Source Files properties, 366
Source Go To dialog box, 230
Source Window Search dialog
box, 230
Source-relative cursor
positioning, 236
Specify groups, 13
Specifying
application defaults, 370
application preferences, 366
multiple acquisitions, 60
stop conditions for compare
operations, 63
Stack, 288
create new, 288
Stack definition, 275
Stack Editor Display
Properties, 280
Stack protocol information, 275
Stacks, 284
exporting, 284
importing, 284
saving, 284
selecting, 277
standard deviation, 300
Start-Up, 87
defaults, 87
properties, 362
Starting, 9
the instrument without the
TLA application, 9
State, 94
adding to a trigger
program, 94
statistic, 112
Statistical Analysis, 300
Status, 392
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Status area
serial analyzer, 43
Status bits, 378
Status Monitor dialog box, 358
Step, 227
backwards, 227
forward, 227
Stopping
an acquisition after compare
definitions are met, 63
Storage
qualification, 139
selection for an LA
module, 140
setup, 139
Storage Definition Dialog
Box, 93
transitional, 139
trigger position (LA), 151
Storing, 92
DSO data in memory, 140
LA module setup and hold
violations, 92
Structure of an LA trigger
program, 181
subnet, 7
Support package
sampling, 328
Suppress Samples Dialog
Box, 199
Suppression, 198
define dialog box, 198
SUT
clock, 45
Symbol
entering a symbol plus an
offsetin a LA trigger, 174
Symbol file header, 117
Pattern symbol file
header, 117
Range symbol file
header, 117

Symbol files, 72
creating, 116
editing, 72
Load Symbols Options dialog
box, 341
pattern, 337
range, 336
Symbol value width, 336
Symbols dialog box, 340
symbol name, 345
Symbol table triggering, 327
Symbol value width, 336
Symbols, 77
Synchronous sampling, 14
Compound clock, 15
merged modules, 27
single clock, 15
Syntax, 239
PSDL, 239
System, 352
trigger and reference system
trigger relationship, 165
trigger placement, 147
window, 352
System configuration, 367
System Inter-probing, 51
System options, 355
System tools, 134
customizing, 134
System trigger, 361

T
Tags, 255
PSDL, 255
Taking Cursor Measure-
ments, 309
Taking measurements, 129
delta time, 129
delta volts, 128
logic analyzer, 130
multiple, 129
time, 128
voltage, 127
Target value limit, 106
TekLink cable, 4
Tektronix
customer feedback, 1
Text color of column, 195
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Threshold, 370
logic thresholds for a DSO
module, 392
presets properties, 370
Time, 194
Alignment dialog box, 194
alignment of correlated data
sources, 136
gaps, 203
measurement, 128
per division, 141
scale (time/division), 120
time correlation, 379
time measurements, 299
time stamp, 379
Timer event target value
limit, 106
Timers, 98
testing, 98
triggering an LA, 98
Timestamp, 195
column, 234
values, 195
Timestamp averaging
serial analyzer, 47
Timing analysis using support
packages, 327
Timing format file, 328
Timing zoom (see MagniVu), 171
TL708EX, 4
TLA, 188
binary file format, 188
TLA Data Exchange format, 188
TLA Server, 5
TLA Symbol File Format, 344
TSF Color Symbols, 347
TSF Function Symbols, 349
TSF Headers, 344
TSF Pattern Symbols, 345
TSF Range Symbols, 346
TSF Source Symbols, 349
TSF Variable Symbols, 351
TLAS000 series, 1
TLA7000 series, 1
Tools properties, 371
Tools Properties dialog box, 372
Tracing the execution of source
code, 237
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Transition, 158
adding, 158
indication, 105
recognizer, 92
word definition, 157
Transition Definition dialog
box, 157
Transition detectors
serial analyzer, 46
Transition recognizer, 95
defining multiples, 95
Transitional storage, 139
Transitions as events
workaround, 94
Transitions note, 94
Trigger
action table, 168
actions, 143
all modules, 361
clauses, 149
defining If/Then or Else
If/Then clause, 163
entering a symbol plus an
offsetin a LA trigger, 174
event table, 166
list contents, 183
loading an LA with saved
settings, 75
placement, 147
position, 151
positioning in acquisition
memory, 96
programming tips, 151
reference, 165
serial analyzer trigger
events, 178
setting the default tab, 87
setting the system source, 148
settings, 377
system, 146
system and reference
relationship, 165
window, 143
word definition, 159
Trigger action, 155
LA, 168
signal restrictions, 155
Trigger event, 166

Index

Trigger on a Glitch, 163
Trigger position
for an LA module, 151
Trigger program, 181
adding a state, 94
defining If/Then clauses, 94
Multiple samples per
clock, 173
setting up, 94
structure, 181
troubleshooting, 105
Trigger program structure, 181
Trigger resources (LA), 169
Trigger Save dialog box, 378
Trigger type, 143
Trigger window, 172
Force Main Prefill check
box, 171
MagniVu storage rate, 172
MagniVu Trigger Pos, 172
serial analyzer, 177
Triggering, 327
an LA module, 103
bus supports, 327
microprocessor supports, 327
on group data ranges, 101
on word recognizers, 101
other modules from an
LA, 104
problems, 175
the entire system, 146
using symbol tables, 327
Triggering an LA, 100
on a setup and hold
violation, 97
on a snapshot event, 100
on a word event, 100
on timer values, 98
Triggering an LA module, 99
on a glitch, 97
on a group, 103
on a single channel, 102
on an internal signal, 99
on counter values, 99
Troubleshooting, 329
external oscilloscope, 48
hardware, 331
LA trigger programs, 105
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Troubleshooting triggering, 332
Type Definitions, 246
PSDL, 246
Types, 252
PSDL, 252
Types of LA triggers, 145

U

Upper threshold, 370
user preferences, 366
Using, 327
a system trigger, 104
parts of a saved system, 74
polarity, 195
support packages for timing
analysis, 327

vV

Value definitions, 254

PSDL, 254
Variable range symbols, 338
Vertical

input settings (DSO), 385

range, 321
Viewing, 135

compare data, 62

LA waveform in Magnitude

mode, 125

protocol data, 278

saved data, 135
Viewing decoded data in a

Protocol Window, 278
Viewing persistence data, 310
Violation color, 121
Violations, 90

for a waveform, 90
Voltage, 127

measurements, 127
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W

Waveform
adding, 118
appearance, 119
color, 119
creating an overlay
waveform, 135
displaying, 384
DSO compressed format, 384
DSO expanded format, 384
LA compressed format, 384
LA expanded format, 384
LA versus DSO module, 383
labels, 213
limits, 85
names, 213
options, 214
overlay, 204
properties, 90
readouts, 120
removing from an overlay
waveform, 139
Removing selected DSO
measurements, 127
selection, 195
setting options, 124
setting to overlay waveform
offset, 207
setting up measurements, 126
size, 124
style, 84
tab, 90
time scale, 120
viewing other types, 10
Waveform data concepts, 382
Waveform properties, 205
Waveform window, 201
Width of column, 195

Window, 352
color scheme for active data
window, 122
data, 352
locking windows
together, 136
properties, 120
renaming, 352
system window, 352
Word definition dialog box, 160
Word event, 100
triggering on an LA, 100
Word recognition triggering, 101

X

X character, 166

V4

Zoom options, 86
Zooming a graph, 309
Zooming a Graph, 86
Zooming a waveform, 86
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